
Activating	Your	Software
How	do	I	activate	my	software?
Use	the	NI	Activation	Wizard	to	obtain	an	activation	code	for	your
software.	You	can	launch	the	NI	Activation	Wizard	two	ways:

Launch	the	product	and	choose	to	activate	your	software	from	the
list	of	options	presented.
Launch	NI	License	Manager	by	selecting	Start»All
Programs»National	Instruments»NI	License	Manager.	Click	the
Activate	button	in	the	toolbar.
Note		You	do	not	need	to	activate	your	software	if	it	is	managed	by
NI	Volume	License	Manager	as	a	part	of	a	Volume	License
Agreement.

What	is	activation?
Activation	is	the	process	of	obtaining	an	activation	code	to	enable	your
software	to	run	on	your	computer.	An	activation	code	is	an	alphanumeric
string	that	verifies	the	software,	version,	and	computer	ID	to	enable
features	on	your	computer.	Activation	codes	are	unique	and	are	valid	on
only	one	computer.
What	is	the	NI	Activation	Wizard?
The	NI	Activation	Wizard	is	a	part	of	NI	License	Manager	that	steps	you
through	the	process	of	enabling	software	to	run	on	your	machine.
What	information	do	I	need	to	activate?
You	need	your	product	serial	number,	user	name,	and	organization.	The
NI	Activation	Wizard	determines	the	rest	of	the	information.	Certain
activation	methods	may	require	additional	information	for	delivery.	This
information	is	used	only	to	activate	your	product.	Complete	disclosure	of
National	Instruments	licensing	privacy	policy	is	available	at
ni.com/activate/privacy.	If	you	optionally	choose	to	register	your	software,
your	information	is	protected	under	the	National	Instruments	privacy
policy,	available	at	ni.com/privacy.
How	do	I	find	my	product	serial	number?
You	can	find	your	serial	number	on	the	proof-of-ownership	and
registration	card	that	you	received	with	your	product,	as	shown	in	the
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following	example.

What	is	a	Computer	ID?
The	computer	ID	contains	unique	information	about	your	computer.
National	Instruments	requires	this	information	to	enable	your	software.
You	can	find	your	computer	ID	through	the	NI	Activation	Wizard	or	by
using	NI	License	Manager,	as	follows:

1.	 Launch	NI	License	Manager	by	selecting	Start»All
Programs»National	Instruments»NI	License	Manager.

2.	 Click	the	Display	Computer	Information	button	in	the	toolbar.
For	more	information	about	product	activation	and	licensing	refer	to
ni.com/activate.
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Related	Documentation
Most	NI	Vision	manuals	also	are	available	as	PDFs.	You	must	have
Adobe	Reader	with	Search	and	Accessibility	5.0.5	or	later	installed	to
view	the	PDFs.	Refer	to	the	Adobe	Systems	Incorporated	Web	site	at
www.adobe.com	to	download	Adobe	Reader.	Refer	to	the	National
Instruments	Product	Manuals	Library	at	ni.com/manuals	for	updated
documentation	resources.
To	access	the	NI	Vision	Assistant	documentation,	select	Start»All
Programs»National	Instruments»Vision	Assistant.

NI	Vision	Assistant	Tutorial—Describes	the	NI	Vision	Assistant
software	interface	and	guides	you	through	creating	example	image
processing	and	machine	vision	applications.
NI	Vision	Concepts	Manual—Describes	the	basic	concepts	of
image	analysis,	image	processing,	and	machine	vision.	This
document	also	contains	in-depth	discussions	about	imaging
functions	for	advanced	users.
NI	Vision	Development	Module	Release	Notes—Contains
information	about	new	functionality,	minimum	system
requirements,	installation	instructions,	and	descriptions	of	the
documentation	for	the	following:	NI	Vision	for	LabVIEW,	NI	Vision
for	LabWindows/CVI,	NI	Vision	for	Visual	Basic,	and	NI	Vision
Assistant.
Application	Notes—Contain	information	about	advanced	NI	Vision
concepts	and	applications.	Application	Notes	are	located	on	the
National	Instruments	Web	site	at	ni.com/appnotes.nsf.
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Getting	Help	in	Vision	Assistant
You	can	get	help	in	Vision	Assistant	in	any	of	the	following	ways:

Click	the	Context	Help	button	 	on	the	Vision	Assistant	toolbar
to	launch	the	Context	Help	window.	The	content	of	the	Context
Help	window	automatically	updates	to	reflect	what	is	currently
selected	in	Vision	Assistant.	Move	the	mouse	pointer	over	the
buttons	in	the	toolbar,	Script	window,	Reference	window,
Acquisition	window,	or	Image	Browser	for	tooltips	that	describe
what	each	button	does.
Click	Help»Solution	Wizard	in	the	Vision	Assistant	menu	to
launch	the	Vision	Assistant	Solution	Wizard	and	view	typical	uses
of	NI	Vision	in	imaging	and	machine	vision	applications.
Click	Start»All
Programs»National	Instruments»Vision	Assistant»Vision	Assistant
Tutorial	to	launch	the	NI	Vision	Assistant	Tutorial.	This	manual	is
designed	to	teach	you	the	fundamental	features	of	Vision	Assistant
through	interactive	discussions	and	examples,	including	particle
analysis	and	part	gauging	examples.
Click	Start»All
Programs»National	Instruments»Vision	Assistant»NI	Vision
Concepts	Manual	to	launch	the	NI	Vision	Concepts	Manual.	This
manual	contains	information	about	the	algorithms,	utilities,	and
tools	available	in	Vision	Assistant	and	the	Vision	Development
Module	library.
Refer	to	the	NI	Vision	Acquisition	Software	Release	Notes	for	more
information	about	configuring	NI-IMAQ	driver	software,	NI	image
acquisition	devices,	and	cameras	using	Measurement	&
Automation	Explorer	(MAX).
Tips		

The	National	Instruments	Web	site	provides	information
about	NI	Vision	hardware	and	software.	Visit	NI	Machine
Vision	at	ni.com/vision.
Visit	the	NI	Developer	Zone	at	ni.com/zone.	NI	Developer
Zone	is	an	essential	resource	for	building	measurement	and
automation	systems.	The	NI	Developer	Zone	allows	easy
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access	to	the	latest	example	programs,	system
configurators,	tutorials,	technical	news,	as	well	as	a
community	of	developers	ready	to	share	their	own
techniques.
Several	example	scripts	are	installed	with	Vision	Assistant.
You	can	run	these	scripts	to	learn	more	about
Vision	Assistant	scripting	capabilities.	You	also	can
customize	these	scripts	for	your	own	applications.	By
default,	the	scripts	are	installed	at
<Vision	Assistant>\Examples,	where	<Vision	Assistant>	is	the
location	to	which	Vision	Assistant	is	installed.



Using	Help
Conventions
Navigating	Help
Searching	Help
Printing	Help	File	Topics



Conventions
This	help	file	uses	the	following	conventions:

<	> Angle	brackets	that	contain	numbers	separated	by	an	ellipsis
represent	a	range	of	values	associated	with	a	bit	or	signal
name—for	example,	AO	<0..3>.

[	] Square	brackets	enclose	optional	items—for	example,
[response].

» The	»	symbol	leads	you	through	nested	menu	items	and
dialog	box	options	to	a	final	action.	The	sequence	File»Page
Setup»Options	directs	you	to	pull	down	the	File	menu,
select	the	Page	Setup	item,	and	select	Options	from	the	last
dialog	box.
This	icon	denotes	a	tip,	which	alerts	you	to	advisory
information.
This	icon	denotes	a	note,	which	alerts	you	to	important
information.
This	icon	denotes	a	caution,	which	advises	you	of
precautions	to	take	to	avoid	injury,	data	loss,	or	a	system
crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	in	the
software,	such	as	menu	items	and	dialog	box	options.	Bold
text	also	denotes	parameter	names.

dark	red Text	in	this	color	denotes	a	caution.
green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,

help	file,	or	Web	address.
italic Italic	text	denotes	variables,	emphasis,	cross	references,	or

an	introduction	to	a	key	concept.	This	font	also	denotes	text
that	is	a	placeholder	for	a	word	or	value	that	you	must
supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should
enter	from	the	keyboard,	sections	of	code,	programming
examples,	and	syntax	examples.	This	font	is	also	used	for
the	proper	names	of	disk	drives,	paths,	directories,
programs,	subprograms,	subroutines,	device	names,



functions,	operations,	variables,	filenames,	and	extensions.



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window	or	use	the	following	toolbar	buttons	located	above
the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents	tab,
allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the	Back
button.
Options—Displays	a	list	of	commands	and	viewing	options	for	the
help	file.



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help
file.	If	you	want	to	search	for	words	in	a	certain	order,	such	as	"related
documentation,"	add	quotation	marks	around	the	search	words	as	shown
in	the	example.	Searching	for	terms	on	the	Search	tab	allows	you	to
quickly	locate	specific	information	and	information	in	topics	that	are	not
included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.
Use	the	asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For
example,	a	search	for	"prog*"	lists	topics	that	contain	the	words
"program,"	"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a
search	term.	For	example,	"?ext"	lists	topics	that	contain	the	words
"next,"	"text,"	and	so	on.

Note		Wildcard	searching	will	not	work	on	Simplified	Chinese,
Traditional	Chinese,	Japanese,	and	Korean	systems.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.
You	can	use	Boolean	expressions	and	wildcards	in	a	nested	expression.
For	example,	"example	AND	(program	OR	VI)"	lists	topics	that	contain
"example	program"	or	"example	VI."	You	cannot	nest	expressions	more
than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both	search	terms.	You
do	not	need	to	specify	this	operator	unless	you	are	using	nested
expressions.
OR—Returns	topics	that	contain	either	the	first	or	second	term.
NOT—Returns	topics	that	contain	the	first	term	without	the	second
term.
NEAR—Returns	topics	that	contain	both	terms	within	eight	words
of	each	other.



Search	Options

Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:
Search	previous	results—Narrows	the	results	from	a	search	that
returned	too	many	topics.	You	must	remove	the	checkmark	from
this	checkbox	to	search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that
contain	words	similar	to	the	search	terms.	For	example,	a	search
for	"program"	lists	topics	that	include	the	words	"programs,"
"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents
tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics

dialog	box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print
the	single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF
documents,	click	the	print	button	located	on	the	Adobe	Acrobat	Viewer
toolbar.



Acquisition	Mode
Use	the	Acquisition	mode	to	acquire	one	or	more	images	for	processing.
You	can	acquire	images	from	an	image	acquisition	device	or	simulate	an
acquisition.	Refer	to	Image	Acquisition	in	Vision	Assistant	for	information
about	hardware	requirements	and	image	acquisition	methods.

1		Reference	Window		 3		Navigation	Buttons		
2		Main	Window		 4		Acquisition	Palette		

Reference	Window—Displays	a	thumbnail	view	of	an	acquired
image.
Main	Window—Displays	the	current	image.
Navigation	Buttons—Switches	between	Vision	Assistant	modes.
Acquisition	Palette—Lists	the	types	of	image	acquisition	you	can
perform.



Browsing	Mode
When	you	acquire	or	open	images	in	Vision	Assistant,	the	images	are
loaded	into	the	Image	Browser.	Use	the	Browsing	mode	to	view	images
in	either	thumbnail	view	or	in	full-size	view.	Use	the	Image	Browser	to
select	the	image	that	you	want	to	process.	Click	an	image	in	the	Image
Browser	to	view	information	about	the	selected	image,	such	as	image
size,	location,	and	type.	The	images	in	the	Image	Browser	can	also	be
accessed	from	the	Reference	Window	in	Processing	mode.



Selecting	an	Image
To	begin	processing	an	image,	click	the	image	and	click	Process
Images.	You	can	also	select	an	image	to	process	by	double-clicking	the
image	in	the	Image	Browser.
If	an	image	is	not	selected	when	you	click	Process	Images,	the	last
acquired	image	is	displayed	in	the	Main	window.	If	you	select	more	than
one	image	and	click	Process	Images,	the	last	image	selected	opens	in
the	Main	window.
For	more	information	about	the	Image	Browser,	refer	to	Adding	New
Images	to	the	Image	Browser,	Removing	Images	from	the	Image
Browser,	and	Image	Browser	Controls.

1		Image	Browser		 6		Add	Image	to	Browser		
2		Navigation	Buttons		 7		Remove	Image	from	Browser		
3		Image	File	Path		 8		Image	Size		
4		Browse	Buttons		 9		Image	Type		
5		Thumbnail/Full-Size	Toggle		 10		File	Format		



Processing	Mode
After	acquiring	or	opening	an	image	in	Vision	Assistant,	you	can	apply
processing	functions	to	the	image	to	develop	an	image	processing
algorithm,	known	in	Vision	Assistant	as	a	script.	The	image	in	the
Processing	window	updates	as	you	apply	different	processing	functions.
Continuous	updating	allows	you	to	immediately	view	the	result	of	a
processing	function.
The	Processing	Functions	palette	displays	the	image	processing
functions	available	to	develop	processing	algorithms.	Each	function	on
the	Processing	Functions	palette	has	a	setup	window	where	you	set
parameters	for	the	function.
The	Reference	window	displays	a	thumbnail	view	of	the	original	image.
The	Script	window	displays	the	image	processing	steps	and	the	settings
for	each	step	in	a	processing	algorithm.	You	can	run	scripts	on	a	single
image	or	on	a	series	of	images.	You	also	can	modify	and	save	scripts	for
use	in	other	applications.

1		Reference	Window		 4		Processing	Functions	Palette		
2		Processing	Window		 5		Script	Window		
3		Navigation	Buttons		 	



Vision	Assistant	Toolbar
The	toolbar	is	located	at	the	top	of	the	Processing	window	of
Vision	Assistant.	You	can	use	the	toolbar	to	perform	several	functions,	as
described	in	the	following	list.

Launch	the	Vision	Assistant	context	help	window.

Open	image.

Save	image.

Print	image.

Display	image	at	2:1	ratio	and	enlarge	image	further	each	time
you	click	on	the	tool.
Display	image	at	1:2	ratio	and	reduce	image	further	each	time
you	click	on	the	tool.
Return	image	to	100%	view.

Display	the	color	palette	for	the	current	image.	You	can	change
the	palette	to	one	of	five	predefined	image	palettes	to	show
details	not	perceived	with	the	current	palette.	Changing	the
palette	here	does	not	change	the	content	of	the	image.

	 Gray	Levels—Gradual	grayscale	variation	from	black	to
white.	Each	value	is	assigned	an	equal	amount	of	the	RGB
intensities.
Binary—16	cycles	of	16	different	colors,	where	g	is	the
grayscale	value	and	g	=	0	corresponds	to	R	=	0,	G	=	0,	B	=
0	(black);	g	=	1	corresponds	to	R	=	1,	G	=	0,	B	=	0	(red);	g
=	2	corresponds	to	R	=	0,	G	=	1,	B	=	0	(green);	and	so	on.
Gradient—Gradation	from	red	to	white	with	a	prominent
range	of	light	blue	in	the	upper	range.	0	is	black	and	255	is
white.
Rainbow—Gradation	from	blue	to	red	with	a	prominent
range	of	greens	in	the	middle	value	range.	0	is	black	and
255	is	white.
Temperature—Gradation	from	light	brown	to	dark	brown.
0	is	black	and	255	is	white.



Point	Tool—Click	to	select	a	point	in	an	image.

Line	Tool—Click	and	drag	to	select	pixels	along	that	line.

Broken	Line	Tool—Click	and	drag	repeatedly	to	select	a	region.
Double-click	when	you	select	the	final	point	of	the	broken	line	to
release	the	ROI	tool.
Freehand	Line	Tool—Click	and	drag	to	select	a	region.	Release
the	mouse	button	when	you	are	finished.	Hold	down	the	<Shift>
key	while	you	click	and	drag	to	draw	straight	lines.
Rectangle	ROI	tool—Click	and	drag	to	select	a	rectangular
region.	Hold	down	the	<Shift>	key	while	you	click	and	drag	to
constrain	the	region	to	a	square.
Rotated	Rectangle	ROI	tool—Click	and	drag	to	select	a
rectangular	region.	Hold	down	the	<Shift>	key	while	you	click	and
drag	to	contain	the	region	to	a	square,	and	then	click	the	lines
inside	the	rectangle	and	drag	to	adjust	the	rotation	angle.
Oval	ROI	tool—Click	and	drag	to	select	an	oval	region.	Hold
down	the	<Shift>	key	while	you	click	and	drag	to	constrain	the
region	to	a	circle.
Annulus	ROI	tool—Click	the	center	position	and	drag	to	the	size
you	want.	Adjust	the	inner	and	outer	radii	and	the	start	and	end
angles.
Polygon	ROI	tool—Click	and	drag	repeatedly	to	select	a
polygon	region.	Double-click	to	complete	the	polygon.
Freehand	Region	ROI	tool—Click	and	drag	to	select	a	region	of
the	image.	To	select	a	region	with	this	tool,	verify	that	the	ending
point	lies	on	the	starting	point	to	enclose	a	region.
Magic	Wand	Tool—Create	an	image	mask	by	extracting	a
region	surrounding	a	reference	pixel,	called	the	origin,	and	using
a	tolerance	(+	or	–)	of	intensity	variations	based	on	this	reference
pixel.	Using	this	origin,	the	Magic	Wand	Tool	searches	for	its
neighbors	with	an	intensity	equal	to	or	falling	within	the	tolerance
value	of	the	point	of	reference.
Tolerance—Set	the	maximum	allowable	deviation	from	the
origin.	All	pixels	satisfying	the	tolerance	criteria	(origin	pixel	–



tolerance	/	origin	pixel	+	tolerance)	become	part	of	the	region.



Image	Acquisition	in	Vision	Assistant
To	start	acquiring	images,	select	File»Acquire	Image	or	click	Acquire
Images.	You	can	acquire	live	images	in	Vision	Assistant	with	various
National	Instruments	Smart	Cameras,	digital	and	analog	frame	grabbers,
DCAM-compliant	IEEE	1394	cameras,	and	Gigabit	Ethernet	(GigE)
Vision	cameras.	For	information	about	driver	software,	refer	to	the	NI
Vision	Acquisition	Software	Release	Notes.
If	the	computer	does	not	have	an	image	acquisition	device,	you	can
simulate	a	live	acquisition	with	the	Simulate	Acquisition	function.	You	can
interact	with	the	simulated	acquisition	as	you	would	with	a	live
acquisition.
Vision	Assistant	offers	three	types	of	acquisitions:	snap,	grab,	and
sequence.

A	snap	acquires	and	displays	a	single	image.
A	grab	acquires	and	displays	images	in	a	continuous	mode	at
maximum	rate,	which	is	useful	when	you	need	to	focus	the
camera.
A	sequence	acquires	images	according	to	settings	that	you	specify
in	the	Sequence	tab	of	the	Acquisition	Interface	window	and	sends
the	images	to	the	Image	Browser.

Related	Topics
Acquiring	a	sequence	of	images
Acquiring	images	in	color
Grabbing	an	image	(continuous	image	acquisition)
Snapping	an	image	(single	image	acquisition)



Acquire	Images
1.	 Select	the	NI	image	acquisition	device	connected	to	the	camera	to

acquire	an	image.
2.	 Click	the	Trigger	tab.
3.	 Enable	the	Triggered	Acquisition	control	if	you	want	to	start	the

image	capture	with	a	trigger.
Note		The	trigger	signal	must	be	connected	to	a	trigger	line
of	the	NI	image	acquisition	device.

Caution		The	trigger	input	lines	of	NI	image	acquisition
devices	expect	TTL	signals	and	are	not	isolated.	Do	not
provide	anything	other	than	TTL	signals	on	these	lines.
Doing	so	could	permanently	damage	the	NI	image
acquisition	device.

4.	 Select	the	trigger	line	to	which	the	trigger	signal	is	connected.
5.	 Select	the	trigger	polarity.	Select	Rising	Edge	if	you	want	to	start

the	acquisition	of	a	new	image	on	the	rising	edge	of	the	trigger
signal.	Select	Falling	Edge	if	you	want	to	start	the	acquisition	of	a
new	image	on	the	falling	edge	of	the	trigger	signal.

6.	 Enter	a	timeout	value.
7.	 Click	the	Acquire	Single	Image,	Acquire	Continuous	Images,	or

Sequence	Acquisition	button.
8.	 Click	Close	to	exit	the	Setup	window.

Related	Topic
Acquire	images	in	color



Acquire	Images	in	Color
1.	 Click	File»Acquire	Image.	Vision	Assistant	displays	the

Acquisition	window.
2.	 Click	the	appropriate	acquisition	step.	The	Devices	window

displays	all	NI	image	acquisition	devices	and	channels	or	ports
available	for	the	computer.

3.	 Select	an	image	acquisition	device	in	the	Parameter	window.
Notes		

You	must	have	an	NI	PCI/PXI-1411,	NI	PCI/PXI-
1422,	NI	PCI-1424,	NI	PCI/PXI-1428,	or	NI	PCIe-
1430	device	installed	to	acquire	color	images.	The	NI
PCI/PXI-1422	and	NI	PCI-1424	must	be	attached	to
a	color	digital	camera	to	acquire	color	images.
Refer	to	the	NI	Vision	Acquisition	Software	Release
Notes	for	information	about	configuring	the	NI	image
acquisition	device.

4.	 Click	the	Acquire	Single	Image	button,	Acquire	Continuous	Image
button,	or	Sequence	Acquisition	button.

5.	 Process	the	images	as	you	would	any	other	image	in
Vision	Assistant.

Related	Topic
Acquire	images



Acquire	Image	Controls
	Acquire	Single	Image—Acquires	and	displays	a	single	image

with	the	selected	National	Instruments	image	acquisition	device.
When	you	click	this	button,	the	step	acquires	and	displays	the	next
image	provided	by	the	camera.	If	you	enabled	the	Triggered
Acquisition	control	in	the	Trigger	tab,	the	step	waits	for	the	next
trigger	signal	to	acquire	and	display	an	image.

	Acquire	Continuous	Images—Acquires	and	displays	images
in	continuous	mode	at	maximum	frame	rate	with	the	selected	NI
image	acquisition	device.	When	you	click	this	button,	the	step
starts	the	continuous	acquisition	and	display	of	images.	If	you
enabled	the	Triggered	Acquisition	control	in	the	Trigger	tab,	the
step	waits	for	the	next	trigger	signal	to	acquire	and	display	a	new
image	for	each	iteration.	Click	the	button	a	second	time	to	stop	the
continuous	image	acquisition.	If	you	enabled	the	Triggered
Acquisition	control	in	the	Trigger	tab,	the	step	waits	for	a	last
trigger	or	timeout	before	stopping	the	acquisition.

	Sequence	Acquisition—Acquires	a	sequence	of	images.	You
can	choose	to	trigger	the	start	of	a	sequence	or	to	trigger	each
image	of	the	sequence.

	Store	Acquired	Image	in	Browser—Sends	the	last	acquired
image	to	the	Image	Browser.



Main	Tab
Devices—List	of	available	NI	image	acquisition	devices	and
channels	or	ports	you	can	use	to	acquire	an	image.



Trigger	Tab
Triggered	Acquisition—When	enabled,	you	can	synchronize	an
image	acquisition	with	events	external	to	the	computer,	such	as
receiving	a	pulse	from	a	sensor	that	indicates	the	position	of	an
item	on	an	assembly	line.	The	trigger	signal	must	be	connected	to
a	trigger	input	of	the	image	acquisition	device.	The	trigger	input
lines	of	NI	image	acquisition	devices	expect	TTL	signals	and	are
not	isolated.

Trigger	Line—Specifies	which	external	trigger	line	receives
the	incoming	trigger	signal.
Polarity—Specifies	if	you	start	the	acquisition	of	a	new
image	on	the	rising	or	falling	edge	of	the	trigger	signal.
Timeout	(ms)—Amount	of	time	to	wait	for	the	trigger	signal
before	returning	a	timeout	error.



Acquire	Image	FAQs
What	types	of	images	does	Vision	Assistant	support?
Vision	Assistant	supports	the	following	image	types:	8-bit,	16-bit,	float,
RGB,	and	HSL.

Can	I	wait	for	a	trigger	indefinitely?
No,	the	maximum	amount	of	time	you	can	wait	for	a	trigger	before
timing	out	is	60,000	ms	(60	seconds).

Which	triggers	can	I	use	for	my	NI	image	acquisition	device?
The	PCI/PXI-1407	and	PCI/PXI-1411	can	use	only	external	trigger	0.	All
other	NI	image	acquisition	devices	can	use	all	the	trigger	lines.

What	are	the	voltage	limits	of	the	trigger	signal?
The	voltage	limits	are	0–5	V	TTL.

What	should	I	do	if	my	device	does	not	appear	in	the	Devices	list?
Save	your	work	in	Vision	Assistant.	Close	Vision	Assistant	and	open
MAX.	Refer	to	the	Measurement	&	Automation	Explorer	Help	for	NI-
IMAQ	for	troubleshooting	tips.	You	can	access	the	Measurement	&
Automation	Explorer	Help	for	NI-IMAQ	in	MAX	by	clicking	Help»Help
Topics»NI-IMAQ.



Acquire	Images	with	an	IEEE	1394	or	GigE
Camera
Main	Tab

1.	 In	the	Target	control,	select	the	computer	you	want	to	use	to
acquire	images.

2.	 In	the	Devices	list,	select	the	device	you	want	to	use	to	acquire
an	image.

3.	 For	IEEE	1394	cameras,	select	the	IEEE	1394	Video	Mode	you
want	to	use.



Attributes	Tab
5.	 Select	and	configure	each	camera	feature	you	want	to	use	for	the

acquisition.
6.	 Click	the	Acquire	Single	Image,	Acquire	Continuous	Images,	or

Sequence	Acquisition	button.
7.	 Click	Close	to	exit	the	Setup	window.



Acquire	Image	(IEEE	1394	or	GigE)	Controls
	Acquire	Single	Image—Acquires	and	displays	a	single	image

from	an	IEEE	1394	or	Gigabit	Ethernet	(GigE)	camera.	When	you
click	this	button,	the	step	acquires	and	displays	the	next	image
provided	by	the	camera.	If	the	camera	is	in	a	triggered	mode,	the
step	waits	for	the	next	trigger	signal	to	acquire	and	display	an
image.

	Acquire	Continuous	Images—Performs	a	continuous
acquisition,	or	a	triggered	grab	if	the	camera	is	in	a	triggered
mode,	and	displays	the	image.	When	you	click	this	button,	the	step
starts	the	continuous	acquisition	and	display	of	images.	If	the
camera	is	in	a	triggered	mode,	the	step	waits	for	the	next	trigger
signal	to	acquire	and	display	a	new	image	for	each	iteration.	Click
this	button	a	second	time	to	stop	the	continuous	image	acquisition.

	Refresh	List	of	Devices—Refreshes	the	Devices	list	on	the
Main	tab.

	Sequence	Acquisition—Acquires	a	sequence	of	images.	You
can	choose	to	trigger	the	start	of	a	sequence	or	to	trigger	each
image	of	the	sequence.

	Store	Acquired	Image	in	Browser—Sends	the	image	to	the
Image	Browser.



Main	Tab
Target—Computer	you	want	to	use	to	acquire	images.

This	Computer—Selects	the	computer	you	are	currently
using.
Select	Network	Target—Launches	the	Select	Target	dialog
box.

IP	Address—IP	address	of	the	computer	you	want	to
use	to	acquire	images.
Password—Network	password	for	the	computer	you
selected	in	IP	Address.

Devices—List	of	image	acquisition	devices	installed	in	the
computer	you	selected	in	Target	and	associated	with	the	NI-
IMAQdx	driver	software.	Use	Measurement	&	Automation	Explorer
(MAX)	to	associate	the	camera	with	the	NI-IMAQdx	driver	software
if	the	camera	does	not	appear	in	the	list.
IEEE	1394	Video	Mode—List	of	video	modes	available	for	the
IEEE	1394	camera	currently	selected	in	Devices.



Attributes	Tab
Attribute—List	of	the	attributes	for	the	selected	camera.
Attribute	Help—Information	about	the	selected	attribute	returned
by	the	camera.
Value—Specifies	the	value	for	the	currently	selected	attribute.
Show	All	Attributes—Displays	all	of	the	attributes	available	on
the	selected	camera,	including	attributes	that	cannot	be
configured.
Show	Attribute	Help—Displays	information	about	the	selected
attribute	returned	by	the	camera.
Reset	All—Resets	all	of	the	attributes	to	the	default	values
configured	in	MAX.



Acquire	Image	(IEEE	1394	or	GigE)	FAQs
In	the	Acquire	Images	tab,	why	is	the	Acquire	Image	(IEEE	1394	or
GigE)	icon	disabled?
The	icon	may	be	disabled	for	several	reasons.	Verify	that	the	correct
version	of	the	NI-IMAQdx	driver	software	is	installed.	If	necessary,
install	the	driver	software.	If	the	icon	is	still	disabled	after	verifying	that
the	correct	driver	is	installed,	refer	to	the	Measurement	&	Automation
Explorer	Help	for	NI-IMAQdx	for	troubleshooting	tips.	You	can	access
the	Measurement	&	Automation	Explorer	Help	for	NI-IMAQdx	in	MAX
by	clicking	Help»Help	Topics»NI-IMAQdx.

My	camera	appears	in	Measurement	&	Automation	Explorer	(MAX)
but	does	not	appear	in	the	Devices	list.	How	can	I	get	the	name	of
my	camera	to	appear	in	the	Devices	list?
Make	sure	that	the	camera	is	associated	with	the	NI-IMAQdx	driver	in
MAX.	If	the	camera	is	listed	under	Legacy	NI-IMAQ	IEEE	1394
Devices,	right-click	the	camera	and	select	Driver»NI-IMAQdx	IIDC
Digital	Camera.	Refer	to	the	Measurement	&	Automation	Explorer
Help	for	NI-IMAQdx	for	troubleshooting	tips.	You	can	access	the
Measurement	&	Automation	Explorer	Help	for	NI-IMAQdx	in	MAX	by
clicking	Help»Help	Topics»NI-IMAQdx.

I	cannot	acquire	images	when	I	press	the	Acquire	Image	or
Continuous	Acquisition	buttons.
Close	Vision	Assistant.	Open	MAX,	and	verify	the	camera	appears
correctly	in	the	Devices	and	Interfaces	branch	of	the	Configuration	tree.
Refer	to	the	Measurement	&	Automation	Explorer	Help	for	NI-IMAQdx
for	troubleshooting	tips.	You	can	access	the	Measurement	&
Automation	Explorer	Help	for	NI-IMAQdx	in	MAX	by	clicking	Help»Help
Topics»NI-IMAQdx.

Why	does	my	16-bit	image	appear	incorrectly?
Complete	the	following	steps	to	adjust	the	16-bit	pixel	representation
parameters	and	correct	the	image:

1.	 In	the	property	page	for	the	Acquire	Image	(IEEE	1394	or
GigE)	step,	on	the	Main	tab,	select	the	camera	from	the
Devices	list.

2.	 Click	the	Attributes	tab.



3.	 Select	the	Show	All	Attributes	checkbox	to	list	all	of	the
attributes	for	the	camera.

4.	 Adjust	the	values	for	the	BitsPerPixel,	ShiftPixelBits,	and
SwapPixelBytes	attributes	to	correct	the	image.

5.	 Click	OK	to	save	the	configuration	settings.
Note		Some	image	processing	algorithms	do	not	support	16-bit
images.

Why	do	some	attributes	not	have	an	effect	on	the	image?
Even	though	an	attribute	is	writable,	the	camera	may	be	in	a	mode	that
ignores	the	attribute	you	are	trying	to	set.	For	example,	if	the	camera	is
in	an	8-bit	mode	and	you	set	the	BitsPerPixel	or	ShiftPixelBits	attribute,
the	image	will	not	be	affected	because	those	attributes	only	apply	to	16-
bit	images.

Why	are	no	triggering	modes	listed	in	the	Attribute	tree?
Not	all	cameras	support	triggering.	Only	attributes	supported	by	the
camera	are	listed	in	the	Attribute	tree.



How	to	Acquire	Images	with	a	USB	Device
1.	 In	Devices,	select	the	USB	device	you	want	to	use	to	acquire	the

image.
2.	 Click	the	Acquire	Single	Image,	Acquire	Continuous	Images,	or

Sequence	Acquisition	button.
3.	 Click	Close	to	exit	the	Setup	window.



Acquire	Image	(USB)	Controls
	Acquire	Single	Image——Acquires	and	displays	a	single

image	from	a	USB	device.	When	you	click	this	button,	the	step
acquires	and	displays	the	next	image	provided	by	the	camera.

	Acquire	Continuous	Images—Performs	a	continuous
acquisition	and	displays	the	image.	When	you	click	this	button,	the
step	starts	the	continuous	acquisition	and	display	of	images.	Click
the	button	a	second	time	to	stop	the	continuous	image	acquisition.

	Sequence	Acquisition—Acquires	a	sequence	of	images.	You
can	choose	to	trigger	the	start	of	a	sequence	or	to	trigger	each
image	of	the	sequence.

	Store	Acquired	Image	in	Browser—Sends	the	image	to	the
image	browser.



Main	Tab
Devices—List	of	USB	devices	you	can	use	to	acquire	an	image.
Video	Settings—Manufacturer	video	settings	property	page	for
the	selected	device.
Image	Settings—Manufacturer	image	settings	property	page	for
the	selected	device.



Acquire	Image	(USB)	FAQs
What	types	of	images	does	Vision	Assistant	support?
Vision	Assistant	supports	the	following	image	types:	8-bit,	16-bit,	float,
RGB,	and	HSL.
Why	is	my	device	not	displayed	in	the	device	list?
When	the	step	is	opened,	all	USB-compliant	cameras	are	found.	Your
camera	may	not	have	been	plugged	in	or	working	when	the	step	was
opened,	or	your	device	may	not	be	USB-compliant.	Try	opening	the	step
again	with	the	camera	powered	and	working	correctly	if	it	is	a	USB-
compliant	camera.
Why	is	my	device	unavailable?
When	you	click	on	a	device,	it	is	initialized.	If	there	are	errors	during
initialization,	the	device	name	is	grayed	out	in	Devices,	which	indicates
that	the	device	is	unavailable.
Why	do	the	Video	and	Image	settings	property	pages	not	work
correctly?
These	property	pages	are	provided	by	the	manufacturer.	Report	any
problems	with	them	to	the	manufacturer	of	the	camera.



How	to	Acquire	an	Image	with	an	NI	17xx	Smart
Camera
Main	Tab

1.	 In	the	Target	drop-down	listbox,	choose	Select	Network	Target
or	select	a	configured	smart	camera	to	acquire	images	from.



Trigger	Tab
1.	 Select	Triggered	Acquisition	if	you	want	to	start	the	image

capture	with	a	trigger.
Note		The	trigger	signal	must	be	connected	to	the	trigger
line	of	the	NI	17xx.	Refer	to	the	NI	17xx	User	Manual	for
information	about	connecting	signals	to	the	NI	17xx.

2.	 Select	the	trigger	polarity.	Select	Rising	Edge	if	you	want	to	start
the	acquisition	of	a	new	image	on	the	rising	edge	of	the	trigger
signal.	Select	Falling	Edge	if	you	want	to	start	the	acquisition	of	a
new	image	on	the	falling	edge	of	the	trigger	signal.

3.	 Enter	a	Timeout	value.	If	a	trigger	signal	is	not	received	within	the
timeout	period,	the	step	fails.

4.	 Select	the	Acquisition	Mode	you	want	to	use	for	the	acquisition.



Lighting	Tab
1.	 If	you	want	to	use	the	internal	Direct	Drive	lighting	controller,

enable	the	Enable	Direct	Drive	control	and	select	the	light
connected	to	the	smart	camera.
If	you	want	to	use	an	external	lighting	controller	with	the	NI	17xx,
use	the	5	V	TTL	Strobe	or	24	V	Strobe	control,	depending	on	the
voltage	your	lighting	controller	requires,	to	generate	strobe	signals
for	the	lighting	controller.



Compression	Tab
1.	 Select	the	level	of	compression	to	apply	to	images.



Acquire	Image	(Smart	Camera)	Controls
The	following	controls	are	available	on	all	tabs.

	Acquire	Single	Image—Acquires	and	displays	a	single	image
from	the	NI	17xx	smart	camera.	When	you	click	this	button,	the
step	acquires	and	displays	the	next	image	provided	by	the	camera.
If	the	camera	is	in	a	triggered	mode,	the	step	waits	for	the	next
trigger	signal	to	acquire	and	display	an	image.

	Acquire	Continuous	Images—Performs	a	continuous
acquisition,	or	a	triggered	grab	if	the	camera	is	in	a	triggered
mode,	and	displays	the	image.	When	you	click	this	button,	the	step
starts	the	continuous	acquisition	and	display	of	images.	If	the
camera	is	in	a	triggered	mode,	the	step	waits	for	the	next	trigger
signal	to	acquire	and	display	a	new	image	for	each	iteration.	Click
this	button	a	second	time	to	stop	the	continuous	image	acquisition.

	Store	Acquired	Image	in	Browser—Sends	the	last	acquired
image	to	the	Image	Browser.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Target—Smart	camera	you	want	to	use	to	acquire	images.
Exposure	Time—Time	during	which	the	camera	sensor	is
exposed	to	light.	Exposure	Time	can	be	adjusted	in	31.2µs
increments.
Gain—Adjusts	the	gain	of	an	image.
Partial	Scan—Specifies	the	scanning	mode	of	the	smart	camera.

Full—Reads	the	full	sensor.
Horizontal	Middle	Half—Reads	the	middle	half	of	the
sensor.
Horizontal	Quarter	Half—Reads	the	middle	quarter	of	the
sensor.

Binning—Specifies	the	binning	mode	of	the	smart	camera.
Off—Pixels	are	not	combined.
1	×	2—Vertical	pixels	are	combined.

Max	Frame	Rate—Displays	the	maximum	rate	of	frames	per
second.



Trigger	Tab
The	following	controls	are	available	on	the	Trigger	tab.

Triggered	Acquisition—When	enabled,	you	can	synchronize	an
image	acquisition	with	events	external	to	the	smart	camera,	such
as	receiving	a	pulse	from	a	detector	that	indicates	the	position	of
an	item	on	an	assembly	line.	The	trigger	signal	must	be	connected
to	the	trigger	input	of	the	smart	camera.
Trigger	Polarity—Specifies	if	you	reset	the	camera	and	start	the
acquisition	of	a	new	image	on	the	rising	or	falling	edge	of	the
trigger	signal.
Exposure	Delay—Specifies	the	amount	of	time	to	delay	the
exposure	of	the	smart	camera	sensor	after	receiving	a	trigger
signal.
Delay	Unit—Specifies	the	units	for	Exposure	Delay.

Note		The	Encoder	Counts	option	is	only	available	for
smart	cameras	that	support	quadrature	encoders.

Timeout—Specifies	the	amount	of	time,	in	milliseconds,	to	wait	for
the	trigger	signal	before	returning	a	timeout	error.



Lighting	Tab
The	following	controls	are	available	on	the	Lighting	tab.

Configure	Light—Launches	the	Configure	Light	dialog	box.	Use
the	controls	in	the	dialog	box	to	configure	your	light.
Enable	Direct	Drive	Lighting—When	enabled,	this	control	allows
you	to	use	the	smart	camera	internal	lighting	controller.	Direct
Drive	lighting	is	not	available	on	all	NI	Smart	Cameras.	Refer	to	the
NI	17xx	Smart	Camera	User	Manual	for	information	about	the
Direct	Drive.
Direct	Drive	Lighting	Mode—Specifies	the	operation	mode	for
the	Direct	Drive	lighting	controller.	The	following	values	are	valid:

Continuous—Continuously	powers	the	connected	light.
Strobe—Drives	the	connected	light	only	when	the	smart
camera	sensor	is	exposed.	Strobe	mode	allows	you	to
temporarily	overdrive	the	light.

Desired	Current	Level—Specifies	the	amount	of	current,	in
milliamperes,	to	use	to	drive	the	light.	If	the	specified	current	is
greater	than	the	maximum	current	level	for	the	connected	light,	the
actual	current	level	is	lowered	to	protect	the	light.
5	V	TTL	Strobe—When	enabled,	the	NI	17xx	generates	a	5	V	TTL
strobe	signal	for	use	with	an	external	lighting	controller.
24	V	Strobe—When	enabled,	the	NI	17xx	generates	a	24	V	strobe
signal	for	use	with	an	external	lighting	controller.
Polarity—Specifies	whether	the	strobe	pulse	is	high	or	low	while
the	smart	camera	is	acquiring.	In	the	rising	mode,	the	strobe	pulse
is	high	when	the	camera	is	acquiring.	In	the	falling	mode,	the
strobe	pulse	is	low	when	the	camera	is	acquiring.



Compression	Tab
The	following	controls	are	available	on	the	Compression	tab.

Compress	Image—Compresses	the	acquired	image	according	to
the	Image	Quality	setting	you	specify.
Image	Quality—Indicates	the	quality	of	the	compressed	image.	0
indicates	the	image	is	highly	compressed	and	is	lower	quality.	1000
indicates	the	image	is	not	compressed.



Acquire	Image	(Smart	Camera)	FAQs
How	can	I	prevent	my	acquisition	step	from	timing	out?
The	Acquire	Image	(Smart	Camera)	step	returns	a	timeout	error	if	the
step	is	configured	for	a	triggered	acquisition	and	a	trigger	is	not	received
before	the	specified	Timeout	period	expires.



How	to	Configure	Remote	Targets
Remote	targets	are	field	programmable	devices	that	you	add	to	a	subnet
and	run	remotely.	You	configure	a	remote	target	from	a	host	machine	on
the	same	subnet,	defining	settings	such	as	the	target	name	and
description,	network	settings,	and	software	revisions.	Refer	to	Getting
Started	with	the	NI	17xx	Smart	Camera	for	information	about	configuring
the	NI	17xx.
If	the	remote	target	you	want	to	select	is	on	a	different	subnet	than	the
development	computer,	it	may	not	appear	in	the	list	of	available	targets.
Click	Add	Target,	enter	the	IP	address	of	the	remote	target	you	want	to
configure,	and	click	OK	to	add	the	target	to	the	table.



Acquire	Images	on	a	Remote	Target
1.	 In	Target,	select	the	computer	you	want	to	use	to	acquire	images.
2.	 Select	the	device	you	want	to	use	to	acquire	the	image.
3.	 Click	the	Parameters	tab.
4.	 If	you	want	to	compress	the	acquired	images,	select	Compress

Images	and	set	the	Image	Quality.
5.	 Click	Acquire	Single	Image	or	click	Acquire	Continuous

Images.
6.	 Click	Close	to	exit	the	Setup	window.



Acquire	Image	(RT)	Controls
	Acquire	Single	Image—Acquires	and	displays	a	single	image

from	a	remote	NI	image	acquisition	device.	When	you	click	this
button,	the	step	acquires	and	displays	the	next	image	provided	by
the	camera.

	Acquire	Continuous	Images—Performs	a	continuous
acquisition	and	displays	the	image.	When	you	click	this	button,	the
step	starts	the	continuous	acquisition	and	display	of	images.	Click
the	button	a	second	time	to	stop	the	continuous	image	acquisition.

	Store	Acquired	Image	in	Browser—Sends	the	image	to	the
Image	Browser.



Main	Tab
Target—Computer	you	want	to	use	to	acquire	images.

This	Computer—Selects	the	computer	you	are	currently
using.
Select	Network	Target—Launches	the	Select	Target	dialog
box.

IP	Address—IP	address	of	the	computer	you	want	to
use	to	acquire	images.
Password—Network	password	for	the	computer	you
selected	in	IP	Address.

Devices—List	of	image	acquisition	devices	installed	in	the
computer	you	selected	in	Target.



Parameters	Tab
Compress	Image—Compresses	the	acquired	image	according	to
the	Image	Quality	setting	you	specify.
Image	Quality—Indicates	the	quality	of	the	compressed	image.	0
indicates	the	image	is	highly	compressed	and	is	lower	quality.	1000
indicates	the	image	is	lightly	compressed	and	is	higher	quality.

Related	Topics
How	to	Acquire	Images	on	a	Remote	Target



Acquire	Image	(RT)	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



How	to	Simulate	an	Image	Acquisition
1.	 Click	File»Acquire	Image	or	click	Acquire	Images.
2.	 Click	Simulate	Acquisition	in	the	Acquisition	functions	list.
3.	 Click	the	 	Browse	button	to	select	a	path	to	a	directory	of

images,	and	click	Select	Cur	Dir.
4.	 Click	the	Acquire	Single	Image,	Acquire	Continuous	Images,	or

Sequence	Acquisition	button.
5.	 Click	Close	to	exit	the	Setup	window.



Simulate	Acquisition	Controls
	Acquire	Single	Image—Acquires	and	displays	a	single

image.	When	you	click	this	button,	the	step	acquires	and	displays
the	next	image	in	the	sequence	of	images.

	Acquire	Continuous	Images—Acquires	and	displays	images
in	continuous	mode	at	a	maximum	frame	rate	from	the	sequence
of	images.	When	you	click	this	button,	the	step	starts	the
continuous	acquisition	and	display	of	images.	Click	the	button	a
second	time	to	stop	the	continuous	image	acquisition.

	Sequence	Acquisition—Acquires	a	sequence	of	images.

	Store	Acquired	Image	in	Browser—Sends	the	last	acquired
image	to	the	Image	Browser.
Path—Location	of	the	currently	specified	image.

	Browse—When	clicked,	this	button	launches	a	dialog	box
from	which	you	can	select	an	image	to	open.



Simulate	Acquisition	FAQs
Which	image	file	formats	are	supported?
Vision	Assistant	supports	the	following	image	file	formats:	BMP,	TIFF,
JPG,	and	PNG.
Is	there	a	size	limit	for	images	I	want	to	load?
Vision	Assistant	does	not	have	an	image	size	limit.



Open	Images	in	Vision	Assistant
1.	 Click	File»Open	Image	or	click	 	Open	Image.
2.	 From	the	Look	In	list,	select	the	drive	on	which	the	image	is

located.
3.	 Browse	to	the	image	and	click	OK.	Vision	Assistant	loads	the

image	file	into	the	Image	Browser.
4.	 Double-click	the	image	to	start	processing	it.
Tip		You	can	select	all	files	in	a	folder	by	enabling	the	Select	all
files	option,	or	you	can	select	multiple	files	by	pressing	the	<Shift>
key	while	clicking	filenames.	When	you	select	an	image	from	the
list,	the	Preview	Image	window	displays	the	image,	file	type,	image
size,	and	image	type.	If	you	have	selected	a	collection	of	images,
the	Preview	window	displays	all	images	in	a	sequence.	To	view	the
sequence	at	a	different	rate,	adjust	the	slide	to	the	right	of	the
Preview	Image	window.

Related	Topics
Adding	a	processed	image	to	the	Image	Browser
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Printing	an	image
Removing	an	image	from	the	Image	Browser
Saving	an	image



Open	AVI	Files	in	Vision	Assistant
1.	 Click	File»Open	AVI	File.	Audio	Video	Interleaved	(AVI)	files	are

movie	files	that	include	a	collection	of	images.
2.	 From	the	Look	In	list,	select	the	drive	on	which	the	AVI	file	is

located.
3.	 Browse	to	the	file	and	click	OK.	Vision	Assistant	loads	the	AVI	file

into	the	Image	Browser.
Tip		When	you	select	a	file	from	the	list,	the	Preview	Image
window	plays	the	AVI	movie	file.	To	view	the	sequence	in	a
continuous	play	mode,	enable	the	Continuous	Play	option.
To	view	individual	images	of	the	AVI	file,	disable	the
Continuous	Play	option	and	adjust	the	slide	below	the
Preview	Image	window.	The	Frame	#	indicator	displays	the
index	of	the	image	in	the	Preview	Image	window.	You	can
select	all	images	by	clicking	the	All	Images	radio	button	in
the	Images	Selection	section	of	the	window,	or	you	can
enter	a	range	of	frames	to	select	by	entering	values	in	the
From,	To,	and	Step	controls.

4.	 Double-click	the	image	to	begin	processing	it.
Related	Topics
Adding	a	processed	image	to	the	Image	Browser
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Printing	an	image
Removing	an	image	from	the	Image	Browser
Saving	an	image



Add	New	Images	to	the	Image	Browser
You	can	add	images	to	the	Image	Browser	when	you	are	processing
images	or	when	you	are	browsing	images.



Add	New	Images	to	the	Image	Browser	in	Processing	Mode
When	you	open	an	image	from	a	file	or	acquire	an	image,	you	can	send
the	image	to	the	Image	Browser	by	clicking	 	Store	Image	in	Browser
in	the	Reference	Window.

Note		When	you	open	an	image	file	and	there	are	already	images
in	the	Image	Browser,	Vision	Assistant	prompts	you	to	remove	the
existing	images	from	the	Image	Browser.	Click	No	to	retain	the
existing	images	and	add	the	new	image	to	the	Image	Browser.
Click	Yes	to	remove	the	existing	images	from	the	Image	Browser
before	adding	the	new	image.



Add	New	Images	to	the	Image	Browser	in	Browsing	Mode
When	you	are	browsing	images	in	the	Image	Browser,	click	 	Open
Image	or	select	File»Open	Image	to	open	new	images	in	the	Image
Browser.

Note		When	you	open	an	image	file	and	there	are	already	images
in	the	Image	Browser,	Vision	Assistant	prompts	you	to	remove	the
existing	images	from	the	Image	Browser.	Click	No	to	retain	the
existing	images	and	add	the	new	image	to	the	Image	Browser.
Click	Yes	to	remove	the	existing	images	from	the	Image	Browser
before	adding	the	new	image.



Browse	and	Remove	Images	in	the	Image
Browser
The	Image	Browser	displays	thumbnail	images	in	groups	of	20.	If	there
are	more	than	20	images	open	in	the	Image	Browser,	use	the	image
browser	controls	to	navigate	the	images.	When	you	are	viewing	images
in	thumbnail	view,	you	can	begin	processing	an	image	by	selecting	the
image	and	clicking	Process	Images	or	by	double-clicking	the	image.

You	can	view	the	thumbnail	images	in	full	size	by	clicking	the	
Thumbnail/Full-Size	View	toggle	button	at	the	bottom	of	the	Image
Browser.	When	you	are	viewing	the	image	in	full-size	view,	use	the	image
browser	controls	to	navigate	the	images.	You	can	use	these	buttons	to
scan	the	images	in	reverse	or	forward	order	and	view	the	images
continuously.	Vision	Assistant	displays	the	current	location,	image	size
and	type,	and	the	file	type	below	the	image.



Remove	Images	from	the	Image	Browser
You	can	remove	images	from	the	Image	Browser	in	both	the	thumbnail
and	full-size	views.

Caution		
If	you	click	 	Close	Selected	Image	while	in	thumbnail
view	without	selecting	an	image,	Vision	Assistant	prompts
you	to	close	all	images	in	the	Image	Browser.
If	you	remove	images	that	you	acquired	and	sent	to	the
Image	Browser,	the	images	are	deleted	from	memory	and
you	cannot	retrieve	them.

To	remove	an	image	from	the	Image	Browser	in	thumbnail	view,	select
the	image	and	click	Close	Selected	Image.	To	remove	multiple	images
from	the	Image	Browser,	click	each	image	that	you	want	to	close,	and
then	click	Close	Selected	Image.
To	remove	an	image	from	the	Image	Browser	in	full-size	view,	click	Close
Selected	Image	while	the	image	is	visible.

Note		Removing	an	image	from	the	Image	Browser	does	not
delete	the	image	from	disk.



Browse	Images	in	the	Reference	Window
While	you	are	processing	an	image,	you	can	use	the	Reference	Window
controls	to	browse	the	images	that	are	open	in	the	Image	Browser.

First	Image—Navigates	to	the	first	image	stored	in	the	Image
Browser.
Previous	Image—Navigates	to	the	previous	image	stored	in	the
Image	Browser.
Next	Image—Navigates	to	the	next	image	stored	in	the	Image
Browser.
Last	Image—Navigates	to	the	last	image	stored	in	the	Image
Browser.
Store	Image	in	Browser—Stores	the	image	in	the	Image	Browser.
After	processing	an	image,	you	can	store	the	image	in	the	Image
Browser	with	this	control.
Make	Image	Active—Sends	the	image	in	the	Reference	Window
to	the	main	window.	The	main	window	is	where	you	apply
processing	functions	to	an	image.



Access	Images	from	the	Reference	Window
1.	 Use	the	Reference	Window	controls	to	navigate	the	images	in	the

Image	Browser	and	select	one	to	process.

2.	 Click	the	 	Make	Image	Active	button	to	process	the	image
shown	in	the	Reference	Window.
Tip		You	can	send	the	image	you	are	currently	processing	to	the
Image	Browser	to	keep	a	copy	of	the	image	resulting	from	a
process	by	clicking	 	Store	Image	in	Browser	in	the	Reference
Window.



Add	Processed	Images	to	the	Image	Browser
You	can	keep	a	copy	of	the	image	you	are	currently	processing	by
sending	a	copy	to	the	Image	Browser.	Click	 	Store	Image	in
Browser	to	send	the	image	to	the	Image	Browser.
Related	Topics
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Opening	images	in	Vision	Assistant
Printing	an	image
Removing	an	image	from	the	Image	Browser
Saving	an	image



Save	Images
You	can	save	one	or	several	images	you	acquired	and	processed	to
separate	image	files,	or	you	can	create	an	AVI	file	containing	a	sequence
of	images.

1.	 Click	File»Save	Image.
2.	 Browse	to	the	location	to	which	you	want	to	save	the	file	and	type

the	filename	for	the	image.
3.	 If	you	are	saving	a	calibrated	image	and	want	to	save	the

calibration	information	with	the	image,	select	Save	Image
Calibration.

4.	 Select	the	File	Format	for	the	image.
If	you	have	calibrated	the	image	and	enable	the	Save
Image	Calibration	checkbox,	only	the	PNG	-	Portable
Network	format	is	available	in	the	File	Format	list.
If	you	select	AVI	-	AVI	Movie	File	from	the	File	Format	list,
select	a	filter	and	a	frame	rate	for	the	movie.
If	you	select	JP2	-	JPEG	2000	File	Format	from	the	File
Format	list,	enable	the	Lossless	checkbox	if	you	want
lossless	compression,	and	specify	a	compression	ratio.

5.	 Click	Save.
Note		When	you	save	binary	images,	select	Expand	Dynamic	of
Binary	Images	to	view	the	image	pixels	without	using	a	binary
palette.

Tips		
You	can	save	a	collection	of	images	using	the	All	Images	or
From,	To,	Step	options.

All	Images	saves	each	image	in	the	Image	Browser
with	the	specified	filename	and	a	number	describing
its	position	in	the	Image	Browser.
The	From,	To,	Step	option	saves	images	starting	with
the	From	parameter	and	ending	with	the	To
parameter.	Step	specifies	if	you	want	to	repetitively
skip	images	in	the	Image	Browser.	For	example,	if	you
set	From=2,	To=10,	and	Step=2,	Vision	Assistant
saves	the	second,	fourth,	sixth,	eighth,	and	tenth



images	from	the	Image	Browser.

Related	Topics
Adding	a	processed	image	to	the	Image	Browser
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Opening	images	in	Vision	Assistant
Printing	an	image
Removing	an	image	from	the	Image	Browser



Print	Images
1.	 Select	the	image	that	you	want	to	print.
2.	 Click	File»Print	Image.
3.	 Type	the	title	of	the	image	and	comments,	if	necessary.	You	can

leave	these	options	blank	if	you	do	not	need	them.
4.	 Enable	the	Print	Results	Overlaid	on	the	Image	option	to	print

overlay	information	such	as	templates	you	use	for	pattern
matching	and	lines	drawn	with	the	Edge	Detector	function.

5.	 Click	Set	Printer	to	select	a	printer.
6.	 Click	OK.

Related	Topics
Adding	a	processed	image	to	the	Image	Browser
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Opening	images	in	Vision	Assistant
Removing	an	image	from	the	Image	Browser
Saving	an	image



Magnify	an	Image
Use	the	 	Zoom	In	and	 	Zoom	Out	tools	to	change	the	view	of	an
image.	The	following	magnification	factors	are	displayed	in	the	lower,	left
corner	of	the	Processing	window:

1/1	indicates	100%	magnification	(default)
2/1	indicates	a	200%	magnified	view
1/2	indicates	a	50%	demagnified	view



Reduce	the	Magnification	of	an	Image
Click	the	 	Zoom	Out	tool	located	in	the	toolbar	to	reduce	the
magnification	of	an	image.

Tips		

Click	the	 	Zoom	In	or	 	Zoom	1:1	tool	to	return	to	the
original	magnification.
Magnification	factors	are	displayed	in	the	lower,	left	corner
of	the	processing	window.	1/1	specifies	100%	magnification
(default).	2/1	specifies	a	200%	magnified	view,	and	1/2
specifies	a	50%	demagnified	view.

Related	Topics
Adding	a	processed	image	to	the	Image	Browser
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Opening	images	in	Vision	Assistant
Printing	an	image
Removing	an	image	from	the	Image	Browser
Saving	an	image



Scripting	Concepts
The	Vision	Assistant	scripting	feature	records	a	series	of	image
processing	steps	and	the	parameters	you	specified	for	each	of	those
steps.	You	can	run	scripts	on	single	images	or	image	collections	(batch
processing).	You	also	can	modify	and	save	scripts.
A	script	is	a	list	of	image	processing	and	analysis	functions	and	the
parameters	for	each	of	those	functions.	As	you	prototype	the	image
processing	application,	Vision	Assistant	records	each	function	and	its
parameters.
Complete	the	following	steps	to	develop	a	script:

1.	 Process	an	image.

When	you	finish	processing	the	image	and	exit	the	Parameter
window,	Vision	Assistant	adds	the	processing	step	to	the	current
script.

2.	 Save	the	script.
You	can	use	the	script,	which	is	also	called	a	Builder	file,	to	implement
the	image	processing	application	using	the	NI	Vision	machine	vision	and
image	processing	library	in	LabVIEW,	LabWindows/CVI,	Visual	Basic,	or
other	ActiveX	containers.
If	you	have	LabVIEW	7.1	or	later	and	the	NI	Vision	8.2.1	Development
Module	or	later	installed,	you	can	use	Vision	Assistant	to	create	the
LabVIEW	VI	implementing	the	image	processing	steps	you	prototyped.



Script	Window
The	Script	window	lists	a	series	of	image	processing	steps	and	the
settings	for	each	of	those	steps.	The	Script	window	contains	several	tools
you	can	use	to	create,	open,	save,	or	run	a	script	as	well	as	remove	or
edit	a	step	in	the	script.	The	Script	window	also	contains	tools	that	allow
you	to	step	through	the	script.	As	you	step	through	the	script	or	select
any	step	in	the	script,	the	image	you	are	currently	processing	changes	to
display	the	results	of	all	image	processing	steps	up	to	and	including	the
selected	step.



Creating	a	New	Script
You	create	a	script	as	you	process	an	image.	To	create	a	new	script,

select	File»New	Script	or	click	the	 	New	button	in	the	Script	window.
Vision	Assistant	prompts	you	to	save	the	current	script	before	creating	a
new	script.



Open	a	Script
Complete	the	following	steps	to	open	a	script:

1.	 Click	File»Open	Script	or	click	the	 	Open	button	in	the	Script
window.

2.	 Browse	to	the	script	you	want	to	open.
3.	 Select	the	script.
4.	 Click	OK.



Save	a	Script
Complete	the	following	steps	to	save	a	script:

1.	 Click	File»Save	Script	or	click	the	 	Save	button	in	the	Script
window.

2.	 Type	the	name	of	the	script	file.
3.	 Click	OK.



Run	a	Script
To	run	a	script,	click	 	Run	Once	in	the	Script	window.	Running	a	script
applies	all	steps	in	the	script	to	the	current	image.	If	the	last	step	is	an
analysis	function,	the	results	are	automatically	displayed.



Edit	a	Step	in	a	Script
Complete	the	following	steps	to	edit	a	script:

1.	 Select	the	appropriate	step	in	the	Script	window	and	click	 	Edit
Step	or	double-click	the	step	that	you	want	to	edit.

2.	 Change	the	function	parameters	in	the	Setup	window.
3.	 Click	OK.
Tips		

If	you	modify	the	image	and	then	decide	that	you	do	not
want	to	save	the	changes,	click	Cancel	in	the	Setup
window.
You	also	can	use	Edit	Step	to	modify	the	currently	selected
step.



Add	a	Step	to	a	Script
You	can	insert	a	new	step	anywhere	in	an	existing	script.

1.	 In	the	Script	window,	select	the	step	that	you	want	to	precede	the
new	step.

2.	 Select	the	image	processing	function	that	you	want	to	apply.
3.	 Set	the	function	parameters.
4.	 Click	OK.	Vision	Assistant	adds	the	step	to	the	script	after	the

selected	step.



Remove	a	Step	from	a	Script
Select	the	step	that	you	want	to	remove	from	the	script	and	click

Edit»Delete	or	click	the	step	and	select	 	Delete.

Note		Removing	steps	from	a	script	can	dramatically	alter	the	final
result	of	the	script.	As	you	delete	steps,	especially	steps	that
change	image	type	(such	as	conversion	and	color	threshold),
consider	how	the	rest	of	the	script	will	run.	The	steps	following	the
one	you	delete	might	try	to	process	an	image	of	an	unexpected
type,	and	you	may	receive	unexpected	results.

Tip		You	can	use	the	 	Step	Backward	and	 	Step	Forward
buttons	to	step	through	the	script.	The	image	you	are	currently
processing	changes	to	reflect	the	effects	of	the	function.



Step	through	a	Script
Use	the	 	Step	Backward	and	 	Step	Forward	buttons	in	the	Script
window	to	step	through	the	script.	The	image	you	are	currently
processing	changes	to	reflect	the	effects	of	the	function.	You	can	also
step	through	a	script	by	clicking	on	the	steps	you	want	to	view.



Perform	Batch	Processing
1.	 Select	Tools»Batch	Processing.
2.	 Select	an	image	source.

If	you	select	Hard	Disk,	browse	to	the	folder	containing	the
images	you	want	to	process.
If	you	select	Acquisition,	complete	the	following	steps:

a.	 Specify	the	acquisition	module	you	want	to	use.
Note		You	must	have	previously	defined	the
parameters	for	the	acquisition	module	you
select.	Vision	Assistant	uses	the	parameter
settings	you	defined	the	last	time	you	used	a
particular	acquisition	module.	For	example,	if
you	select	Image	Capture	RT,	you	must	have
previously	used	the	Acquire	Image	(RT)
function	in	the	Acquire	Images	tab	of	the
Processing	Functions.	If	you	select	an
acquisition	module	you	have	not	used
previously,	Vision	Assistant	prompts	you	to
exit	batch	processing	setup	and	acquire	an
image	using	the	module	you	selected	in
Acquisition	Modules.

b.	 In	Iterations,	specify	the	number	of	times	you	want
to	acquire	an	image	during	batch	processing.

c.	 In	Period	(s.),	specify	the	length	of	the	delay,	in
seconds,	between	acquisitions.

3.	 Select	a	step	in	the	Script	Steps	list.
If	the	step	processes	the	image	under	inspection,	select
one	of	the	Process	Mode	options:	Open	Process	Interface,
Display	Result	Image,	or	Save	Result	Image.
If	the	step	analyzes	the	image	under	inspection,	select	one
of	the	Analysis	Mode	options:	Open	Results	Panel	or	Save
Results.

4.	 If	you	selected	Save	Results	or	Save	Result	Image	in	step	3,
click	Setup	and	configure	the	save	options.	Otherwise,	proceed	to
step	6.

5.	 Click	OK	to	close	the	save	setup	dialog	box.



6.	 Click	Run	to	start	the	batch	process.
7.	 Click	Return	to	exit	batch	processing	mode.
Tips		

The	progress	window	displays	the	current	process,	the
number	of	iterations	completed,	the	starting	time,	and	an
estimation	of	the	time	remaining.
To	stop	batch	processing,	click	the	Cancel	button	in	the
progress	window.	Vision	Assistant	stops	the	batch	process
when	the	current	step	is	complete	or	is	cancelled	from	the
Parameter	window.



Performance	Meter
You	can	use	the	Performance	Meter	to	estimate	how	long	(in
milliseconds	and	frames/second)	the	script	takes	to	complete	in	the
Vision	Development	Module	on	a	given	image.

Note		The	speed	of	some	functions	in	the	script	varies	depending
on	the	image	you	process.

1.	 Open	the	script	you	want	to	test.
2.	 Select	Tools»Performance	Meter.	Vision	Assistant	evaluates	the

performance	of	the	functions	in	the	script	and	displays	an
estimate	of	the	total	time	the	Vision	Development	Module	would
take	to	complete	the	script.

3.	 Click	Details	to	view	an	estimate	of	the	time	the	Vision
Development	Module	would	take	to	complete	each	function	in	the
script.

4.	 Click	OK	to	close	the	Performance	Meter.



Use	Image	Functions
This	palette	groups	several	functions	that	analyze	the	content	of	an
image	to	obtain	information	you	specify.	This	palette	also	contains
functions	you	can	use	to	modify	the	geometry	of	the	image,	calibrate	the
image	so	you	can	make	measurements	in	real-world	units,	and	correct
the	image.



Histogram
Use	this	function	to	count	the	total	number	of	pixels	in	each	grayscale
value	and	graph	the	results.	You	can	use	the	histogram	to	determine	if
the	overall	intensity	of	your	image	adequate	for	your	inspection	task	or	if
the	image	contains	distinct	regions	of	certain	grayscale	values.



Line	Profile
Use	this	function	to	analyze	the	grayscale	distribution	along	a	line	of
pixels	in	an	image.	You	can	use	a	line	profile	to	examine	boundaries
between	components,	quantify	the	magnitude	of	intensity	variations,	and
detect	the	presence	of	repetitive	patterns.



Measure
Use	this	function	to	calculate	the	position,	length,	angle,	or	area	of	a
region	of	interest	in	an	image.



3D	View
Use	this	function	to	display	the	light	intensity	of	an	image	in	a	three-
dimensional	coordinate	system,	where	the	spatial	coordinates	of	the
image	form	two	dimensions	and	the	light	intensity	forms	the	third
dimension.



Brightness
Use	this	function	to	alter	the	brightness,	contrast,	and	gamma	of	an
image.



Set	Coordinate	System
Use	this	function	to	build	a	coordinate	system	based	on	the	location	and
orientation	of	a	reference	feature.



Image	Mask
Use	this	function	to	build	a	mask	from	an	entire	image	or	a	selected
region.	You	can	use	image	masks	to	focus	your	processing	or	inspection
on	particular	regions	in	the	image.



Geometry
Use	this	function	to	modify	the	geometrical	representation	of	an	image	by
transforming,	rotating,	or	resampling	the	image	data.



Image	Buffer
Use	this	function	to	store	and	retrieve	images	from	buffers.



Get	New	Image
Use	this	function	to	open	a	new	image	from	a	file.



Image	Calibration
Use	this	function	to	calibrate	an	image	to	make	measurements	in	real-
world	units.



Calibrate	from	Image
Use	this	function	to	apply	the	calibration	information	in	an	image	file	to
the	current	image.



Image	Correction
Use	this	function	to	transform	a	distorted	image	acquired	in	a	calibrated
setup	by	correcting	perspective	errors	and	lens	distortion.



Overlay
Use	this	function	to	overlay	figures,	text,	and	bitmaps	onto	an	image
without	destroying	the	image	data.



Run	LabVIEW	VI
Use	this	function	to	run	a	user-specified	LabVIEW	VI	within	the	Vision
Assistant	script.



Histogram
Counts	the	total	number	of	pixels	in	each	grayscale	value	and	graphs	it.
You	can	perform	a	histogram	on	an	entire	image	or	selected	regions	of
the	image.	Use	the	ROI	tools	from	the	toolbar	to	select	regions	in	an
image.

Note		The	Histogram	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify	the
image.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Histogram	Tab
The	following	controls	are	available	on	the	Histogram	tab.

Histogram—Graphical	representation	of	the	quantitative
distribution	of	pixels	per	grayscale	value.
Minimum	Value—Smallest	pixel	intensity	found	in	the	image	or
selected	regions	in	the	image.
Maximum	Value—Largest	pixel	intensity	found	in	the	image	or
selected	regions	in	the	image.
Mean	Value—Mean	value	of	intensities	found	in	the	image	or
selected	regions	in	the	image.
Std	Deviation—Standard	deviation	of	the	pixel	intensities.
Number	of	Pixels—Number	of	pixels	used	to	calculate	the
histogram.
Mapping	mode—Specifies	if	the	vertical	scale	(y-axis)	of	the
histogram	is	linear	or	logarithmic.

Linear—Displays	the	histogram	in	a	linear	scale.
Logarithmic—Displays	the	histogram	in	a	logarithmic	scale.
Use	the	logarithmic	scale	if	the	linear	values	are	too	small	to
view.



Perform	a	histogram
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Histogram	Tab
1.	 If	you	want	to	perform	a	histogram	for	a	portion	of	the	image,

select	an	ROI	tool	and	draw	an	ROI	on	the	image.	The	histogram
displays	data	for	the	currently	selected	region.

2.	 Click	OK	to	add	the	step	to	the	script.
Note		The	Histogram	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify	the
image.

Tips		
To	display	the	histogram	for	the	entire	image	after	you
selected	an	ROI	or	to	delete	the	selected	ROI,	click	the
image	or	press	the	<Delete>	key.
If	you	want	to	save	the	histogram	data,	click	the	Send	Data
to	Excel	button	or	the	Save	Results	button.



Histogram	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Line	Profile
Displays	the	grayscale	distribution	along	a	line	of	pixels	in	an	image.
Using	the	Line	Tool,	Broken	Line	Tool,	or	Freehand	Line	Tool	from	the
toolbar,	click	and	drag	to	draw	a	line	segment.

Note		The	Line	Profile	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify	the
image.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Line	Profile	Tab
The	following	controls	are	available	on	the	Line	Profile	tab.

Line	Profile—Variations	of	intensity	along	a	line.
Minimum	Value—Smallest	pixel	intensity	found	in	the	line	profile.
Maximum	Value—Largest	pixel	intensity	found	in	the	line	profile.
Mean	Value—Mean	value	of	pixel	intensities	found	in	the	line
profile.
Std	Deviation—Standard	deviation	of	pixel	intensities	from	the	line
profile.
Number	of	Pixels—Number	of	pixels	found	in	the	line	profile.
Mapping	mode—Specifies	if	the	vertical	scale	(y-axis)	of	the
histogram	is	linear	or	logarithmic.

Linear—Displays	the	line	profile	in	a	linear	scale.
Logarithmic—Displays	the	line	profile	in	a	logarithmic	scale.
Use	the	logarithmic	scale	if	the	linear	values	are	too	small	to
view.



Perform	a	Line	Profile
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Line	Profile	Tab
1.	 Select	one	of	the	line	tools	from	the	toolbar	and	draw	a	line	on	the

image.	The	line	profile	displays	data	for	the	currently	selected
pixels.

2.	 Click	OK	to	add	the	step	to	the	script.
Note		The	Line	Profile	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify	the
image.

Tips		
Use	the	arrow	keys	(←,	↑,	→,	↓)	to	move	the	line	one	pixel
in	the	corresponding	direction.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.



Line	Profile	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Measure
Calculates	measurement	statistics	associated	with	the	region	of	interest
(ROI).

Note		The	Measure	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify	the
image.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Measure	Tab
The	following	controls	are	available	on	the	Measure	tab.	You	can
calculate	position,	length,	angle,	and	area.

Position	Results—Position	of	the	point	that	you	selected	on	the
image	using	an	ROI	tool	from	the	toolbar.

X	Pos.—X-coordinate
Y	Pos.—Y-coordinate
Lev.—Grayscale	value	of	the	pixel

Length	Results—Length	measurements	associated	with	the	ROI.
Length—Length	of	the	ROI	in	user-calibrated	units.
Start	X—X-coordinate	of	the	starting	point	of	the	ROI.
Start	Y—Y-coordinate	of	the	starting	point	of	the	ROI.
End	X—X-coordinate	of	the	ending	point	of	the	ROI.
End	Y—Y-coordinate	of	the	ending	point	of	the	ROI.
Mean—Mean	of	the	grayscale	values	found	in	the	ROI.
StdDev—Standard	deviation	in	the	ROI.
Min—Smallest	grayscale	value	found	in	the	ROI.
Max—Largest	grayscale	value	found	in	the	ROI.

Angle	Results—Angle	results	associated	with	line	segments
drawn	on	the	image.

Angle—Angle	between	any	two	line	segments	on	the	image,
measured	in	degrees,	counterclockwise.

Area	Results—Area	measurements	associated	with	the	ROI.
Area—Area	of	the	ROI.
Ratio—Ratio	of	the	ROI	area	to	the	entire	image	area.
X1—Top,	left	x-coordinate	of	the	ROI	bounding	rectangle.
Y1—Top,	left	y-coordinate	of	the	ROI	bounding	rectangle.
X2—Bottom,	right	x-coordinate	of	the	ROI	bounding
rectangle.
Y2—Bottom,	right	y-coordinate	of	the	ROI	bounding
rectangle.
Mean—Mean	of	all	grayscale	values	found	in	the	ROI.
StdDev—Standard	deviation	of	all	grayscale	values	found	in



the	ROI.
Min—Smallest	grayscale	value	found	in	the	ROI.
Max—Largest	grayscale	value	found	in	the	ROI.



Calculate	ROI	Measurements
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Measure	Tab
1.	 Select	the	type	of	measurement	that	you	want	to	calculate.
2.	 Draw	an	ROI	on	the	image.

Vision	Assistant	displays	the	results	for	that	measurement	in	the
Results	table.

Notes		
The	Measure	function	analyzes	the	image	and
displays	information	for	you	to	review.	This	function
does	not	modify	the	image.
Angles	are	measured	in	degrees,	counterclockwise.

Tips		
To	save	the	data,	click	the	Send	Data	to	Excel
button	or	the	Save	Results	button.
To	remove	the	selected	row,	click	Delete	Selection.
To	delete	all	results,	click	Delete	All	Results.

3.	 Click	OK	to	add	the	step	to	the	script.



Measure	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



3D	View
Displays	the	light	intensity	in	a	three-dimensional	coordinate	system,
where	the	spatial	coordinates	of	an	image	form	two	dimensions	and	the
light	intensity	forms	the	third	dimension.	Each	pixel	from	the	image
source	is	represented	as	a	column	of	pixels	in	the	3D	view.	The	pixel
value	corresponds	to	the	altitude.

Note		The	3D	View	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify	the
image.



3D	View
Northwest—Sets	the	viewing	orientation	for	the	3D	view	in	the
Northwest	direction.
Northeast—Sets	the	viewing	orientation	for	the	3D	view	in	the
Northeast	direction.
Southwest—Sets	the	viewing	orientation	for	the	3D	view	in	the
Southwest	direction.
Southeast—Sets	the	viewing	orientation	for	the	3D	view	in	the
Southeast	direction.
Height—Maximum	height	of	a	pixel	drawn	in	3D	from	the	image
source.

	—Angle	between	the	horizontal	axis	and	baseline.	 	must
be	between	0°	and	45°.
	—Angle	between	the	horizontal	axis	and	second	baseline.	
must	be	between	0°	and	45°.

Reduction—Sets	the	size	reduction.	Reduction	is	a	divisor	that	is
applied	to	the	image	source	when	determining	the	final	height	and
width	of	the	3D	view	image.
Invert—Inverts	the	3D	view	when	selected.



View	an	Image	in	3D
Notes		

The	3D	View	function	analyzes	the	image	and	displays
information	for	you	to	review.	This	function	does	not	modify
the	image.
The	3D	View	function	works	only	with	8-bit	images.

1.	 Set	the	direction	orientation.
2.	 Specify	the	maximum	Height	of	a	3D	pixel.
3.	 Specify	the	angle	between	the	horizontal	axis	and	baseline	in	 .
4.	 Define	the	angle	between	the	horizontal	axis	and	second	baseline

in	 .
5.	 Set	the	size	Reduction.
6.	 Click	OK	to	close	the	Parameter	window.
Tip		Select	Invert	to	invert	the	3D	image,	which	can	be	useful	in
distinguishing	details	in	the	darkest	part	of	the	image.



3D	View	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Brightness,	Contrast,	Gamma	Correction
Alters	the	brightness,	contrast,	and	gamma	of	an	image.

Step	Name—Name	to	give	the	step.
Brightness—Brightness	of	the	image.	Brightness	is	expressed	in
gray	levels,	centered	at	128.	Higher	values	(up	to	255)	result	in	a
brighter	image,	and	lower	values	(down	to	0)	result	in	a	darker
image.
Contrast—Contrast	of	the	image,	expressed	as	an	angle.	A	value
of	45°	specifies	no	change	in	contrast.	Higher	values	(up	to	89°)
increase	contrast,	and	lower	value	(down	to	1°)	decrease	contrast.
Gamma—Gamma	value	used	in	Gamma	Correction.	The	higher
the	Gamma	coefficient,	the	stronger	the	intensity	correction.
Lookup	Table—Displays	the	lookup	table	with	the	specified
settings	of	Brightness,	Contrast,	and	Gamma.
Color	Plane—Specifies	the	color	plane	to	which	you	want	to	apply
the	transform.

Note		This	parameter	appears	only	when	an	RGB	(color)
image	is	loaded.

Reset—Reverts	Brightness,	Contrast,	and	Gamma	to	neutral
default	settings.



Modify	Brightness,	Contrast,	and	Gamma	Values
of	an	Image

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Modify	the	Brightness,	Contrast,	and	Gamma	values	with	the

slide	or	by	manually	entering	the	value.	When	you	process	a	color
image,	you	can	apply	Brightness,	Contrast,	and	Gamma
modifications	to	each	Color	Plane	separately,	or	you	can	apply
the	same	transformation	to	all	color	planes	at	the	same	time.

3.	 Click	OK	to	add	the	step	to	the	script.
Tips		

If	you	modify	the	values	and	want	to	return	to	the	source
image,	click	the	Reset	button.
You	can	modify	the	brightness	of	a	portion	of	an	image	by
drawing	an	ROI.



Brightness,	Contrast,	and	Gamma	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Set	Coordinate	System	Controls
Defines	a	coordinate	system	relative	to	a	feature	in	the	image.	The
following	controls	are	available.

Coordinate	System	Name—Name	to	give	the	coordinate	system
step.
Mode—Directions	in	which	you	expect	the	object	under	inspection
to	move	within	the	inspection	images.	The	following	options	are
available:

Horizontal	Motion—When	selected,	Vision	Assistant
adjusts	the	region	of	interest	positions	for	moves	along	the
horizontal	axis	of	the	image	for	steps	linked	to	this	Set
Coordinate	System	step.	Select	this	mode	when	the
position	of	the	object	under	inspection	is	mechanically
constrained	so	that	the	part	cannot	rotate	or	move	vertically
within	the	camera's	field	of	view.
Vertical	Motion—When	selected,	Vision	Assistant	adjusts
the	region	of	interest	positions	for	moves	along	the	vertical
axis	of	the	image	for	steps	linked	to	this	Set	Coordinate
System	step.	Select	this	mode	when	the	position	of	the
object	under	inspection	is	mechanically	constrained	so	that
the	part	cannot	rotate	or	move	horizontally	within	the
camera's	field	of	view.
Horizontal	and	Vertical	Motion—When	selected,	Vision
Assistant	adjusts	the	region	of	interest	positions	for	moves
along	the	horizontal	and	vertical	axes	of	the	image	for	steps
linked	to	this	Set	Coordinate	System	step.	Select	this	mode
when	the	position	of	the	object	under	inspection	is
mechanically	constrained	so	that	the	part	cannot	rotate
within	the	camera's	field	of	view.
Horizontal,	Vertical,	and	Angular	Motion—When	selected,
Vision	Assistant	adjusts	the	region	of	interest	positions	for
moves	along	the	horizontal	and	vertical	axes	as	well	as
rotational	changes	for	steps	linked	to	this	Set	Coordinate
System	step.	Select	this	mode	when	the	position	of	the
object	under	inspection	is	not	mechanically	constrained.

Tip		This	mode	requires	more	time	to	reposition	a



region	of	interest	than	the	other	modes.	If	the	object
does	not	rotate	in	the	field	of	view,	select	another
mode	that	meets	your	application	needs.

Origin—Feature	whose	x-coordinate	and	y-coordinate	locations
are	used	as	the	origin	of	the	coordinate	system.	You	may	also	use
the	value	of	a	point	variable	as	the	origin.
X-Axis	Angle—Feature	whose	angle	measurement	you	want	to
use	to	represent	the	angle	made	by	the	x-axis	of	the	coordinate
system	and	the	horizontal	axis	of	the	system.	This	control	is
available	only	if	you	select	the	Horizontal,	Vertical,	and	Angular
Motion	mode.



Set	Up	a	Coordinate	System
1.	 In	the	Coordinate	System	Name	control,	enter	a	descriptive

name	for	the	step.
2.	 Select	the	mode	that	best	represents	the	position	of	the	object

under	inspection.	Take	into	account	the	position	of	the	camera,
lighting,	and	the	type	of	synchronization	between	the	image
acquisition	and	the	motion	of	the	object	under	inspection.

3.	 Select	the	feature	whose	location	and	angle	measurement	you
want	to	use	to	specify	the	origin	and	angle	of	the	coordinate
system.



Set	Coordinate	System	FAQs
Why	are	there	no	measurements	listed	in	the	X-Axis	Angle	listbox?
You	must	configure	a	step	that	defines	an	x-axis	angle	or	produces	a
numeric	result	for	the	X-Axis	Angle	listbox	to	contain	items.	You	can	use
the	Pattern	Matching,	Geometric	Matching,	Straight	Edge	(Rake),	Adv.
Straight	Edge,	and	Geometry	steps	to	define	an	x-axis	angle.
I	want	to	select	an	x-axis	angle	but	the	items	in	the	X-Axis	Angle	list
are	dimmed.	What	should	I	do?
Select	the	Horizontal,	Vertical,	and	Angular	Motion	option	of	the	Mode
control	to	enable	the	X-Axis	Angle	list.
What	steps	should	I	use	to	find	features	on	which	to	base	a
coordinate	system	origin?
Coordinate	system	origins	are	based	on	feature	locations.	You	can	locate
features	using	the	following	steps:	Edge	Detector,	Straight	Edge	(Rake),
Adv.	Straight	Edge,	Circular	Edge	(Spoke),	Detect	Objects,	Pattern
Matching,	Geometric	Matching,	Clamp,	and	Geometry.



Image	Mask
Builds	a	mask	from	an	entire	image	or	a	region	of	interest	(ROI).	An
image	mask	is	an	image	containing	values	of	1	and	0.	Vision	Assistant
processes	only	those	pixels	in	the	image	source	that	have	a
corresponding	mask	image	value	of	1.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Mask	Tab
The	following	controls	are	available	on	the	Mask	tab.

Image	Mask
Create	from	ROI Creates	an	image	mask	from	an	ROI

selected	on	the	image.
Create	from	Image	File Creates	an	image	mask	from	an	image

file.
Mask	Options	(Create	from	ROI)
Outside	the	ROI Sets	all	pixels	outside	the	selected	region

to	0.
Inside	the	ROI Sets	all	pixels	inside	the	selected	region

to	0.
Extract	Masked	Region Casts	the	resulting	image	to	the	bounding

rectangle	of	the	ROI.	You	can	use	this
option	with	ROIs	such	as	circles,	ellipses,
and	freehand	regions.	When	this	option	is
not	selected,	the	entire	image	is	returned.

Mask	Options	(Create	from	Image	File)
Black	in	Image	File Masks	all	pixels	with	a	corresponding

mask	image	value	equal	to	0	(black).
Not	Black	in	Image	File Masks	all	pixels	not	equal	to	0	(non-

black).
Extract	Masked	Region Casts	the	resulting	image	to	the	bounding

rectangle	of	the	ROI.	You	can	use	this
option	with	ROIs	such	as	circles,	ellipses,
and	freehand	regions.	When	this	option	is
not	selected,	the	entire	image	is	returned.



Mask	an	Image
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Mask	Tab
Choose	one	of	the	following	methods	to	mask	an	image:

Mask	an	image	from	a	ROI
a.	 Select	Create	from	ROI.
b.	 Select	an	ROI	tool	from	the	toolbar	and	draw	the	region	of

interest.
c.	 Click	Set	ROI.
d.	 Select	mask	options.
e.	 Click	OK	to	add	this	step	to	the	script.
Tip		You	can	select	a	new	region	of	interest	by	selecting	an
ROI	tool	and	selecting	a	new	area	in	the	image.

Mask	an	Image	from	an	Image	File
a.	 Select	Create	from	Image	File.
b.	 Click	the	Browse	button,	navigate	to	the	location	of	the

image	file,	select	the	file,	and	click	OK.
c.	 Select	mask	options.
d.	 Click	OK	to	add	this	step	to	the	script.



Image	Mask	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Geometry
Modifies	the	geometrical	representation	of	an	image.



Main	Tab
The	following	control	is	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.



Geometry	Tab
The	following	controls	are	available	on	the	Geometry	tab.

Image	Source—Original	input	image.
Symmetry—Transforms	an	image	through	its	symmetry.

Horizontal—Horizontal	axis	of	the	image.
Vertical—Vertical	axis	of	the	image.
Central—Center	of	the	image.

Rotation—Rotates	an	image.
Angle	(degrees)—Angle	through	which	the	image	is
rotated.	To	set	the	angle,	type	the	angle	in	degrees	or	turn
the	knob.

Resampling—Resamples	an	image	based	on	user	settings.
X	Resolution—Image	size	in	the	x	direction	(in	pixels).
Y	Resolution—Image	size	in	the	y	direction	(in	pixels).
Keep	Image	Ratio—Maintains	the	original	ratio	when
selected.
Interpolation—Type	of	interpolation.	Valid	values	include
Zero	Order,	Bi-linear,	Quadratic,	or	Cubic	Spline.



Compute	the	Symmetry	of	an	Image
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Geometry	Tab
1.	 Select	Symmetry.
2.	 Select	a	type	of	symmetry.
3.	 Click	OK	to	add	this	step	to	the	script.

Related	Topics
Resample	an	image
Rotate	an	image



Rotate	an	Image
1.	 Click	Image»Geometry	or	select	Geometry	in	the	Image	tab	of

the	Processing	Functions	palette.
2.	 Select	Rotation.
3.	 Turn	the	knob	to	select	the	angle	of	rotation	or	manually	enter	an

angle.
4.	 Click	OK	to	add	this	step	to	the	script.

Related	Topics
Compute	the	symmetry	of	an	image
Resample	an	image



Resample	an	Image
1.	 Click	Image»Geometry	or	select	Geometry	in	the	Image	tab	of

the	Processing	Functions	palette.
2.	 Select	Resampling.
3.	 Select	Keep	Image	Ratio	to	maintain	the	original	image	ratio.

Deselect	this	option	to	change	the	image	aspect	ratio.
4.	 Set	the	Interpolation	Type.
5.	 Set	X	Resolution	and	Y	Resolution.
6.	 Click	OK	to	add	this	step	to	the	script.

Related	Topics
Compute	the	symmetry	of	an	image
Rotate	an	image



Geometry	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Image	Buffer
Stores	and	retrieves	images	from	buffers.	The	following	controls	are
available.

Step	Name—Name	to	give	the	step.
Current	Image—Lists	image	currently	displayed	in	the	Processing
window.
Store	Copy—Adds	the	current	image	to	an	empty	Image	Buffer.
Retrieve	Copy—Retrieves	the	image	from	the	selected	Image
Buffer.
Image	Buffer—Specifies	the	buffer	to	which	an	image	is	sent	or
from	which	an	image	is	retrieved.



Store	an	Image	in	an	Image	Buffer
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	Store.
3.	 Select	an	empty	image	buffer	from	the	Image	Buffer	list.	If	you	do

not	have	an	empty	buffer,	select	a	buffer	that	contains	an	image
that	you	no	longer	need.

4.	 Click	OK	to	save	the	image	to	the	selected	image	buffer	and	add
this	step	to	the	script.

Related	Topics
Retrieve	an	image	from	an	image	buffer



Retrieve	an	Image	from	an	Image	Buffer
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	Retrieve.
3.	 Select	the	image	buffer	that	contains	the	image	you	want	to

restore.
4.	 Click	OK	to	restore	the	image	and	add	this	step	to	the	script.
Note		You	must	already	have	an	image	stored	in	an	image	buffer
before	you	can	restore	it.

Related	Topics
Store	an	image	in	an	image	buffer



Image	Buffer	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Get	Image
Opens	an	image	from	a	file.	Use	this	function	when	you	need	to	open	an
image	as	a	step	in	a	script.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Path—Browse	to	the	location	of	the	file	you	want	to	open.
Cycle	Through	Folder	Images—When	enabled,	the	inspection
cycles	through	all	images	in	the	folder	each	time	the	step	is	run.
Note		You	can	use	only	the	Image»Get	Image	function	to
configure	a	script	to	open	an	image.



Get	an	Image
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Click	the	 	Browse	button	to	navigate	to	the	image	you	want

the	script	to	open.
3.	 Click	Open.
4.	 Click	OK	to	add	this	step	to	the	script	and	close	the	Parameter

window.
Note		You	can	use	only	the	Image»Get	Image	or	select	Get
Image	in	the	Image	tab	of	the	Processing	Functions	palette
function	to	configure	a	script	to	open	an	image.



Get	Image	FAQs
Which	image	file	formats	are	supported?
Vision	Assistant	supports	the	following	image	file	formats:	BMP,	TIFF,
JPG,	and	PNG.
Is	there	a	size	limit	for	images	I	want	to	load?
Vision	Assistant	does	not	have	an	image	size	limit.



Calibrate	Images
Vision	Assistant	can	calibrate	images	containing	linear,	perspective,	or
nonlinear	distortions	in	order	to	return	accurate	measurements.	The
Image	Calibration	step	calibrates	images	so	that	inspection	results	are
returned	in	real-world	units.
Calibrating	an	image	is	a	two-step	process.	The	first	is	an	offline	step
during	which	you	specify	the	type	of	calibration,	the	calibration
parameters,	and	the	real-world	unit	in	which	you	want	to	express
measurements.	The	second	step	of	the	calibration	process	applies	the
computed	calibration	to	the	image	during	the	inspection	process.	This
step	is	represented	in	the	inspection	as	the	Image	Calibration	step.
Vision	Assistant	supports	three	types	of	calibration,	which	depend	on	the
position	of	the	camera	in	relation	to	the	object	under	inspection	and	the
type	of	lens	used	in	the	application:	Simple	Calibration,	Calibration
Using	User-Defined	Points,	and	Grid	Calibration.

Select	Simple	Calibration	when	the	camera	angle	is	perpendicular
to	the	image	plane	and	lens	distortion	is	negligible.	Simple
Calibration	transforms	a	pixel	coordinate	to	a	real-world
coordinate	through	scaling	in	the	x	(horizontal)	and	y	(vertical)
directions.
Select	Calibration	Using	User-Defined	Points	when	lens	distortion
is	negligible	and	when	the	camera	is	not	perpendicular	to	the
image	plane,	which	causes	perspective	distortion	in	the	image.
This	calibration	type	uses	a	set	of	known	mappings	between	points
in	the	image	and	their	corresponding	locations	in	the	real	world	to
compute	the	pixel-to-real-world	mapping	for	the	entire	image.
Select	Grid	Calibration	when	the	image	exhibits	either	perspective
or	nonlinear	distortion.	Nonlinear	distortion	usually	occurs	when
you	use	a	wide-angle	lens.	Grid	Calibration	uses	the	distances
between	dots	in	a	calibration	grid	and	the	distances	between	dots
in	an	image	of	the	grid	to	generate	a	list	of	pixel-to-real-world
mappings	for	the	calibration	process.
Tip		Whenever	possible,	position	the	camera	perpendicular	to	the
object	to	minimize	perspective	distortion	in	the	image.	Use	a	high
quality	lens	or	telecentric	lens	to	minimize	nonlinear	distortion	in
the	image.



Image	Calibration
The	Choose	a	calibration	type	dialog	box	appears	when	you	select
Image	Calibration	in	the	Image	tab	of	the	Processing	Functions	palette
or	select	Image»Image	Calibration.

Note		To	edit	the	settings	in	the	Calibration	and	Calibration	Axis
tabs,	click	Edit	Calibration	to	launch	the	Calibration	wizard.



Main	Tab
The	following	control	is	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.



Calibration	Tab
The	following	controls	are	available	on	the	Calibration	tab.

Simple	Calibration
Pixel	Type—Indicates	if	the	image	has	square	or	nonsquare
pixels.
Correspondence	Image	-	Real	World—Gives	the	real-
world	size	of	a	pixel	in	both	the	horizontal	(x)	and	vertical	(y)
directions.

User	Points	Calibration
Calibration	Points—Lists	the	points	you	selected	for
calibration	in	the	Calibration	wizard.
Image	Coordinates—Coordinates	of	the	currently	selected
calibration	point,	given	as	the	number	of	pixels	from	the
origin.
Real-World	Coordinates—Coordinates	of	the	currently
selected	calibration	point,	given	as	the	number	of	Units	from
the	origin.
Unit—Unit	of	measure	you	selected	in	the	Calibration
wizard.
Distortion—Type	of	distortion	you	selected	in	the
Calibration	wizard,	either	Perspective	or	Nonlinear.

Grid	Calibration
Pixel	Type—Indicates	if	the	image	has	square	or	nonsquare
pixels.
Correspondence	Image	-	Real	World—Gives	the	real-
world	size	of	a	pixel	in	both	the	horizontal	(x)	and	vertical	(y)
directions.
Unit—Unit	of	measure	you	selected	in	the	Calibration
wizard.
Distortion—Type	of	distortion	you	selected	in	the
Calibration	wizard,	either	Perspective	or	Nonlinear.

Edit	Calibration—Displays	the	Calibration	wizard,	allowing	you	to
modify	the	calibration	settings	you	specified.



Axis	Tab
The	following	controls	are	available	on	the	Axis	tab.

Axis	Origin—X-	and	y-coordinates	of	the	origin	you	selected	in	the
Calibration	wizard.
Axis	Reference—Direction	of	the	y-axis,	either	Direct	or	Indirect.
Angle	Relative	to	Horizontal—Angle	of	the	x-axis	of	the
calibration	axis	you	selected	relative	to	horizontal.
Preview	Corrected	Image—Option	to	preview	the	image	with
perspective	errors	and	lens	distortion	errors	corrected.



Perform	a	Simple	Calibration
1.	 Click	Image»Image	Calibration	or	select	Image	Calibration	in

the	Image	tab	of	the	Processing	Functions	palette.
2.	 Select	Simple	Calibration	and	click	OK.
3.	 Select	the	Pixel	Type	that	applies	to	the	camera.
4.	 Click	Next.
5.	 Select	two	points.	You	can	select	points	that	were	defined	by

previous	inspection	steps	by	double-clicking	the	point	in	the	list	or
clicking	the	point	in	the	image.	You	also	can	define	new	points	by
clicking	unspecified	pixels	in	the	image.

If	you	selected	square	pixels	in	the	previous	wizard	step,
enter	the	distance	between	the	two	selected	points	in	real-
world	units	and	specify	the	correct	unit.	Proceed	to	the	next
step.
If	you	selected	nonsquare	pixels	in	the	previous	step,	follow
these	instructions:

a.	 Enter	the	x	projection	of	the	two	points	in	real-world
units	and	specify	the	correct	unit.

b.	 Click	Next.
c.	 If	you	want	to	use	different	points	to	specify	the	pixel

ratio	along	the	y-axis,	select	two	other	points.
Otherwise,	go	to	the	next	substep.

d.	 Enter	the	y	projection	of	the	two	points	in	real-world
units	and	specify	the	correct	unit.

6.	 Click	Next.
7.	 Select	the	origin	of	the	calibration	axis	by	entering	the	X-	and	Y-

coordinates	or	by	selecting	an	Existing	Point	from	the	list.
8.	 Select	the	User-Defined	Angle	of	the	calibration	or	select	an

Existing	Angle.	If	you	choose	an	Existing	Angle	from	the	list,
you	can	add	90°,	180°,	or	270°	to	the	value.

9.	 Select	an	Axis	Reference.
10.	 Click	OK	to	apply	the	calibration.
11.	 Click	OK	to	save	the	step	in	the	script	and	close	the	Setup

window.
Note		To	save	an	image	calibrated	with	Simple	Calibration,



complete	the	following	steps.
1.	 Click	File»Save	Image.
2.	 In	the	Save	Image	window,	select	a	location	to	save	the

image.
3.	 Enter	a	name	in	the	File	Name	textbox.
4.	 Enable	the	Save	Extra	Information	control.
5.	 Click	Save.



Control	Descriptions
Open	Image—Image	on	which	you	specify	points	to	base	the
calibration.	This	image	must	be	the	same	size	as	the	image	you
want	to	calibrate.	Vision	Assistant	does	not	run	the	script	on	this
image.
Pixel	Type—Square	or	nonsquare	pixels.
List	of	points—Points	defined	in	the	image	that	you	can	use	to
calibrate	the	image.
Point	X	and	Y—Coordinates	of	the	selected	points.
Length—Distance,	in	pixels,	between	the	two	selected	points.	This
control	appears	only	when	you	set	Pixel	Type	to	Square.
dX—Projection	of	the	segment	specified	by	the	two	points	onto	the
x-axis.	This	control	appears	only	when	you	set	Pixel	Type	to
Nonsquare.
dY—Projection	of	the	segment	specified	by	the	two	points	onto	the
y-axis.	This	control	appears	only	when	you	set	Pixel	Type	to
Nonsquare.
Unit—Real-world	unit	of	the	measurement.
Axis	Origin

User	Defined—X-	and	y-coordinates	of	the	pixel	that	you
want	to	use	as	the	calibration	axis	origin.
Existing	Point—Point	defined	in	a	previous	step	that	you
want	to	use	as	the	calibration	axis	origin.

X	Axis	Angle
User	Defined—Angle	you	want	to	use	between	the	x-axis	of
the	calibration	axes	and	the	horizontal	axis	of	the	image.
Existing	Angle—Angle	defined	in	a	previous	step	that	you
want	to	use	between	the	x-axis	of	the	calibration	axes	and
the	horizontal	axis	of	the	image.	You	can	select	a	value	from
the	+	control	to	add	to	the	Angle	value.

Axis	Reference—Direction	of	the	y-axis.



Perform	Calibration	with	User-Defined	Points
1.	 Click	Image»Image	Calibration	or	select	Image	Calibration	in

the	Image	tab	of	the	Processing	Functions	palette.
2.	 Select	Calibration	Using	User-Defined	Points	and	click	OK.
3.	 Select	the	type	of	Distortion	that	applies	to	the	image.
4.	 Select	a	point.	You	can	select	a	point	that	was	defined	by	a

previous	inspection	step	by	double-clicking	the	point	in	the	list	or
clicking	the	point	in	the	image.	You	also	can	define	a	new	point	by
clicking	an	unspecified	pixel	in	the	image.

5.	 Enter	the	Real-World	Coordinates	of	the	point	you	selected.
6.	 Select	at	least	three	more	points.
7.	 Click	OK.
8.	 Click	the	Specify	Calibration	Axis	tab.
9.	 Select	the	origin	of	the	calibration	axis	by	entering	the	X-	and	Y-

coordinates	or	by	selecting	an	Existing	Point	from	the	list.
10.	 Select	the	User-Defined	Angle	of	the	calibration	or	select	an

Existing	Angle.	If	you	choose	an	Existing	Angle	from	the	list,
you	can	add	90°,	180°,	or	270°	to	the	value.

11.	 Select	an	Axis	Reference.
12.	 Click	OK	to	learn	the	calibration.
13.	 Browse	to	the	directory	you	want	to	save	the	calibration

information	in,	enter	a	File	name,	and	click	OK.
14.	 Click	OK	to	save	the	step	in	the	script	and	close	the	Parameter

window.



Control	Descriptions
Define	Reference	Points	Tab

Open	Image—Image	on	which	you	specify	points	to	base	the
calibration.	This	image	must	be	the	same	size	as	the	image	you
want	to	calibrate.	Vision	Assistant	does	not	run	the	script	on	this
image.
Distortion—Type	of	image	distortion.
Select	at	least	4	points—Points	defined	in	the	image	that	you	can
use	to	calibrate	the	image.
Reset—Option	to	deselect	all	points.
Unit—Real-world	unit	of	the	measurement.
Image	Coordinates—Pixel	coordinates	of	the	selected	point.
Real-World	Coordinates—Real-world	coordinates	of	the	selected
point.

Specify	Calibration	Axis	Tab
Axis	Origin

User	Defined—X-	and	y-coordinates	of	the	pixel	that	you
want	to	use	as	the	calibration	axis	origin.
Existing	Point—Point	defined	in	a	previous	step	that	you
want	to	use	as	the	calibration	axis	origin.

X	Axis	Angle
User	Defined—Angle	you	want	to	use	between	the	x-axis	of
the	calibration	axes	and	the	horizontal	axis	of	the	image.
Existing	Angle—Angle	defined	in	a	previous	step	that	you
want	to	use	between	the	x-axis	of	the	calibration	axes	and
the	horizontal	axis	of	the	image.	You	can	select	a	value	from
the	+	control	to	add	to	the	Angle	value.

Axis	Reference—Direction	of	the	y-axis.
Related	Topics
Calibrate	Controls



Perform	a	Grid	Calibration
1.	 Click	Image»Image	Calibration	or	select	Image	Calibration	in

the	Image	tab	of	the	Processing	Functions	palette.
2.	 Select	Grid	Calibration	and	click	OK.
3.	 Select	the	type	of	Distortion	that	applies	to	the	image.
4.	 Click	Next.
5.	 Select	Threshold	Range	values	to	separate	the	dots	of	the	grid

from	the	rest	of	the	image.	When	you	select	the	Threshold
Range,	the	following	operations	are	performed	on	the	image:

The	image	is	thresholded	using	the	range	you	provide	in
Threshold	Range.
Particles	that	are	touching	the	image	borders	are	removed
using	the	Remove	border	objects	function.
Particles	that	are	too	small	or	that	are	larger	than	the
largest	dot	are	rejected	using	the	Particle	Filter	function.

6.	 Click	Next.
7.	 Select	the	real-world	distance	between	the	grid	dots	in	the	x	and	y

directions.
If	the	grid	does	not	cover	the	entire	image,	draw	a	region	of
interest	around	the	grid	or	a	portion	of	the	grid	to	learn	the
calibration	information	only	in	this	area.

Tip		Double-click	the	last	point	of	the	polygonal	region	of
interest	to	close	the	region.

8.	 Click	Next.
9.	 Select	the	origin	of	the	calibration	axis	by	entering	the	X-	and	Y-

coordinates	or	by	selecting	an	Existing	Point	from	the	list.
10.	 Select	the	User-Defined	Angle	of	the	calibration	or	select	an

Existing	Angle.	If	you	choose	an	Existing	Angle	from	the	list,
you	can	add	90°,	180°,	or	270°	to	the	value.

11.	 Select	an	Axis	Reference.
12.	 Click	OK	to	learn	the	calibration.
13.	 Browse	to	the	directory	you	want	to	save	the	calibration

information	in,	enter	a	File	name,	and	click	OK.
14.	 Click	OK	to	save	the	step	in	the	script	and	close	the	Parameter



window.



Control	Descriptions
Open	Image—Grid	image	on	which	to	base	the	calibration.	This
image	must	be	the	same	size	as	the	image	you	want	to	calibrate.
Distortion—Type	of	image	distortion.
Threshold	Range—Minimum	and	maximum	intensity	values	to
include	in	the	threshold	range.
X	Spacing—Distance	between	two	dots	in	the	x	direction.
Y	Spacing—Distance	between	two	dots	in	the	y	direction.
Unit—Real-world	unit	of	the	distances.
Axis	Origin

User	Defined—X-	and	y-coordinates	of	the	pixel	that	you
want	to	use	as	the	calibration	axis	origin.
Existing	Point—Point	defined	in	a	previous	step	that	you
want	to	use	as	the	calibration	axis	origin.

X	Axis	Angle
User	Defined—Angle	you	want	to	use	between	the	x-axis	of
the	calibration	axes	and	the	horizontal	axis	of	the	image.
Existing	Angle—Angle	defined	in	a	previous	step	that	you
want	to	use	between	the	x-axis	of	the	calibration	axes	and
the	horizontal	axis	of	the	image.	You	can	select	a	value	from
the	+	control	to	add	to	the	Angle	value.

Axis	Reference—Direction	of	the	y-axis.
Related	Topics
Calibrate	Controls



Image	Calibration	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Calibration	from	Image
Applies	the	calibration	information	saved	in	an	image	to	the	current
image.



Pixel	Calibration	Tab
Defines	physical	dimensions	of	the	area	of	a	pixel	in	the	image	and	the
correspondence	between	pixels	and	real-world	units.	The	following
controls	are	available	on	the	Pixel	Calibration	tab.

Step	Name—Name	to	give	the	step.
Load	Calibration	from	Image	File—Selects	the	image	file
containing	the	calibration	information	to	load.
Pixel	Type—Indicates	the	pixel	type	of	the	image	you	are	using	for
calibration.
Correspondence	Image	-	Real	World—Indicates	the	real-world
coordinates	and	units	of	the	points	used	for	calibration	on	the
image	you	are	loading	from	file.
Unit—Unit	of	measurement.



Calibration	Tab
Defines	a	reference	coordinate	system	in	the	image.	The	following
controls	are	available	on	the	Calibration	tab.

Axis	Origin—X-	and	y-coordinates	of	the	origin	of	the	coordinate
system,	in	pixels.
Axis	Reference—Specifies	the	direction	of	the	y-axis	of	the
coordinate	system	with	reference	to	the	x-axis.	The	vertical	axis
direction	can	be	either	indirect	(default)	or	direct.
Angle	Relative	to	Horizontal—Specifies	the	angle	of	the	x-axis	of
the	coordinate	system	with	respect	to	the	horizontal.
Corrected	Image	Scaling—Specifies	how	to	scale	the	corrected
image	when	you	apply	the	Image	Correction	function.	Two	scaling
mode	options	are	available:	Scale	to	Fit	and	Scale	to	Preserve
Area.	With	the	Scale	to	Fit	option,	the	corrected	image	is	scaled	to
fit	in	an	image	the	same	size	as	the	original	image.	With	the	Scale
to	Preserve	Area	option,	the	corrected	image	is	scaled	such	that
features	in	the	image	retain	the	same	area	as	they	did	in	the
original	image.	Images	that	are	scaled	to	preserve	the	area	are
usually	larger	than	the	original	image.



Apply	Calibration	Information	from	One	Image	to
Another

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Click	Load	Calibration	from	Image	File.
3.	 Navigate	to	a	calibrated	image	file	and	click	Open.
4.	 Navigate	through	the	tabs	to	see	the	calibration	values.
5.	 Click	OK	to	add	this	step	to	the	script	and	close	the	Parameter

window.
Note		The	size	of	the	calibrated	image	you	select	must	be	the
same	size	as	the	image	you	want	to	calibrate.

Related	Topics
Calibration	From	Image	(Image»Calibration	from	Image)
Image	Correction	(Image»Image	Correction)



Calibration	from	Image	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Image	Correction
Transforms	a	distorted	image	acquired	in	a	calibrated	setup	into	an
image	where	perspective	errors	and	lens	distortion	are	corrected.	The
following	controls	are	available.

Step	Name—Name	to	give	the	step.
Interpolation	Type—Specifies	the	interpolation	type	(Zero	Order
or	Bi-linear)	used	by	the	algorithm	when	correcting	the	image.



Correct	Images
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	the	Interpolation	Type	you	want	to	use	to	rescale	the

image.	A	Zero-Order	interpolation	is	faster,	but	provides	lower-
quality	results	than	a	Bi-Linear	interpolation.

3.	 Click	OK	to	add	this	step	to	the	script	and	close	the	Parameter
window.
Note		You	must	already	have	calibrated	the	image	with	the
Calibration	from	Image	function	before	you	correct	an	image.



Image	Correction	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Overlay
Overlay	figures,	text,	and	bitmaps	onto	an	image	without	destroying	the
underlying	image	data.	Use	the	Overlay	step	to	select	and	configure	the
overlay	elements	you	want	to	display	on	images	within	Vision	Assistant.

Note		The	Overlay	function	does	not	modify	the	image	pixels.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.



Overlay	Tab
The	following	controls	are	available	on	the	Overlay	tab.

Selection	Tool—Selects	an	overlay	element	in	the	image.

Line	Tool—Overlays	a	line.

Broken	Line	Tool—Overlays	a	broken	line.

Freehand	Line	Tool—Overlays	a	freehand	line.

Rotated	Rectangle	Tool—Overlays	a	rotated	rectangle.

Oval	Tool—Overlays	an	oval.

Polygon	Tool—Overlays	a	polygon.

Freehand	Region	Tool—Overlays	a	freehand	region.

Bitmap	Tool—Overlays	a	bitmap.

Text	Tool—Overlays	text.

Overlays—Lists	the	overlay	elements	that	you	create.
Delete—Deletes	the	selected	overlay	element.

Line	Parameters
Start	Point—Point	coordinates	that	define	the	starting	point	of	the
line.

X—X-coordinate	of	the	start	point.
Y—Y-coordinate	of	the	start	point.

End	Point—Point	coordinates	that	define	the	ending	point	of	the
line.

X—X-coordinate	of	the	end	point.
Y—Y-coordinate	of	the	end	point.

Color—Color	of	the	overlay.
Broken	Line	Parameters

Points—Array	of	point	coordinates	that	define	the	ends	of	the	line.
X—X-coordinate	of	a	point	in	the	array.
Y—Y-coordinate	of	a	point	in	the	array.

Color—Color	of	the	overlay.



Freehand	Line	Parameters
Points—Array	of	point	coordinates	that	define	the	ends	of	the	line.

X—X-coordinate	of	a	point	in	the	array.
Y—Y-coordinate	of	a	point	in	the	array.

Color—Color	of	the	overlay.
Rotated	Rectangle	Parameters

Left—X-coordinate	of	the	upper	left	corner	of	the	rectangle.
Top—Y-coordinate	of	the	upper	left	corner	of	the	rectangle.
Right—X-coordinate	of	the	bottom	right	corner	of	the	rectangle.
Bottom—Y-coordinate	of	the	bottom	right	corner	of	the	rectangle.
Rotation—Rotation	angle,	in	degrees,	of	the	rectangle	with	its
center	as	point	of	rotation.	If	the	rotation	angle	does	not	equal	0,
the	Left,	Top,	Right,	and	Bottom	coordinates	are	not	the	actual
coordinates	of	the	upper	left	and	bottom	right	corner	of	the
rectangle,	but	their	positions	if	the	rotation	angle	equaled	0.
Drawing	Mode—Specifies	whether	to	draw	only	the	frame	of	the
rectangle	or	fill	the	rectangle	with	color.
Color—Color	of	the	overlay.

Oval	Parameters
Note		The	position	of	an	oval	is	specified	by	the	coordinates	of	the
bounding	rectangle	that	contains	the	oval.
Left—X-coordinate	of	the	upper	left	corner	of	the	bounding
rectangle.
Top—Y-coordinate	of	the	upper	left	corner	of	the	bounding
rectangle.
Right—X-coordinate	of	the	bottom	right	corner	of	the	bounding
rectangle.
Bottom—Y-coordinate	of	the	bottom	right	corner	of	the	bounding
rectangle.
Drawing	Mode—Specifies	whether	to	draw	only	the	frame	of	the
oval	or	fill	the	oval	with	color.
Color—Color	of	the	overlay.

Polygon	and	Freehand	Region	Parameters
Points—Array	of	point	coordinates	that	define	the	ends	of	the	line.



X—X-coordinate	of	a	point	in	the	array.
Y—Y-coordinate	of	a	point	in	the	array.

Drawing	Mode—Specifies	whether	to	draw	only	the	frame	of	the
polygon	or	fill	the	polygon	with	color.
Color—Color	of	the	overlay.

Bitmap	Parameters
Image	File	Path—Complete	pathname—including	drive,	directory,
and	filename—of	the	bitmap	to	overlay.
Insertion	Point—Location	in	the	image	where	the	top,	left	point	of
the	bitmap	is	overlaid.

X—X-coordinate	of	the	point.
Y—Y-coordinate	of	the	point.

Use	Keying	Color—Specifies	whether	to	use	a	keying	color.
Keying	Color—Color	in	the	overlaid	bitmap	that	you	want	to	be
transparent.

Text	Parameters
Text—Text	to	overlay.

	Text	Properties—Launches	a	dialog	box	in	which	you	select
the	specific	font	characteristics	of	the	text	to	overlay.
Origin—Location	in	the	image	where	the	bottom,	left	point	of	the
first	character	is	overlaid.

X—X-coordinate	of	the	point.
Y—Y-coordinate	of	the	point.

Text	Color—Color	of	the	text.
Background	Color—Color	of	the	text	background.



Layer	Management	Tab
The	following	controls	are	available	on	the	Layer	Management	tab.

Overlay	Elements—Lists	the	overlay	elements	created.	You	can
use	the	Up	and	Down	buttons	to	arrange	the	order	in	which
elements	are	overlaid	on	the	image.	The	first	overlay	element	in
the	list	is	the	topmost	layer.
Color—Foreground	color	of	the	selected	overlay	element.
X—X-coordinate	location	of	the	first	point	of	the	selected	overlay
element.
Y—Y-coordinate	location	of	the	first	point	of	the	selected	overlay
element.

Note		When	you	modify	the	x-coordinate	and	y-coordinates
of	an	element	shown	in	the	Overlay	Elements	table,	the
coordinates	of	the	other	points	in	the	element	are	offset	by
the	same	amount	so	that	the	element	maintains	its	shape.

Up—Moves	the	selected	overlay	element	up	the	drawing	order.
Down—Moves	the	selected	overlay	element	down	the	drawing
order.
Delete—Deletes	the	selected	overlay	element.



Overlay	Figures,	Text,	or	Bitmaps	on	an	Image
Main	Tab
In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.



Overlay	Tab
1.	 Select	the	type	of	overlay	you	want	to	add	to	the	image	from	the

tools	palette.
2.	 Draw	the	overlay	in	the	image.	Vision	Assistant	adds	the	element

to	the	Overlays	drop-down	list.
You	can	adjust	the	size	and	position	of	the	element	by	using	the	

	Selection	Tool	or	by	modifying	the	element	Parameters.

Note		To	delete	an	overlay	element,	select	the	element	in
the	Overlays	drop-down	list	and	click	Delete.

3.	 Set	the	overlay	color.
4.	 Set	any	Parameters	specific	to	the	element	you	created,	such	as

the	overlay	text.



Layer	Management	Tab
1.	 Use	the	Layer	Management	controls	to	set	the	order	in	which

Vision	Assistant	overlays	elements	on	the	image.	The	Overlay
Elements	table	lists	all	the	overlays	in	the	reverse	order	they	were
created.	The	first	overlay	in	the	table	is	the	topmost	layer.
To	move	an	element	up	or	down	the	stack	of	layers,	select	the
element	in	the	Overlay	Elements	table	and	click	either	Up	or
Down.

2.	 Click	OK	to	add	the	step	to	the	script.



Overlay	FAQs
I	can	move	only	one	overlay	element	in	the	image	with	my	mouse.
How	can	I	select	and	move	another	overlay	element?
Only	the	overlay	element	selected	in	the	Overlays	dropdown	list	box	can
be	moved	or	modified	with	the	mouse.	If	you	want	to	use	the	mouse	to
move	or	modify	another	overlay	element,	select	the	desired	element	in
the	Overlays	dropdown	list	or	click	the	element	with	the	Selection	tool	to
select	and	modify	any	overlay.

Note		When	you	click	the	selection	tool,	all	overlay	elements
appear	in	white	because	you	can	modify	all	of	them.

Tip		To	fine	tune	the	position	of	an	overlay	element,	modify	the
coordinates	of	the	element	in	the	Parameters	window.



Run	LabVIEW	VI
Runs	a	user-specified	LabVIEW	VI.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
VI	Path—Path	of	the	VI	to	run.



VI	Controls	Tab
The	following	controls	are	available	on	the	VI	Controls	tab.

VI	Controls—Displays	the	labels	and	current	values	of	the	VI
controls.
Configure—Launches	the	Select	VI	Value	window	where	you	can
set	or	modify	the	values	of	the	VI	controls	on	the	VI	connector
pane.
VI	Indicators—Displays	the	labels	and	current	values	of	the	VI
indicators	on	the	VI	connector	pane.
Debug	Mode—When	enabled,	the	VI	runs	from	within	the
LabVIEW	environment,	which	allows	you	to	use	execution
highlighting,	breakpoints,	and	other	LabVIEW	debugging
techniques.
Test—Runs	the	selected	VI	to	test	your	configuration.



Run	a	LabVIEW	VI	from	Vision	Assistant
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Click	 	Browse	to	select	the	path	to	the	VI	you	want	to	run.
Note		The	Run	LabVIEW	VI	step	works	only	with	VIs	saved	using
LabVIEW	8.6.	To	share	or	redistribute	a	VI,	you	must	first	save	the
VI	for	distribution.



VI	Controls	Tab
1.	 Click	Configure	to	launch	the	Select	VI	Value	window.
2.	 Select	a	VI	control	name	from	the	VI	Controls	list.
3.	 Specify	a	value	for	the	control.
4.	 Repeat	steps	2	and	3	as	necessary.
5.	 Click	OK	to	save	the	specified	values	and	close	the	Select	VI

window.
Note		The	Select	VI	Value	window	displays	only	controls	that	are
connected	on	the	VI	connector	pane.	Make	sure	to	connect	any
controls	or	indicators	that	need	to	be	accessed	by	this	step.



Run	LabVIEW	VI	FAQs
What	types	of	controls	and	indicators	can	I	use	in	my	VI?
There	are	no	restrictions	about	the	types	of	controls	or	indicators	you	can
use	in	the	VI.	However,	to	use	measurements	from	a	previous	Vision
Assistant	step	or	set	constant	values,	the	controls	must	be	numerics	(I8,
I16,	I32,	U8,	U16,	U32,	DBL,	SGL,	or	EXT),	strings,	Boolean	values,	or
IMAQ	Image	controls.	Indicators	must	be	numerics,	strings,	or	Boolean
values	to	be	accessible	in	future	steps.
Do	I	need	to	update	the	connector	pane	for	this	step	to	use	my
indicators	or	controls?
Yes,	the	Run	LabVIEW	VI	step	can	only	use	controls	and	indicators	that
are	connected	on	the	VI	connector	pane.
How	do	I	use	the	current	image	from	Vision	Assistant	and	modify
the	image	so	subsequent	steps	use	the	modified	image?
In	the	VI	Controls	tab,	click	Configure.	If	you	have	an	IMAQ	Image
control	on	the	specified	VI,	select	Images»Current	Image	as	the	value
for	the	IMAQ	Image	control.	When	the	current	image	is	associated	with
your	image	control,	you	can	access	the	current	Vision	Assistant	image.
Any	modification	to	the	image	is	reflected	in	the	resulting	image	after	the
VI	is	run.	Image	Buffer	steps	that	store	images	are	also	accessible	to	the
Run	LabVIEW	VI	step.

Note		If	an	image	from	an	Image	Buffer	step	is	modified	by	the
Run	LabVIEW	VI	step,	all	subsequent	steps	that	use	that	Image
Buffer	also	use	the	modified	image.

Because	the	image	passed	in	is	the	same	one	to	be	modified,	using	an
image	display	control	can	produce	confusing	results	because	it	may	not
be	clear	if	the	image	displayed	is	the	original	passed	from	Vision
Assistant	or	the	modified	version	after	the	VI	has	run.	National
Instruments	recommends	that	you	use	the	IMAQ	Image	control	instead	of
the	IMAQ	Image	Display	control	to	avoid	confusion.

Note		If	you	pass	the	current	Vision	Assistant	image	to	your	VI,
overlays	in	the	image	are	preserved.	However,	any	calibration
information	from	previous	steps	is	lost.

Why	does	Vision	Assistant	appear	unresponsive	when	I	run	a	VI?



The	Run	LabVIEW	VI	step	waits	for	the	specified	VI	to	complete	before
executing	additional	steps	in	the	application.	If	the	VI	runs	continuously	or
requires	a	user	interaction	to	stop	the	VI,	the	step	waits	indefinitely.	To
avoid	this	situation,	be	sure	that	the	selected	VI	can	complete	without
user	interaction.
Why	do	I	get	an	error	about	my	VI	or	one	of	the	subVIs	being
broken?
You	need	to	save	the	VI	for	distribution	to	ensure	that	all	the	VI
dependencies	are	available.	Refer	to	Saving	a	VI	for	Distribution	for
instructions	about	saving	a	VI	for	distribution.
When	I	generate	the	LabVIEW	code	for	my	script	containing	a	Run
LabVIEW	VI	step	and	run	the	generated	VI,	I	do	not	get	the	same
results	that	I	get	in	Vision	Assistant.	Why?
The	only	controls	connected	to	the	VI	in	the	generated	code	are	the
image	input	and	error	clusters.	You	must	connect	the	other	controls
manually.	First,	identify	the	VI	that	produces	the	value	you	want	to
connect	to	the	control.	If	the	value	is	a	simple	numeric,	Boolean,	or	string,
wire	the	output	to	the	corresponding	control	on	your	VI.	If	the	value	is
contained	in	an	array	or	cluster,	first	use	the	LabVIEW	primitives	Index
Array	and/or	Unbundle	to	access	the	value.	Then,	wire	the	output	to	the
corresponding	control	on	your	VI.



Use	Color	Functions
This	palette	groups	several	image	functions	that	analyze	color	images.



Color	Operators
Use	these	functions	to	perform	arithmetic	and	logical	operations	on	color
images.	Common	applications	of	these	operators	include	time-delayed
comparisons,	identification	of	the	union	or	intersection	between	images,
correction	of	image	backgrounds	to	eliminate	light	drifts,	and
comparisons	between	several	images	and	a	model.	You	also	can	use
operators	to	threshold	or	mask	images	and	to	alter	contrast	and
brightness.



Color	Plane	Extraction
Use	this	function	to	extract	the	RGB,	HSV,	and	HSL	planes	from	an
image.	The	result	of	this	function	is	a	grayscale	image	with	intensity
values	that	correspond	to	the	plane	you	extracted.



Color	Threshold
Use	this	function	to	isolate	color	features	for	analysis	and	processing	or
to	remove	unnecessary	features	based	on	their	color.	The	result	of	this
function	is	a	binary	image.



Color	Location
Use	this	function	to	locate	regions	in	an	image	that	contain	a	specified
color.	This	function	does	not	modify	the	image.



Color	Pattern	Matching
Use	this	function	to	locate	color	objects	that	match	a	predefined	template.
This	function	does	not	modify	the	image.



Color	Matching
Use	this	function	to	compare	the	color	content	of	an	image	or	regions	in
an	image	to	a	template	containing	reference	color	information.	This
function	does	not	modify	the	image.



Color	Operators
Performs	arithmetic	and	logical	operations	on	images.	The	following
controls	are	available.

Step	Name—Name	to	give	the	step.
Operators
Image
Source

Opens	the	original	input	image.

Add Adds	a	constant	or	an	image	to	the	original	input
image.	This	is	a	pixel-by-pixel	operation.

Subtract Subtracts	a	constant	or	an	image	from	the	original
input	image.	This	is	a	pixel-by-pixel	operation.

Multiply Multiplies	the	original	input	image	by	a	constant	or
another	image.	This	is	a	pixel-by-pixel	operation.

Divide Divides	the	original	input	image	by	a	constant	or
another	image.	This	is	a	pixel-by-pixel	operation.

Multiply
Divide

Computes	a	ratio	between	two	images.	Each	pixel	in
the	original	image	is	multiplied	by	the	constant	before
being	divided	by	the	equivalent	pixel	found	in	another
image	stored	in	the	buffer.	This	is	a	pixel-by-pixel
operation.

Modulo Executes	modulo	division	(remainder)	of	the	original
input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	pixel-by-pixel	operation.

Absolute
Difference

Subtracts	one	image	from	another	or	a	constant	from
an	image	and	returns	the	absolute	value	of	the
difference.

And Performs	a	logical	AND	operation	between	the	original
input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	bit-wise	operation.

Not	And Performs	a	logical	NAND	operation	between	the
original	input	image	and	a	constant	or	another	image
stored	in	the	buffer.	This	is	a	bit-wise	operation.

Or Performs	a	logical	OR	operation	between	the	original



input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	bit-wise	operation.

Not	Or Performs	a	logical	NOR	operation	between	the	original
input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	bit-wise	operation.

Exclusive
Or

Performs	an	Exclusive	OR	operation	between	the
original	input	image	and	a	constant	or	another	image
stored	in	the	buffer.	This	is	a	bit-wise	operation.

Not
Exclusive
Or

Performs	an	Exclusive	NOR	operation	between	the
original	input	image	and	a	constant	or	another	image
stored	in	the	buffer.	This	is	a	bit-wise	operation.

Logical
Difference

Finds	the	logical	difference	between	the	original	input
image	and	a	constant	or	another	image	stored	in	the
buffer.	This	is	a	bit-wise	operation.

Mask Replaces	pixels	in	the	original	input	image	that
correspond	to	pixels	with	value	0	in	the	image	mask	as
0.	The	image	mask	is	an	8-bit	image	that	specifies	the
regions	in	the	original	input	image	to	be	modified.	This
is	a	pixel-by-pixel	operation.

Constant—Constant	value	to	be	used	in	an	operation,	when
selected.
Image—Image	from	an	active	buffer	to	be	used	in	an	operation,
when	selected.	You	can	select	only	those	image	buffers	that
contain	8-bit	or	RGB	images	of	the	same	size	as	the	image	source.
Click	Image»Image	Buffer	or	select	Image	Buffer	in	the	Image
tab	of	the	Processing	Functions	palette	to	store	an	image	in	an
empty	image	buffer.



Use	the	Color	Operators	Function
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	one	of	the	operators	from	the	Operators	list.
3.	 Select	either	the	Constant	or	Image	option.	The	Constant	option

uses	a	constant	and	the	current	image	in	the	operation.	The
Image	option	uses	the	current	image	and	an	image	stored	in	an
image	buffer.

Note		For	the	Mask	operator,	you	can	select	only	the
Image	option.	For	the	Multiply	Divide	operator,	you	must
specify	an	Image	and	a	Constant.

4.	 Enter	the	constant	or	select	the	image	buffer	that	contains	the
image	you	are	adding	to	the	source	image	or	enter	the	constant
value.

5.	 Click	OK	to	add	the	step	to	the	script	and	close	the	Parameters
window.
Note			You	must	already	have	an	image	stored	in	an	image	buffer
before	you	can	perform	an	operation	using	the	current	image	and
another	image.	The	buffered	image	must	be	the	same	size	as	the
source	image	and	must	be	an	8-bit	or	RGB	image.



Color	Operators	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Color	Plane	Extraction
Extracts	one	of	the	three	color	planes	(Red,	Green,	Blue,	Hue,
Saturation,	Luminance,	Value,	Intensity)	from	an	image.	The	following
controls	are	available.

Step	Name—Name	to	give	the	step.
Image	Source—Original	input	image.
RGB	–	Red	Plane—Extracts	the	red	plane	from	an	RGB	image.
RGB	–	Green	Plane—Extracts	the	green	plane	from	an	RGB
image.
RGB	–	Blue	Plane—Extracts	the	blue	plane	from	an	RGB	image.
HSL	–	Hue	Plane—Extracts	the	hue	plane	from	an	HSL	image.
HSL	–	Saturation	Plane—Extracts	the	saturation	plane	from	an
HSL	image.
HSL	–	Luminance	Plane—Extracts	the	luminance	plane	from	an
HSL	image.
HSV	–	Value	Plane—Extracts	the	value	plane	from	an	HSV	image.
HSI	–	Intensity	Plane—Extracts	the	intensity	plane	from	an	HSI
image.



Extract	Color	Planes	from	an	Image
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	the	color	plane	that	you	want	to	extract.
3.	 Click	OK	to	add	this	step	to	the	script.
Note			Because	each	color	plane	is	made	up	of	8	bits,	the	color
plane	you	extract	is	an	8-bit	grayscale	image.



Color	Plane	Extraction	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Color	Threshold
Applies	a	threshold	to	the	three	planes	of	a	color	image	and	places	the
result	into	an	8-bit	image.



Main	Tab
The	following	control	is	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.



Color	Threshold	Tab
The	following	controls	are	available	on	the	Color	Threshold	tab.

Color	Model—Color	encoding	scheme:	RGB,	HSL,	HSV,	or	HSI.
Preview	Color—Color	used	to	highlight	the	pixels	selected	by	the
threshold	Min	and	Max	values.	Default	value	is	red.
Histogram

Linear—Displays	the	histograms	in	a	linear	scale.
Logarithmic—Displays	the	histograms	in	a	logarithmic
scale.	Use	the	logarithmic	scale	if	the	linear	values	are	too
small	to	view	using	a	linear	scale.

Red/Hue—Thresholding	range	for	the	red	or	hue	plane	(depending
on	Color	Model).	Any	pixel	values	not	included	in	this	range	are
reset	to	zero	in	the	destination	image.	You	can	modify	the	Min	and
Max	values	by	clicking	and	dragging	on	the	blue	and	red	markers
on	the	histogram.
Green/Saturation—Thresholding	range	for	the	green	or	saturation
plane	(depending	on	Color	Model).	Any	pixel	values	not	included
in	this	range	are	reset	to	zero	in	the	destination	image.	You	can
modify	the	Min	and	Max	values	by	clicking	and	dragging	on	the
blue	and	red	markers	on	the	histogram.
Blue/Luminance/Value/Intensity—Thresholding	range	for	the
blue,	luminance,	value,	or	intensity	plane	(depending	on	Color
Model).	Any	pixel	values	not	included	in	this	range	are	reset	to
zero	in	the	destination	image.	You	can	modify	the	Min	and	Max
values	by	clicking	and	dragging	on	the	blue	and	red	markers	on
the	histogram.

Note		You	can	use	the	Hue	indicator	to	select	all	pixels	with
a	certain	hue	when	you	set	Color	Model	to	HSL,	HSV,	or
HSI.	Select	a	specific	hue	that	you	want	to	isolate	in	the
image	using	the	ROI	tools.	The	histograms	display	the
pixels	that	you	need	to	select	in	order	to	isolate	all	of	pixels
with	that	hue.	Drag	the	blue	and	red	markers	on	the
histograms	until	all	pixels	with	that	hue	are	selected.

Min—Lowest	pixel	value	included	in	the	manual	threshold	range.
For	manual	thresholds,	you	can	adjust	the	blue	cursor	on	the



histogram	to	set	the	lower	bound	for	this	range.
Max—Highest	pixel	value	included	in	the	manual	threshold	range.
For	manual	thresholds,	you	can	adjust	the	red	cursor	on	the
histogram	to	set	the	upper	bound	for	this	range.
In/Out	Range	(Valid	for	HSL,	HSV,	or	HSI)

In—Hue	is	included	in	the	threshold	range.	Threshold
range:	[Min,	Max]
Out—Hue	is	not	included	in	the	threshold	range.	Threshold
range:	[0,	Min]	[Max,	255]

Tip		You	can	display	the	histogram	of	a	portion	of	an	image	by
drawing	an	ROI	around	the	area	of	interest.	The	local	histogram
gives	you	valuable	information	about	the	threshold	range	you	can
select	to	keep	or	reject	certain	parts	of	the	image.



Threshold	a	Color	Image
Main	Tab
In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.



Color	Threshold	Tab
1.	 Select	the	color	model	(RGB,	HSL,	HSV,	or	HSI)	you	want	to	use

to	process	the	image.
2.	 Adjust	the	blue	and	red	lines	on	the	Red	(Hue),	Green

(Saturation),	and	Blue	(Luminance/Value/Intensity)	histograms
until	all	of	the	particles	of	interest	are	highlighted	with	the	color
specified	in	Preview	Color.

3.	 Click	OK	to	threshold	the	image	and	add	this	step	to	the	script.
Tips		

If	you	have	trouble	finding	a	threshold	range	that	selects	all
of	the	pixels	in	the	range,	draw	an	ROI	around	the	portion	of
the	image	that	you	want	to	keep.	The	histogram	displays	the
intensities	of	the	ROI	only.	Use	the	minimum	and	maximum
values	for	the	threshold.
You	can	display	the	histogram	in	either	linear	or	logarithmic
form.



Color	Threshold	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Color	Location
Locates	colors	in	a	color	image.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Template	Tab
The	following	controls	are	available	on	the	Template	tab.

Template	Image—The	image	to	use	as	the	template.
Template	Size

Width—Width	of	the	template	in	pixels.
Height—Height	of	the	template	in	pixels.

Ignore	Black	and	White
Disabled—Specifies	that	black	and	white	pixels	are	not
ignored	during	the	search	phase.
Ignore	Black—Specifies	that	black	pixels	are	ignored	during
the	search	phase.
Ignore	White—Specifies	that	white	pixels	are	ignored	during
the	search	phase.
Ignore	Black	and	White—Specifies	that	black	and	white
pixels	are	ignored	during	the	search	phase.

Sat.	Threshold—Specifies	the	threshold	used	to	distinguish
between	two	colors	having	the	same	hue	values.	For	more
information	about	saturation	threshold,	refer	to	the	NI	Vision
Concepts	Manual.
Create	Template—Learns	the	selected	ROI	and	saves	the	result
as	a	template	image	file.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	template	image	file	and	specify	that	file	as	the	search
template.
Template	Path—Displays	the	location	of	the	template	image	file.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Number	of	Matches	to	Find—Specifies	the	number	of	valid
matches	you	expect	the	color	location	function	to	return.
Minimum	Score—Specifies	the	minimum	score	an	instance	of	the
template	can	have	to	be	considered	a	valid	match.	This	value	can
range	from	0	to	1000,	where	a	score	of	1000	indicates	a	perfect
match.
Search	Strategy—Specifies	how	the	color	features	of	the	image
are	used	during	the	search	phase.	You	can	choose	from	the
following	three	strategies:

Conservative	(default)—Uses	the	smallest	step	size,	a	sub-
sampling	factor	of	two,	and	all	the	color	information	present
in	the	template	to	search	for	a	template.	The	Conservative
strategy	is	the	most	reliable	method	to	look	for	a	template	in
any	image	at	potentially	reduced	speed.

Note		Use	the	Conservative	strategy	if	you	have
multiple	matches	located	very	close	to	each	other	in
the	image.

Balance—Uses	values	between	the	Aggressive	and
Conservative	strategies.
Aggressive—Uses	values	between	the	Balanced	and	Very
Aggressive	strategies.
Very	Aggressive—Uses	the	largest	step	size,	the	most	sub-
sampling,	and	only	the	dominant	color	from	the	template	to
search	for	the	template.	Use	this	strategy	when	the	color	in
the	template	is	almost	uniform,	the	template	is	well
contrasted	from	the	background,	and	there	is	a	good	amount
of	separation	between	different	occurrences	of	the	template
in	the	image.	The	Very	Aggressive	strategy	is	the	fastest
way	to	find	templates	in	an	image.

Tip		You	can	specify	a	search	area	by	drawing	an	ROI
on	the	image	with	the	Rectangle	tool.	Specifying	a
search	area	increases	the	speed	and	reliability	of	the
color	location	function.



Color	Sensitivity—Specifies	the	level	of	color	sensitivity	in	the
image.	The	default	is	Low	sensitivity.
Color	Spectrum—Represents	the	color	information	associated
with	the	template.



Results
Displays	the	following	information	after	searching	the	image	for	the
template:

Center	X—X-coordinate	of	each	object	that	matches	the	template.
Center	Y—Y-coordinate	of	each	object	that	matches	the	template.
Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.



Search	for	Colors
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Template	Tab
1.	 Create	or	select	the	template	you	want	to	use	for	comparison.

To	create	a	new	template,	complete	the	following	steps:
a.	 Click	Create	Template.
b.	 Select	an	ROI	and	click	OK.
c.	 Enter	a	File	Name	for	the	template	and	click	OK.

To	use	an	existing	template,	complete	the	following	steps:
a.	 Click	Load	from	File.
b.	 Browse	to	the	appropriate	template	image	and	click

OK.
2.	 Modify	the	Ignore	Black	and	White	and	Sat.	Threshold

parameters	as	necessary.



Settings	Tab
1.	 Select	the	Number	of	Matches	to	Find	and	a	Minimum	Score.
2.	 Select	the	appropriate	Search	Strategy	and	Color	Sensitivity.
3.	 Click	OK	to	save	this	step	to	the	script	and	exit	the	Parameter

window.



Color	Location	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Color	Pattern	Matching
Searches	for	color	templates	in	color	images	using	Color	Pattern
Matching.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Template	Tab
The	following	controls	are	available	on	the	Template	tab.

Template	Image—The	image	to	use	as	the	template.
Template	Size—Specifies	the	dimensions	of	the	template.

Width—Width	of	the	template	in	pixels.
Height—Height	of	the	template	in	pixels.

Create	Template—Learns	the	selected	ROI	and	saves	it	as	a
template	image	file.	Specifies	that	file	as	the	template	to	search	for.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	template	image	file	and	specify	that	file	as	the	search
template.
Ignore	Black	and	White—Specifies	the	pixels	to	ignore	during	the
matching	phase.

Disabled—Specifies	that	black	and	white	pixels	are	not
ignored	during	the	matching	phase.
Ignore	Black—Specifies	that	black	pixels	are	ignored	during
the	matching	phase.
Ignore	White—Specifies	that	white	pixels	are	ignored	during
the	matching	phase.
Ignore	Black	and	White—Specifies	that	black	and	white
pixels	are	ignored	during	the	matching	phase.

Sat.	Threshold—Specifies	the	threshold	used	to	distinguish
between	two	colors	having	the	same	hue	values.	For	more
information	about	saturation	threshold,	refer	to	the	NI	Vision
Concepts	Manual.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Number	of	Matches	to	Find—Specifies	the	number	of	valid
matches	you	expect	the	color	pattern	matching	function	to	return.
Minimum	Score—Specifies	the	minimum	score	a	template	must
have	for	the	template	to	be	considered	a	valid	match.	This	value
can	range	from	0	to	1000,	where	a	score	of	1000	indicates	a
perfect	match.
Color	Score	Weight—Determines	the	percent	contribution	of	the
color	score	to	the	final	color	pattern	matching	score.	The	software
uses	the	color	score	weight	for	the	final	match	ranking.	For
example,	if	you	use	a	weight	of	1000,	the	algorithm	finds	each
match	by	using	both	color	and	shape	information	and	then	ranks
the	matches	based	on	their	color	scores.	If	the	weight	is	0,	the
matches	are	ranked	based	on	their	shape	scores.	The	default	is
500,	which	indicates	that	the	match	score	is	based	on	an	equal
combination	of	the	color	and	shape	scores.
Search	Strategy—Specifies	how	the	color	features	of	the	image
are	used	during	the	search	phase.	You	can	choose	from	the
following	four	strategies:

Conservative	(default)—Uses	the	smallest	step	size,	a	sub-
sampling	factor	of	two,	and	all	the	color	information	present
in	the	template	to	search	for	a	template.	The	Conservative
strategy	is	the	most	reliable	method	to	look	for	a	template	in
any	image	at	potentially	reduced	speed.

Note		Use	the	Conservative	strategy	if	you	have
multiple	matches	located	very	close	to	each	other	in
the	image.

Balance—Uses	values	between	the	Aggressive	and
Conservative	strategies.
Aggressive—Uses	values	between	the	Balanced	and	Very
Aggressive	strategies.
Very	Aggressive—Uses	the	largest	step	size,	the	most	sub-
sampling,	and	only	the	dominant	color	from	the	template	to
search	for	the	template.	Use	this	strategy	when	the	color	in
the	template	is	almost	uniform,	the	template	is	well



contrasted	from	the	background,	and	there	is	a	good	amount
of	separation	between	different	occurrences	of	the	template
in	the	image.	The	Very	Aggressive	strategy	is	the	fastest
way	to	find	templates	in	an	image.

Color	Sensitivity—Specifies	the	level	of	sensitivity	used	to
describe	the	color	features	in	the	image.	The	default	is	Low
sensitivity.



Results
Displays	the	following	information	after	searching	the	image	for	the
template:

Center	X—X-coordinate	of	each	object	that	matches	the	template.
Center	Y—Y-coordinate	of	each	object	that	matches	the	template.
Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.
Angle—Rotation	angle	of	each	object	that	matches	the	template	at
the	current	match	location.	Angles	are	expressed	in	degrees.	This
output	is	valid	only	when	you	select	rotation-invariant	matching.



Use	Color	Pattern	Matching
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Template	Tab
1.	 Create	or	select	the	template	you	want	to	use	for	comparison.

To	create	a	new	template,	complete	the	following	steps:
a.	 Click	Create	Template.
b.	 Select	an	ROI	and	click	OK.
c.	 Enter	a	File	Name	for	the	template	and	click	OK.

To	use	an	existing	template,	complete	the	following	steps:
a.	 Click	Load	from	File.
b.	 Browse	to	the	appropriate	template	image	and	click

OK.
By	default,	the	center	of	the	template	is	used	as	the	focal	point	of
the	template.	You	can	change	the	location	of	the	focal	point	to	any
position	in	the	template.	Change	the	focal	point	of	the	template	by
dragging	the	red	pointer	in	the	template	image	or	adjusting	the
Match	Offset	values.

2.	 Modify	the	Ignore	Black	and	White	and	Sat.	Threshold
parameters	as	necessary.



Settings	Tab
1.	 Modify	Number	of	Matches	to	Find,	Minimum	Score,	Color

Score	Weight,	Color	Sensitivity,	and	Search	Strategy	as
necessary.

2.	 Select	Search	for	Rotated	Patterns	to	indicate	that	the	match
can	be	a	rotated	version	of	the	template.	You	can	restrict	the
amount	of	rotation	you	want	to	allow	by	specifying	an	acceptable
angle	range.	You	also	can	include	the	mirrored	angle	range	by
enabling	Mirror	Angle.

3.	 Click	OK	to	save	this	step	to	the	script.



Color	Pattern	Matching	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Color	Matching
Learns	the	color	content	of	a	region	of	an	image	and	compares	it	to	the
color	content	of	another	region.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Template	Tab
The	following	controls	are	available	on	the	Template	tab.

Template	Path—Displays	the	location	of	the	template	image	file.
Create	Template—Learns	the	colors	enclosed	by	the	ROI	you
draw	on	the	image	and	saves	the	ROI	as	a	color	image	file.
Specifies	that	file	as	the	template	color	to	match.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	color	image	file	and	specify	that	file	as	the	search	template.
Color	Sensitivity—Specifies	the	level	of	color	sensitivity	in	the
image.	The	default	is	Low	sensitivity.	Select	High	sensitivity	to
distinguish	small	differences	in	hue.
Sat.	Threshold—Specifies	the	threshold	used	to	distinguish
between	two	colors	having	the	same	hue	values.	For	more
information	about	saturation	threshold,	refer	to	the	NI	Vision
Concepts	Manual.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Minimum	Match	Score—Specifies	the	minimum	score	an
instance	of	the	template	can	have	to	be	considered	a	valid	match.
This	value	can	range	from	0	to	1000,	where	a	score	of	1000
indicates	a	perfect	match.



Results
Displays	the	following	information	after	searching	the	ROI	for	colors:

Pass/Fail—Indicates	if	the	ROI	contains	colors	that	are	equal	to	or
greater	than	the	Minimum	Match	Score.
Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.



Match	Colors	in	an	Image	to	a	Template
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Template	Tab
1.	 Create	or	select	the	template	you	want	to	use	for	comparison.

To	create	a	new	template,	complete	the	following	steps:
a.	 Click	Create	Template.
b.	 Select	an	ROI	and	click	OK.
c.	 Enter	a	File	Name	for	the	template	and	click	OK.

To	use	an	existing	template,	complete	the	following	steps:
a.	 Click	Load	from	File.
b.	 Browse	to	the	appropriate	template	image	and	click

OK.
By	default,	the	center	of	the	template	is	used	as	the	focal	point	of
the	template.	You	can	change	the	location	of	the	focal	point	to	any
position	in	the	template.	Change	the	focal	point	of	the	template	by
dragging	the	red	pointer	in	the	template	image	or	adjusting	the
Match	Offset	values.

2.	 Modify	the	Ignore	Black	and	White	and	Sat.	Threshold
parameters	as	necessary.



Settings	Tab
1.	 Set	the	Minimum	Match	Score.
2.	 Click	OK	to	add	the	step	to	the	script	and	exit	the	Parameter

window.



Color	Matching	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Use	Grayscale	Functions
This	palette	groups	several	image	functions	that	analyze	grayscale
images.



Lookup	Table
Use	this	function	to	improve	the	contrast	and	brightness	in	an	image	by
applying	a	lookup	table.



Filters
Use	this	function	to	enhance	the	quality	of	an	image	with	spatial	filters	so
that	only	the	image	information	you	need	is	extracted	during	processing.



Gray	Morphology
Use	this	function	to	modify	the	shape	of	features	in	an	image	by	altering
pixel	values.



FFT	Filter
Use	this	function	to	remove	high	or	low	frequencies	in	the	FFT	plane.
Removing	high	frequencies	smooths	noise,	details,	textures,	and	sharp
edges.	Removing	low	frequencies	reduces	overall	patterns,	such	as
variations	in	light	intensity,	and	emphasizes	details.



Threshold
Use	this	function	to	separate	significant	structures	in	an	image	from	the
rest	of	the	image.	Thresholding	sets	all	pixels	within	the	Threshold
Range	to	1	and	sets	all	other	pixels	in	the	image	to	0.	The	resulting
image	is	a	binary	image.



Watershed
Use	this	function	to	segment	an	image	containing	noise,	touching
particles,	or	overlapping	particles	based	on	the	topographic	surface	of	an
image.



Operators
Use	this	function	to	perform	arithmetic	and	logical	operations	on
grayscale	images.	Common	applications	of	these	operators	include	time-
delayed	comparisons,	identification	of	the	union	or	intersection	between
images,	correction	of	image	backgrounds	to	eliminate	light	drifts,	and
comparisons	between	several	images	and	a	model.	You	also	can	use
operators	to	threshold	or	mask	images	and	to	alter	contrast	and
brightness.



Conversion
Use	this	function	to	convert	the	current	image	to	the	specific	image	type.



Quantify
Use	this	function	to	quantify	the	content	of	an	image	or	regions	within	the
image.



Centroid
Use	this	function	to	calculate	the	energy	center	of	the	image.



Lookup	Table
Improves	contrast	and	brightness	by	applying	a	lookup	table	to	an	image.
A	lookup	table	(LUT)	contains	values	used	to	transform	the	grayscale
values	of	an	image.	For	each	grayscale	value	in	the	image,	the
corresponding	new	value	is	obtained	from	the	LUT	and	assigned	to	every
pixel	of	that	grayscale	value.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Lookup	Tables

Image	Source—Opens	the	original	input	image.
Equalize—Increases	the	intensity	dynamic	by	distributing	a
given	grayscale	interval	[min,	max]	over	the	full	grayscale
[0,255].	This	function	redistributes	pixel	intensities	in	order	to
provide	a	linear	cumulated	histogram.
Reverse—Reverses	the	pixel	values,	producing	a
photometric	negative	of	the	original	image.
Logarithmic—Applies	logarithmic	transformation	on	the
image	pixels,	which	increases	brightness	and	contrast	in
dark	regions.
Exponential—Applies	an	exponential	transformation	on	the
image	pixels,	which	decreases	brightness	and	increases
contrast	in	bright	regions.
Square—Reduces	contrast	in	dark	regions.	Similar	to
Exponential	but	with	a	more	gradual	effect.
Square	Root—Reduces	contrast	in	bright	regions.	Similar	to
Logarithmic	but	with	a	more	gradual	effect.
Power	X—Reduces	contrast	in	dark	regions.
Power	1/X—Reduces	contrast	in	bright	regions.

Power	Value—Value	of	the	power	X	for	the	Power	X	and	Power
1/X	functions.	Default	value	is	1.5.



Apply	a	Lookup	Table	Transformation
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	the	lookup	table	that	you	want	to	apply	to	the	image.
3.	 Click	OK	to	apply	the	lookup	table	and	add	this	step	to	the	script.



Lookup	Table	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Filters
Prepares	an	image	for	processing	so	you	can	extract	only	the	information
you	need	from	the	image.	Most	of	these	filters	apply	a	kernel	across	the
image.	A	kernel	represents	a	pixel	and	its	relationship	to	neighboring
pixels.	The	weight	of	the	relationship	is	specified	by	the	coefficients	of
each	neighbor.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Filters
Image
Source

Original	input	image.

Smoothing-
Lowpass

Lowpass	filtering.	Smoothes	images	by	eliminating
details	and	blurring	edges.

Smoothing-
Local
Average

Local	averaging	of	the	image	pixels	based	on	the
kernel.

Smoothing-
Gaussian

Gaussian	filtering	based	on	the	kernel.	Attenuates
the	variations	of	light	intensity	in	the	neighborhood
of	a	pixel.	The	Gaussian	kernel	has	the	following
model:	a	d	c	b	x	b	c	d	a
where	a,	b,	c	and	d	are	integers	and	x	<	1.

Smoothing-
Median

Median	filtering.	Each	pixel	is	assigned	the	median
value	of	its	neighborhood.

Edge
Detection-
Laplacian

Laplacian	filtering.	Extracts	the	contour	of	objects
and	outlines	details.	The	Laplacian	filter	kernel	has
the	following	model:	a	d	c	b	x	b	c	d	a
where	a,	b,	c,	and	d	are	integers	and	x	is	greater
than	or	equal	to	the	sum	of	the	absolute	values	of
the	outer	coefficients.

Edge
Detection-
Diff.

Differentiation	filtering.	Produces	continuous
contours	by	highlighting	each	pixel	where	an
intensity	variation	occurs	between	itself	and	its	three
upper	left	neighbors.

Edge Prewitt	filtering.	A	highpass	filter	that	extracts	the



Detection-
Prewitt

outer	contours	of	objects.

Edge
Detection-
Sobel

Sobel	filter.	A	highpass	filter	that	extracts	the	outer
contours	of	objects.

Edge
Detection-
Roberts

Roberts	filter	to	detect	edges.	Outlines	the	contours
that	highlight	pixels	where	an	intensity	variation
occurs	along	the	diagonal	axes.

Convolution-
Highlight
Details

Convolution	kernel	that	highlights	the	edges	of	an
image.

Convolution-
Custom

Custom	filtering	using	the	kernel	coefficients	and
size	that	you	specify.

Kernel	Size—Size	of	the	structuring	element.	Valid	values	include
3	x	3,	5	x	5,	and	7	x	7.
Filter	Size—Sets	the	size	of	the	filter	for	the	Lowpass	and	Median
functions.
Kernel—Specifies	the	kernel	coefficients.
Tip		The	kernel	coefficients	for	each	filter	are	set	to	default	values.
You	may	need	to	experiment	with	different	coefficients	and	the
kernel	size	to	get	the	results	you	want.



Smooth	an	Image	with	Filtering
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	one	of	the	smoothing	functions	from	the	Filters	list.
3.	 Set	the	Kernel	Size	and	coefficients	if	you	are	using	a	Local

Average	or	Gaussian	filter.	Set	the	filter	size	if	you	are	using	the
Lowpass	or	Median	filter.

4.	 Click	OK	to	filter	the	image	and	add	this	step	to	the	script.
Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Detect	edges	with	filters
Filter	an	image	with	a	custom	convolution	filter
Highlight	details	in	an	image



Detect	Edges	with	Filters
1.	 Click	Grayscale»Filters	or	click	Filters	in	the	Grayscale	tab	of

the	Processing	Functions	palette.
2.	 Select	one	of	the	edge	detection	filters	from	the	Filters	list.	If	you

are	using	the	Laplacian	filter,	set	the	Kernel	Size	and	coefficients.
3.	 Click	OK	to	filter	the	image	and	add	this	step	to	the	script.
Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Filter	an	image	with	a	custom	convolution	filter
Highlight	details	in	an	image
Smooth	an	image	with	filtering



Highlight	Details	in	an	Image
1.	 Click	Grayscale»Filters	or	click	Filters	in	the	Grayscale	tab	of

the	Processing	Functions	palette.
2.	 Select	Convolution-Highlight	Details	from	the	Filters	list.
3.	 Adjust	the	Kernel	Size	and	coefficients,	if	necessary.
4.	 Click	OK	to	filter	the	image	and	add	this	step	to	the	script.
Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Detect	edges	with	filters
Filter	an	image	with	a	custom	convolution	filter
Smooth	an	image	with	filtering



Filter	an	Image	with	a	Custom	Convolution	Filter
1.	 Click	Grayscale»Filters	or	click	Filters	in	the	Grayscale	tab	of

the	Processing	Functions	palette.
2.	 Select	Convolution	–	Custom	from	the	Filters	list.
3.	 Set	the	Kernel	Size	and	coefficients.
4.	 Click	OK	to	filter	the	image	and	add	this	step	to	the	script.
Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Detect	edges	with	filters
Highlight	details	in	an	image
Smooth	an	image	with	filtering



Filters	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Gray	Morphology
Affects	the	structure	of	objects	in	grayscale	images.	You	can	use	these
functions	for	tasks	such	as	expanding	or	reducing	objects,	filling	holes,
closing	particles,	or	smoothing	boundaries,	which	are	tasks	you	perform
to	delineate	objects	and	prepare	images	for	thresholding	and	quantitative
analysis.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Gray	Morphology	Operations
Image
Source

Original	input	image.

Dilate Grayscale	dilation	operation.	Dilation	increases	the
brightness	of	each	pixel	surrounded	by	neighbors	with	a
higher	intensity.

Erode Grayscale	erosion	operation.	Erosion	reduces	the
brightness	of	pixels	that	are	surrounded	by	neighbors
with	a	lower	intensity.

Close Grayscale	dilation	followed	by	a	grayscale	erosion.
Closing	removes	dark	spots	isolated	in	bright	regions	and
smoothes	boundaries.

Open Grayscale	erosion	followed	by	a	grayscale	dilation.
Opening	removes	bright	spots	isolated	in	dark	regions
and	smoothes	boundaries.

Proper
Close

Finite	and	dual	combination	of	closing	and	opening
operations.	Proper	Closing	removes	dark	pixels	isolated
in	bright	regions	and	smoothes	the	boundaries	of	dark
regions.

Proper
Open

Finite	and	dual	combination	of	opening	and	closing
operations.	Proper	Opening	removes	bright	pixels
isolated	in	dark	regions	and	smoothes	the	boundaries	of
bright	regions.

Auto
Median

Dual	combinations	of	openings	and	closings.	Auto
Median	generates	simpler	objects	with	fewer	details.

Structuring	Element
2D	array	used	as	a	binary	mask	to	define	the	neighbors	of	a



pixel.	You	can	modify	the	structuring	element	by	clicking	its
cells.	If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white
(empty),	it	has	a	value	of	0.	If	cell	is	black,	the
corresponding	pixel	is	considered	to	be	a	neighbor	and	its
value	is	used	during	the	morphology	operation.

Size—Size	of	the	structuring	element.	Valid	values	include	3	x	3,	5
x	5,	and	7	x	7.
#	of	Iterations	(Dilate	and	Erode	functions)—Number	of	times	the
operation	is	applied	to	the	image.



Expand	(Dilate)	Objects	in	Grayscale	Images
1.	 Click	Grayscale»Gray	Morphology	or	select	Gray	Morphology

in	the	Grayscale	tab	of	the	Processing	Functions	palette.
2.	 Select	Dilate	from	the	Gray	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Enter	the	number	of	times	that	you	want	the	dilation	applied	to	the

image	in	Iterations.
6.	 Click	OK	to	apply	the	dilation	and	add	this	step	to	the	script.
Tips		

The	structuring	element	is	a	2D	array	used	as	a	binary	mask
to	define	the	neighborhood	of	a	pixel.	You	can	modify	the
structuring	element	by	clicking	its	cells.	If	a	cell	is	black,	it
has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has	a	value	of	0.
Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Fill	gaps	and	holes	(close)	in	grayscale	images
Reduce	(erode)	objects	in	grayscale	images
Remove	small	objects	(open)	from	grayscale	images
Smooth	object	boundaries	in	grayscale	images



Reduce	(Erode)	Objects	in	Grayscale	Images
1.	 Click	Grayscale»Gray	Morphology	or	select	Gray	Morphology

in	the	Grayscale	tab	of	the	Processing	Functions	palette.
2.	 Select	Erode	from	the	Gray	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Enter	the	number	of	times	that	you	want	the	erosion	applied	to	the

image	in	Iterations.
6.	 Click	OK	to	apply	the	erosion	and	add	this	step	to	the	script.
Tips		

The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its
cells.	If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white
(empty),	it	has	a	value	of	0.
Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	grayscale	images
Fill	gaps	and	holes	(close)	in	grayscale	images
Reduce	(erode)	objects	in	binary	images
Remove	small	objects	(open)	from	grayscale	images
Smooth	object	boundaries	in	grayscale	images



Fill	Gaps	and	Holes	(Close)	in	Grayscale	Images
1.	 Click	Grayscale»Gray	Morphology	or	select	Gray	Morphology

in	the	Grayscale	tab	of	the	Processing	Functions	palette.
2.	 Select	Close	from	the	Gray	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	closing	and	add	this	step	to	the	script.
Tips		

The	structuring	element	is	a	2D	array	used	as	a	binary	mask
to	define	the	neighborhood	of	a	pixel.	You	can	modify	the
structuring	element	by	clicking	its	cells.	If	a	cell	is	black,	it
has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has	a	value	of	0.
Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	grayscale	images
Fill	gaps	and	holes	(close)	in	binary	images
Reduce	(erode)	objects	in	grayscale	images
Remove	small	objects	(open)	from	grayscale	images
Smooth	object	boundaries	in	grayscale	images



Remove	Small	Objects	(Open)	from	Grayscale
Images

1.	 Click	Grayscale»Gray	Morphology	or	select	Gray	Morphology
in	the	Grayscale	tab	of	the	Processing	Functions	palette.

2.	 Select	Open	from	the	Gray	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	opening	and	add	this	step	to	the	script.
Tips		

The	structuring	element	is	a	2D	array	used	as	a	binary	mask
to	define	the	neighborhood	of	a	pixel.	You	can	modify	the
structuring	element	by	clicking	its	cells.	If	a	cell	is	black,	it
has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has	a	value	of	0.
Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	grayscale	images
Fill	gaps	and	holes	(close)	in	grayscale	images
Reduce	(erode)	objects	in	grayscale	images
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	grayscale	images



Smooth	Object	Boundaries	in	Grayscale	Images
1.	 Click	Grayscale»Gray	Morphology	or	select	Gray	Morphology

in	the	Grayscale	tab	of	the	Processing	Functions	palette.
2.	 Select	one	of	the	three	following	morphological	functions	from	the

Gray	Morphology	list:
Proper	Open—Smoothes	boundaries	of	objects	and	fills
small	holes.
Proper	Close—Smoothes	boundaries	of	objects	and
removes	small	particles.
Auto	Median—Smoothes	boundaries	of	objects.

3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	morphology	and	add	this	step	to	the	script.
Tips		

The	structuring	element	is	a	2D	array	used	as	a	binary	mask
to	define	the	neighborhood	of	a	pixel.	You	can	modify	the
structuring	element	by	clicking	its	cells.	If	a	cell	is	black,	it
has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has	a	value	of	0.
Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	grayscale	images
Fill	gaps	and	holes	(close)	in	grayscale	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	grayscale	images
Remove	small	objects	(open)	from	grayscale	images
Smooth	an	image	with	filtering
Smooth	object	boundaries	in	binary	images



Gray	Morphology	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



FFT	Filter
Applies	a	frequency	filter	to	the	image.	This	function	performs	three
steps.	First,	it	finds	the	fast	Fourier	transform	(FFT)	of	the	source	image,
which	is	a	complex	image.	Then	the	function	filters	(truncates	or
attenuates)	the	complex	image.	Finally,	it	computes	the	inverse	FFT.
Generally,	the	FFT	Filter	is	used	to	compute	backgrounds	in	order	to
correct	light	drifts.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
FFT	Filters
Image	Source Opens	the	original	input	image.
Truncate Truncates	the	frequencies	of	a	complex	image.
Attenuate Attenuates	the	frequencies	of	a	complex	image.
Mode—Determines	which	frequencies	to	truncate	or	attenuate.
Low	Pass Removes	high	frequencies.
High	Pass Removes	low	frequencies.
Truncation	Frequency	%—Percentage	of	the	frequencies
retained	within	a	Fourier-transformed	image.	This	percentage	is
expressed	with	respect	to	the	length	of	the	diagonal	of	the	FFT
image	and	the	Mode	value.
Display	FFT—Shows	the	complex	image	after	filtering.



Apply	an	FFT	Filter	to	an	Image
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	the	Truncate	or	Attenuate	option.
3.	 Select	the	Mode.	Low	Pass	removes	or	attenuates	high

frequencies,	and	High	Pass	removes	or	attenuates	low
frequencies.

4.	 If	you	selected	Truncate,	set	the	Truncation	Frequency	%.
Otherwise,	proceed	to	the	next	step.

5.	 Click	OK	to	apply	the	FFT	Filter,	add	this	step	to	the	script,	and
close	the	Parameter	window.
Note		This	function	is	computer-intensive	and	can	take	several
seconds.

Tip		If	you	want	to	see	the	complex	image	created	by	the	FFT
Filter,	select	the	Display	FFT	option.	To	see	details	of	the	FFT
Filter,	select	the	Gradient	color	palette	from	the	Display	Color
Palette	control	in	the	toolbar.



FFT	Filter	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Threshold
Segments	pixels	in	grayscale	images.	The	Manual	Threshold	operation
enables	you	to	select	ranges	of	grayscale	pixel	values.	Local	threshold
operations	select	pixels	using	a	locally	adaptive	thresholding	algorithm.
Use	local	thresholds	in	applications	whose	images	exhibit	non-uniform
lighting	changes	that	may	result	from	a	strong	illumination	gradient	or
shadows.	Automatic	threshold	operations	select	threshold	ranges	for	you.
Use	automatic	thresholds	when	you	expect	uniform	lighting	changes	from
image	to	image.



Main	Tab
The	following	control	is	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.



Threshold	Tab
The	following	controls	are	available	on	the	Threshold	tab.

Look	For
Bright
Objects

Isolates	pixels	whose	intensity	values	range	from	a
user-specified	value	to	255.

Dark
Objects

Isolates	pixels	whose	intensity	values	range	from	0	to	a
user-specified	value.

Gray
Objects

Isolates	pixels	whose	intensity	values	lie	within	a	user-
specified	range.

Threshold	Type
Image
Source

Opens	the	original	input	image.

Manual
Threshold

Applies	a	threshold	to	the	image	based	on	the
Minimum	and	Maximum	threshold	values	that	you
enter.	All	pixels	not	contained	between	the	Minimum
and	Maximum	values	are	set	to	0.	All	pixels	that	fall
in	the	range	are	replaced	by	1.

Local
Threshold:
Niblack

Calculates	a	threshold	value	for	each	pixel	based	on
the	statistics	of	surrounding	pixels.	This	algorithm
compensates	for	high	lighting	variations.

Local
Threshold:
Background
Correction

Performs	a	background	correction	to	eliminate	non-
uniform	lighting	effects	and	then	performs
thresholding	using	the	interclass	variance
thresholding	algorithm.

Auto
Threshold:
Clustering

Applies	a	threshold	to	an	image	based	on	a
statistical	technique	called	clustering.

Auto
Threshold:
Entropy

Applies	a	threshold	to	an	image	based	on	an	image
analysis	technique	called	entropy.

Auto
Threshold:
Metric

Applies	a	threshold	to	an	image	by	calculating	the
optimal	threshold,	which	depends	on	the	surfaces
representing	the	initial	grayscale,	using	the	metric
technique.



Auto
Threshold:
Moments

Applies	a	threshold	to	an	image	by	using	a	statistical
tool	called	moments,	which	recalculates	a	theoretical
binary	image.

Auto
Threshold:
Inter
Variance

Applies	a	threshold	to	an	image	based	on	a	classical
statistical	technique	called	interclass	variance.

Threshold	Range—Configurable	only	with	a	Manual	Threshold.
Minimum Lowest	grayscale	pixel	value	included	in	the	manual

threshold	range.	You	can	adjust	the	black	cursor	on	the
histogram	to	set	the	lower	bound	for	this	range	when
you	are	looking	for	bright	or	gray	objects.

Maximum Highest	grayscale	pixel	value	included	in	the	manual
threshold	range.	You	can	adjust	the	white	cursor	on	the
histogram	to	set	the	upper	bound	for	this	range	when
you	are	looking	for	dark	or	gray	objects.

Histogram—Displays	the	total	number	of	pixels	in	each	grayscale
value.	From	the	histogram,	you	can	discern	if	the	image	contains
distinct	regions	of	a	certain	grayscale	value,	and	you	can	select
grayscale	pixel	regions	of	the	image	by	sliding	the	white	and	black
cursors.

Tips		
You	can	display	the	histogram	of	a	portion	of	an
image	by	drawing	an	ROI	around	the	area	of	interest
with	one	of	the	tools	from	the	toolbar.	The	local
histogram	gives	you	valuable	information	about	the
threshold	range	you	can	select	to	keep	or	reject
certain	parts	of	the	image.
Thresholding	an	image	produces	a	binary	images	with
pixel	values	of	0	and	1.	You	must	use	a	binary	color
palette	to	display	binary	images.

Kernel	Size—Size	of	the	neighborhood	around	each	pixel	used	to
compute	the	mean	value.	The	Kernel	Size	is	typically	the	size	of
the	object	you	want	to	isolate	with	the	threshold.	This	control	is
configurable	only	with	a	local	threshold.



Tip		You	can	get	the	approximate	size	of	an	object	in	your
image	by	drawing	an	ROI	around	the	object.	ROI	Size
displays	the	size	of	the	last	ROI	drawn.	Click	 	to	apply

the	ROI	Size	to	the	Kernel	Size.
Deviation	Factor—Determines	the	sensitivity	of	the	algorithm.
Values	range	from	0	to	1,	with	0	being	the	most	sensitive	to	noise.
The	lower	the	Deviation	Factor,	the	closer	the	pixel	value	must	be
to	the	mean	value	to	be	selected	as	part	of	a	particle.	This	control
is	configurable	only	with	the	Local	Threshold:	Niblack	Threshold
Type.



Threshold	a	Grayscale	Image
Main	Tab
In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.



Threshold	Tab
1.	 Select	whether	you	want	the	function	to	look	for	bright,	dark,	or

gray	objects.
2.	 Select	the	type	of	threshold	you	want	to	perform.
Note		You	cannot	adjust	the	threshold	levels	of	the	local	and
automatic	thresholds.	If	none	of	the	local	or	automatic	thresholding
options	work	for	the	image,	select	Manual	Threshold	and	adjust
the	pointers	on	the	histogram	until	all	of	the	particles	of	interest	are
highlighted	in	red.

3.	 Click	OK	to	threshold	the	image	and	add	this	step	to	the	script.
Tips		

If	you	have	trouble	finding	a	manual	threshold	range	that
selects	all	of	the	pixels	in	the	range,	draw	an	ROI	around	the
portion	of	the	image	that	you	want	to	keep.	The	histogram
displays	the	intensities	of	the	ROI	only.	Use	the	minimum
and	maximum	values	for	the	threshold.



Grayscale	Threshold	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Watershed	Segmentation
Performs	segmentation	on	images	using	the	watershed	transform.	Refer
to	the	NI	Vision	Concepts	Manual	for	information	about	the	watershed
transform.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Number	of	Zones—Displays	the	total	number	of	zones	detected
in	the	image.
Connectivity	4/8—Defines	which	of	the	surrounding	pixels	for	any
given	pixel	constitute	its	neighborhood.

Connectivity-8—All	adjacent	pixels	are	considered
neighbors.
Connectivity-4—Only	pixels	adjacent	in	the	horizontal	and
vertical	directions	are	considered	neighbors.

Display—Controls	how	Vision	Assistant	displays	the	image	after
watershed	segmentation.

Labeled	Binary	Output—Displays	the	labeled	binary	image
returned	by	the	watershed	algorithm.
Image	Source	with	Separation	Overlay—Overlays	the
watershed	lines	in	red	on	top	of	the	input	image.	This	display
is	helpful	to	see	if	the	zones	found	are	correct.	This	is	for
viewing	purposes	only	and	does	not	change	the	output	of
the	step.
Note		The	Display	options	control	how	the	results	are
displayed	in	the	Processing	window	when	the	Setup	window
is	open.	However,	the	output	image	of	the	step	is	always	a
labeled	binary	image.



Segment	an	Image	Using	a	Watershed
Transform

Note		The	watershed	function	works	only	with	8-bit	and	16-bit
images.

The	following	steps	illustrate	one	method	of	segmenting	objects.
1.	 Threshold—(Grayscale»Threshold)	Threshold	the	image	to

isolate	the	objects	you	want	to	segment	from	the	rest	of	the
image.

2.	 Remove	Noise—(Binary»Advanced	Morphology	or
Binary»Particle	Filter)	Remove	extraneous	information	from	the
binary	image	using	various	morphology	operations.	For	example,
you	can	fill	in	holes	with	the	Advanced	Morphology	option	Fill
holes	or	remove	noise	with	the	Particle	Filter	function.

3.	 Create	Distance	Map—(Binary»Advanced	Morphology)	Use	the
Danielsson	option	to	transform	the	binary	image	into	a	grayscale
image	in	which	the	center	of	each	object	represents	a	local
maximum	in	the	image.	If	you	were	to	look	at	the	topographical
surface	of	the	image	after	applying	the	distance	map,	each	object
would	appear	as	a	smooth,	gradual	peak.

4.	 Apply	Watershed	Transform	—(Grayscale»Watershed
Segmentation)	Apply	the	watershed	transform	to	segment	the
image	into	local	zones.	A	zone	is	determined	by	the	watershed
line	that	separates	the	influence	zone	of	each	peak.

Refer	to	the	NI	Vision	Concepts	Manual	for	more	information	about
thresholding,	morphology,	distance	transforms,	or	watershed	transforms.



Watershed	Segmentation	FAQs
How	can	I	label	more	than	255	zones?
The	watershed	transform	accepts	8-bit	and	16-bit	images.	The	maximum
number	of	labels	in	an	8-bit	image	is	255.	Zones	over	255	are	saturated
at	255.	The	maximum	number	of	labels	in	a	16-bit	grayscale	image	is
32,766.	If	an	8-bit	image	requires	more	than	255	labels,	cast	the	image	to
a	16-bit	image	before	using	the	Watershed	Segmentation	step.
If	8-bit	images	can	label	up	to	only	255	zones,	is	the	Number	of
Zones	result	still	accurate	if	more	than	255	zones	are	detected?
Watershed	Segmentation	returns	the	correct	number	of	zones	found
even	if	the	number	of	zones	is	greater	than	the	maximum	number	of
labels	for	a	particular	bit	depth.
Can	I	use	the	output	of	the	watershed	transform	to	separate
touching	objects?
The	Watershed	Segmentation	algorithm	partitions	an	image	based	on	the
topographic	surface	of	the	image.	The	image	is	separated	into	non-
overlapping	segments.	Each	segment	contains	a	unique	particle.
Complete	these	steps	to	separate	touching	particles	by	masking	the
segmentation	lines.

1.	 Store	a	copy	of	the	binary	image	in	Buffer	#1	with	the	Image
Buffer	step	(Image»Image	Buffer).

2.	 Use	the	Danielsson	option	(Binary»Adv.
Morphology»Danielsson)	to	assign	to	each	pixel	a	grayscale
value	equal	to	the	shortest	distance	to	the	border	of	the	object.

3.	 Use	the	Watershed	Segmentation	step	(Grayscale»Watershed
Segmentation)	to	partition	the	image.

4.	 Store	the	watershed	image	in	Buffer	#2	with	the	Image	Buffer
step.

5.	 Retrieve	the	thresholded	image	from	Buffer	#1	using	the	Image
Buffer	step.

6.	 Mask	the	thresholded	image	with	the	watershed	image	by	using
the	Mask	Buffer	step	(Grayscale»Operators»Mask).



Operators
Performs	arithmetic	and	logical	operations	on	images.	The	following
controls	are	available.

Step	Name—Name	to	give	the	step.
Operators
Image
Source

Opens	the	original	input	image.

Add Adds	a	constant	or	an	image	to	the	original	input
image.	This	is	a	pixel-by-pixel	operation.

Subtract Subtracts	a	constant	or	an	image	from	the	original
input	image.	This	is	a	pixel-by-pixel	operation.

Multiply Multiplies	the	original	input	image	by	a	constant	or
another	image.	This	is	a	pixel-by-pixel	operation.

Divide Divides	the	original	input	image	by	a	constant	or
another	image.	This	is	a	pixel-by-pixel	operation.

Multiply
Divide

Computes	a	ratio	between	two	images.	Each	pixel	in
the	original	image	is	multiplied	by	the	constant	before
being	divided	by	the	equivalent	pixel	found	in	another
image	stored	in	the	buffer.	This	is	a	pixel-by-pixel
operation.

Modulo Executes	modulo	division	(remainder)	of	the	original
input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	pixel-by-pixel	operation.

Absolute
Difference

Subtracts	one	image	from	another	or	a	constant	from
an	image	and	returns	the	absolute	value	of	the
difference.

And Performs	a	logical	AND	operation	between	the	original
input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	bit-wise	operation.

Not	And Performs	a	logical	NAND	operation	between	the
original	input	image	and	a	constant	or	another	image
stored	in	the	buffer.	This	is	a	bit-wise	operation.

Or Performs	a	logical	OR	operation	between	the	original



input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	bit-wise	operation.

Not	Or Performs	a	logical	NOR	operation	between	the	original
input	image	and	a	constant	or	another	image	stored	in
the	buffer.	This	is	a	bit-wise	operation.

Exclusive
Or

Performs	an	Exclusive	OR	operation	between	the
original	input	image	and	a	constant	or	another	image
stored	in	the	buffer.	This	is	a	bit-wise	operation.

Not
Exclusive
Or

Performs	an	Exclusive	NOR	operation	between	the
original	input	image	and	a	constant	or	another	image
stored	in	the	buffer.	This	is	a	bit-wise	operation.

Logical
Difference

Finds	the	logical	difference	between	the	original	input
image	and	a	constant	or	another	image	stored	in	the
buffer.	This	is	a	bit-wise	operation.

Mask Replaces	pixels	in	the	original	input	image	that
correspond	to	pixels	with	value	0	in	the	image	mask	as
0.	The	image	mask	is	an	8-bit	image	that	specifies	the
regions	in	the	original	input	image	to	be	modified.	This
is	a	pixel-by-pixel	operation.

Average Calculates	the	average	of	the	original	input	image	and
a	constant	or	another	image	stored	in	the	buffer.	This
is	a	pixel-by-pixel	operation.

Min Extracts	the	smallest	value	between	the	original	input
image	and	a	constant	or	another	image	stored	in	the
buffer.	This	is	a	pixel-by-pixel	operation.

Max Extracts	the	largest	value	between	the	original	input
image	and	a	constant	or	another	image	stored	in	the
buffer.	This	is	a	pixel-by-pixel	operation.

Clear	if	< If	pixel	(x,	y)	in	the	original	input	image	is	less	than	a
constant	or	pixel	(x,	y)	in	another	image,	the	resulting
pixel	(x,	y)	equals	0.	Otherwise,	the	resulting	pixel	(x,
y)	equals	pixel	(x,	y)	in	the	original	input	image.	This	is
a	pixel-by-pixel	operation.

Clear	if	<
or	=

If	pixel	(x,	y)	in	the	original	input	image	is	less	than	or
equal	to	a	constant	or	pixel	(x,	y)	in	another	image,	the



resulting	pixel	(x,	y)	equals	0.	Otherwise,	the	resulting
pixel	(x,	y)	equals	pixel	(x,	y)	in	the	original	input
image.	This	is	a	pixel-by-pixel	operation.

Clear	if	= If	pixel	(x,	y)	in	the	original	input	image	is	equal	to	a
constant	or	pixel	(x,	y)	in	another	image,	the	resulting
pixel	(x,	y)	equals	0.	Otherwise,	the	resulting	pixel	(x,
y)	equals	pixel	(x,	y)	in	the	original	input	image.	This	is
a	pixel-by-pixel	operation.

Clear	if	>
or	=

If	pixel	(x,	y)	in	the	original	input	image	is	greater	than
or	equal	to	a	constant	or	pixel	(x,	y)	in	another	image,
the	resulting	pixel	(x,	y)	equals	0.	Otherwise,	the
resulting	pixel	(x,	y)	equals	pixel	(x,	y)	in	the	original
input	image.	This	is	a	pixel-by-pixel	operation.

Clear	if	> If	pixel	(x,	y)	in	the	original	input	image	is	greater	than
a	constant	or	pixel	(x,	y)	in	another	image,	the
resulting	pixel	(x,	y)	equals	0.	Otherwise,	the	resulting
pixel	(x,	y)	equals	pixel	(x,	y)	in	the	original	input
image.	This	is	a	pixel-by-pixel	operation.

Constant—Constant	value	to	be	used	in	an	operation,	when
selected.
Image—Image	from	an	active	buffer	to	be	used	in	an	operation,
when	selected.	Vision	Assistant	allows	you	to	select	only	image
buffers	that	contain	images	of	the	same	type	and	size	as	the	image
source.	Click	Image»Image	Buffer,	or	select	Image	Buffer	in	the
Image	tab	of	the	Processing	Functions	palette	to	store	an	image	in
an	empty	image	buffer.



Use	the	Operators	Function
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	one	of	the	operators	from	the	Operators	list.
3.	 Select	either	the	Constant	or	Image	option.	The	Constant	option

uses	a	constant	and	the	current	image	in	the	operation.	The
Image	option	uses	the	current	image	and	an	image	stored	in	an
image	buffer.

Note		For	the	Mask	operator,	you	can	select	only	the
Image	option.	For	the	Multiply	Divide	operator,	you	must
specify	an	Image	and	a	Constant.

4.	 Enter	the	constant	or	select	the	image	buffer	that	contains	the
image	you	are	combining	with	the	source	image.

5.	 Click	OK	to	perform	the	operation.
Note			You	must	already	have	an	image	stored	in	an	image
buffer	before	you	can	perform	an	operation	using	the
current	image	and	another	image.	The	buffered	image	must
have	the	same	size	and	type	as	the	source	image.

Related	Topics
Retrieve	an	image	from	an	image	buffer
Store	an	image	in	an	image	buffer



Operators	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Conversion
Converts	the	current	image	to	the	specified	image	type.	The	following
controls	are	available.

Step	Name—Name	to	give	the	step.
From—Image	type	for	the	current	image.
To—Image	type	that	you	want	to	convert	the	current	image	to.
Valid	values	include	8-bit,	16-bit,	and	float.
Method—Conversion	method	used	to	convert	the	image	to	a
smaller	data	type.
Adjust
dynamic

Adjusts	the	dynamic	of	the	image	so	that	the	lowest
intensity	in	the	image	corresponds	to	the	smallest	value
available	in	the	new	image	type	and	the	highest	value
corresponds	to	the	highest	value	available	in	the	new
image	data	type.	All	pixel	intensities	within	those	limits
are	distributed	linearly.
Note		The	Adjust	dynamic	function	is	not	always
available.

Shift	# Available	only	for	16-bit	to	8-bit	conversion.	Performs
Shift	#	to	the	16-bit	image	prior	to	converting	it	to	an	8-
bit	data	type.	The	value	of	Shift	#	depends	on	the
dynamic	of	the	image.	For	example,	if	you	acquired	the
image	with	a	12-bit	camera	and	you	want	to	convert	it	to
an	8-bit	image,	keep	the	most	significant	bits.	To	keep
the	most	significant	bits	in	this	case,	perform	4	(12-8)
shifts	to	retrieve	the	8	most	significant	bits	of	the	image.

Cast Casts	the	values	too	large	to	be	represented	in	the	new
data	type	to	the	largest	value	available	and	values	too
small	to	the	smallest	value	available.



Convert	Grayscale	Images
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	the	data	type	that	you	want	to	convert	the	current	image	to.

If	you	are	converting	the	image	to	a	smaller	data	type,	select	the
method	of	conversion.

3.	 Click	OK	to	convert	the	image,	add	this	step	to	the	script,	and
close	the	Conversion	window.



Conversion	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Quantify
Quantifies	the	contents	of	an	image	or	regions	within	an	image.	You	can
select	regions	using	the	ROI	tools	from	the	toolbar.



Quantify	Tab
The	following	controls	are	available	on	the	Quantify	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Results
Area	(%)—Percentage	of	the	analyzed	surface	in	relation	to	the
complete	image.
Mean	Value—Mean	value	of	the	pixels.
Standard	Variation—Standard	deviation	of	the	pixel	values.
Minimum	Value—Smallest	pixel	value.
Maximum	Value—Largest	pixel	value.



Quantify	an	ROI	in	an	Image
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	one	of	the	ROI	tools	from	the	toolbar.
3.	 Select	a	region	of	interest	from	the	image.	Vision	Assistant	lists

the	intensity	measurements	for	that	ROI	in	the	Results	table.
4.	 Click	OK	to	add	this	step	to	the	script.
Tips		

You	can	select	multiple	regions	of	interest	on	the	image.
Vision	Assistant	numerically	labels	all	of	the	ROIs	selected
and	the	corresponding	measurements.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.
You	can	remove	the	selected	data	with	the	Delete	Selection
button	or	delete	all	results	with	the	Delete	All	Results
button.



Quantify	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Centroid
Calculates	the	energy	center	of	the	image.	The	following	controls	are
available.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
X	Position—X-coordinate	of	the	energy	center	of	the	image.
Y	Position—Y-coordinate	of	the	energy	center	of	the	image.
Tip		You	can	perform	the	centroid	computation	on	a	portion	of	the
image	by	drawing	a	region	of	interest	(ROI)	around	the	region.



Compute	the	Energy	Center	of	an	Image
1.	 Vision	Assistant	calculates	the	energy	center	(centroid)	of	the

image	and	returns	the	coordinates.
2.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
3.	 Click	OK	to	add	this	step	to	the	script.
Tip		You	can	compute	the	centroid	of	a	portion	of	the	image	by
drawing	an	ROI.



Centroid	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Use	Binary	Functions
This	palette	groups	several	image	functions	that	analyze	binary	images.



Basic	Morphology
Use	this	function	to	expand	or	reduce	particles,	smooth	the	particle
borders,	and	isolate	external	or	internal	particle	boundaries.	You	can	use
basic	morphological	transformations	to	prepare	particles	for	quantitative
analysis,	to	observe	the	geometry	of	regions,	and	to	extract	the	simplest
forms	for	modeling	and	identification.



Adv.	Morphology
Use	this	function	to	fill	holes	in	particles,	remove	particles	that	touch	the
border	of	the	image,	remove	unwanted	small	and	large	particles,
separate	touching	particles,	find	the	convex	hull	of	particles,	and	more.



Particle	Filter
Use	this	function	to	remove	or	keep	particles	in	an	image	as	specified	by
the	filter	criteria.



Binary	Image	Inversion
Use	this	function	to	reverse	the	dynamic	of	an	image,	making	the
background	pixels	into	particles	and	making	particles	into	background
pixels.



Shape	Matching
Use	this	function	to	search	an	image	for	objects	that	have	a	shape	similar
to	a	template	object.



Particle	Analysis
Use	this	function	to	make	shape	measurements	on	particles	in	the	image.



Circle	Detection
Use	this	function	to	finds	the	center	and	radius	of	circular	particles	in	an
image.



Basic	Morphology
Affects	the	shape	of	particles	in	binary	images.	Each	particle	or	region	is
affected	on	an	individual	basis.	You	can	use	these	functions	for	tasks
such	as	expanding	or	reducing	objects,	filling	holes,	closing	particles,	or
smoothing	boundaries,	which	are	tasks	you	perform	to	delineate	objects
and	prepare	images	for	quantitative	analysis.	The	following	controls	are
available.

Step	Name—Name	to	give	the	step.
Basic	Morphology	Operations
Image
Source

Opens	the	original	input	image.

Erode
objects

Eliminates	pixels	isolated	in	the	background	and	erodes
the	contour	of	objects	based	on	the	structuring	element.
Erosion	makes	objects	smaller.

Dilate
objects

Eliminates	tiny	holes	isolated	in	objects	and	expands
the	contour	of	the	objects	based	on	the	structuring
element.	Dilation	makes	objects	larger.

Open
objects

Removes	small	objects	and	smoothes	boundaries.	An
opening	is	an	erosion	followed	by	a	dilation,	which	does
not	significantly	alter	the	area	or	shape	of	objects.
Borders	removed	by	erosion	are	restored	by	dilation,	but
small	objects	that	were	removed	during	erosion	do	not
reappear	after	dilation.

Close
objects

Fills	tiny	holes	and	smoothes	boundaries.	A	closing	is	a
dilation	followed	by	erosion,	which	does	not	significantly
alter	the	area	or	shape	of	objects.	Objects	are	expanded
by	the	dilation	and	then	reduced	by	erosion,	so	borders
are	smoothed	and	holes	are	filled.

Proper
Open

Removes	small	particles	and	smoothes	the	contour	of
objects	based	on	the	structuring	element.	It	is	a	finite
and	dual	combination	of	openings	and	closings.

Proper
Close

Fills	tiny	holes	and	smoothes	inner	contours	of	objects
based	on	the	structuring	element.	It	is	a	finite	and	dual
combination	of	closings	and	openings.

Gradient Extracts	the	interior	contours	of	a	particle.



In
Gradient
Out

Extracts	the	exterior	contours	of	a	particle.

Auto
Median

Simplifies	objects	based	on	the	structuring	element	so
that	they	have	fewer	details.	The	Auto	Median	function
uses	dual	combinations	of	openings	and	closings.

Thick Alters	the	shape	of	objects	by	adding	parts	to	the	object
that	match	the	pattern	specified	in	the	structuring
element.	Thickening	is	useful	for	filling	holes	and
smoothing	right	angles	along	edges	of	objects.

Thin Alters	the	shape	of	objects	by	eliminating	parts	of	the
object	that	match	the	pattern	specified	in	the	structuring
element.	Thinning	is	useful	for	removing	single	pixels
isolated	in	the	background	and	right	angles	along	edges
of	objects.

Structuring	Element
2D	array	used	as	a	binary	mask	to	define	the	neighbors	of	a
pixel.	You	can	modify	the	structuring	element	by	clicking	its
cells.	If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white
(empty),	it	has	a	value	of	0.	If	cell	is	black,	the
corresponding	pixel	is	considered	to	be	a	neighbor	and	its
value	is	used	during	the	morphology	operation.

Size—Size	of	the	structuring	element.	Valid	values	include	3	x	3,	5
x	5,	and	7	x	7.
Iterations—Specifies	the	number	of	3	x	3	erosions	to	apply	to	the
image.
Square/HexagonSpecifies	the	shape	of	the	pixel	frame	during	the
transformation.

Square	pixel	frame.	Each	pixel	is	surrounded	by	eight
neighbors.	The	vertical	and	horizontal	neighbors	have	a
distance	d	from	the	pixel.	Diagonal	pixels	have	a	slightly
greater	distance	because	they	are	farther	away	from	the
central	pixel.
Hexagon	pixel	frame.	Each	pixel	is	surrounded	by	six
neighbors,	which	are	each	located	at	an	equal	distance	from



the	central	pixel.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	binary	images



Reduce	(Erode)	Objects	in	Binary	Images
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Erode	objects	from	the	Basic	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Enter	the	number	of	times	that	you	want	the	erosion	applied	to	the

image	in	Iterations.
6.	 Click	OK	to	apply	the	erosion	and	add	this	step	to	the	script.
Note			The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	grayscale	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	binary	images



Expand	(Dilate)	Objects	in	Binary	Images
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Dilate	objects	from	the	Basic	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Enter	the	number	of	times	that	you	want	the	dilation	applied	to	the

image	in	Iterations.
6.	 Click	OK	to	apply	the	dilation	and	add	this	step	to	the	script.
Note			The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	grayscale	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smoothing	right	angles
Reduce	(eroding)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	binary	images



Remove	Small	Objects	(Open)	from	Binary
Images

1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in
the	Binary	tab	of	the	Processing	Functions	palette.

2.	 Select	Open	objects	from	the	Basic	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	opening	and	add	this	step	to	the	script.
Note		The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	grayscale	images
Smooth	object	boundaries	in	binary	images



Fill	Gaps	and	Goles	(Close)	in	Binary	Images
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Close	objects	from	the	Basic	Morphology	list.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	closing	and	add	this	step	to	the	script.
Note		The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Basic	Morphology	(Binary»Basic	Morphology)
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	grayscale	images
Fill	holes	and	smoothing	right	angles
Reduce	(erode)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	binary	images



Smooth	Object	Boundaries	in	Binary	Images
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	a	function	from	the	Basic	Morphology	list.	You	can	use

one	of	three	morphological	functions	to	smooth	the	boundaries	of
objects:

Proper	Open—Smoothes	boundaries	of	objects	and	fills
small	holes.
Proper	Close—Smoothes	boundaries	of	objects	and
removes	small	particles.
Auto	Median—Smoothes	boundaries	of	objects.

3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	smoothing	function	and	add	this	step	to	the

script.
Note		The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	grayscale	images



Extract	the	Contours	of	a	Particle
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Gradient	In	to	extract	the	interior	contours	of	a	particle	or

Gradient	Out	to	extract	the	exterior	contours	of	a	particle.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	function	and	add	this	step	to	the	script.
Note		The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip			Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	binary	images



Fill	Holes	and	Smooth	Right	Angles
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Thick	to	alter	the	shape	of	objects	by	adding	parts	to	the

object	that	match	the	pattern	specified	in	the	structuring	element.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	thickening	and	add	this	step	to	the	script.
Note		The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	gaps	and	holes	(close)	in	grayscale	images
Fill	holes
Reduce	(erode)	objects	in	binary	images
Remove	single	pixels	and	right	angles
Remove	small	objects	(open)	from	binary	images
Smooth	an	image	with	filtering
Smooth	object	boundaries	in	binary	images
Smooth	object	boundaries	in	grayscale	images



Remove	Single	Pixels	and	Right	Angles
1.	 Click	Binary»Basic	Morphology	or	select	Basic	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Thin	to	alter	the	shape	of	objects	by	eliminating	parts	to

the	object	that	match	the	pattern	specified	in	the	structuring
element.

3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Click	OK	to	apply	the	thinning	and	add	this	step	to	the	script.
Note			The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its	cells.
If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white	(empty),	it	has
a	value	of	0.

Tip		Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Expand	(dilate)	objects	in	binary	images
Extract	the	contours	of	a	particle
Fill	gaps	and	holes	(close)	in	binary	images
Fill	holes	and	smooth	right	angles
Reduce	(erode)	objects	in	binary	images
Remove	small	objects	(open)	from	binary	images
Smooth	object	boundaries	in	binary	images



Basic	Morphology	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Adv.	Morphology
Perform	high-level	operations	on	particles	in	binary	images.	Use	these
functions	for	tasks	such	as	removing	small	particles	from	an	image,
labeling	particles	in	an	image,	or	filling	holes	in	particles.	The	following
controls	are	available.

Step	Name—Name	to	give	the	step.
Advanced	Morphology	Operations
Image
Source

Opens	the	original	input	image.

Remove
small
objects

Removes	small	objects.	A	small	object	is	defined	by
the	number	of	erosions	(specified	in	Iterations)
needed	to	remove	the	object.

Remove
large
objects

Removes	large	objects.	A	large	object	is	defined	by
the	number	of	erosions	(specified	in	Iterations)	that
do	not	remove	the	object.

Remove
border
objects

Eliminates	particles	that	touch	the	borders	of	an
image.

Fill	holes Fills	holes	found	in	a	particle.	Holes	are	filled	with	a
pixel	value	of	1.

Convex	Hull Computes	the	convex	hull	of	objects.
Skeleton Applies	a	succession	of	thinnings	until	the	width	of

each	object	equals	one	pixel.	The	Skeleton	L
function	uses	an	L-shaped	structuring	element.	The
Skeleton	M	function	extracts	the	skeleton	with	more
dendrites.	The	Skiz	function	behaves	like	the
Skeleton	M	function	but	it	affects	background
regions,	rather	than	object	regions.

Separate
objects

Breaks	narrow	isthmuses	and	separates	objects	that
touch.

Label
objects

Produces	a	labeled	image	using	grayscale	values
equal	to	the	number	of	objects	in	the	image	plus	the
grayscale	0	used	in	the	background	area.

Distance Assigns	to	each	pixel	a	grayscale	value	equal	to	the



shortest	distance	to	the	border	of	the	object,	which
might	be	to	a	hole	within	the	object.

Danielsson Creates	a	distance	map	similar	to	the	Distance
function.	Danielsson	uses	a	more	accurate	algorithm
than	Distance.

Segment
image

Partitions	an	image	into	segments,	each	centered	on
an	object,	so	that	the	segments	do	not	overlap	and
leave	empty	zones.

Mode	(Skeleton)—Specifies	the	type	of	Skeleton	function	you
want	to	perform.	The	Skeleton	L	function	uses	an	L-shaped
structuring	element.	The	Skeleton	M	function	extracts	the	skeleton
with	more	dendrites.	The	Skiz	function	behaves	like	the	Skeleton	L
function	but	it	affects	background	regions,	rather	than	object
regions.
Structuring	Element

2D	array	used	as	a	binary	mask	to	define	the	neighbors	of	a
pixel.	You	can	modify	the	structuring	element	by	clicking	its
cells.	If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white
(empty),	it	has	a	value	of	0.	If	cell	is	black,	the
corresponding	pixel	is	considered	to	be	a	neighbor	and	its
value	is	used	during	the	morphology	operation.

Size—Size	of	the	structuring	element.	Valid	values	include	3	x	3,	5
x	5,	and	7	x	7.
Iterations—Specifies	the	number	of	3	x	3	erosions	to	apply	to	the
image.
Connectivity	4/8—Specifies	how	the	algorithm	determines	if	an
adjacent	pixel	is	the	same	or	a	different	particle.

Connectivity-8.	All	adjacent	pixels	are	considered	neighbors.
Connectivity-4.	Only	pixels	adjacent	in	the	horizontal	and
vertical	directions	are	considered	neighbors.

Square/Hexagon—Specifies	if	the	pixel	frame	is	treated	as	a
square	or	hexagon	during	the	transformation.

Square	pixel	frame.	Each	pixel	is	surrounded	by	eight
neighbors.	The	vertical	and	horizontal	neighbors	have	a
distance	d	from	the	pixel.	Diagonal	pixels	have	a	slightly



greater	distance	because	they	are	farther	away	from	the
central	pixel.
Hexagon	pixel	frame.	Each	pixel	is	surrounded	by	six
neighbors.	Each	neighbor	is	at	an	equal	distance	from	the
central	pixel.



Remove	Small	Objects
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Remove	small	objects.
3.	 Specify	the	number	of	3	x	3	erosions	that	need	to	be	applied	to

completely	remove	a	small	object	in	Iterations.
4.	 Click	OK	to	remove	small	objects	and	add	this	step	to	the	script.

Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Segment	an	image
Separate	objects



Remove	Large	Objects
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Remove	large	objects.
3.	 Specify	the	number	of	3	x	3	erosions	to	apply	in	Iterations.	The

particles	that	remain	after	the	erosion	operations	are	removed
from	the	image	and	the	rest	of	the	particles	are	restored.

4.	 Click	OK	to	remove	large	objects	and	add	this	step	to	the	script.
Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image
Separate	objects



Remove	Objects	Touching	the	Image	Border
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Remove	border	objects.
3.	 Click	OK	to	remove	all	objects	touching	the	border	of	the	object

and	add	this	step	to	the	script.
Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	small	objects
Segment	an	image
Separate	objects



Fill	Holes
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Fill	holes.
3.	 Click	OK	to	fill	the	holes	and	add	this	step	to	the	script.

Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	gaps	and	holes	(close)	in	binary	images
Fill	gaps	and	holes	(close)	in	grayscale	images
Fill	holes	and	smooth	right	angles
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image
Separate	objects



Compute	the	Convex	Hull	of	Objects
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Convex.
3.	 Click	OK	to	close	objects	and	add	this	step	to	the	script.
Note		This	function	is	computer-intensive	and	can	take	several
seconds.

Tip		Use	this	function	to	close	particles	so	you	can	make
measurements	even	when	the	contour	of	the	object	is	irregular.

Related	Topics
Create	a	distance	map
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image
Separate	objects



Reduce	Objects	to	Skeletons
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Skeleton.
3.	 Select	the	type	of	skeleton	you	want	to	see.

Skeleton	L—Uses	an	L-shaped	structuring	element.
Skeleton	M—Extracts	the	skeleton	with	more	dendrites.
Skiz—Uses	an	L-shaped	structuring	element	that	affects
background	regions,	extracting	the	watershed	line	in	an
image.

4.	 Click	OK	to	add	this	step	to	the	script.
Note			This	function	is	computer-intensive	and	can	take	several
seconds.

Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Label	objects
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image
Separate	objects



Separate	Objects
1.	 Select	Binary»Adv.	Morphology	or	select	Adv.	Morphology	in

the	Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Separate	objects.
3.	 Set	the	Size	of	the	Structuring	Element.
4.	 Click	the	cells	of	the	structuring	element	that	you	want	to	have	a

value	of	0.
5.	 Enter	the	number	of	erosions	that	you	want	the	function	to	apply

to	the	image	in	Iterations.
6.	 Click	OK	to	separate	objects	and	add	this	step	to	the	script.
Notes		

The	structuring	element	is	a	2D	array	used	as	a	binary
mask.	You	can	modify	the	structuring	element	by	clicking	its
cells.	If	a	cell	is	black,	it	has	a	value	of	1.	If	a	cell	is	white
(empty),	it	has	a	value	of	0.
This	function	is	computer-intensive	and	can	take	several
seconds	to	process.

Tip			Experiment	with	different	coefficients	and	the	Kernel	Size	to
get	the	results	you	want.

Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image



Label	Objects
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Label	objects.
3.	 Click	OK	to	add	this	step	to	the	script.
Tip		Labeling	is	especially	useful	when	viewing	images	containing
many	objects	that	are	not	clearly	separated.

Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image
Separate	objects



Create	a	Distance	Map
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Distance	or	Danielsson.
3.	 Click	OK	to	add	this	step	to	the	script.
Note		This	function	assigns,	to	each	pixel,	a	grayscale	value	equal
to	the	shortest	distance	to	the	border	of	the	object.	The	border
might	be	to	a	hole	within	the	object.	Danielsson	uses	a	more
accurate	algorithm	than	Distance.

Related	Topics
Compute	the	convex	hull	of	objects
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Segment	an	image
Separate	objects



Segment	an	Image
1.	 Click	Binary»Adv.	Morphology	or	click	Adv.	Morphology	in	the

Binary	tab	of	the	Processing	Functions	palette.
2.	 Select	Segment	image.
3.	 Click	OK	to	add	this	step	to	the	script.
Notes		

This	function	partitions	an	image	into	segments,	each
centered	on	an	object,	so	that	the	segments	do	not	overlap
and	leave	empty	zones.
This	function	is	computer-intensive	and	can	take	several
seconds.

Related	Topics
Compute	the	convex	hull	of	objects
Create	a	distance	map
Fill	holes
Label	objects
Reduce	objects	to	their	skeletons
Remove	large	objects
Remove	objects	touching	the	border	of	an	image
Remove	small	objects
Separate	objects



Advanced	Morphology	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Particle	Filter
Removes	or	keeps	particles	in	an	image	as	specified	by	the	filter	criteria.
The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Filter	Criteria—List	of	measurements	that	you	use	as	criteria	to
keep	or	remove	particles	from	the	image.
Parameter	Range
Minimum
value

Specifies	the	minimum	value	of	the	parameter	range.

Maximum
value

Specifies	the	maximum	value	of	the	parameter	range.

Exclude
Interval

Specifies	the	range	to	filter.	When	this	option	is
deselected,	the	selected	range	is	[Minimum	value,
Maximum	value].	When	this	option	is	selected,	the
selected	range	is	[–	¥	,	Minimum	value]	[Maximum
value,	+	¥]

Unit Specifies	the	unit	of	the	minimum	and	maximum	value.
The	unit	is	either	pixels	or	real-world	values.

Current	Parameter—The	minimum	value,	maximum	value,	and
mean	value	for	the	selected	filter	criteria,	which	is	calculated	using
all	of	the	particles	in	the	image.
Action
Remove Removes	particles	that	do	not	fit	in	the	range	bounded

by	the	minimal	and	maximal	values	for	the	selected
measurement.

Keep Keeps	particles	that	fit	in	the	range	bounded	by	the
minimal	and	maximal	values	for	the	selected
measurement.

Connectivity	4/8—Defines	which	of	the	surrounding	pixels	for	any
given	pixel	constitute	its	neighborhood.

Connectivity-8.	All	adjacent	pixels	are	considered	neighbors.
Connectivity-4.	Only	pixels	adjacent	in	the	horizontal	and
vertical	directions	are	considered	neighbors.



Filter	Objects	Based	on	Particle	Measurements
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Double-click	each	object	measurement	in	the	Particle	Filter	list

that	you	want	the	particle	filter	to	include	as	criteria.
3.	 Enter	the	parameter	range	for	each	filter	criteria.
4.	 Select	the	action	you	want	to	perform.	Remove	removes	particles

that	do	not	fit	in	the	range	bounded	by	the	minimum	and
maximum	values	for	the	selected	measurement.	Keep	keeps
particles	that	fit	in	the	range	bounded	by	the	minimum	and
maximum	values	for	the	selected	measurement.

5.	 Click	OK	to	filter	the	image	and	add	this	step	to	the	script.
Tip		If	you	want	the	filter	to	be	applied	outside	of	the	specified
parameter	range,	enable	the	Exclude	Interval	control.



Particle	Filter	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Binary	Image	Inversion
Reverses	the	dynamic	of	an	image	containing	two	different	grayscale
populations.	The	following	control	is	available.

Step	Name—Name	to	give	the	step.
Notes		

To	convert	the	binary	image	to	an	image	containing	pixel
values	0	and	255,	use	the	Multiply	function	to	multiply	the
image	by	a	constant	value	of	255	or	use	the	Lookup
Table:Equalize	function	to	increase	the	dynamic	of	a	binary
image.
Increase	the	dynamic	of	the	binary	image	when	you	are
applying	arithmetic	operators	between	the	image	and	other
images	or	constants.



Invert	a	Binary	Image
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Click	OK	to	reverse	the	dynamic	of	an	image	containing	two

different	grayscale	populations.



Binary	Image	Inversion	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Particle	Analysis
Displays	measurement	results	for	selected	particle	measurements
performed	on	the	image.

Step	Name—Name	to	give	the	step.
Number	of	Objects—Displays	the	total	number	of	particles	found
in	the	image.
Connectivity	4/8—Defines	which	of	the	surrounding	pixels	for	any
given	pixel	constitute	its	neighborhood.

Connectivity-8.	All	adjacent	pixels	are	considered	neighbors.
Connectivity-4.	Only	pixels	adjacent	in	the	horizontal	and
vertical	directions	are	considered	neighbors.

Show	Labels—Vision	Assistant	assigns	numeric	labels	to	objects
that	it	analyzes.
Select	Measurements—Displays	a	list	of	object	measurements
that	can	be	calculated	and	displayed.
Results—Displays	the	measurements	for	each	particle	in	the
image.



Perform	a	Particle	Analysis
1.	 Vision	Assistant	calculates	measurements	for	every	particle	in	the

image	and	displays	the	results.
2.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
3.	 Click	OK	to	add	this	step	to	the	script.
Tips		

Vision	Assistant	assigns	numerical	labels	to	all	particles	in
the	particle	analysis.	Select	Show	Labels	to	display	labels.
When	you	click	a	labeled	particle,	Vision	Assistant	highlights
the	particle	and	the	corresponding	results	in	the	table.	You
also	can	click	the	results	to	highlight	the	corresponding
particle	in	the	image.
To	remove	or	add	particle	measurements	displayed	in	the
Results	table,	click	the	Select	Measurements	button	and
click	the	object	measurements	to	select	or	deselect	them.
Vision	Assistant	places	a	check	mark	to	the	left	of	the
measurements	currently	displayed.

To	save	the	data,	click	the	 	Send	Data	to	Excel	button	or
the	 	Save	Results	button.



Particle	Analysis	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Shape	Matching
Finds	objects	in	an	image	that	are	shaped	like	the	object	specified	by	the
template.	Images	must	be	binary,	and	objects	being	searched	must	be
white.	The	following	controls	are	available.



Template	Tab
Step	Name—Name	to	give	the	step.
Create	Template—Learns	the	selected	ROI	and	saves	the	result
as	a	template	shape	file.	Specifies	that	file	as	the	shape	to	search
for.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	template	image	file	and	specify	that	file	as	the	search
template.
Minimum	Score—Specifies	the	minimum	score	an	instance	of	the
template	can	have	to	be	considered	a	valid	match.	This	value	can
range	from	0	to	1000,	where	a	score	of	1000	indicates	a	perfect
match.
Scale	Invariance—Searches	for	any	objects	that	match	the	shape
specified	in	the	template,	regardless	of	size.



Results
Displays	the	following	information	after	searching	the	image	for	the
shape:

Results—Numeric	label	associated	with	each	of	the	matches
found	in	the	image.
Center	X—X-coordinate	of	each	object	that	matches	the	shape
template.
Center	Y—Y-coordinate	of	each	object	that	matches	the	shape
template.
Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.

Related	Topics
Pattern	Matching	(Machine	Vision»Pattern	Matching)
Searching	a	binary	image	for	a	shape
Searching	for	templates	using	pattern	matching
Selecting	a	region	of	interest	(ROI)



Search	a	Binary	Image	for	a	Shape
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Create	a	new	template	or	select	an	existing	template	to	use	for

shape	matching:
Click	Create	Template,	select	an	ROI,	and	click	OK.	Enter
a	File	name	for	the	template	and	click	OK.

or
Click	Load	from	File,	browse	to	the	appropriate	template
file,	and	click	OK.

3.	 Set	Minimum	Score,	which	is	a	threshold	parameter	between	0
and	1000.	Shapes	scoring	above	the	specified	value	are
considered	matching	shapes.

4.	 If	you	want	all	matching	shapes	returned	regardless	of	size,	select
Scale	Invariance.

5.	 Click	OK	to	save	this	step	to	the	script.



Shape	Matching	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Circle	Detection
Finds	the	center	and	radius	of	circular	particles	in	an	image.	The
following	controls	are	available.

Step	Name—Name	to	give	the	step.
Number	of	Circles	Found—Total	number	of	circles	found	in	the
image.
Minimum	Radius—Specifies	the	smallest	radius,	in	pixels,	to
detect.	Circles	with	a	radius	smaller	than	this	value	are	not
returned	in	the	Results	table.
Maximum	Radius—Specifies	the	largest	radius,	in	pixels,	to
detect.	Circles	with	a	radius	larger	than	this	value	are	ignored.



Results
Displays	the	results	for	all	circles	detected	in	the	image.

Center	X—X-coordinate	of	the	center	of	the	circle.
Center	Y—Y-coordinate	of	the	center	of	the	circle.
Radius—Radius	of	the	circle.



Detect	Circles
1.	 Vision	Assistant	finds	the	best	circular	fit	in	each	particle	and

displays	the	results.
2.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
3.	 Set	up	the	Minimum	Radius	and	Maximum	Radius	of	the	circles

to	be	detected.
4.	 Click	OK	to	add	this	step	to	the	script.
Note		This	algorithm	is	dedicated	to	convex	objects,	and	may	find
and	return	multiple	circles	in	a	single	non-convex	object.



Circle	Detection	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Use	Machine	Vision	Functions
This	palette	groups	several	image	functions	that	perform	the	following
common	machine	vision	inspection	tasks:

Detecting	the	presence	or	absence	of	parts	in	an	image.
Measuring	the	dimension	of	parts	to	determine	if	they	meet
specifications.
Locating	objects	in	an	image.



Edge	Detector
Use	this	function	to	find	edges	along	a	line	that	you	draw	with	the	Line
Tool	from	the	toolbar.



Straight	Edge	(Rake)
Use	this	function	to	find	points	within	the	edge	of	an	object	and	fit	a	line
to	those	points	describing	the	edge.



Circular	Edge	(Spoke)
Use	this	function	to	locate	the	intersection	points	between	a	set	of	search
lines	within	a	circular	area	(annulus)	and	find	the	best	fit	circle.



Clamp
Use	this	function	to	find	edges	within	a	rectangular	region	drawn	in	the
image	and	measures	the	distance	between	the	first	and	last	edge.



Pattern	Matching
Use	this	function	to	locate	regions	of	a	grayscale	image	that	match	a
predetermined	template.	Pattern	Matching	can	find	template	matches
regardless	of	poor	lighting,	blur,	noise,	shifting	of	the	template,	and
rotation	of	the	template.



Geometric	Matching
Use	this	function	to	locate	regions	in	a	grayscale	image	that	match	a
predetermined	template.	Geometric	matching	is	designed	to	locate
templates	characterized	by	distinct	geometric	or	shape	information.	The
function	can	find	template	matches	regardless	of	lighting	variation,	blur,
noise,	occlusion,	and	geometric	transformations	such	as	shifting,	rotation,
or	scaling	of	the	template.



Shape	Detection
Use	this	function	to	locate	circles,	ellipses,	rectangles,	or	lines	that	meet
the	specified	geometric	criteria.



Defect	Inspection
Use	this	function	to	compare	areas	of	an	image	to	a	learned	template
and	return	the	differences	found	in	the	image.



Caliper
Use	this	function	to	compute	measurements—such	as	distances,	areas,
and	angles—based	on	results	returned	from	other	machine	vision	and
image	processing	functions.



Edge	Detector
Detects	edges	in	grayscale	images.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Edge	Detector	Tab
The	following	controls	are	available	on	the	Edge	Detector	tab.

Edge	Detector
Simple
Edge	Tool

Finds	step	edges	along	a	selected	path	based	on	a
threshold	of	the	grayscale	values	along	the	path.	The
Simple	Edge	Tool	can	return	the	first,	both	the	first	and
the	last,	or	all	the	edges	found	along	the	path.

Advanced
Edge	Tool

Finds	edges	along	a	path	defined	in	the	image.	A
kernel	operator	is	applied	to	the	search	region	to
detect	edges	in	the	image.

Look	For
First	Edge Finds	and	labels	only	the	first	edge	along	the	line

selected	with	the	ROI	tool.
First	&
Last	Edge

Finds	and	labels	only	the	first	and	last	edge	along	the
line	selected	with	the	ROI	tool.

All	Edges Finds	and	labels	all	edges	along	the	line	selected	with
the	ROI	tool.

Best	Edge Finds	the	strongest	edge	in	the	search	region.

Advanced	Edge	Tool	Controls
The	following	controls	are	available	when	the	Edge	Detector	control	is	set
to	Advanced	Edge	Tool.

Edge	Polarity
All	Edges Searches	for	all	edges.
Rising	Edges Searches	for	rising	edges.
Falling	Edges Searches	for	falling	edges.
Interpolation	Type
Zero
Order

Rounds	to	the	nearest	integral	edge	location.

Bilinear Uses	bilinear	interpolation	to	compute	the	edge	location.
Bilinear
Fixed

Uses	the	fixed-point	computation	of	bilinear	interpolation
to	determine	the	edge	location.



Kernel	Size—Specifies	the	size	of	the	edge	detection	kernel.
Width—Specifies	the	number	of	pixels	averaged	perpendicular	to
the	search	direction	to	compute	the	edge	profile	strength	at	each
point	along	the	search	ROI.
Min	Edge	Strength—Specifies	the	minimum	edge	strength
required	for	a	detected	edge.
Edge	Strength	Profile—Plots	the	variations	of	intensity	along	the
selected	ROI.
Edges	Found—Number	of	edges	found	along	the	selected	ROI
according	to	the	parameters	you	set.

Simple	Edge	Tool	Controls
The	following	controls	are	available	when	the	Edge	Detector	control	is	set
to	Simple	Edge	Tool.

Level	Type
Absolute
Value

Specifies	the	threshold	level	in	pixel	values.

Relative
Value

Specifies	the	threshold	level	as	a	percentage	of	the
intensity	range	found	along	the	ROI	path.

Threshold	Level—Specifies	the	intensity	level,	expressed	either	in
pixel	values	or	as	a	percentage,	that	you	expect	to	constitute	an
edge	in	the	image.	For	example,	when	you	set	Absolute	Value	to
128,	an	edge	occurs	when	there	is	a	transition	from	below	128	to
above	128.
Line	Profile—Plots	the	variations	of	intensity	along	the	selected
ROI.
Edges	Found—Number	of	edges	found	along	the	selected	ROI
according	to	the	parameters	you	set.



Detect	Edges	in	Grayscale	Images
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Edge	Detector	Tab
You	can	find	edges	in	grayscale	images	using	the	Simple	Edge	Tool	or
the	Advanced	Edge	Tool.



Edge	Detector	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Straight	Edge	(Rake)
Finds	points	along	the	edge	of	an	object	and	finds	a	line	describing	the
edge.
Locates	the	intersection	points	between	a	set	of	search	lines	within	a
rectangular	search	area	and	the	edge	of	an	object.	Edges	are	determined
based	on	their	contrast	and	slope.	The	function	returns	the	line	that	best
fits	the	edges	found.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Auto	Setup—When	enabled,	the	step	automatically	locates	the
strongest	edge	in	the	region	of	interest	(ROI)	and	returns	the
parameters	it	used	to	find	the	edge.

Note		Vision	Assistant	uses	the	Auto	Setup	parameters	to
compute	the	optimal	parameters	the	first	time	you	configure
the	step.	After	the	optimal	parameters	are	computed,	they
are	saved	in	the	script,	and	the	Auto	Setup	parameters	are
disabled.	Edits	to	the	step	will	edit	the	optimal	parameters.

Search	Lines
Direction—Direction	in	which	you	want	the	search	lines	to
look	for	a	straight	edge	within	the	ROI.
Gap—Number	of	pixels	between	search	lines	in	the	ROI.
Edge	Strength—Minimum	difference	in	the	intensity	values
between	the	edge	and	its	surroundings.
Smoothing—Number	of	pixels	averaged	to	find	the	contrast
at	either	side	of	the	edge.
Steepness—Maximum	distance	in	which	the	edge	strength
must	occur.	Steepness	characterizes	the	slope	of	the	edge.
Use	a	higher	Steepness	value	to	detect	edges	in	images
whose	pixel	intensities	gradually	transition	from	the
background	to	the	edge.

Edge	Strength	Profile—Edge	strength	along	the	search	line
located	in	the	middle	of	the	ROI.



Results	Tab
Displays	the	results	for	edges	detected	in	the	image.

Current	Angle—Angle	from	the	horizontal	axis	to	the	located
edge.
Current	Deviation—Maximum	distance	found	between	the	points
of	the	edge	and	the	fitted	line.
Current	Short	Distance—Indicates	the	shorter	of	the	following
distances:

The	distance	between	the	start	point	of	the	first	search	line
and	the	intersection	of	the	fitted	line	and	the	first	search	line.
The	distance	between	the	start	point	of	the	last	search	line
and	the	intersection	of	the	fitted	line	and	the	last	search	line.

Current	Long	Distance—Indicates	the	longer	of	the	following
distances:

The	distance	between	the	start	point	of	the	first	search	line
and	the	intersection	of	the	fitted	line	and	the	first	search	line.
The	distance	between	the	start	point	of	the	last	search	line
and	the	intersection	of	the	fitted	line	and	the	last	search	line.

Displays	the	results	of	the	edge	detection.
Related	Topics
Detecting	circular	edges	in	grayscale	images
Detecting	straight	edges	in	grayscale	images
Edge	Detector	(Machine	Vision»Edge	Detector)
Circular	Edge	(Spoke)	(Machine	Vision»Circular	Edge	(Spoke))
Finding	edges	in	grayscale	images



Detect	Straight	Edges	in	Grayscale	Images
Note		The	Straight	Edge	(Rake)	function	works	only	with	8-bit
images.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Settings	Tab
1.	 Select	the	appropriate	ROI	tool.
2.	 Draw	a	region	of	interest	that	includes	the	straight	edge	you	want

to	find.
When	you	specify	a	region	of	interest,	the	step	automatically	tries
to	locate	a	straight	edge	in	the	region.	If	the	automatically	located
edge	corresponds	to	the	edge	you	expected	to	find,	click	OK	to
close	the	Parameter	window	and	add	the	step	to	the	script.
Otherwise,	go	to	the	next	step.

3.	 Disable	Auto	Setup	and	manually	adjust	the	edge	location
parameters.

a.	 Select	the	direction	properties	of	the	search	lines.	Select	a
search	line	orientation	that	is	perpendicular	to	the	edge.
Also,	select	the	search	direction	along	the	line	that	has	the
least	number	of	obstacles	between	the	edge	of	the	region
and	the	object	edge	you	want	to	find.

b.	 If	the	Edge	Strength	Profile	contains	a	strong	peak	that
corresponds	to	the	edge	you	want	to	find,	adjust	the	yellow
edge	strength	line	so	that	it	lies	slightly	below	the	top	of	the
edge	peak	but	above	all	of	the	other	peaks.
If	the	Edge	Strength	Profile	does	not	contain	a	strong	edge
peak,	adjust	the	Smoothing	and	Steepness	controls	until
a	peak	appears.
If	the	step	still	cannot	find	the	edge	or	the	location	of	the
detected	edge	is	inaccurate,	adjust	the	Gap	between	the
search	lines	until	you	achieve	the	expected	result.

Tip		You	can	modify	and	move	the	ROI	using	context	sensitivity.
Click	the	ROI	and	move	the	contours	as	necessary.	You	also	can
select	the	complete	ROI	by	clicking	the	middle	of	the	ROI	and
dragging	it.



Straight	Edge	(Rake)	FAQs
What	settings	does	Auto	Setup	use?
Auto	Setup	tries	to	determine	the	best	straight	edge	in	the	region	of
interest	by	searching	for	edges	in	all	directions.	The	values	for	Gap,
Edge	Strength,	Smoothing,	and	Steepness	are	estimated	to	find	the
best	edge	from	each	search	direction.	The	quality	of	the	edge	is	based
on	the	average	deviation	of	the	edge	points	from	the	fitted	edge.	The
parameters	that	locate	the	edge	with	the	smallest	deviation	are	returned
as	the	Auto	Setup	results.	The	parameter	values	estimated	by	Auto
Setup	appear	in	the	dimmed	setting	controls.



Adv.	Straight	Edge
Locates	a	straight	edge	in	a	region	of	interest.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Edge	Detector	Settings	Tab
The	following	controls	are	available	on	the	Edge	Detector	Settings	tab.

Suggest	Values—When	enabled,	the	step	suggests	appropriate
values	for	the	Edge	Detector	controls.
Detection	Method—Specifies	the	method	to	use	to	find	the
straight	edge.	The	following	options	are	available:

First	Edge	Rake—Fits	a	straight	edge	on	the	first	point
detected	using	a	Rake.
Best	Edge	Rake—Fits	a	straight	edge	on	the	best	points
detected	using	a	Rake.
Best	Hough	Edge	Rake—Fits	the	strongest	straight	edge
using	all	points	detected	using	a	Rake.
First	Edge	Projection—Uses	the	location	of	the	first
projected	edge	as	the	straight	edge.
Best	Edge	Projection—	Finds	the	strongest	projected	edge
location	to	determine	the	straight	edge.

Search	Direction—Direction	in	which	you	want	the	search	lines	to
look	for	a	straight	edge	within	the	region	of	interest.	The	following
options	are	available:

Left	to	Right—Searches	for	edges	within	the	region	of
interest	from	left	to	right.
Right	to	Left—Searches	for	edges	within	the	region	of
interest	from	right	to	left.
Top	to	Bottom—Searches	for	edges	within	the	region	of
interest	from	top	to	bottom.
Bottom	to	Top—Searches	for	edges	within	the	region	of
interest	from	bottom	to	top.

Edge	Polarity—Specifies	the	pixel	intensity	transitions	to	use	to
determine	edges.	The	following	options	are	available:

Any	Edge—Finds	edges	characterized	by	dark-to-bright	and
bright-to-dark	pixel	intensity	transitions.
Dark	to	Bright—Finds	only	those	edges	characterized	by
dark-to-bright	pixel	intensity	transitions	along	the	direction	of
the	search	line.
Bright	to	Dark—Finds	only	those	edges	characterized	by



bright-to-dark	pixel	intensity	transitions	along	the	direction	of
the	search	line.

Minimum	Edge	Strength—Minimum	difference	in	the	intensity
values	between	the	edge	and	its	surroundings.
Minimum	Edge	SNR—Specifies	the	minimum	signal	to	noise
ration	(SNR)	of	the	edge	points	used	to	fit	the	straight	line.
Kernel	Size—Specifies	the	size	of	the	edge	detection	kernel.
Gap—Specifies	the	size,	in	pixels,	of	the	space	between	the
search	lines.	This	control	is	only	used	with	a	Rake-based
Detection	Method.
Projection	Width—Specifies	the	number	of	pixels	averaged
perpendicular	to	the	Search	Direction	to	compute	the	edge	profile
strength	at	each	point	along	the	region	of	interest.
Interpolation—Specifies	the	interpolation	method	used	to	locate
the	edge	position.	The	following	options	are	available:

Zero	Order—Rounds	to	the	nearest	integral	edge	location.
Bilinear—Uses	bilinear	interpolation	to	compute	the	edge
location.
Bilinear	Fixed—Uses	bilinear	fixed	interpolation	to	compute
the	edge	location.

Projection	Method—Specifies	the	method	used	to	process	the
data	extracted	by	the	edge	detector.	The	following	options	are
available:

Average—Averaged	the	data	extracted	for	edge	detection.
Median—Computes	the	median	of	the	data	extracted	for
edge	detection.

Straight	Edges	Found—Displays	the	number	of	straight	edges
found	by	the	step.
Search	Line	Index—For	a	Rake-based	Detection	Method,
specifies	the	search	line	used	by	the	Edge	Strength	Profile	and
Edge	Points	Found	on	Search	Line	controls.
Edge	Index—For	an	Edge	Projection	Detection	Method,	specifies
the	index	of	the	edge	for	which	the	Edge	Strength	Profile	is
shown.
Edge	Strength	Profile—Displays	a	strength	profile	of	the	edges
found	along	the	specified	Search	Line	Index	based	on	the	current



control	settings.
Edge	Points	Found	on	Search	Line—Displays	information	about
the	edge	points	found	on	the	specified	Search	Line	Index.	The
following	information	is	displayed	for	each	edge:

X—X-coordinate	of	the	edge.
Y—Y-coordinate	of	the	edge.
Strength—Strength	of	the	edge.	Higher	values	indicate	a
stronger	edge.
STR—Signal	to	threshold	ratio	for	the	edge.
TNR—Threshold	to	noise	ratio	for	the	edge.
SNR—Signal	to	noise	ratio	for	the	edge.



Straight	Edge	Settings	Tab
The	following	controls	are	available	on	the	Straight	Edge	Settings	tab.

Suggest	Values—When	enabled,	the	step	suggests	appropriate
values	for	the	Straight	Edge	Settings	controls.
Minimum	Score—Specifies	the	minimum	score	of	a	detected
straight	edge.
Maximum	Score—Specifies	the	maximum	score	of	a	detected
straight	edge.
Angle	Range—Specifies	the	positive	and	negative	range	within
which	the	straight	edge	is	expected	to	be	found.
Angle	Tolerance—Specifies	the	expected	angular	accuracy	of	the
straight	edge.
Minimum	Coverage—Specifies	the	number	of	points,	as	a
percentage	of	the	number	of	search	lines,	that	need	to	be	included
in	the	detected	straight	edge.
Maximum	Iterations—Specifies	the	number	of	iterations	used	for
a	Hough	Detection	Method.
Straight	Edges	Requested—Specifies	the	number	of	straight
edges	to	find	in	the	image.
Straight	Edges	Found—Displays	the	number	of	straight	edges
found	by	the	step.
Search	Line	Index—For	a	Rake-based	Detection	Method,
specifies	the	search	line	used	by	the	Edge	Strength	Profile	and
Edge	Points	Found	on	Search	Line	controls.
Edge	Strength	Profile—Displays	a	strength	profile	of	the	edges
found	along	the	specified	Search	Line	Index	based	on	the	current
control	settings.
Edge	Points	Found	on	Search	Line—Displays	information	about
the	edge	points	found	on	the	specified	Search	Line	Index.	The
following	information	is	displayed	for	each	edge:

X—X-coordinate	of	the	edge.
Y—Y-coordinate	of	the	edge.
Strength—Strength	of	the	edge.	Higher	values	indicate	a
stronger	edge.
STR—Signal	to	threshold	ratio	for	the	edge.



TNR—Threshold	to	noise	ratio	for	the	edge.
SNR—Signal	to	noise	ratio	for	the	edge.



Results	Tab
Displays	the	results	for	edges	detected	in	the	image.

Straight	Edge	Results—Displays	information	about	the	straight
edges	found	in	the	image.
Straight	Edges	Found—Displays	the	number	of	straight	edges
found	by	the	step.



Detect	a	Straight	Edge
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Edge	Detector	Settings	Tab
1.	 Select	the	detection	method	and	direction	properties	of	the	search

lines.	Select	a	search	line	orientation	that	is	perpendicular	to	the
edge.	For	example,	the	orientation	of	the	edge	in	the	following
figure	is	vertical.	Therefore,	the	search	lines	are	horizontal.
Also,	select	the	search	direction	along	the	lines	that	has	the	least
number	of	obstacles	between	the	edge	of	the	region	and	the
object	edge	you	want	to	find.	In	the	following	figure,	the	search
direction	is	right	to	left	so	that	the	step	avoids	detecting	the	edges
of	miscellaneous	objects.

1		Edge	to	Locate		 3		Search	Lines		
2		Search	Region		 4		Miscellaneous	Objects	in	the	Image		

2.	 If	the	step	does	not	locate	the	correct	edge,	disable	the	Suggest
Values	control,	and	adjust	the	blue	edge	strength	line	so	that	it
lies	slightly	below	the	top	of	the	edge	peak	but	above	all	of	the
other	peaks.
If	the	Edge	Strength	Profile	does	not	contain	a	strong	edge	peak,
adjust	the	edge	detection	controls	until	a	peak	appears.
If	the	step	still	cannot	find	the	edge	or	the	location	of	the	detected
edge	is	inaccurate,	adjust	the	gap	between	the	search	lines	until
you	achieve	the	expected	result.



Straight	Edge	Settings	Tab
4.	 In	the	Straight	Edges	Requested	control,	set	the	number	of

edges	you	want	to	find	in	the	image.
5.	 If	necessary,	disable	the	Suggest	Values	control	and	use	the

other	controls	on	the	Edge	Settings	tab	to	specify	additional
criteria	for	determining	edges.



Results	Tab
6.	 Set	the	limits	that	correspond	to	the	specifications	of	the	edges

you	want	to	find	in	the	image.
7.	 Click	OK	to	add	the	step	to	the	inspection.



Adv.	Straight	Edge	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Circular	Edge	(Spoke)
Locates	the	intersection	points	between	a	set	of	search	lines	within	a
circular	area,	such	as	an	annulus	and	the	edge	of	a	circular	object.
Edges	are	determined	based	on	their	contrast	and	slope.	The	function
returns	the	circle	that	best	fits	the	edges	found.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Auto	Setup—When	enabled,	the	software	locates	the	strongest
edge	in	the	region	of	interest	(ROI)	and	returns	the	parameters	it
used	to	find	the	edge.

Note		Vision	Assistant	uses	the	parameters	returned	by	the
Auto	Setup	function	to	compute	the	optimal	parameters	the
first	time	you	configure	the	step.	After	the	optimal
parameters	are	computed,	they	are	saved	in	the	script,	and
the	Auto	Setup	parameters	are	disabled.	Edits	to	the	step
will	edit	the	optimal	parameters.

Search	Lines
Direction—Direction	in	which	you	want	the	search	lines	to
look	for	a	circular	edge	within	the	ROI.
Gap—Number	of	pixels	between	search	lines	in	the	ROI.
Edge	Strength—Minimum	difference	in	the	intensity	values
between	the	edge	and	its	surroundings.
Smoothing—Number	of	pixels	averaged	to	find	the	contrast
at	either	side	of	the	edge.
Steepness—Maximum	distance	in	which	the	edge	strength
must	occur.	Steepness	characterizes	the	slope	of	the	edge.
Use	a	higher	Steepness	value	to	detect	edges	in	images
whose	pixel	intensities	gradually	transition	from	the
background	to	the	edge.

Edge	Strength	Profile—Edge	strength	along	the	search	line
located	in	the	middle	of	the	ROI.



Results	Tab
Displays	the	results	of	the	edge	detection.

Center	X—X-coordinate	of	the	center	of	the	circle.
Center	Y—Y-coordinate	of	the	center	of	the	circle.
Current	Radius—Radius	of	the	circular	edge	found.
Current	Deviation—Maximum	distance	found	between	the	points
of	the	edge	and	the	fitted	circle.



Detect	Circular	Edges	in	Grayscale	Images
Note		The	Circular	Edge	(Spoke)	function	works	only	with	8-bit
images.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Settings	Tab
1.	 Draw	and	adjust	a	region	of	interest	using	the	annulus	tool	that

includes	the	circular	edge	you	want	to	find.
When	you	specify	a	region	of	interest,	the	step	automatically	tries
to	locate	a	circular	edge	in	the	region.	If	the	automatically-located
edge	corresponds	to	the	edge	you	expected	to	find,	skip	the	next
step.	Otherwise,	go	to	the	next	step.

2.	 Disable	the	Auto	Setup	control	and	manually	adjust	the	edge
location	parameters.

a.	 Select	the	direction	properties	of	the	search	lines.	Select
the	search	direction	along	the	lines	that	has	the	least
number	of	obstacles	between	the	edge	of	the	region	and
the	object	edge	you	want	to	find.

b.	 If	the	Edge	Strength	Profile	contains	a	strong	peak	that
corresponds	to	the	edge	you	want	to	find,	adjust	the	yellow
edge	strength	line	so	that	it	lies	slightly	below	the	top	of	the
edge	peak	but	above	all	of	the	other	peaks.
If	the	Edge	Strength	Profile	does	not	contain	a	strong	edge
peak,	adjust	the	Smoothing	and	Steepness	controls	until
a	peak	appears.
If	the	step	still	cannot	find	the	edge	or	the	location	of	the
detected	edge	is	inaccurate,	adjust	the	gap	between	the
search	lines	until	you	achieve	the	expected	result.



Results	Tab
1.	 Click	the	Results	tab	to	view	information	about	the	center	and

radius	of	the	circular	edge	the	step	found	on	the	image.
2.	 Click	OK	to	add	this	step	to	the	script	and	close	the	parameter

window.
Tip		You	can	modify	and	move	the	ROI	using	context	sensitivity.
Move	the	mouse	close	to	the	control	points	of	the	ROI	to	adjust
their	positions.	You	also	can	select	the	entire	ROI	by	clicking	the
middle	of	the	ROI	and	dragging	it.



Circular	Edge	(Spoke)	FAQs
What	settings	does	Auto	Setup	use?
Auto	Setup	tries	to	determine	the	best	circular	edge	in	the	region	of
interest	by	searching	for	edges	in	all	directions.	The	values	for	Gap,
Edge	Strength,	Smoothing,	and	Steepness	are	estimated	to	find	the
best	edge	from	each	search	direction.	The	quality	of	the	edge	is	based
on	the	average	deviation	of	the	edge	points	from	the	fitted	edge.	The
edge	with	the	smallest	deviation	is	returned	as	the	Auto	Setup	result.
The	parameter	values	estimated	by	Auto	Setup	appear	in	the	dimmed
setting	controls.



Clamp
Finds	edges	along	a	rectangular	region	of	interest	(ROI)	that	you	draw	in
the	image	and	measures	the	distance	between	the	first	and	last	edges
found.	The	edges	are	located	along	multiple	parallel	search	lines	drawn
within	a	rectangular	ROI.	Edges	are	determined	based	on	their	contrast
and	slope.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Clamp	Tab
Process—Type	of	caliper	you	want	to	use.

		Horizontal	Max	Caliper—Measures	a	distance	in	the
horizontal	direction	from	the	vertical	sides	of	the	ROI	toward
the	center	of	the	ROI.

		Horizontal	Min	Caliper—Measures	a	distance	in	the
horizontal	direction	from	the	center	of	the	ROI	toward	the
vertical	sides	of	the	ROI.

		Vertical	Max	Caliper—Measures	a	distance	in	the
vertical	direction	from	the	horizontal	sides	of	the	ROI	toward
the	center	of	the	ROI.

		Vertical	Min	Caliper—Measures	a	distance	in	the
vertical	direction	from	the	center	of	the	ROI	toward	the
horizontal	sides	of	the	ROI.

Gap—Number	of	pixels	between	search	lines	in	the	ROI.
Edge	Strength—Minimum	difference	in	the	intensity	values
between	the	edge	and	its	surroundings.	Only	those	edges	whose
strength	is	greater	than	this	value	are	used	in	the	detection
process.
Smoothing—Number	of	pixels	averaged	to	find	the	contrast	at
either	side	of	the	edge.
Steepness—Maximum	distance	in	which	the	edge	strength	must
occur.	Steepness	characterizes	the	slope	of	the	edge.	Use	a
longer	Steepness	to	detect	edges	in	images	whose	pixel	intensities
gradually	transition	from	the	background	to	the	edge.
Edge	Strength	Profile—Edge	strength	along	the	search	line
located	in	the	middle	of	the	ROI.
Current	Distance—Distance	measured	between	the	clamp	arms.



Measure	Distances	Between	Edges	Using	the
Clamp	Tool

Note		The	Clamp	function	works	only	with	8-bit	images.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Clamp	Tab
1.	 Select	one	of	the	ROI	tools.	Click	and	drag	to	select	a	path	along

which	to	search	for	edges	and	find	the	distance.
2.	 Select	the	appropriate	Process.	In	the	Edge	Strength	Profile,

Vision	Assistant	displays	the	average	of	the	line	profiles	of	all	the
lines	used	for	edge	detection.

3.	 Adjust	the	Gap,	Edge	Strength,	Smoothing,	and	Steepness
parameters	until	the	Process	window	indicates	that	the	step	has
correctly	detected	the	edges	of	the	object	you	want	to	measure.

4.	 Click	OK	to	add	this	step	to	the	script	and	close	the	Parameter
window.
Tip		You	can	modify	and	move	the	ROI	using	context	sensitivity.
Move	the	mouse	close	to	the	control	points	of	the	ROI	to	adjust
their	positions.	You	also	can	select	the	entire	ROI	by	clicking	the
middle	of	the	ROI	and	dragging	it.



Clamp	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Pattern	Matching
Performs	template	matching	on	grayscale	images	using	Pattern
Matching.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Template	Tab
The	following	controls	are	available	on	the	Template	tab.

Template	Image—Image	you	want	to	search	for	in	an	inspection
image.
Template	Size—The	width	and	height,	in	pixels,	of	the	selected
template	image.
Match	Offset—Specifies	the	number	of	pixels	you	want	to	shift	the
focal	point	of	the	template	from	the	center	of	the	template.	The
focal	point	of	the	template	is	the	coordinate	location	of	the	template
match	within	an	inspection	image.
New	Template—Launches	the	NI	Vision	Template	Editor	wizard,	in
which	you	can	learn	a	template	and	save	the	result	as	a	template
image	file.
Edit	Template—Launches	the	NI	Vision	Template	Editor	wizard,	in
which	you	can	modify	a	template	and	save	the	result	as	a	template
image	file.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	template	image	file	and	specify	that	file	as	the	search
template.

Note		When	you	load	a	template	from	file,	the	template	can
be	any	valid	NI	Vision	template	file,	such	as	a	golden
template.	The	Pattern	Matching	step	prompts	you	to	add
pattern	matching	information	to	the	file.

Template	Path—Displays	the	location	of	the	template	image	file.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Number	of	Matches	to	Find—Specifies	the	number	of	valid
matches	you	expect	the	pattern	matching	function	to	return.
Minimum	Score—Specifies	the	minimum	score	an	instance	of	the
template	can	have	to	be	considered	a	valid	match.	This	value	can
range	from	0	to	1000,	where	a	score	of	1000	indicates	a	perfect
match.
Subpixel	Accuracy—When	enabled,	returns	the	match	with
subpixel	accuracy.
Search	for	Rotated	Patterns—When	selected,	searches	for	the
template	in	an	image	regardless	of	rotation	and	shift	of	the
template.	When	unselected,	this	option	searches	for	the	image
regardless	of	shifting	along	the	x-axis	and	y-axis.
Angle	Range—Angles	at	which	you	want	to	search	for	the
template	image.	The	function	searches	for	the	template	image	at
angles	ranging	from	the	positive	angle	to	the	negative	angle.
Mirror	Angle—When	enabled,	the	function	searches	for	the
template	image	in	the	angle	range,	which	you	specified	in	Angle
Range,	and	in	the	mirror	of	that	angle	range.



Results
Displays	the	following	information	after	searching	the	image	for	the
template:

Center	X—X-coordinate	of	each	object	that	matches	the	template.
Center	Y—Y-coordinate	of	each	object	that	matches	the	template.
Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.
Angle—Rotation	angle	of	each	object	that	matches	the	template	at
the	current	match	location.	Angles	are	expressed	in	degrees.	This
output	is	valid	only	when	you	select	rotation-invariant	matching.



Search	for	Templates	Using	Pattern	Matching
Note		The	Pattern	Matching	function	works	only	with	8-bit	images.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Template	Tab
Choose	one	of	the	following	methods	to	specify	the	template	for	the	step:

1.	 Click	Create	Template,	select	an	ROI,	and	click	OK.	Enter	a	File
name	for	the	template	and	click	OK.
or

2.	 Click	Load	from	File,	browse	to	the	appropriate	template	file,	and
click	OK.
By	default,	the	center	of	the	template	is	used	as	the	focal	point	of
the	template.	You	can	change	the	location	of	the	focal	point	to	any
position	in	the	template.	Change	the	focal	point	of	the	template	by
dragging	the	red	pointer	in	the	template	image	or	adjusting	the
Match	Offset	values.



Settings	Tab
1.	 Modify	Number	of	Matches	to	Find,	Minimum	Score,	and

Subpixel	Accuracy	as	necessary.
2.	 Select	Search	for	Rotated	Patterns	to	indicate	that	the	match

can	be	a	rotated	version	of	the	template.	You	can	restrict	the
amount	of	rotation	you	want	to	allow	by	specifying	an	acceptable
angle	range.	You	also	can	include	the	mirrored	angle	range	by
enabling	Mirror	Angle.

3.	 Click	OK	to	save	this	step	to	the	script.



Pattern	Matching	FAQs
What	does	the	red	pointer	in	the	template	image	indicate?
The	red	pointer	indicates	the	point	on	the	template	whose	coordinate
location	you	want	returned	when	the	step	finds	matches	of	the	template
in	the	inspection	image.
When	should	I	mirror	the	search	angle?
Mirror	the	search	angle	when	the	fixture	of	the	part	under	inspection
constrains	the	location	of	the	part	along	a	specified	axis.	Another	typical
use	for	this	parameter	is	to	find	templates	that	are	symmetric	along	one
axis.
What	is	the	difference	between	the	green	and	red	regions?
The	green	region	indicates	the	region	of	the	image	in	which	you	want	to
search	for	matches	to	the	template.	The	red	region	indicates	an	area	that
matches	the	template.



Geometric	Matching
Performs	template	matching	on	grayscale	images	using	Geometric
Matching.	Refer	to	the	NI	Vision	Template	Editor	Help	for	information
about	the	NI	Vision	Template	Editor	controls.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Template	Tab
The	following	controls	are	available	on	the	Template	tab.

Template	Image—The	image	to	use	as	the	template.
Template	Size

Width—Width	of	the	template	in	pixels.
Height—Height	of	the	template	in	pixels.

New	Template—Launches	the	NI	Vision	Template	Editor	wizard,	in
which	you	can	learn	a	template	and	save	the	result	as	a	template
image	file.
Edit	Template—Launches	the	NI	Vision	Template	Editor	wizard,	in
which	you	can	modify	a	template	and	save	the	result	as	a	template
image	file.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	template	image	file	and	specify	that	file	as	the	search
template.

Note		When	you	load	a	template	from	file,	the	template	can
be	any	valid	NI	Vision	template	image	file,	such	as	a	golden
template.	The	Geometric	Matching	step	prompts	you	to	add
geometric	matching	information	to	the	file.

Template	Path—Displays	the	location	of	the	template	image	file.



Curve	Settings	Tab
The	following	controls	are	available	on	the	Curve	Settings	tab.

Extraction	Mode—Specifies	how	the	algorithm	identifies	curves	in
the	image.

Normal—Makes	no	assumptions	about	the	uniformity	of
objects	in	the	image	or	the	image	background.
Uniform	Regions—Assumes	that	either	the	objects	in	the
image	or	the	image	background	consist	of	uniform	pixel
values.	Use	this	mode	to	calculate	the	external	curves	of	the
objects	with	greater	accuracy.

Edge	Threshold—Specifies	the	minimum	contrast	an	edge	pixel
must	have	to	be	considered	part	of	a	curve.	This	value	can	range
from	0	to	255.	The	default	value	is	75.
Edge	Filter	Size—Specifies	the	kernel	size	to	use	for	computing
the	edges	in	the	image.	The	options	are	Normal	and	Fine.	The
default	value	is	Normal.
Minimum	Length—Specifies	the	length,	in	pixels,	of	the	smallest
curve	you	want	to	extract.	The	default	value	is	25.
Row	Search	Step	Size—Specifies	the	distance,	in	the	y	direction,
between	the	image	rows	that	the	algorithm	inspects	for
curve	seed	points.	Valid	values	range	from	1	to	255.	The	default
value	is	15.
Column	Search	Step	Size—Specifies	the	distance,	in	the	x
direction,	between	the	image	columns	that	the	algorithm	inspects
for	curve	seed	points.	Valid	values	range	from	1	to	255.	The	default
value	is	15.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Number	of	Matches	to	Find—Specifies	the	number	of	valid
matches	you	expect	the	geometric	matching	function	to	return.
Minimum	Score—Specifies	the	minimum	score	an	instance	of	the
template	can	have	to	be	considered	a	valid	match.	This	value	can
range	from	0	to	1000,	where	a	score	of	1000	indicates	a	perfect
match.
Subpixel	Accuracy—When	enabled,	returns	the	match	with
subpixel	accuracy.
Search	for	matches	that	are—Defines	the	match	modes	and
ranges	used	to	match	the	template.

Rotated—When	enabled,	this	function	searches	for	the
template	image	in	the	angle	range	you	specify	with	the
Range	control.	When	disabled,	this	function	searches	for	the
image	regardless	of	shifting	along	the	x-axis	and	y-axis.	You
may	specify	a	second	angle	range	if	needed.
Scaled—When	enabled,	this	function	searches	for	a
template	image	that	may	be	scaled	in	the	inspection	image.
Specify	the	percentage	of	scale	to	search	for	with	the	Range
control.
Occluded—When	enabled,	this	function	searches	for	a
template	image	that	may	be	occluded	in	the	inspection
image.	Specify	the	amount	of	occlusion	to	search	for	with
the	Range	control.	The	units	for	the	Range	control	are	the
percentage	of	the	template	image	that	is	occluded.



Results
Displays	the	following	information	after	searching	the	image	for	the
template:

X	Position—X-coordinate	of	each	object	that	matches	the
template.
Y	Position—Y-coordinates	of	each	object	that	matches	the
template.
Angle—Rotation	angle	of	each	object	that	matches	the	template	at
the	current	match	location.	Angles	are	expressed	in	degrees.
Scale—The	change	in	scale,	expressed	as	a	percentage,	of	the
object	found	in	the	image	relative	to	the	template.
Occlusion	%—The	amount	of	occlusion,	expressed	as	a
percentage	of	the	template	curves,	for	each	object	that	matches
the	template.
Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.
Template	Target	Curve	Score—Specifies	how	closely	the	curves
in	the	template	match	the	curves	in	the	match	region	of	the
inspection	image.	Score	values	can	range	from	0	to	1000,	where	a
score	of	1000	indicates	that	all	template	curves	have	a
corresponding	curve	in	the	match	region	of	the	inspection	image.
Correlation	Score—Specifies	how	closely	a	match	matches	the
template	using	a	correlation	metric	that	compares	the	two	regions
as	a	function	of	their	pixel	values.



Search	for	Templates	Using	Geometric	Matching
Note		The	geometric	matching	function	works	only	with	8-bit
images.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Template	Tab
Choose	one	of	the	following	methods	to	specify	the	template	for	the	step:

Click	New	Template	to	launch	the	NI	Vision	Template	Editor.	Refer
to	the	NI	Vision	Template	Editor	Help	for	instructions	on	how	to
create	a	geometric	template.	After	creating	a	template,	click	Finish
in	the	training	interface	to	validate	the	template.	Enter	a	File	name,
and	click	OK.
or

Click	Load	from	File,	browse	to	the	appropriate	template	file,	and
click	OK.



Curve	Settings	Tab
By	default,	the	values	of	the	parameters	in	this	tab	are	initialized	to	the
values	you	selected	in	the	training	interface.	You	can	adjust	these	values
to	improve	edge	detection	in	the	inspection	image.
Modify	the	Extraction	Mode,	Edge	Threshold,	Edge	Filter	Size,
Minimum	Length,	Row	Search	Step	Size,	and	Column	Search	Step
Size	to	improve	edge	detection,	if	necessary.



Settings	Tab
1.	 Set	the	Number	of	Matches	to	Find,	Minimum	Score,	and

Subpixel	Accuracy.
2.	 Enable	Search	for	matches	that	are:	Rotated,	Scaled,	or

Occluded	to	indicate	that	a	match	may	be	a	rotated,	scaled,	or
occluded	version	of	the	template.	Specify	an	acceptable	range	for
each	parameter	to	restrict	the	amount	of	rotation,	scale,	or
occlusion	allowed	in	a	valid	match.

3.	 Click	OK	to	save	this	step	to	the	script.



Geometric	Matching	FAQs
What	does	the	red	pointer	in	the	template	image	indicate?
The	red	pointer	indicates	the	pixel	of	the	template	whose	coordinate
location	you	want	returned	when	the	step	finds	matches	of	the	template
in	the	inspection	image.
What	is	the	difference	between	the	green	and	red	regions?
The	green	region	indicates	the	area	of	the	image	in	which	you	want	to
search	for	matches	to	the	template.	The	red	region	indicates	an	area	that
matches	the	template.
Additional	edges	are	detected	in	the	image,	besides	the	curves	of
my	template.	Does	this	affect	the	accuracy	of	the	matching?
Superfluous	edge	detection	can	negatively	affect	the	accuracy	of
geometric	matching.	Adjust	the	curve	parameters	so	that	the	algorithm
detects	only	the	curves	of	your	template	object.	If	the	algorithm	detects
additional	edges	because	of	glare	for	example,	use	the	NI	Vision
Template	Editor	to	define	regions	whose	edges	you	want	the	function	to
ignore.



Shape	Detection
Detects	shapes	in	grayscale	images.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
View	Contour	Lines—Displays	the	edges	detected	in	the	image.



Curve	Settings	Tab
The	following	controls	are	available	on	the	Curve	Settings	tab.

Extraction	Mode—Specifies	how	the	algorithm	identifies	curves	in
the	image.

Normal—Makes	no	assumptions	about	the	uniformity	of
objects	in	the	image	or	the	image	background.
Uniform	Regions—Assumes	that	either	the	objects	in	the
image	or	the	image	background	consist	of	uniform	pixel
values.	Use	this	mode	to	calculate	the	external	curves	of	the
objects	with	greater	accuracy.

Edge	Threshold—Specifies	the	minimum	contrast	an	edge	pixel
must	have	to	be	considered	part	of	a	curve.	This	value	can	range
from	0	to	255.	The	default	value	is	75.
Edge	Filter	Size—Specifies	the	kernel	size	to	use	for	computing
the	edges	in	the	image.	The	options	are	Normal	and	Fine.	The
default	value	is	Normal.
Minimum	Length—Specifies	the	length,	in	pixels,	of	the	smallest
curve	you	want	to	extract.	The	default	value	is	25.
Row	Search	Step	Size—Specifies	the	distance,	in	the	y	direction,
between	the	image	rows	that	the	algorithm	inspects	for
curve	seed	points.	Valid	values	range	from	1	to	255.	The	default
value	is	15.
Column	Search	Step	Size—Specifies	the	distance,	in	the	x
direction,	between	the	image	columns	that	the	algorithm	inspects
for	curve	seed	points.	Valid	values	range	from	1	to	255.	The	default
value	is	15.
Maximum	Endpoint	Gap—Specifies	the	maximum	gap,	in	pixels,
allowed	between	the	endpoints	of	a	curve	for	the	step	to	identify
the	curve	as	closed.	If	the	gap	is	larger	than	this	value,	the	step
identifies	the	curve	as	an	open	curve.	The	default	value	is	10.
View	Contour	Lines—Displays	the	edges	detected	in	the	image.



Shape	Tab
The	following	controls	are	available	on	the	Shape	tab.

Shape	Type—Specifies	the	type	of	shape	to	detect	in	the	image.
The	options	are	Circles,	Ellipses,	Rectangles,	and	Lines.
Descriptor—Descriptor	associated	with	the	selected	Shape	Type.

Max	Radius	(Circles)—Maximum	length	of	the	radius	of	the
circle	to	detect.
Min	Radius	(Circles)—Minimum	length	of	the	radius	of	the
circle	to	detect.	This	value	must	be	3	or	higher.
Max	Major	Radius	(Ellipses)—Maximum	length	of	the	major
radius	of	the	ellipse	to	detect.	This	value	must	be	greater
than	Max	Minor	Radius.
Min	Major	Radius	(Ellipses)—Minimum	length	of	the	major
radius	of	the	ellipse	to	detect.	This	value	must	be	3	or
higher,	and	it	must	be	greater	than	Min	Minor	Radius.
Max	Minor	Radius	(Ellipse)—Maximum	length	of	the	minor
radius	of	the	ellipse	to	detect.
Min	Minor	Radius	(Ellipses)—Minimum	length	of	the	minor
radius	of	the	ellipse	to	detect.	This	value	must	be	3	or
higher.
Max	Width	(Rectangles)—Maximum	width	of	the	rectangle
to	detect.	This	value	must	be	greater	than	Max	Height.
Min	Width	(Rectangles)—Minimum	width	of	the	rectangle	to
detect.	This	value	must	be	3	or	higher,	and	it	must	be
greater	than	Min	Height.
Max	Height	(Rectangles)—Maximum	height	of	the	rectangle
to	detect.
Min	Height	(Rectangles)—Minimum	height	of	the	rectangle
to	detect.	This	value	must	be	3	or	higher.
Max	Length	(Lines)—Maximum	length	of	the	line	to	detect.
Min	Length	(Lines)—Minimum	length	of	the	line	to	detect.
This	value	must	be	3	or	higher.

View	Contour	Lines—Displays	the	edges	detected	in	the	image.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Minimum	Score—Specifies	the	minimum	score	a	detected	shape
can	have	to	be	considered	a	valid	match.	This	value	can	range
from	0	to	1000,	where	a	score	of	1000	indicates	a	perfect	match.
Search	for	matches	that	are—Defines	the	match	modes	and
ranges	used	to	match	the	template.

Rotated—When	enabled,	this	function	searches	for	the
shape	in	the	angle	range	you	specify.	When	disabled,	this
function	searches	for	the	shape	regardless	of	shifting	along
the	x-axis	and	y-axis.	You	may	specify	a	second	angle	range
if	needed.
Scaled—When	enabled,	this	function	searches	for	a	shape
that	may	be	scaled	in	the	inspection	image.
Occluded—When	enabled,	this	function	searches	for	a
shape	that	may	be	occluded	in	the	inspection	image.

View	Contour	Lines—Displays	the	edges	detected	in	the	image.



Results
Displays	the	following	information	after	searching	the	image	for	a	shape:

Score—Score	of	each	valid	match.	Score	values	can	range	from	0
to	1000,	where	a	score	of	1000	indicates	a	perfect	match.
Radius	(Circles)—Length	of	the	radius	for	each	detected	circle.
Major	Radius	(Ellipses)—Length	of	the	major	radius	for	each
detected	ellipse.
Minor	Radius	(Ellipses)—Length	of	the	minor	radius	for	each
detected	ellipse.
Width	(Rectangles)—Width	of	each	detected	rectangle.
Height	(Rectangles)—Length	of	each	detected	rectangle.
Angle—Rotation	angle,	in	degrees,	of	each	detected	shape.
Center	X—X-coordinate	of	the	center	of	each	detected	circle	or
ellipse.
Center	Y—Y-coordinate	of	the	center	of	each	detected	circle	or
ellipse.
Corner#	X	(Rectangles)—X-coordinate	of	the	corner	of	each
detected	rectangle.
Corner#	Y	(Rectangles)—Y-coordinate	of	the	corner	of	each
detected	rectangle.
Start	Point	X	(Lines)—X-coordinate	of	the	start	point	of	each
detected	line.
Start	Point	Y	(Lines)—Y-coordinate	of	the	start	point	of	each
detected	line.
End	Point	X	(Lines)—X-coordinate	of	the	end	point	of	each
detected	line.
End	Point	Y	(Lines)—Y-coordinate	of	the	end	point	of	each
detected	line.



Search	for	Shapes	Using	Shape	Detection
Note		The	shape	detection	step	works	only	with	8-bit	images.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Curve	Settings	Tab
Modify	the	Extraction	Mode,	Edge	Threshold,	Edge	Filter	Size,
Minimum	Length,	Row	Search	Step	Size,	and	Column	Search	Step
Size	to	improve	edge	detection,	if	necessary.



Shape	Tab
1.	 Select	the	type	of	shape	you	want	to	detect.
2.	 Set	the	Descriptor	values	to	indicate	the	size	of	the	shapes	to

return.



Settings	Tab
1.	 Specify	the	minimum	score	a	detected	shape	can	have	to	be

considered	a	valid	match.	This	value	can	range	from	0	to	1000,
where	a	score	of	1000	indicates	a	perfect	match.

2.	 Enable	Search	for	Matches	that	are	Rotated,	Scaled,	or
Occluded	to	indicate	that	a	match	may	be	a	rotated,	scaled,	or
occluded	version	of	the	shape	you	want	to	detect.	Specify	an
acceptable	range	for	each	parameter	to	restrict	the	amount	of
rotation,	scale,	or	occlusion	allowed	in	a	valid	shape.

3.	 Click	OK	to	save	this	step	to	the	script.



Shape	Detection	FAQs
What	is	the	difference	between	the	green	region	and	red	region?
The	green	region	indicates	the	area	of	the	image	in	which	you	want	to
search	for	shapes.	The	red	region	indicates	a	detected	shape.
Edges	in	addition	to	the	curves	of	my	shape	are	detected	in	the
image.	Does	this	affect	the	accuracy	of	the	function?
Detecting	superfluous	edges	can	negatively	affect	the	accuracy	of	shape
detection.	Adjust	the	Curve	Parameters	so	that	the	algorithm	detects	only
the	relevant	curves.
What	does	the	text	overlay	in	the	image	indicate?
Each	detected	shape	has	a	text	overlay	close	to	the	first	point	of	the
shape.	The	text	displays	the	shape	number	and	score.



Golden	Template	Comparison
Compares	an	inspection	image	to	a	golden	template	and	returns	the
areas	that	do	not	match	up	as	defects.	Refer	to	the	NI	Vision	Template
Editor	Help	for	information	about	the	Template	Editor	controls.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Template	Image—The	image	to	use	as	the	template.
Template	Size

Width—Width	of	the	template	in	pixels.
Height—Height	of	the	template	in	pixels.

New	Template—Launches	the	NI	Vision	Template	Editor	wizard,	in
which	you	can	learn	a	template	and	save	the	result	as	a	template
image	file.
Edit	Template—Launches	the	NI	Vision	Template	Editor	wizard,	in
which	you	can	modify	a	template	and	save	the	result	as	a	template
image	file.
Load	from	File—Launches	a	dialog	box	in	which	you	can	browse
to	a	template	image	file	and	specify	that	file	as	the	search
template.
Note		When	you	load	a	template	from	file,	the	template	can	be	any
valid	NI	Vision	template,	such	as	a	Pattern	Matching	template.	The
Golden	Template	Comparison	step	prompts	you	to	add	golden
template	information	to	the	template.
Template	Path—Displays	the	location	of	the	template	image	file.



Alignment	Tab
The	following	controls	are	available	on	the	Alignment	tab.

Center	X—X-coordinate	of	the	center	point	in	the	region	of
interest.
Center	Y—Y-coordinate	of	the	center	point	in	the	region	of	interest.
Angle	(deg)—Rotation	angle	of	the	region	of	interest,	in	degrees.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
Scale	(percentage)—Scale	of	the	golden	template	in	the
inspection	image	expressed	as	a	percentage.
Alignment	Correction—Specifies	the	algorithm	to	use	to	correct
for	slight	misalignments	between	the	golden	template	and
inspection	image.	The	following	options	are	available:

None—No	alignment	correction.
Perspective—Adjusts	the	inspection	image	to	correct	for
minor	variations	in	alignment	or	perspective.

Display—Specifies	what	is	displayed	in	the	Main	window.	The
following	options	are	available:

Defects	Only—Displays	only	the	bright	and	dark	defects.
Overlay	Defects—Displays	the	bright	and	dark	defects	as
an	overlay	on	the	inspection	image.



Settings	Tab
The	following	controls	are	available	on	the	Settings	tab.

Look	For—Specifies	the	type	of	defects	to	search	for	in	the	image.
All	Defects—Searches	for	areas	in	the	image	that	are
brighter	and/or	darker	than	the	corresponding	area	in	golden
template.
Bright	Defects—Searches	for	areas	in	the	image	that	are
brighter	than	the	corresponding	area	in	the	golden	template.
Dark	Defects—Searches	for	areas	in	the	image	that	are
darker	than	the	corresponding	area	in	the	golden	template.

Intensity—Specifies	the	algorithm	used	to	resolve	differences	in
the	intensity	of	the	inspection	image	compared	to	the	intensity	of
the	golden	template.

No	Change—Does	not	adjust	the	intensity	of	the	golden
template	and	the	inspection	image.
Histogram	Matching	Normalization—Adjusts	the
inspection	image	histogram	to	be	similar	to	the	histogram	of
the	golden	template.
Average	Matching	Normalization—Adjusts	the	inspection
image	so	the	mean	pixel	value	of	the	inspection	image
equals	the	mean	pixel	value	of	the	golden	template.

Ignore	Edges—Specifies	whether	edges	are	ignored	during	the
comparison	process.	If	enabled,	you	can	set	the	thickness	of	the
edges	to	ignore	using	the	Edge	Thickness	control.

Edge	Thickness—Specifies	the	thickness	of	the	edges	to
ignore.

Threshold	Defect	Image—Specifies	whether	to	threshold	the
defect	image.

Bright	Level—Threshold	value	for	determining	the	minimum
pixel	intensity	difference	between	the	golden	template	and
the	inspection	image	used	for	determining	bright	defects.
Dark	Level—Threshold	value	for	determining	the	minimum
pixel	intensity	difference	between	the	golden	template	and
the	inspection	image	used	for	determining	dark	defects.
Bright	Defects—Color	used	to	display	bright	defects.



Dark	Defects—Color	used	to	display	dark	defects.
Display—Specifies	what	is	displayed	in	the	Main	window.	The
following	options	are	available:

Defects	Only—Displays	only	the	bright	and	dark	defects.
Overlay	Defects—Displays	the	bright	and	dark	defects	as
an	overlay	on	the	inspection	image.



Search	for	Defects	Using	Golden	Template
Comparison
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Define	the	golden	template	to	compare	to	the	inspection	image

using	one	of	the	following	methods:
To	create	a	new	golden	template,	complete	the	following
steps:

a.	 Click	New	Template	to	launch	the	NI	Vision
Template	editor.

b.	 Complete	the	steps	in	the	NI	Vision	Template	Editor
to	create	a	golden	template.	Refer	to	the	NI	Vision
Template	Editor	Help	for	specific	instructions	about
how	to	define	a	golden	template.

c.	 Click	Finish	to	validate	the	new	template.
d.	 In	the	Save	Template	As	dialog	box,	browse	to	the

location	where	you	want	to	save	the	template	file,
enter	a	File	Name,	and	click	OK.

To	use	an	existing	image	as	the	golden	template,	complete
the	following	steps:

a.	 Click	Load	from	File.
b.	 Browse	to	the	image	you	want	to	use	as	the	golden

template.
c.	 Click	Open.

If	the	image	you	selected	is	not	a	valid	golden	template	file,
complete	the	following	steps	to	create	a	golden	template
based	on	the	image	you	selected:

a.	 Click	Yes	to	launch	the	NI	Vision	Template	Editor.
b.	 Adjust	the	Edge	Threshold	value	until	only	the

edges	you	want	to	exclude	during	the	golden
template	comparison	remain.

c.	 Click	OK.
d.	 In	the	Save	Template	As	dialog	box,	browse	to	the

location	where	you	want	to	save	the	template	file,



enter	a	File	Name,	and	click	OK.
Tip		Click	Edit	Template	to	launch	the	NI	Vision	Template	Editor
and	modify	the	currently	selected	golden	template.



Alignment	Tab
1.	 If	necessary,	adjust	the	position	of	the	region	of	interest	to

correspond	with	the	area	of	the	image	you	want	to	search	for
defects.
For	rough	alignment	of	the	region	of	interest	within	the	inspection
image,	use	the	mouse	to	adjust	the	center	of	the	position	of	the
region	of	interest.	For	fine	adjustments	in	the	position	of	the
region	of	interest,	use	the	arrow	keys	or	the	Center	X,	Center	Y,
and	Angle	controls.	The	size	of	the	region	of	interest	cannot	be
adjusted	because	the	size	of	the	region	of	interest	is	based	on	the
size	of	the	specified	golden	template.

2.	 Verify	that	the	Reposition	Region	of	Interest	checkbox	is
enabled	if	you	want	to	link	the	region	of	interest	specified	in	this
step	to	a	previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.

3.	 Specify	a	Scale	value	to	apply	to	the	golden	template	if	the	area
in	the	image	you	want	to	compare	to	the	golden	template	is	larger
or	smaller	than	the	golden	template	image.

4.	 Select	the	type	of	Alignment	Correction	you	want	to	use	to	when
the	golden	template	is	applied	to	the	image.



Settings	Tab
1.	 Specify	the	type	of	defects	to	detect	using	the	Look	For	control.
2.	 Use	the	Intensity,	Ignore	Edges,	and	Edge	Thickness	controls

to	adjust	for	variations	in	lighting	and	minor	differences	along	the
edges	of	the	image	that	you	want	to	ignore.

3.	 Use	the	Threshold	Defect	Image,	Bright	Level,	and	Dark	Level
controls	to	set	the	threshold	limits	for	defects	in	the	image.

4.	 Click	OK	to	save	this	step	to	the	script.
Tip		Use	the	Display	button	to	show	only	the	defects	in	the	image
or	show	the	defects	as	an	overlay	on	the	original	image.	The	green
defects	represent	pixels	in	the	inspection	image	that	are	brighter
than	the	corresponding	pixels	in	the	golden	template	image.	The
red	defects	represent	pixels	in	the	inspection	image	that	are	darker
than	the	corresponding	pixels	in	the	golden	template	image.



Golden	Template	Comparison	FAQs
What	is	the	difference	between	the	green	defects	and	red	defects?
The	green	defects	represent	pixels	in	the	inspection	image	that	are
brighter	than	corresponding	pixels	in	the	template	image.	The	red	defects
represent	pixels	in	the	inspection	image	that	are	darker	than	the
corresponding	pixels	in	the	template	image.
Why	is	the	image	showing	the	defects	not	binary?
The	defect	image	is	computed	by	performing	a	difference	between	the
pixel	values	in	the	template	image	and	the	corresponding	pixel	values	in
the	inspection	image.	Vision	Assistant	displays	this	image	with	the
Gradient	palette.	The	algorithm	does	not	threshold	the	result	of	the
difference	unless	you	instruct	it	to	do	so	by	enabling	the	Threshold
Defect	Image	control.



Caliper
Computes	measurements—such	as	distances,	areas,	and	angles—
based	on	results	returned	from	other	machine	vision	and	image
processing	functions.	The	following	controls	are	available.

Step	Name—Name	to	give	the	step.
Geometric	Feature—Geometric	feature	you	want	to	compute
based	on	points	you	located	during	a	previous	step.

Distance—Computes	the	distance	between	two	selected
points.
Mid	Point—Finds	the	center	of	a	segment	defined	by	two
selected	points.
Perpendicular	Projection—Locates	the	perpendicular
projection	of	the	third	point	you	selected	onto	a	line	specified
by	the	first	two	points	you	selected.
Lines	Intersection—Locates	the	intersection	of	the	lines
specified	by	the	first	two	points	you	select	and	the	last	two
points	you	select.
Angle	from	Horizontal—Finds	the	counterclockwise	angle
from	the	horizontal	axis	to	a	line	specified	by	two	points.
Angle	from	Vertical—Finds	the	counterclockwise	angle
from	the	vertical	axis	to	a	line	specified	by	two	points.
Angle	Defined	by	3	Points—Finds	the	counterclockwise
angle	between	three	points,	where	the	second	point	is	the
vertex.
Angle	Defined	by	4	Points—Finds	the	counterclockwise
angle	between	the	lines	specified	by	the	first	two	points	you
select	and	the	last	two	points	you	select.
Bisecting	Line—Finds	the	line	bisecting	the
counterclockwise	angle	formed	by	two	lines,	where	the	first
two	points	you	select	create	the	first	line	and	the	second	two
points	you	select	create	the	second	line.
Mid	Line—Finds	a	line	midway	between	the	line	specified
by	the	first	two	points	you	select	and	the	third	point	you
select.	The	new	line	is	parallel	to	the	line	specified	by	the
first	two	points	you	select.



Center	of	Mass—Finds	the	center	of	mass	of	two	or	more
points	you	select.
Area—Computes	the	area	of	a	polygon,	where	the	vertices
are	points	you	select.
Line	Fit—Fits	a	straight	line	to	a	set	of	two	or	more	points.
Circle	Fit—Fits	a	circle	to	a	set	of	three	or	more	points.
Ellipse	Fit—Fits	an	ellipse	to	a	set	of	six	or	more	points.

Available	Points—Points	between	which	you	want	to	find	angles,
lines,	or	mid	points.



Use	the	Caliper	Tool
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Select	the	type	of	geometric	feature	you	want	to	compute.

Note		When	you	select	a	geometric	feature,	the	step
displays	the	minimum	number	of	points	you	need	to	select
to	compute	the	feature.

3.	 Select	the	points	that	define	the	geometric	feature	using	one	of
the	following	methods:

Click	the	points	overlaid	on	the	image.
Select	the	checkboxes	in	the	Available	Points	list.
Double-click	the	point	names	in	the	Available	Points	list.

Tips		
If	a	measurement	creates	a	new	point,	the	new	point	is
available	for	new	measurements	when	you	close	the	caliper
parameter	window	and	re-open	it.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.
To	deselect	all	points	on	the	image,	click	Reset.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points
Find	the	distance	between	two	points
Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Distance	Between	Two	Points
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Distance.
3.	 Select	two	points	on	the	image	by	clicking	them.
4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Note			You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge	Detector,
Straight	Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern
Matching,	Color	Pattern	Matching,	Color	Location,	Shape
Matching,	Particle	Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points
Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Center	of	Two	Points
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Mid	Point.
3.	 Select	two	points	on	the	image	by	clicking	them.
4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Note		You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge	Detector,
Straight	Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern
Matching,	Color	Pattern	Matching,	Color	Location,	Shape
Matching,	Particle	Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
The	center	point	is	available	for	new	measurements	when
you	close	the	caliper	parameter	window	and	re-open	it.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	circular	fit	using	three	or	more	points
Find	the	distance	between	two	points
Find	the	intersection	of	two	lines



Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Perpendicular	Projection	of	a	Point	on	a
Line

1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the
Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
located	with	the	Edge	Detector,	Straight	Edge	(Rake),	Circular
Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Perpendicular	Projection	in	Geometric	Feature.
3.	 Select	three	points	(for	example,	points	1,	2,	and	3)	on	the	image

by	clicking	them.
4.	 Click	Measure.	Vision	Assistant	computes	the	location	of	the

perpendicular	projection	of	point	3	on	the	line	(point	1,	point	2).
5.	 Click	OK	to	add	this	step	to	the	script.
Note		You	must	have	already	located	the	position	of	objects	in	the
image	using	one	of	the	following	functions:	Edge	Detector,	Straight
Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,
Color	Pattern	Matching,	Color	Location,	Shape	Matching,	Particle
Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points



Find	the	distance	between	two	points
Find	the	intersection	of	two	lines



Find	the	Intersection	of	Two	Lines
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
located	with	the	Edge	Detector,	Straight	Edge	(Rake),	Circular
Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Line	Intersections	in	Geometric	Feature.
3.	 Select	four	points	(for	example,	points	1,	2,	3,	and	4)	on	the	image

by	clicking	them.
4.	 Click	Measure.	Vision	Assistant	computes	the	location	of	the

intersection	of	the	lines	represented	by	the	lines	(point	1,	point	2)
and	(point	3,	point	4).

5.	 Click	OK	to	add	this	step	to	the	script.
Note		You	must	have	already	located	the	position	of	objects	in	the
image	using	one	of	the	following	functions:	Edge	Detector,	Straight
Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,
Color	Pattern	Matching,	Color	Location,	Shape	Matching,	Particle
Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points



Find	the	distance	between	two	points
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Angle	Made	by	Two	Points
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	either	Angle	from	Horizontal	or	Angle	from	Vertical,
depending	on	the	type	of	angle	you	want.

3.	 Select	two	points	on	the	image	by	clicking	them.
4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Notes		

You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge
Detector,	Straight	Edge	(Rake),	Circular	Edge	(Spoke),
Centroid,	Pattern	Matching,	Color	Pattern	Matching,	Color
Location,	Shape	Matching,	Particle	Analysis,	or	Circle
Detection.
The	angle	is	measured	in	degrees,	counterclockwise.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Finding	the	angle	made	by	three	or	four	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points



Find	the	distance	between	two	points
Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Angle	Made	by	Three	or	Four	Points
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Angle	Defined	by	3	Points	or	Angle	Defined	by	4
Points.

3.	 Select	three	or	four	points	on	the	image	by	clicking	them.	If	you
select	three	points,	the	second	point	is	used	as	the	common
vertex,	and	the	angle	is	measured	between	(1,2)	and	(2,3).	If	you
select	four	points,	the	angle	is	measured	between	(1,2)	and	(3,4).

4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Notes		

You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge
Detector,	Straight	Edge	(Rake),	Circular	Edge	(Spoke),
Centroid,	Pattern	Matching,	Color	Pattern	Matching,	Color
Location,	Shape	Matching,	Particle	Analysis,	or	Circle
Detection.
The	angle	is	measured	in	degrees,	counterclockwise.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points



Find	the	circular	fit	using	three	or	more	points
Find	the	distance	between	two	points
Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Center	of	Mass	Using	Three	or	More
Points

1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the
Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Center	of	Mass.
3.	 Select	three	or	more	points	on	the	image	by	clicking	them.
4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Note		You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge	Detector,
Straight	Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern
Matching,	Color	Pattern	Matching,	Color	Location,	Shape
Matching,	Particle	Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
The	center	point	is	available	for	new	measurements	when
you	close	the	caliper	parameter	window	and	re-open	it.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points
Find	the	distance	between	two	points



Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Area	Enclosed	by	Three	or	More	Points
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Area.
3.	 Select	three	or	more	points	on	the	image	by	clicking	them.
4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Note		You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge	Detector,
Straight	Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern
Matching,	Color	Pattern	Matching,	Color	Location,	Shape
Matching,	Particle	Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	circular	fit	using	three	or	more	points
Find	the	distance	between	two	points
Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Find	the	Circular	Fit	Using	Three	or	More	Points
1.	 Click	Machine	Vision»Caliper	or	select	Caliper	from	the

Machine	Vision	tab	in	the	Processing	Functions	palette.
Vision	Assistant	displays	and	numerically	labels	all	points	that	you
have	located	with	the	Edge	Detector,	Straight	Edge	(Rake),
Circular	Edge	(Spoke),	Centroid,	Pattern	Matching,	Color	Pattern
Matching,	Color	Location,	Shape	Matching,	Particle	Analysis,	or
Circle	Detection	functions.

2.	 Select	Circle	Fit.
3.	 Select	three	or	more	points	on	the	image	by	clicking	them.
4.	 Click	Measure.
5.	 Click	OK	to	add	this	step	to	the	script.
Note		You	must	have	already	located	the	position	of	objects	in	the
image	using	one	or	more	of	the	following	functions:	Edge	Detector,
Straight	Edge	(Rake),	Circular	Edge	(Spoke),	Centroid,	Pattern
Matching,	Color	Pattern	Matching,	Color	Location,	Shape
Matching,	Particle	Analysis,	or	Circle	Detection.

Tips		
You	also	can	select	points	on	the	image	by	double-clicking
them	in	the	Points	list.	When	a	point	is	selected,
Vision	Assistant	places	a	check	mark	to	the	left	of	the	item.
The	center	of	the	circle	is	available	for	new	measurements
when	you	close	the	caliper	parameter	window	and	re-open
it.
To	save	the	data,	click	the	Send	Data	to	Excel	button	or	the
Save	Results	button.

Related	Topics
Find	the	angle	made	by	three	or	four	points
Find	the	angle	made	by	two	points
Find	the	area	enclosed	by	three	or	more	points
Find	the	center	of	mass	using	three	or	more	points
Find	the	center	of	two	points
Find	the	distance	between	two	points



Find	the	intersection	of	two	lines
Find	the	perpendicular	projection	of	a	point	on	a	line



Caliper	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Use	Identification	Functions
This	palette	groups	visual	inspection	steps	whose	purposes	are	to	read
and	verify	printed	characters,	classify	binary	objects,	and	read	1D	and	2D
barcodes.



OCR/OCV
Use	this	function	to	read	characters	in	a	region	of	an	image.



Classification
Use	this	function	to	classify	samples	in	an	image.



Barcode	Reader
Use	this	function	to	read	values	encoded	in	1D	barcodes.



Data	Matrix	Reader
Use	this	function	to	read	values	encoded	in	a	Data	Matrix	code.



PDF417	Code	Reader
Use	this	function	to	read	values	encoded	in	a	PDF417	code.



OCR/OCV
Refer	to	the	NI	OCR	Training	Interface	Help	for	information	about	the	NI
OCR	Training	Interface	controls.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
Text	Read—Displays	characters	recognized	in	the	region	of
interest	(ROI).



Train	Tab
The	following	controls	are	available	on	the	Train	tab.

Character	Set	Path—Path	of	the	character	set	you	want	to	use	to
recognize	the	characters.	A	character	set	file	contains	a	unique
representation	for	each	trained	character,	as	well	as	its
corresponding	value.
New	Character	Set	File—Creates	a	new	character	set	file	or	edits
an	existing	one.
Annulus	Orientation—Becomes	available	when	you	select	the
Annulus	ROI	tool.	Choose	one	of	the	following	options:

Baseline	Inside—Select	this	option	when	the	imaginary	line
on	which	the	bottoms	of	the	letters	align	is	closer	to	the
center	of	the	annulus.
Baseline	Outside—Select	this	option	when	the	imaginary
line	on	which	the	bottoms	of	the	letters	align	is	closer	to	the
outside	of	the	annulus.

Text	Read—Displays	characters	recognized	in	the	region	of
interest	(ROI).



Threshold	Tab
The	following	controls	are	available	on	the	Threshold	tab.

Mode—Type	of	threshold	you	want	to	perform.
Fixed	Range—Determines	the	threshold	value	for	the	ROI.
Uniform—Calculates	a	single	threshold	value	for	the	ROI.
Linear—Divides	the	ROI	into	the	number	of	blocks	you
specify,	calculates	a	threshold	value	for	the	first	and	last
blocks,	and	linearly	interpolates	values	for	the	blocks
between	the	first	and	last	blocks.
Nonlinear—Divides	the	ROI	into	the	number	of	blocks	you
specify	and	calculates	a	threshold	value	for	each	block.

Characters—Specifies	the	relative	intensity	value	of	a	character
with	respect	to	the	background	of	the	image.	Use	this	control	to
specify	if	the	character	set	includes	light	characters	on	a	dark
background	or	dark	characters	on	a	light	background.
Range	Min—Minimum	threshold	value.
Range	Max—Maximum	threshold	value.
#	of	Blocks—Number	of	blocks	that	the	ROI	is	divided	into	when
you	use	the	Linear	or	Nonlinear	Mode.
Ignore	Objects	Touching	Region	Borders—When	enabled,
ignores	objects	that	are	touching	the	border	of	the	ROI	you	drew.
Remove	Small	Objects	(#	of	Erosions)—Number	of	erosions	you
want	to	perform	to	remove	small	objects	from	the	ROI.
Text	Read—Displays	characters	recognized	in	the	region	of
interest	(ROI).



Size	Tab
The	following	controls	are	available	on	the	Size	tab.

Autosplit—When	enabled,	the	step	is	configured	to	read	slanted
characters.
Min	Bounding	Rect	Width—Minimum	width	limits,	in	pixels,	for
the	character	bounding	rectangle.
Max	Bounding	Rect	Width—Maximum	width	limits,	in	pixels,	for
the	character	bounding	rectangle.
Min	Bounding	Rect	Height—Minimum	height	limits,	in	pixels,	for
the	character	bounding	rectangle.
Max	Bounding	Rect	Height—Maximum	height	limits,	in	pixels,	for
the	character	bounding	rectangle.
Min	Character	Size—Minimum	size	requirements,	in	pixels,	for	an
object	in	an	ROI	to	be	considered	a	character	that	can	be	trained.
Max	Character	Size—Maximum	size	requirements,	in	pixels,	for
an	object	in	an	ROI	to	be	considered	a	character	that	can	be
trained.
Min	Char	Spacing—Minimum	amount	of	space,	in	pixels,	that	can
be	between	characters	in	the	ROI	you	specified.	This	value	must
be	greater	than	Max	Element	Spacing.
Max	Horizontal	Element	Spacing—Maximum	amount	of	space,
in	pixels,	that	can	be	between	horizontally	adjacent	elements,	such
as	in	dot-matrix	objects.	This	value	must	be	less	than	Min	Char
Spacing.
Max	Vertical	Element	Spacing—Maximum	amount	of	space,	in
pixels,	that	can	be	between	vertically	adjacent	elements.



Read	Options	Tab
The	following	controls	are	available	on	the	Read	Options	tab.

Read	Strategy—Specifies	the	criteria	to	determine	if	read
characters	match	trained	characters.

Conservative—The	step	uses	extensive	criteria	to
determine	if	read	characters	match	trained	characters.
Aggressive—The	step	uses	fewer	criteria	to	determine	if
read	characters	match	trained	characters.	The	Aggressive
strategy	processes	images	faster	than	the	Conservative
strategy.

Read	Resolution—Level	of	character	detail	the	step	uses	to
determine	if	an	object	matches	a	trained	character.
Acceptance	Level—Value	to	indicate	how	closely	an	object	must
match	a	trained	character	to	be	a	recognized	character.	The	valid
range	of	values	is	0	to	1000.	A	value	of	1000	indicates	a	perfect
match	between	an	object	and	a	trained	character.
Substitution	Character—Character	you	want	to	use	for	objects
that	are	not	yet	trained	and	recognized.
Aspect	Ratio	Dependent—Configures	the	step	to	read	characters
whose	size	is	between	a	range.	Specify	how	much	larger	or
smaller,	in	percentages,	the	characters	can	be	compared	to	the
trained	character.	To	maintain	performance	in	the	OCR	process,
limit	the	difference	to	±50.	Avoid	creating	character	sets	whose
characters	differ	only	in	height	and	width.	Consider	separating	the
characters	into	different	character	sets,	using	valid	characters	to
restrict	trained	characters,	and	enforcing	the	aspect	ratio.
Aspect	Ratio—Specifies	how	much	larger	or	smaller,	in
percentages,	the	characters	can	be	compared	to	the	trained
character.	To	maintain	performance	in	the	OCR	process,	limit	the
difference	to	±50.	Avoid	creating	character	sets	whose	characters
differ	only	in	height	and	width.	Consider	separating	the	characters
into	different	character	sets,	using	valid	characters	to	restrict
trained	characters,	and	enforcing	the	aspect	ratio.
Use	Text	Pattern—Specifies	whether	you	want	to	define	a	pattern
of	characters	that	you	expect	read	strings	to	follow.
Specify	Text	Pattern—Specifies	that	the	text	being	read	always



has	the	same	pattern.	You	can	then	instruct	the	step	that	the	first
character	expected	is	a	letter,	the	second	character	a	digit,	and	so
on.	Doing	so	increases	the	speed	and	accuracy	of	recognition.
Text	Read—Text	that	the	step	read.



Results
Displays	the	following	information	after	reading	the	selected	text:

Classification	Score—Indicates	how	closely	a	character	matched
its	closest	match	in	the	character	set.	A	high	value	indicates	a
close	match,	and	a	low	value	indicates	a	poor	match.
Identification	Score—Indicates	how	closely	a	character	matched
the	reference	character	of	the	class	to	which	it	is	assigned.	A	high
value	indicates	a	close	match,	and	a	low	value	indicates	a	poor
match.
Left,	Top—X-	and	y-coordinates	of	the	bounding	rectangle
surrounding	the	character	in	the	current	ROI.
Width,	Height—Width	and	height	of	the	character	read	in	the
current	ROI.



Read	and	Verify	Text	in	Images
Main	Tab

1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Train	Tab
Follow	these	instructions	to	compare	objects	in	an	image	to	a	trained	set
of	characters	and	determine	if	the	characters	match	a	given	string:

1.	 Click	Identification»OCR/OCV	or	click	OCR/OCV	in	the
Identification	tab	of	the	Processing	Functions	palette.

2.	 Browse	to	the	character	set	file	you	want	to	open,	select	the	file,
and	click	Open.
If	necessary,	click	New	Character	Set	File	to	train	additional
characters	in	the	NI	OCR	Training	Interface.

3.	 Draw	a	region	of	interest	around	the	characters	you	want	to	read.
Vision	Assistant	segments	objects	in	the	region	of	interest	by
drawing	character	bounding	rectangles	around	the	objects
according	to	the	current	settings	in	the	Threshold,	Size,	and
Read	Options	tabs.



Threshold	Tab
Note		Configure	options	in	the	Threshold	tab	carefully.	If	you
manually	set	the	threshold	values,	and	OCR/OCV	cannot	detect
characters	in	the	region	you	specified,	the	training	process	does
not	create	the	character	set	file	correctly.	For	example,	if	you
select	Fixed	Range	from	the	Mode	control,	and	you	select	a	Max
value	that	is	too	low,	OCR/OCV	cannot	correctly	detect	the
characters	in	the	region	of	interest.

1.	 Select	a	threshold	type	from	the	Mode	control.
When	you	select	Linear	or	Nonlinear,	you	must	set	#	of	Blocks
to	at	least	the	number	of	objects	in	the	region	of	interest.	If	you
selected	Fixed	Range	in	Type,	use	Min	and	Max	or	the	slider	at
the	bottom	of	the	histogram	to	determine	the	threshold	value.	If
you	selected	Computed,	Linear,	or	Nonlinear	in	Type,	use
Characters	to	indicate	the	character	color	in	the	image.	Light	on
Dark	indicates	that	the	image	contains	light	characters	on	a	dark
background.	Dark	on	Light	indicates	that	the	image	contains	dark
characters	on	a	light	background.

2.	 Enable	the	Ignore	Objects	Touching	Region	Borders	control	to
ignore	objects	that	touch	the	border	of	the	region	of	interest.

3.	 In	Remove	Small	Objects	(#	of	Erosions),	select	the	number	of
erosions	to	remove	small	objects	from	the	region	of	interest.	The
OCR	Training	Interface	displays	segmented	objects	in	blue.



Size	Tab
Use	the	controls	to	indicate	the	character	size	and	spacing	values
required	for	character	recognition.	OCR/OCV	recognizes	only	those
characters	in	the	region	of	inspection	that	meet	the	criteria	in	the	Size
tab.



Read	Options
1.	 Select	a	Read	Strategy.
2.	 Enable	the	Aspect	Ratio	Invariant	control	to	read	characters

regardless	of	character	size.	Otherwise,	select	an	Aspect	Ratio
value	to	indicate	the	allowable	difference	between	the	training	and
reading	character	sizes	and	height/width	ratios.

3.	 Enter	the	Substitution	Character	you	want	to	appear	in	the
string	to	indicate	objects	that	are	not	trained	and	recognized.

4.	 Select	an	Acceptance	Level	value	to	indicate	how	closely	an
object	must	match	a	trained	character	to	be	a	recognized
character.

5.	 Click	Specify	Pattern	if	you	know	that	the	text	to	read	always	has
the	same	pattern.	For	example,	you	can	specify	that	the	first
character	should	be	a	letter	and	the	second	character	should	be	a
digit.	Specifying	a	pattern	increases	the	speed	and	accuracy	of
recognition.

6.	 Click	OK	to	add	this	step	to	the	script	and	close	the	parameter
window.



OCR/OCV	FAQs
Why	is	the	step	not	properly	recognizing	the	text	inside	my	region
of	interest?
Before	the	OCR/OCV	step	can	read	characters	in	a	region	of	interest,
you	need	to	train	the	software	to	recognize	the	characters.	If	you	have
not	trained	for	the	characters,	click	Edit	Character	Set	File	on	the	Main
tab	to	launch	the	NI	OCR	Training	Interface	and	train	for	the	characters.
Make	sure	you	selected	a	Character	Set	Path	from	the	Main	tab	that
describes	the	characters	you	want	to	read.
Also,	make	sure	that	each	character	in	the	region	of	interest	is	tightly
bounded	by	a	character	bounding	rectangle.	If	each	character	is	not
bounded,	adjust	the	parameters	in	the	Threshold	and	Size	tabs.	In
particular,	enable	the	Ignore	Objects	Touching	Region	Borders	control
in	the	Threshold	tab	if	artifacts	touch	the	character	bounding	rectangle.
Also,	adjust	the	Max	Bounding	Rect	Width	in	the	Size	tab	if	the
characters	are	slanted	and	slightly	overlap	in	the	vertical	direction
causing	one	character	bounding	rectangle	to	surround	all	of	the
characters.	Adjusting	this	parameter	forces	the	width	of	the	character
bounding	rectangle.
What	is	the	difference	between	the	Classification	Score	and
Identification	Score?
The	Classification	Score	indicates	the	level	of	confidence	that	a	character
belongs	to	a	specific	class.	The	Identification	Score	indicates	how	similar
a	character	is	to	the	reference	character	specified	for	the	class.



Classification
Classifies	the	sample	or	samples	located	in	the	given	region	of	interest
(ROI)	based	on	their	shape.	Refer	to	the	NI	Classification	Training
Interface	Help	for	information	about	the	NI	Classification	Training
Interface	controls.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
Samples—Indicates	the	number	of	samples	learned	in	the
selected	classifier	file.



Train	Tab
The	following	controls	are	available	on	the	Train	tab.

Classifier	File	Path—Path	of	the	classifier	file	you	want	to	use	to
classify	samples.	A	classifier	file	contains	a	representation	for	each
trained	sample	as	well	as	its	corresponding	label.
New	Classifier	File—Allows	you	to	create	a	new	classifier	file
using	the	NI	Classification	Training	Interface.
Sample	to	Classify—Specifies	whether	to	classify	only	the	largest
sample	in	the	region	or	all	of	the	samples	in	the	region.
Training	Required—Indicates	that	you	modified	some	parameters
that	require	the	classifier	to	be	trained	before	classifying	samples.
Samples—Indicates	the	number	of	samples	learned	in	the
selected	classifier	file.



Threshold	Tab
The	following	controls	are	available	on	the	Threshold	tab.

Method—Specifies	whether	to	perform	a	manual	or	automatic
threshold.	To	perform	a	manual	threshold,	select	Manual
Threshold	from	the	Method	drop-down	menu.	To	perform	an
automatic	threshold,	select	one	of	the	following	options:

Clustering—Sorts	the	histogram	of	the	image	within	a
discrete	number	of	classes	corresponding	to	the	number	of
phases	perceived	in	an	image.	Clustering	is	the	most
frequently	used	automatic	thresholding	method.
Entropy—Detects	samples	that	are	present	in	minuscule
proportions	on	the	image.
Metric—Calculates	a	value	for	each	threshold	that	is
determined	by	the	surfaces	representing	the	initial	gray
scale.
Moments—Use	for	images	that	have	poor	contrast.
Inter	Variance—Use	for	images	in	which	classes	are	not	too
disproportionate.	For	satisfactory	results,	the	smallest	class
must	be	at	least	5%	of	the	largest	one.

Look	For—Specifies	whether	you	want	to	classify	bright,	dark,	or
gray	objects.
Range—Cluster	specifying	the	threshold	range.

Min—Lower	value	of	the	threshold	range	when	you	perform
a	manual	threshold.	In	automatic	threshold	mode,	Min
displays	the	value	computed	by	the	automatic	threshold
algorithm	you	selected.
Max—Upper	value	of	the	threshold	range	when	you	use	a
manual	thresholding	method.	In	automatic	threshold	mode,
Max	displays	the	value	computed	by	the	automatic	threshold
algorithm	you	selected.
Lower	Limit—Lower	limit	of	the	thresholding	range	when
you	use	an	automatic	thresholding	method.	The	automatic
thresholding	algorithm	you	select	cannot	compute	a
threshold	value	lower	than	Lower	Limit.
Upper	Limit—Upper	Limit	of	the	thresholding	range	when



you	use	an	automatic	thresholding	method.	The	automatic
thresholding	algorithm	you	select	cannot	compute	a
threshold	value	greater	than	Upper	Limit.

Ignore	Objects	Touching	Region	Borders—When	enabled,
ignores	objects	in	the	sample	that	are	touching	the	border	of	the
ROI.
Remove	Small	Objects	(#	of	Erosions)—Number	of	erosions	you
want	the	classification	engine	to	perform	to	remove	small	objects	in
the	sample	from	the	ROI.
Training	Required—Indicates	that	you	modified	some	parameters
that	require	the	classifier	to	be	trained	before	classifying	samples.
Samples—Indicates	the	number	of	samples	learned	in	the
selected	classifier	file.



Options	Tab
The	following	controls	are	available	on	the	Options	tab.

Method—Method	of	classification.
Nearest	Neighbor—Most	direct	approach	to	classification.
In	nearest	neighbor	classification,	the	distance	of	an	input
feature	vector	of	unknown	class	to	another	class	is	defined
as	the	distance	to	the	closest	samples	that	are	used	to
represent	that	class.
K-Nearest	Neighbor—More	robust	to	noise	compared	with
nearest	neighbor	classification.	In	K-nearest	neighbor
classification,	an	input	feature	vector	is	classified	into	a	class
based	on	a	voting	mechanism.	The	NI	Classifier	finds	K
nearest	samples	from	all	the	classes.	The	input	feature
vector	of	unknown	class	is	assigned	to	the	class	with
majority	of	the	votes	in	the	K	nearest	samples.
Minimum	Mean	Distance—Most	effective	in	applications
that	have	little	or	no	feature	pattern	variability	or	other
corruptive	influences.	In	minimum	mean	distance
classification,	an	input	feature	vector	of	unknown	class	is
classified	based	on	its	distance	to	each	class	center.

Metric—Computes	the	distance	between	features	in	a
classification	application.

Maximum—Most	sensitive	to	small	variations	between
samples.	Use	Maximum	when	you	need	to	classify	samples
with	very	small	differences	into	different	classes.
Sum—Metric	used	in	most	classification	applications	(also
known	as	the	Manhattan	metric	or	Taxicab	metric).	This	is
the	default	value.
Euclidean—Least	sensitive	to	small	variations	between
samples.	Use	Euclidean	when	you	need	to	classify	samples
with	small	differences	into	the	same	class.

K—Sets	the	K	value	when	using	the	K-Nearest	Neighbor	method
of	classification.	The	default	is	3.
Training	Required—Indicates	that	you	modified	some	parameters
that	require	the	classifier	to	be	trained	before	classifying	samples.
Samples—Indicates	the	number	of	samples	learned	in	the



selected	classifier	file.



Parameters	Tab
The	following	controls	are	available	on	the	Parameters	tab.
Parameters	define	the	dependence	of	the	classification	engine	on	shape,
scale,	and	mirror	symmetry.	By	default,	when	the	Scale	Dependent	and
Mirror	Dependent	options	are	disabled,	the	NI	Classifier	depends	only
on	variations	in	shape	to	classify	samples.	When	Scale	Dependent	and
Mirror	Dependent	are	enabled,	the	dependence	on	shape	is	calculated
as	follows:	Shape	Dependence	=	1000	–	(Scale	Factor	+	Mirror	Factor).

Scale	Factor—Determines	the	relative	importance	(between	0	and
1000)	of	scale	when	classifying	samples.	If	the	value	is	0,	the
samples	are	classified	independent	of	scale.
Mirror	Factor—Determines	the	relative	importance	(between	0
and	1000)	of	mirror	symmetry	when	classifying	samples.	If	the
value	is	0,	the	samples	are	classified	independent	of	mirror
symmetry.	Examples	of	objects	exhibiting	mirror	symmetry	are	a
lowercase	letter	p	and	a	lowercase	letter	q.
Training	Required—Indicates	that	you	modified	some	parameters
that	require	the	classifier	to	be	trained	before	classifying	samples.
Samples—Indicates	the	number	of	samples	learned	in	the
selected	classifier	file.



Classify	Samples
Follow	these	instructions	to	classify	a	sample	in	a	given	region	of	interest
(ROI):



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Train	Tab
1.	 Browse	to	the	classifier	file	you	want	to	use,	select	the	file,	and

click	Open.
2.	 If	you	want	to	create	a	new	classifier	file,	click	New	Classifier

File.	In	the	Save	Classifier	File	As	window,	enter	the	file	name	for
the	file	you	want	to	create.

3.	 Click	OK	to	open	the	NI	Classification	Training	Interface.
Tip		Refer	to	the	NI	Classification	Training	Interface	Help
for	more	information	about	how	to	train	and	classify
samples	in	the	Classification	Training	Interface.

Note		If	necessary,	click	Edit	Classifier	File	to	classify
additional	samples	in	the	NI	Classification	Training
Interface.

4.	 Draw	an	ROI	around	the	sample	you	want	to	classify.	

Vision	Assistant	segments	samples	in	the	ROI	by	drawing	particle
bounding	rectangles	around	the	samples	according	to	the	current
settings	in	the	Main,	Threshold,	Engine	Options,	and
Parameters	tabs.



Threshold	Tab
Note		Configure	options	in	the	Threshold	tab	carefully.	If	you
manually	set	the	threshold	values	and	the	classification	engine
cannot	detect	samples	in	the	region	you	specified,	the	training
process	does	not	create	the	classifier	file	correctly.

1.	 Select	a	threshold	type	from	the	Method	control.	When	you	select
Manual	Threshold,	you	must	set	the	threshold	range	with	the	Min
and	Max	controls.

2.	 Select	the	type	of	objects	you	want	to	classify	in	the	sample	from
the	Look	For	control.	You	can	classify	Bright	Objects,	Dark
Objects,	or	Gray	Objects.

3.	 Enable	the	Ignore	Objects	Touching	Region	Borders	control	to
ignore	objects	in	the	sample	that	touch	the	border	of	the	ROI.

4.	 In	Remove	Small	Objects	(#	of	Erosions),	select	the	number	of
erosions	to	remove	small	objects	in	the	sample	from	the	ROI.	

The	classification	engine	displays	segmented	objects	in	blue.



Options	Tab
Use	the	controls	to	indicate	the	Method	and	Metric	used	by	the
classification	engine	for	sample	recognition.



Parameters	Tab
1.	 Enable	the	Scale	Dependent	control	to	determine	the	relative

importance	of	scale	when	classifying	samples.	Enter	the
numerical	scale	value	(between	0	and	1000)	in	the	Scale	Factor
control.	If	the	value	is	0,	samples	are	classified	independent	of
scale.

2.	 Enable	the	Mirror	Dependent	to	determine	the	relative
importance	of	mirror	symmetry	when	classifying	samples.	Enter
the	numerical	value	of	importance	(between	0	and	1000)	for	the
mirror	symmetry	in	the	Mirror	Factor	control.	If	the	value	is	0,
samples	are	classified	independent	of	mirror	symmetry.



Classification	FAQs
Why	is	the	step	not	properly	recognizing	the	sample	inside	my
region	of	interest?
Before	the	Classification	step	can	locate	a	sample	in	a	region	of	interest
(ROI),	you	need	to	train	the	software	to	recognize	the	sample.	If	you	have
not	trained	for	the	sample,	click	Edit	Classifier	File	on	the	Main	tab	to
launch	the	NI	Classification	Training	Interface	and	train	the	samples.
Make	sure	you	selected	a	Classifier	File	Path	from	the	Main	tab	that
describes	the	sample	you	want	to	classify.



Barcode	Reader
Reads	a	one-dimensional	barcode.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.



Read	1D	Barcode	Tab
The	following	controls	are	available	on	the	Read	1D	Barcode	tab.

Barcode	Type—Type	of	barcode	you	want	to	read.
Validate—When	enabled,	the	step	validates	the	barcode	data.	If
the	barcode	type	is	Codabar,	Code	39,	or	Interleaved	2	of	5,	the
error	correction	information	built	into	the	barcode	is	used	to
validate	the	results.	For	all	other	barcode	types,	either	no
validation	is	performed	or	the	validation	is	performed	automatically
because	the	barcode	type	requires	it.
Add	Special	Character	to	Code	Read—When	enabled,	this	step
adds	the	special	characters	to	the	encoded	data.	Only	Codabar,
Code	128,	EAN	8,	EAN	13,	and	UPCA	barcodes	contain	special
characters.
Add	Checksum	to	Code	Read—When	enabled,	this	step	adds
the	checksum	value	read	with	the	barcode	to	the	encoded	data.
Refer	to	the	following	table	for	the	layout	of	special	characters,
data,	and	checksum	for	each	type	of	barcode.	

Barcode
Type

Special
Characters Layout

Codabar Start	character
and	stop
character		

<start	char>	<data>	<checksum>
<stop	char>

Code	39 None <data>	<checksum>
Code	93 None <data>	<checksum>
Code	128 FNC	Number <FNC>	<data>	<checksum>
EAN	8 Country

character	1	and
2

<country	char1>	<country	char2>
<data>	<checksum>

EAN	13 Country
character	1	and
2

<country	char1>	<country	char2>
<data>	<checksum>

Interleaved
2	of	5		

None <data>	<checksum>



MSI None <data>	<checksum>
UPCA System	char <system	char>	<data>

<checksum>
Pharmacode None <data	char>
RSS	Limited None <left	guard>	<left	data	char>

<check	char>	<right	data	char>
<right	guard>

Region	Profile—Average	intensity	of	the	pixels	in	the	region	of
interest	(ROI).
Code	Read—Decoded	barcode	data.



Read	Barcodes	in	Images
Use	the	Barcode	Reader	function	to	decode	a	1D	barcode.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Read	1D	Barcode	Tab
1.	 Draw	a	region	of	interest	(ROI)	around	the	barcode.	Make	sure

the	ROI	contains	all	of	the	bars.
2.	 Select	the	Barcode	Type	you	want	to	read.

If	the	barcode	type	is	Codabar,	Code	39,	or	Interleaved	2	of	5,	you
can	enable	the	Validate	control	to	use	the	encoded	error
correction	information	to	validate	the	results.	If	the	validation	fails,
the	step	also	fails.
If	the	barcode	type	is	Codabar,	Code	128,	EAN	8,	EAN	13,	or
UPCA,	you	can	enable	the	Add	Special	Character	to	Code
control	to	add	the	special	characters	of	the	code	to	the	encoded
data.	You	also	can	add	the	checksum	to	the	encoded	data	by
checking	the	Add	Checksum	to	Code	control.



Barcode	Reader	FAQs
Why	is	the	Code	Read	control	empty?
Make	sure	Barcode	Type	is	set	correctly	and	the	region	of	interest	(ROI)
encloses	all	of	the	bars.
Can	I	adjust	the	parameters	for	finding	the	bars?
No.	The	algorithm	that	Barcode	Reader	uses	is	adaptive	and	can	find
the	bars	even	when	the	image	contains	a	slight	light	drift	along	the
barcode.
The	string	returned	by	the	algorithm	does	not	match	the	code
written	below	the	barcode.
If	the	type	of	barcode	is	Codabar,	Code	128,	EAN	8,	EAN	13,	or	UPCA,
enable	the	Add	Special	Characters	to	Code	control.	You	also	can
enable	the	Add	Checksum	to	Code	control.



Data	Matrix	Reader
Decodes	a	Data	Matrix	barcode.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
Code	Read—Code	that	the	step	read.
Iterations—Number	of	iterations	the	step	took	in	attempting	to
locate	the	matrix.	If	this	number	is	equal	to	Maximum	Iterations
and	the	step	failed	to	locate	the	matrix,	you	may	be	able	to	locate
the	matrix	by	increasing	the	Maximum	Iterations	value.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Basic	Tab
The	following	controls	are	available	on	the	Basic	tab.

Suggest	Value?—When	enabled,	the	step	suggests	a	value	for
the	associated	control	after	the	Suggest	Values	button	is	clicked.
ECC—Specifies	the	ECC	used	for	this	Data	Matrix.

Auto-detect—Sets	the	step	to	determine	the	ECC
automatically.
ECC	000—Sets	the	step	to	read	Data	Matrix	codes	of	ECC
000	only.
ECC	050—Sets	the	step	to	read	Data	Matrix	codes	of	ECC
050	only.
ECC	080—Sets	the	step	to	read	Data	Matrix	codes	of	ECC
080	only.
ECC	100—Sets	the	step	to	read	Data	Matrix	codes	of	ECC
100	only.
ECC	140—Sets	the	step	to	read	Data	Matrix	codes	of	ECC
140	only.
ECC	000–140—Sets	the	step	to	read	Data	Matrix	codes	of
ECC	000,	ECC	050,	ECC	080,	ECC	100,	and	ECC	140	only.
ECC	200—Sets	the	step	to	read	Data	Matrix	codes	of	ECC
200	only.

Shape—Specifies	if	the	matrix	is	square	or	rectangular.
Matrix	Size—Size	of	the	matrix	to	read.
Barcode	Polarity—Specifies	the	data-to-background	contrast	for
the	matrix.

Auto-detect—Sets	the	step	to	determine	the	matrix	polarity
automatically.
Black	On	White—Sets	the	step	to	read	matrices	with	dark
data	on	a	bright	background.
White	On	Black—Sets	the	step	to	read	matrices	with	bright
data	on	a	dark	background.

Min.	Barcode	Size	(pixels)—Specifies	the	minimum	size,	in
pixels,	of	the	matrix	in	the	image.	If	you	set	this	value	to	0,	the	step
never	excludes	a	matrix	candidate	because	it	is	too	small.



Max.	Barcode	Size	(pixels)—Specifies	the	maximum	size,	in
pixels,	of	the	matrix	in	the	image.	If	you	set	this	value	to	0,	the	step
never	excludes	a	matrix	candidate	because	it	is	too	large.
Min	Border	Integrity	%—Minimum	percentage	of	the	finder
pattern	that	the	step	should	expect	in	the	Data	Matrix.	During	the
location	phase,	the	step	ignores	possible	matrix	candidates	that	do
not	have	at	least	this	level	of	border	integrity.
Uncheck/Check	All—Disables/Enables	all	Suggest	Value
checkboxes.
Code	Read—Code	that	the	step	read.
Iterations—Number	of	iterations	the	step	took	in	attempting	to
locate	the	matrix.	If	this	number	is	equal	to	Maximum	Iterations
and	the	step	failed	to	locate	the	matrix,	you	may	be	able	to	locate
the	matrix	by	increasing	the	Maximum	Iterations	value.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Search	Tab
The	following	controls	are	available	on	the	Search	tab.

Suggest	Value?—When	enabled,	the	step	suggests	a	value	for
the	associated	control	after	the	Suggest	Values	button	is	clicked.
Quiet	Zone	Width—Specifies	the	expected	minimum	size,	in
pixels,	of	the	quiet	zone.	The	step	ignores	Data	Matrix	candidates
whose	quiet	zones	are	smaller	than	this	value.
Aspect	Ratio—Ratio	of	the	matrix	width	(in	pixels)	divided	by	the
matrix	height	(in	pixels).	If	you	have	rectangular	matrices,	and	you
set	this	value	to	1,	the	step	appropriately	recalculates	the	aspect
ratio.	If	you	set	this	value	to	0,	the	step	automatically	determines
the	aspect	ratio.
Rotation	Mode—Specifies	the	amount	of	Data	Matrix	rotation	to
allow.

Unlimited—The	step	allows	for	unlimited	rotation.
0	Degrees—The	step	allows	for	no	rotation.
90	Degrees—The	step	allows	for	+/-	90	degrees	of	rotation.
180	Degrees—The	step	allows	for	+/-	180	degrees	of
rotation.
270	Degrees—The	step	allows	for	+/-	270	degrees	of
rotation.

Skew	Degrees	Allowed—Amount	of	skew	in	the	matrix	to	allow.
The	default	is	5	degrees.
Maximum	Iterations—Maximum	number	of	iterations	the	step
makes	before	it	stops	looking	for	the	matrix.	The	default	is	150.
Initial	Search	Vector	Width—Number	of	pixels	the	step	should
average	together	to	determine	the	location	of	an	edge.	You	may
need	to	increase	this	value	when	the	Data	Matrix	has	cells	with	a
low	fill	percentage.
Edge	Threshold—Minimum	contrast	a	pixel	must	have	to	be
considered	part	of	a	matrix	cell	edge.	The	lower	this	value,	the
more	potential	edge	candidates	the	step	examines	during	the
location	phase.	Setting	this	value	too	low	decreases	the
performance	of	the	step	because	the	step	examines	too	many
potential	edge	candidates.	Setting	this	value	too	high	may	also



decrease	the	performance	of	the	step	by	removing	valid	edge
candidates,	making	location	more	difficult.	Setting	this	value	too
high	may	also	cause	the	step	to	fail	to	identify	the	matrix	because
all	edge	candidates	are	eliminated.
Uncheck/Check	All—Disables/Enables	all	Suggest	Value
checkboxes.
Code	Read—Code	that	the	step	read.
Iterations—Number	of	iterations	the	step	took	in	attempting	to
locate	the	matrix.	If	this	number	is	equal	to	Maximum	Iterations
and	the	step	failed	to	locate	the	matrix,	you	may	be	able	to	locate
the	matrix	by	increasing	the	Maximum	Iterations	value.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Cell	Sampling	Tab
The	following	controls	are	available	on	the	Cell	Sampling	tab.

Suggest	Value?—When	enabled,	the	step	suggests	a	value	for
the	associated	control	after	the	Suggest	Values	button	is	clicked.
Cell	Fill	Percentage—Specifies	the	fill	percentage	for	a	cell	that	is
in	the	On	state.

Auto-detect—Sets	the	step	to	determine	the	matrix	cell	fill
percentage	automatically.
<	30%—Sets	the	step	to	read	matrices	with	a	cell	fill
percentage	of	less	than	30%.
>=	30%—Sets	the	step	to	read	matrices	with	a	cell	fill
percentage	greater	than	or	equal	to	30%.

Demodulation	Mode—Mode	that	determines	which	cells	are	on
and	which	cells	are	off	in	the	Data	Matrix.

Auto-detect—The	step	tries	each	demodulation	mode	and
use	the	one	which	decodes	the	Data	Matrix	within	the	fewest
iterations	and	utilizes	the	least	amount	of	error	correction.
Histogram—The	step	uses	a	histogram	of	all	of	the	matrix
cells	to	calculate	a	threshold.	This	threshold	determines	if	a
cell	is	on	or	off.	This	is	the	fastest	method	but	requires
images	with	consistent	levels	of	contrast	in	the	matrix.
Local	Contrast—The	step	examines	each	neighbor	of	a	cell
to	determine	if	the	cell	is	on	or	off.	This	method	is	slower	but
works	with	images	that	have	inconsistent	levels	of	contrast
in	the	matrix.
Combination—The	step	uses	the	histogram	of	the	matrix	to
calculate	a	threshold.	For	cells	with	pixel	values	that	are
sufficiently	below	or	above	this	threshold,	the	step	uses	the
threshold	to	determine	if	the	cell	is	on	or	off.	If	the	cell	pixel
values	are	close	to	the	threshold,	the	step	uses	the	Local
Contrast	method	to	determine	if	the	cell	is	on	or	off.	This
method	is	slower	but	works	with	images	that	have	extremely
low	cell	fill	percentages	or	gross	print	growth	errors.
All—The	step	tries	Histogram	first,	then	Local	Contrast,	and
then	Combination,	stopping	when	one	mode	is	successful.



Cell	Sample	Size—Sample	size,	in	pixels,	to	use	to	determine	if
each	cell	is	on	or	off.

Auto-detect—The	step	tries	each	sample	size	and	uses	the
one	that	decodes	the	Data	Matrix	in	the	fewest	iterations
using	the	least	amount	of	error	correction.
1×1—The	step	uses	a	1×1	sized	sample	from	each	cell.
2×2—The	step	uses	a	2×2	sized	sample	from	each	cell.
3×3—The	step	uses	a	3×3	sized	sample	from	each	cell.
4×4—The	step	uses	a	4×4	sized	sample	from	each	cell.
5×5—The	step	uses	a	5×5	sized	sample	from	each	cell.
6×6—The	step	uses	a	6×6	sized	sample	from	each	cell.
7×7—The	step	uses	a	7×7	sized	sample	from	each	cell.

Cell	Filter	Mode—Mode	the	step	uses	to	determine	the	pixel	value
for	each	cell.	Note	that	if	Cell	Sample	Size	is	1×1,	the	value	of	the
single	samples	pixel	always	determines	the	pixel	value	for	the	cell.

Auto-detect—The	step	tries	all	filter	modes	and	uses	the
one	that	decodes	the	Data	Matrix	within	the	fewest	iterations
and	utilizing	the	least	amount	of	error	correction.
Average—The	step	sets	the	pixel	value	for	the	cell	to	the
average	of	the	sampled	pixels.
Median—The	step	sets	the	pixel	value	for	the	cell	to	the
median	of	the	sampled	pixels.
Central	Average—The	step	sets	the	pixel	value	for	the	cell
to	the	average	of	the	pixels	in	the	center	of	the	cell	sample.
High	Average—The	step	sets	the	pixel	value	for	the	cell	to
the	average	value	of	the	half	of	the	sampled	pixels	with	the
highest	pixel	values.
Low	Average—The	step	sets	the	pixel	value	for	the	cell	to
the	average	value	of	the	half	of	the	sampled	pixels	with	the
lowest	pixel	values.
Very	High	Average—The	step	sets	the	pixel	value	for	the
cell	to	the	average	value	of	the	ninth	of	the	sampled	pixels
with	the	highest	pixel	values.
Very	Low	Average—The	step	sets	the	pixel	value	for	the
cell	to	the	average	value	of	the	ninth	of	the	sampled	pixels
with	the	lowest	pixel	values.



All	Filters—The	step	tries	each	filter	mode,	starting	with
Average	and	ending	with	Very	Low	Average,	stopping	once
a	filter	mode	decodes	correctly.

Mirror	Mode—Specifies	if	the	matrix	appears	normally	in	the
image	or	if	the	matrix	appears	mirrored	in	the	image.

Auto-detect—Sets	the	step	to	determine	if	the	matrix	is
mirrored	automatically.
Normal—Sets	the	step	to	read	matrices	that	appear
normally	in	the	image.
Mirrored—Sets	the	step	to	read	matrices	that	appear
mirrored	in	the	image.

Uncheck/Check	All—Disables/Enables	all	Suggest	Value
checkboxes.
Code	Read—Code	that	the	step	read.
Iterations—Number	of	iterations	the	step	took	in	attempting	to
locate	the	matrix.	If	this	number	is	equal	to	Maximum	Iterations
and	the	step	failed	to	locate	the	matrix,	you	may	be	able	to	locate
the	matrix	by	increasing	the	Maximum	Iterations	value.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Grading	Tab
The	following	controls	are	available	on	the	Grading	tab.

Grading—Specifies	whether	to	enable	matrix	grading.
Overall	Grade—Overall	letter	grade,	which	is	equal	to	the	lowest
of	the	other	five	letter	grades.
Decoding	Grade—Letter	grade	assigned	to	a	data	matrix	based
on	the	step's	success	in	decoding	the	data	matrix.	The	step	sets
this	grade	to	A	if	the	step	could	decode	the	data	matrix,	otherwise
the	step	sets	this	grade	to	F.
Symbol	Contrast—Raw	score	representing	the	percentage
difference	between	the	mean	of	the	reflectance	of	the	darkest	10%
and	lightest	10%	of	the	matrix.
Print	Growth—Print	growth	raw	score	for	the	matrix,	which	is
based	on	the	extent	to	which	dark	or	light	markings	appropriately
fill	their	cell	boundaries.
Axial	Nonuniformity	Grade—Axial	nonuniformity	grade	for	the
matrix.
Unused	Error	Correction	Grade—Unused	error	correction	letter
grade	for	the	matrix.
Code	Read—Code	that	the	step	read.
Iterations—Number	of	iterations	the	step	took	in	attempting	to
locate	the	matrix.	If	this	number	is	equal	to	Maximum	Iterations
and	the	step	failed	to	locate	the	matrix,	you	may	be	able	to	locate
the	matrix	by	increasing	the	Maximum	Iterations	value.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Read	Data	Matrix	Codes	in	Images
Use	the	Data	Matrix	Reader	step	to	decode	a	Data	Matrix	code.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Basic	Tab
Set	the	controls	to	specify	the	shape	of	the	matrix	and	to	improve	the
performance	of	the	step.	Enable	the	Suggest	Value?	checkbox	if	you
want	the	step	to	suggest	values	for	the	controls	when	you	click	the
Suggest	Values	button.



Search	Tab
Set	the	controls	on	the	Search	tab.	Enable	the	Suggest	Value?
checkbox	if	you	want	the	step	to	suggest	values	for	the	controls	when
you	click	the	Suggest	Values	button.



Cell	Sampling	Tab
Set	the	controls	on	the	Cell	Sampling	tab	if	the	step	cannot	consistently
read	the	matrix	because	of	variations	in	lighting	or	matrix	quality.
Otherwise,	use	the	default	values	for	the	controls	on	this	tab.



Grading	Tab
Enable	the	Grading	control	if	you	want	the	step	to	return	AIM	grading
metrics	for	your	matrices.	If	you	do	not	need	grading	information	for	your
application,	disable	the	Grading	control	to	decrease	the	amount	of	time
the	step	takes	to	complete.
The	decoded	characters	read	during	the	step	are	shown	in	the	Code
Read	box.



Data	Matrix	Reader	FAQs
What	is	the	difference	between	the	Suggest	Value?	checkboxes	and
the	Auto-detect	option	available	with	some	parameters?
When	the	Suggest	Value?	checkbox	is	enabled	for	a	given	parameter,
and	you	click	the	Suggest	Values	button,	the	step	suggests	a	value	for
that	parameter	based	on	the	image	currently	loaded	in	the	Processing
window.	The	purpose	of	the	Suggest	Value?	checkboxes	is	to
recommend	parameter	values	that	may	increase	the	reading	speed	of	the
step.	However,	if	you	expect	the	parameter	values	of	the	barcodes	in
your	application	to	vary,	select	the	Auto-detect	option	when	available.
When	the	Auto-detect	option	is	selected	for	a	given	parameter,	the	Data
Matrix	Reader	step	automatically	detects	the	value	for	that	parameter
during	run	time.



QR	Code	Reader
Decodes	a	QR	code.



Main	Tab
The	following	controls	are	available	on	the	Main	tab.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
Code	Read—Specifies	the	code	that	the	step	read.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Basic	Tab
The	following	controls	are	available	on	the	Basic	tab.

Suggest	Value?—When	enabled,	the	step	suggests	a	value	for
the	associated	control	after	the	Suggest	Values	button	is	clicked.
QR	Model—Specifies	the	QR	code	model	to	look	for	in	the	image.

Auto-detect—Sets	the	step	to	determine	the	QR	code
model	automatically.
Micro—Sets	the	step	to	read	Micro	QR	codes	only.	Micro
QR	codes	have	only	a	single	target	in	the	top	left.
Model	1—Sets	the	step	to	read	Model	1	QR	codes	only.
Model	1	QR	codes	have	targets	in	all	corners	except	for	the
bottom	right	corner	and	have	alignment	patterns	along	the
edges.
Model	2—Sets	the	step	to	read	Model	2	QR	codes	only.
Model	2	QR	codes	have	targets	in	all	corners	except	for	the
bottom	right	corner	and	have	alignment	patterns	inside	the
data.

Matrix	Size—Sets	the	size	of	the	QR	code	to	read.
Barcode	Polarity—Specifies	the	data-to-background	contrast	for
the	QR	code.

Auto-detect—Sets	the	step	to	determine	the	QR	code
polarity	automatically.
Black	On	White—Sets	the	step	to	read	QR	codes	with	dark
data	on	a	bright	background.
White	On	Black—Sets	the	step	to	read	QR	codes	with
bright	data	on	a	dark	background.

Min	Cell	Size	(pixels)—Specifies	the	minimum	size,	in	pixels,	of
the	matrix	in	the	image.	If	you	set	this	value	to	0,	the	step	never
excludes	a	matrix	candidate	because	it	is	too	small.
Max	Cell	Size	(pixels)—Specifies	the	maximum	size,	in	pixels,	of
the	matrix	in	the	image.	If	you	set	this	value	to	0,	the	step	never
excludes	a	matrix	candidate	because	it	is	too	large.
Uncheck/Check	All—Disables/Enables	all	Suggest	Value
checkboxes.
Code	Read—Specifies	the	code	that	the	step	read.



Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Advanced	Search	Tab
The	following	controls	are	available	on	the	Advanced	Search	tab.

Suggest	Value?—When	enabled,	the	step	suggests	a	value	for
the	associated	control	after	the	Suggest	Values	button	is	clicked.
Rotation	Mode—Specifies	the	amount	of	QR	code	rotation	to
allow.

Unlimited—The	step	allows	for	unlimited	rotation.
0	Degrees—The	step	allows	for	no	rotation.
90	Degrees—The	step	allows	for	+/-	90	degrees	of	rotation.
180	Degrees—The	step	allows	for	+/-	180	degrees	of
rotation.
270	Degrees—The	step	allows	for	+/-	270	degrees	of
rotation.

Skew	Degrees	Allowed—Amount	of	skew	in	the	QR	code	to
allow.	The	default	is	5	degrees.
Edge	Threshold—Specifies	the	minimum	contrast	a	pixel	must
have	to	be	considered	part	of	a	QR	code	cell	edge.	The	lower	this
value,	the	more	potential	edge	candidates	the	step	examines
during	the	location	phase.	Setting	this	value	too	low	decreases	the
performance	of	the	step	because	the	step	examines	too	many
potential	edge	candidates.	Setting	this	value	too	high	may	also
decrease	the	performance	of	the	step	by	removing	valid	edge
candidates,	making	location	more	difficult.	Setting	this	value	too
high	may	also	cause	the	step	to	fail	to	identify	the	QR	code
because	all	edge	candidates	are	eliminated.
Code	Read—Specifies	the	code	that	the	step	read.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Value—Allows	the	algorithm	to	detect	the	best	values	for
parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Cell	Sampling	Tab
The	following	controls	are	available	on	the	Cell	Sampling	tab.

Suggest	Value?—When	enabled,	the	step	suggests	a	value	for
the	associated	control	after	the	Suggest	Values	button	is	clicked.
Demodulation	Mode—Specifies	the	mode	that	the	step	uses	to
determine	which	cells	are	on	and	which	cells	are	off	in	the	QR
code.

Auto-detect—The	step	tries	each	demodulation	mode	and
use	the	one	which	decodes	the	QR	code	within	the	fewest
iterations	and	utilizes	the	least	amount	of	error	correction.
Histogram—The	step	uses	a	histogram	of	all	of	the	matrix
cells	to	calculate	a	threshold.	This	threshold	determines	if	a
cell	is	on	or	off.	This	is	the	fastest	method	but	requires
images	with	consistent	levels	of	contrast	in	the	matrix.
Local	Contrast—The	step	examines	each	neighbor	of	a	cell
to	determine	if	the	cell	is	on	or	off.	This	method	is	slower	but
works	with	images	that	have	inconsistent	levels	of	contrast
in	the	matrix.
Combination—The	step	uses	the	histogram	of	the	matrix	to
calculate	a	threshold.	For	cells	with	pixel	values	that	are
sufficiently	below	or	above	this	threshold,	the	step	uses	the
threshold	to	determine	if	the	cell	is	on	or	off.	If	the	cell	pixel
values	are	close	to	the	threshold,	the	step	uses	the	Local
Contrast	method	to	determine	if	the	cell	is	on	or	off.	This
method	is	slower	but	works	with	images	that	have	extremely
low	cell	fill	percentages	or	gross	print	growth	errors.
All—The	step	tries	Histogram	first,	then	Local	Contrast,	and
then	Combination,	stopping	when	one	mode	is	successful.

Cell	Sample	Size—Specifies	the	cell	sample	size,	in	pixels,	to	use
to	determine	if	each	cell	is	on	or	off.

Auto-detect—The	step	tries	each	sample	size	and	uses	the
one	that	decodes	the	QR	code	in	the	fewest	iterations	using
the	least	amount	of	error	correction.
1×1	The	step	uses	a	1×1	sized	sample	from	each	cell.
2×2—The	step	uses	a	2×2	sized	sample	from	each	cell.



3×3—The	step	uses	a	3×3	sized	sample	from	each	cell.
4×4—The	step	uses	a	4×4	sized	sample	from	each	cell.
5×5—The	step	uses	a	5×5	sized	sample	from	each	cell.
6×6—The	step	uses	a	6×6	sized	sample	from	each	cell.
7×7—The	step	uses	a	7×7	sized	sample	from	each	cell.

Cell	Filter	Mode—Specifies	the	mode	the	step	uses	to	determine
the	pixel	value	for	each	cell.	If	Cell	Sample	Size	is	1×1,	the	value
of	the	single	samples	pixel	always	determines	the	pixel	value	for
the	cell.

Auto-detect—The	step	tries	all	filter	modes	and	uses	the
one	that	decodes	the	QR	code	within	the	fewest	iterations
and	utilizing	the	least	amount	of	error	correction.
Average—The	step	sets	the	pixel	value	for	the	cell	to	the
average	of	the	sampled	pixels.
Median—The	step	sets	the	pixel	value	for	the	cell	to	the
median	of	the	sampled	pixels.
Central	Average—The	step	sets	the	pixel	value	for	the	cell
to	the	average	of	the	pixels	in	the	center	of	the	cell	sample.
High	Average—The	step	sets	the	pixel	value	for	the	cell	to
the	average	value	of	the	half	of	the	sampled	pixels	with	the
highest	pixel	values.
Low	Average—The	step	sets	the	pixel	value	for	the	cell	to
the	average	value	of	the	half	of	the	sampled	pixels	with	the
lowest	pixel	values.
Very	High	Average—The	step	sets	the	pixel	value	for	the
cell	to	the	average	value	of	the	ninth	of	the	sampled	pixels
with	the	highest	pixel	values.
Very	Low	Average—The	step	sets	the	pixel	value	for	the
cell	to	the	average	value	of	the	ninth	of	the	sampled	pixels
with	the	lowest	pixel	values.
All	Filters—The	step	tries	each	filter	mode,	starting	with
Average	and	ending	with	Very	Low	Average,	stopping	once
a	filter	mode	decodes	correctly.

Mirror	Mode—Specifies	if	the	QR	code	appears	normally	in	the
image	or	if	the	QR	code	appears	mirrored	in	the	image.

Auto-detect—Sets	the	step	to	determine	if	the	QR	code	is



mirrored	automatically.
Normal—Sets	the	step	to	read	QR	codes	that	appear
normally	in	the	image.
Mirrored—Sets	the	step	to	read	QR	codes	that	appear
mirrored	in	the	image.

Uncheck/Check	All—Disables/Enables	all	Suggest	Value
checkboxes.
Code	Read—Specifies	the	code	that	the	step	read.
Elapsed	Time—Amount	of	time	the	step	took	to	read	the	code.
Suggest	Values—Allows	the	algorithm	to	detect	the	best	values
for	parameters	whose	Suggest	Value?	checkboxes	are	enabled.



Read	QR	Codes	in	Images
Use	the	QR	Code	Reader	step	to	decode	a	QR	code.



Main	Tab
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Verify	that	the	Reposition	Region	of	Interest	option	is	enabled	if

you	want	to	link	the	region	of	interest	specified	in	this	step	to	a
previously	defined	coordinate	system.
Link	the	region	of	interest	to	a	coordinate	system	if	the	position	of
the	object	under	inspection	changes	from	image	to	image,	and
you	need	to	adjust	the	position	of	the	region	of	interest	to	match
the	new	location	of	the	object.



Basic	Tab
Set	the	controls	on	the	Basic	tab	to	specify	the	shape	of	the	QR	code
and	to	improve	the	performance	of	the	step.	Enable	the	Suggest	Value?
checkbox	if	you	want	the	step	to	suggest	values	for	the	controls	when
you	click	the	Suggest	Values	button.



Advanced	Search	Tab
Set	the	controls	on	the	Advanced	Search	tab.	Enable	the	Suggest
Value?	checkbox	if	you	want	the	step	to	suggest	values	for	the	controls
when	you	click	the	Suggest	Values	button.



Cell	Sampling	Tab
Set	the	controls	on	the	Cell	Sampling	tab	if	the	step	cannot	consistently
read	the	matrix	because	of	variations	in	lighting	or	matrix	quality.
Otherwise,	use	the	default	values	for	the	controls	on	this	tab.
The	decoded	characters	read	during	the	step	are	shown	in	the	Code
Read	box.



Read	QR	Code	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



PDF417	Code	Reader
Use	the	PDF417	Code	Reader	function	to	decode	a	PDF417	2D
barcode.

Step	Name—Name	to	give	the	step.
Reposition	Region	of	Interest—When	enabled,	the	step
dynamically	repositions	the	region	of	interest	based	on	a
coordinate	system	you	built	in	a	previous	step.
Reference	Coordinate	System—Coordinate	system	to	which	you
want	to	link	the	region	of	interest.
Code	Read—Code	that	the	step	read.
Errors	Corrected—Number	of	errors	that	the	barcode	reading
algorithm	corrected.
Erasures	Corrected—Number	of	erasures	that	the	barcode
reading	algorithm	corrected.
Rows—Number	of	rows	in	the	barcode.
Columns—Number	of	columns	in	the	barcode.



Read	PDF417	Codes	in	Images
1.	 In	the	Step	Name	control,	enter	a	descriptive	name	for	the	step.
2.	 Draw	a	region	of	interest	(ROI)	around	the	barcode.	Make	sure

the	ROI	contains	all	of	the	barcode.
The	code	read	during	the	step	is	shown	in	the	Code	Read	box.



PDF417	Code	Reader	FAQs
Currently,	there	are	no	FAQs	associated	with	this	processing	function.



Vision	Assistant	Express	VI	Controls
Use	the	Vision	Assistant	Express	VI	to	create,	edit,	and	run	vision
applications	in	LabVIEW.

Required	Controls—The	following	controls	are	required	and	will
always	appear	on	the	Express	VI	connector	pane.

Image	Src—Specifies	a	reference	to	the	source	image
Image	Dst—Specifies	a	reference	to	the	destination	image.
error	in	(no	error)—Describes	error	conditions	that	occur
before	this	VI	runs.

User-Selected	Controls—Displays	the	controls	associated	with	the
processing	functions	used	on	the	image.	The	controls	displayed
depend	on	the	processing	functions	you	selected.
Required	Indicators

Image	Dst	Out—Specifies	a	reference	to	the	destination
image.	If	Image	Dst	is	connected,	Image	Dst	Out	is	the
same	as	Image	Dst.	Otherwise,	Image	Dst	Out	refers	to	the
image	referenced	by	Image	Src.
error	out—Contains	error	information.

User-Selected	Indicators—Displays	the	indicators	associated	with
the	processing	functions	used	on	the	image.	The	indicators
displayed	depend	on	the	processing	functions	you	selected.
Create	Destination	Image—When	enabled,	the	Express	VI
internally	creates	a	destination	image	and	outputs	that	image.

Note		You	are	responsible	for	disposing	of	the	images	that
are	no	longer	needed	in	your	application.

Process	Images—Navigates	to	the	Process	Images	step	of	the
Vision	Assistant	Express	VI	Wizard.
Select	Controls—Navigates	to	the	Select	Controls	and
Indicators	step	of	the	Vision	Assistant	Express	VI	Wizard.
Finish—Click	Finish	to	return	to	LabVIEW	and	update	the	Express
VI.
Cancel—Click	Cancel	to	return	to	LabVIEW	without	modifying	the
existing	Express	VI.
Image	Caching—When	Image	caching	is	enabled,	the	Vision



Assistant	Express	VI	automatically	gets	the	last	image	used	in
LabVIEW.	To	disable/enable	image	caching,	right-click	the	Vision
Assistant	Express	VI	in	the	block	diagram	and	select	Disable
Image	Caching	or	Enable	Image	Caching.



Use	the	Vision	Assistant	Express	VI
Use	the	Vision	Assistant	Express	VI	to	quickly	create	a	vision	application
and	to	select	the	controls	and	indicators	that	you	want	to	be	able	to
programmatically	change	in	LabVIEW.
Complete	the	following	steps	if	you	are	using	the	Vision	Assistant
Express	VI	for	the	first	time	in	your	VI.	If	you	are	using	the	Vision
Acquisition	Express	VI,	skip	this	section	and	proceed	to	the	Using	the
Vision	Acquisition	Express	VI	with	the	Vision	Assistant	Express	VI
section.
When	the	Vision	Assistant	Express	VI	is	placed	on	the	LabVIEW	block
diagram,	Vision	Assistant	opens.

1.	 Open	an	image	to	process	from	the	Vision	Assistant	environment.

Click	 	Open	Image	or	click	File»Open	Image.	Browse	to	the
image	you	want	to	open	and	click	Open.

2.	 Develop	your	vision	application	using	the	Vision	Assistant
processing	functions.

3.	 When	you	have	finished	developing	your	application,	click	Select
Controls.

4.	 Select	the	controls	and	indicators	that	you	want	to	be	able	to
programmatically	set	in	LabVIEW.	The	selected	controls	and
indicators	appear	on	the	Express	VI	connector	pane	after	you	exit
the	configuration	interface.

Note		The	Required	Controls	and	Required	Indicators
appear	on	the	Express	VI	connector	pane	by	default.

5.	 When	you	are	finished	selecting	controls	and	indicators,	complete
one	of	the	following	options:

Click	Finish	to	return	to	LabVIEW	and	update	the	Express
VI.
Click	Cancel	to	return	to	LabVIEW	without	modifying	the
Express	VI.
Click	Process	Images	to	modify	your	application.

6.	 To	edit	the	Vision	Assistant	Express	VI,	double-click	the	Express
VI	on	the	block	diagram.

Note		Any	changes	you	make	in	the	Express	VI	dialog	box



could	result	in	broken	wires	on	the	block	diagram.



Use	the	Vision	Assistant	Express	VI	with	the	Vision
Acquisition	Express	VI

Note		You	must	have	NI	Vision	Acquisition	Software	installed	to
access	the	Vision	Acquisition	Express	VI.

Use	the	Vision	Acquisition	Express	VI	to	easily	configure	acquisitions
from	a	camera	or	to	simulate	an	acquisition.	Use	the	Vision	Assistant
Express	VI	to	process	the	image	acquired	with	the	Vision	Acquisition
Express	VI.

1.	 Place	the	Vision	Acquisition	Express	VI	on	the	block	diagram	and
configure	your	acquisition.	Refer	to	the	NI	Vision	Acquisition
Express	VI	Help	for	more	information.

Note		You	must	click	the	Test	button	in	the	Configure
Acquisition	Settings	step	of	the	Vision	Acquisition
Express	VI	wizard	to	be	able	to	use	the	acquired	image	in
Vision	Assistant.

2.	 Place	the	Vision	Assistant	Express	VI	on	the	block	diagram.
Vision	Assistant	will	automatically	open	the	image	acquired	from
the	Configure	Acquisition	Settings	step	of	the	Vision
Acquisition	Express	VI	wizard.

Note		This	feature	only	works	when	the	Vision	Assistant
Express	VI	is	placed	on	the	block	diagram.	Otherwise,
Vision	Assistant	follows	the	behavior	described	in	Vision
Assistant	Express	VI	Image	Caching.

3.	 Develop	your	vision	application	using	the	Vision	Assistant
processing	functions.

4.	 When	you	have	finished	developing	your	application,	click	Select
Controls.

5.	 Select	the	controls	and	indicators	that	you	want	to	be	able	to
programmatically	set	in	LabVIEW.	The	selected	controls	and
indicators	appear	on	the	Express	VI	connector	pane	after	you	exit
the	configuration	interface.

Note		The	Required	Controls	and	Required	Indicators
appear	on	the	Express	VI	connector	pane	by	default.

6.	 When	you	are	finished	selecting	controls	and	indicators,	complete



one	of	the	following	options:
Click	Finish	to	return	to	LabVIEW	and	update	the	Express
VI.
Click	Cancel	to	return	to	LabVIEW	without	modifying	the
Express	VI.
Click	Process	Images	to	modify	your	application.

7.	 To	edit	the	Vision	Assistant	Express	VI,	double-click	the	Express
VI	on	the	block	diagram.

Note		Any	changes	you	make	in	the	Express	VI	dialog	box
could	result	in	broken	wires	on	the	block	diagram.

Related	Topics
Vision	Assistant	Express	VI	Image	Caching
Use	Coordinate	Systems	with	Vision	Assistant	Express	VIs



Vision	Assistant	Express	VI	FAQs
How	can	I	prevent	IMAQ	ReadImageAndVisionInfo	File	not	found,	IMAQ
ReadClassifier	File	not	found,	and	IMAQ	OCR	Read	File	File	not	found
errors	when	running	the	Vision	Assistant	Express	VI	on	a	remote
target?
This	error	occurs	when	the	Vision	Assistant	Express	VI	runs	on	a	remote
target	and	cannot	locate	the	template	file	for	a	classification,	pattern
matching,	geometric	matching,	or	OCR	step.	To	correct	this	error,	you
must	manually	copy	the	template	file	to	the	remote	target,	in	a	location
that	corresponds	to	the	location	you	saved	the	template	on	the
development	computer.	For	example,	if	you	saved	template.png	on	your
development	computer	at	C:\images,	you	must	copy	template.png	to	the
<root>\images	directory	on	the	remote	target.	Open	the	Vision	Assistant
step	to	see	the	file	path	where	the	template	is	saved.



Vision	Assistant	Express	VI	Image	Caching
When	image	caching	is	enabled,	the	Vision	Assistant	Express	VI
automatically	gets	the	last	image	used	when	the	VI	was	run.	To
disable/enable	image	caching,	right-click	the	Vision	Assistant	Express	VI
in	the	block	diagram	and	select	Disable	Image	Caching	or	Enable
Image	Caching.	Image	caching	is	enabled	by	default.
When	you	double-click	the	Vision	Assistant	Express	VI	to	edit	it,	Vision
Assistant	opens	the	last	image	used	when	the	VI	was	run.	If	you	have	not
run	the	VI,	the	Vision	Assistant	Express	VI	will	re-open	the	last	image
that	was	opened.
If	you	are	using	the	Vision	Assistant	Express	VI	with	the	Vision
Acquisition	Express	VI,	the	first	time	you	place	the	Vision	Assistant
Express	VI	on	the	block	diagram,	Vision	Assistant	will	automatically	open
the	image	acquired	from	the	Configure	Acquisition	Settings	step	of	the
Vision	Acquisition	Express	VI	wizard.



Use	Coordinate	Systems	with	Vision	Assistant
Express	VIs
You	can	create	a	coordinate	system	in	one	instance	of	a	Vision	Assistant
Express	VI	and	reference	that	coordinate	system	in	a	second	instance	of
a	Vision	Assistant	Express	VI.
Complete	the	following	steps	to	set	up	a	reference	coordinate	system
using	the	Vision	Assistant	Express	VI.

1.	 Place	the	Vision	Assistant	Express	VI	on	the	LabVIEW	block
diagram.

2.	 Develop	your	vision	application	using	the	Vision	Assistant
processing	functions.

3.	 Set	up	a	coordinate	system	using	the	Set	Coordinate	System
step.	Coordinate	system	origins	are	based	on	feature	locations.
You	can	locate	features	using	the	following	steps:	Edge	Detector,
Straight	Edge	(Rake),	Adv.	Straight	Edge,	Circular	Edge	(Spoke),
Detect	Objects,	Pattern	Matching,	Geometric	Matching,	Clamp,
and	Geometry.

4.	 When	you	have	finished	developing	your	application,	click	Select
Controls.

5.	 Select	the	controls	and	indicators	that	you	want	to	be	able	to
programmatically	set	in	LabVIEW.	To	use	a	reference	coordinate
system	in	another	Express	VI	instance,	you	must	select	the
Coordinate	System	Out	control.

6.	 Click	Finish	to	return	to	LabVIEW	and	update	the	Express	VI.
7.	 Place	a	second	instance	of	the	Vision	Assistant	Express	VI	on	the

LabVIEW	block	diagram.	If	you	configured	a	Set	Coordinate
System	step	in	the	first	instance	of	the	Vision	Assistant	Express
VI,	the	Select	Coordinate	System	dialog	will	open.

8.	 If	you	want	to	use	the	coordinate	system	defined	in	the	first
instance	of	the	Vision	Assistant	Express	VI	as	a	reference
coordinate	system	in	the	second	instance	of	the	Vision	Assistant
Express	VI,	select	I	want	to	use	a	coordinate	system	defined	in
the	following	VI	in	this	Express	VI.

9.	 Select	the	VI	that	creates	the	coordinate	system	from	the	drop-
down	listbox.



10.	 When	the	second	instance	of	the	Vision	Assistant	Express	VI
dialog	opens,	you	will	see	a	Set	Coordinate	System	step	in	your
script.	You	cannot	edit	the	step	in	the	second	instance,	but	you
can	delete	the	step	from	the	script.	The	Express	VI	will	be	created
with	a	Coordinate	System	in	input	control.	It	is	your	responsibility
to	manually	wire	the	Coordinate	System	Out	from	the	first
Express	VI	to	the	Coordinate	System	in	of	the	second	Express
VI.



Considerations
When	you	open	an	instance	of	the	Vision	Assistant	Express	VI	that
references	a	coordinate	system	from	a	previous	instance	of	an
Express	VI,	Vision	Assistant	opens	with	the	last	image	used	to
configure	the	coordinate	system.	You	cannot	modify	the	image
because	the	regions	of	interest	you	define	in	subsequent	steps
must	be	able	to	reference	the	image.
The	image	used	to	define	the	coordinate	system	must	be	available
when	you	edit	the	Express	VI	that	references	that	coordinate
system.	This	means	you	must	edit	or	run	the	Express	VI	that
defines	the	coordinate	system	before	editing	the	Express	VI	that
references	the	coordinate	system.
If	you	try	to	edit	the	Express	VI	when	an	image	is	not	available,
Vision	Assistant	prompts	you	to	either	run	the	VI	that	defines	the
coordinate	system	or	disable	the	repositioning	of	regions	of	interest
in	the	steps	that	reference	that	specific	coordinate	system.



Migrating	to	a	development	environment
Creating	a	LabVIEW	VI
You	can	create	a	LabVIEW	VI	using	Vision	Assistant.	Refer	to	LabVIEW
VI	Creation	(Tools»Create	LabVIEW	VI)	for	more	information	about
creating	a	LabVIEW	VI.



Creating	C	Code
You	can	create	C	code	using	Vision	Assistant.	Refer	to	C	Code	Creation
(Tools»Create	C	Code)	for	more	information	about	creating	C	code.



Creating	a	Builder	File
A	Builder	file	is	a	tab-delimited	ASCII	text	file	that	contains	the	processing
functions	and	relevant	parameters	for	a	script	that	you	created	and	saved
in	Vision	Assistant.	You	can	implement	the	algorithm	defined	by	the
Builder	file	in	Visual	Basic	using	the	NI	Vision	machine	vision	and	image
processing	libraries.
Complete	the	following	steps	to	save	a	Builder	file:

1.	 Select	Tools»Builder	File.
2.	 Browse	to	the	location	in	which	you	want	to	save	the	Builder	file.
3.	 Type	a	File	name.
4.	 Click	Save.

To	view	a	Builder	file,	open	it	in	a	text	editor,	word	processor,	or
spreadsheet.
Related	Topics
Creating	C	Code
Creating	a	LabVIEW	VI
Script	Window
Scripting



Create	C	Code
Creates	C	code	using	a	wizard	to	implement	the	different	steps	of	the
script.

Note		You	must	have	a	C	compiler	and	the	NI	Vision	8.2.1
Development	Module	or	later	installed	to	use	the	Create	C	Code
function.
Implementation	File	Name—Name	of	the	C	file	that	implements
the	image	processing	algorithm	you	prototyped	in	the	script.
Main	File	Name—Name	of	the	C	file	that	implements	a	main
function,	which	acquires	an	image	from	a	source,	then	calls	the
image	processing	function	created	in	the	Implementation	File.



Image	Source
Select	the	source	image	from	the	following	options:

Image	File—Creates	the	C	code	to	open	an	image	file	from	the
hard	drive.
Acquisition	from	an	NI	Image	Acquisition	device—Creates	the
C	code	to	acquire	an	image	from	a	camera	connected	to	an	NI
image	acquisition	device.
Triggered	Acquisition	from	an	NI	Image	Acquisition	device—
Creates	the	C	code	to	perform	a	triggered	acquisition	with	an	NI
image	acquisition	device.
Acquisition	from	an	IEEE	1394	Camera—Creates	the	C	code	to
acquire	an	image	from	an	IEEE	1394	camera	connected	to	an	NI
image	acquisition	device.
Note		Vision	Assistant	acquires	images	from	interface	img0.	If	you
have	more	than	one	image	acquisition	device	installed	in	the
computer	and	want	to	use	a	different	interface,	you	must	modify
the	interface	name	within	the	created	C	Code.



Create	C	Code
1.	 Select	Tools»Create	C	Code.
2.	 Enter	the	file	name	under	which	you	want	to	save	the	C	code	in

the	Implementation	File	Name	control.
3.	 If	you	would	like	the	C	Code	Creation	Wizard	to	generate	a	main

function,	which	acquires	an	image	from	a	source,	enable	the
Create	Main	Function	option.	Enter	the	name	of	the	main
function	file	in	the	Main	File	Name	control.

4.	 Select	the	Image	Source	for	the	C	Code	creation.	The	following
image	source	options	are	available:

Image	File—Creates	the	C	code	to	open	an	image	file	from
the	hard	drive.
Acquisition	from	an	NI	Image	Acquisition	device—
Creates	the	C	code	to	acquire	an	image	from	a	camera
connected	to	an	NI	image	acquisition	device.
Triggered	Acquisition	from	an	NI	Image	Acquisition
device—Creates	the	C	code	that	performs	a	triggered
image	acquisition	with	an	NI	image	acquisition	device.
Acquisition	from	an	IEEE	1394	Camera—Creates	the	C
code	to	acquire	an	image	with	NI-IMAQ	for	IEEE	1394
Cameras.
Note		You	must	have	NI-IMAQ	for	IEEE	1394	Cameras
installed	to	create	the	code	to	acquire	images	from	IEEE
1394	cameras.

5.	 Browse	to	the	location	to	which	you	want	to	save	the	generated
files.

6.	 If	you	would	like	to	add	the	generated	files	to	a	LabWindows/CVI
project,	enable	the	Add	Files	to	LabWindows/CVI	project
option.	If	you	have	a	LabWindows/CVI	Project	open	to	which	you
want	to	add	the	generated	files,	enable	the	Use	Currently	Open
Project	option.	Enable	the	Create	New	Project	option	to	add	the
files	to	a	new	project.

Note		This	option	is	available	only	if	LabWindows/CVI	is
installed	on	your	computer.



Create	LabVIEW	VI
Creates	a	LabVIEW	VI	using	a	wizard	to	implement	the	different	steps	of
the	script.

Note		You	must	have	LabVIEW	7.1	or	later	and	the	NI	Vision	8.2.1
Development	Module	or	later	installed	to	use	the	Create	LabVIEW
VI	function.
Select	the	Vision	Assistant	script—Select	the	script	from	the
following	options:
Current
Script

Creates	a	diagram	for	the	current	Vision	Assistant
script.

Script	File Creates	a	diagram	according	to	a	script	file	you	have
saved	on	the	hard	drive

Script	File
Path

Path	of	the	script	file	you	want	to	use	to	create	the	VI.

Select	the	image	source—Select	the	source	image	from	the
following	options:
Image	Control Creates	an	Image	In	control	and	Image	Out

indicator,	allowing	you	to	use	the	created	VI
as	a	sub-VI

Image	File Creates	the	diagram	to	open	an	image	file
from	the	hard	drive.

Image	Acquisition Creates	the	diagram	to	acquire	an	image
from	a	camera	connected	to	an	NI	image
acquisition	device.

Image	Acquisition
from	an	IEEE	1394
Camera

Creates	the	diagram	to	acquire	an	image
from	an	IEEE	1394	camera.

Triggered	Image
Acquisition

Creates	the	diagram	to	perform	a	triggered
acquisition	with	an	NI	image	acquisition
device.

Note		Vision	Assistant	creates	the	VI	to	acquire	images	from	the
interface	img0.	If	you	have	more	than	one	image	acquisition	device
installed	in	the	computer	and	want	to	use	a	different	interface,	you



must	modify	the	interface	name	in	the	created	VI.



Create	a	LabVIEW	VI
1.	 Select	Tools»Create	LabVIEW	VI.
2.	 Select	the	version	of	LabVIEW	that	you	want	to	use	to	create	the

VI.
If	you	have	several	versions	of	LabVIEW	installed,	the	wizard
displays	a	list	of	available	LabVIEW	versions	that	you	can	use	to
create	the	VI.

3.	 Browse	to	the	location	to	which	you	want	to	save	the	VI.
4.	 Click	Next.
5.	 Select	the	script	you	want	to	use	to	create	the	VI.	Current	Script

creates	the	VI	from	the	script	that	is	currently	loaded	in
Vision	Assistant.	Script	File	allows	you	to	browse	for	a	script	file.

6.	 Click	Next.
7.	 Select	the	image	source	for	the	VI.

Image	Control—Creates	an	Image	In	control	and	Image
Out	indicator,	allowing	you	to	use	the	created	VI	as	a	sub-
VI.
Image	File—Creates	the	diagram	to	open	an	image	file
from	the	hard	drive.
Image	Acquisition—Creates	the	diagram	to	acquire	an
image	from	a	camera	connected	to	an	NI	image	acquisition
device.
Triggered	Image	Acquisition—Creates	the	diagram	that
performs	a	triggered	image	acquisition	with	an	NI	image
acquisition	device.
Image	Acquisition	from	an	IEEE	1394	Camera—Creates
the	diagram	to	acquire	an	image	with	an	IEEE	1394
camera.
Note		You	must	have	NI-IMAQ	for	IEEE	1394	Cameras	1.5
or	later	installed	to	create	the	code	to	acquire	images	from
IEEE	1394	cameras.

8.	 Click	Finish.



Using	the	Solution	Wizard
Use	the	Solution	Wizard	to	view	typical	uses	of	NI	Vision	in	imaging	and
machine	vision	applications.

1.	 Select	Help»Solution	Wizard.
2.	 Select	an	industry	and	an	application	from	the	list	in	the	left

window.
3.	 Look	at	the	image	representing	the	application	and	read	the	brief

problem	description.
4.	 Click	Load	Solution	to	load	images	and	a	solution	script	into

Vision	Assistant.	When	you	load	the	solution	into	Vision	Assistant,
run	the	script	on	the	Solution	Wizard	images	or	on	the	own
images.	You	also	can	alter	the	script	to	experiment	with	different
functions	and	parameters.

Related	Topics
Getting	help	in	Vision	Assistant



Fusebox	Inspection
Application	Type Inspection
Image	Characteristics Color
Machine	Vision	Tool(s) Color	Matching

The	fusebox	inspection	determines	if	all	the	color-coded	fuses	are
present	and	in	the	correct	locations	in	the	fuse	box.	The	application	uses
color	matching	to	compare	the	color	information	at	each	fuse	socket	in
the	image	with	the	expected	color	for	the	fuse.
Color	Matching—Compares	the	color	information	contained	in	the
fuse	labeled	20	with	the	color	information	in	two	predefined	regions
where	you	expect	to	find	the	fuse.	In	this	application,	it	is	assumed	that
the	fuse	boxes	you	are	inspecting	are	always	located	at	the	same
position	in	the	image.	The	Color	Matching	function	calls	on	the	color
information	of	the	fuse,	which	has	been	learned	and	stored	in	the	script.
That	color	information	is	compared	with	the	color	information	in	the
search	regions.	If	the	correct	fuse	is	identified,	the	Color	Matching
function	returns	a	match	score	greater	than	750.	If	the	correct	fuse	is
not	present	in	either	of	the	search	regions,	the	Color	Matching	function
returns	a	lower	score	and	the	fuse	box	fails	the	inspection	process.
Color	Matching—Compares	the	color	information	contained	in	the
fuse	labeled	25	with	the	color	information	from	two	predefined	regions
in	the	image	where	you	expect	to	find	the	fuse.

Note		There	are	two	types	of	colors	associated	with	the	fuse
labeled	3,	so	color	matching	is	performed	twice	(steps	3	and	4).

Color	Matching—Compares	the	color	information	contained	in	the	first
type	of	fuse	labeled	3	with	the	color	information	from	two	predefined
regions	in	the	image	where	you	expect	to	find	the	fuse.
Color	Matching—Compares	the	color	information	contained	in	the
second	type	of	fuse	labeled	3	to	same	regions	used	in	Step	3.
The	fusebox	passes	inspection	for	the	fuse	labeled	3	if	each	of	the	two
search	regions	passes	at	least	one	of	the	color	matching	tasks	defined
in	Steps	3	and	4.
Color	Matching—Compares	the	color	information	contained	in	the
fuse	labeled	10	to	a	predefined	region	in	the	image	of	the	fusebox



where	you	expect	to	locate	the	fuse.



Sparkplug	Inspection
Application	Type Inspection
Image
Characteristics

Monochrome;	Good	Contrast;	Very	Little	Image
Noise

Machine	Vision
Tool(s)

Edge	Detection;	Caliper

The	sparkplug	inspection	determines	the	width	of	the	spark	plug	base
and	the	gap	between	the	electrodes	using	the	Edge	Detection	and
Caliper	functions.
Edge	Detection:	All	Edges	(Simple	Edge	Detection)—Finds	points
on	either	end	of	the	base	of	the	spark	plug.	The	edge	detection	process
looks	for	edges	(sharp	transitions	in	pixel	values)	along	a	search	path.
The	search	path	is	defined	as	the	line	that	is	drawn	across	the	base.
The	line	is	drawn	long	enough	so	that	it	always	cuts	through	the	base
even	if	the	spark	plug	moves	from	image	to	image.
The	simple	edge	tool	is	used	to	detect	the	edges	because	the	spark
plug	is	well	contrasted	from	the	image	and	there	is	no	noise	in	the
image.	Based	on	the	line	profile	obtained	along	the	search	line,	a
threshold	value	of	128	is	used	to	detect	the	edges.
Edge	Detection:	All	Edges	(Simple	Edge	Detection)—Finds	points
on	the	spark	plug	electrodes	on	either	side	of	the	gap.	In	this	case,	the
search	line	is	drawn	so	it	cuts	across	the	spark	plug	electrodes	on
either	side	of	the	gap.
Caliper—Measures	the	distance	between	the	points	found	on	the	base
to	measure	the	width	of	the	base.	The	distance	between	the	points
found	on	either	side	of	the	gap	indicates	the	length	of	the	gap.



Cell	Analysis
Application	Type Counting;	Identification
Image	Characteristics Monochrome;	Good	Contrast;	Noisy
Image	Processing	Tool(s) Filtering;	Thresholding

The	cell	analysis	example	counts	the	number	of	cells	and	measures	their
areas	using	the	Grayscale	Filtering,	Thresholding,	and	Binary	Image
Inversion	functions.
Filters:	Smoothing—Gaussian—Smoothes	the	image	using	a
Gaussian	filter.
Filters:	Edge	Detection—Laplacian—Highlights	the	edges	in	the
image	using	a	Laplacian	filter.	This	operation	finds	edges	in	the	filtered
image	and	adds	them	to	the	original	image.	This	operation	helps
increase	the	separation	between	the	cells	and	the	background.
Threshold:	Auto	Threshold—Metric—Separates	the	dark	regions	in
the	image	from	the	rest	of	the	image	using	an	automatic	threshold
technique.	In	this	case,	the	dark	regions	in	the	image	correspond	to	the
cells.	The	regions	corresponding	to	the	medium	in	which	the	cells	are
present	appear	as	foreground	in	the	resulting	binary	image.
Basic	Morphology:	Proper	Close—Improves	the	shape	of	the
particles	in	the	binary	image	by	smoothing	the	boundary	of	the
particles,	filling	small	holes	in	the	particles,	and	closing	small	gaps
along	the	perimeter	of	the	particles.
Adv.	Morphology:	Fill	Holes—Fills	any	size	holes	in	a	particle.
Particle	Filter—Removes	unwanted	particles	from	the	binary	image
using	the	particle	filter.	This	application	only	analyzes	particles	that	are
mostly	circular	and	larger	than	10	pixels.	Particles	that	have	a	Heywood
Circularity	Factor	that	falls	outside	of	the	0	to	1.40	range	or	have	a	pixel
area	of	less	than	10	are	removed.
Particle	Analysis—Analyzes	the	properties	of	the	remaining	particles
(cells)	in	the	image.	The	particle	measurement	function	can	analyze	up
to	50	different	properties	of	a	particle.



Culture	Analysis
Application	Type Segmentation;	Counting
Image	Characteristics Monochrome;	Good	Contrast;	Some	Speckle

Noise
Image	Processing
Tool(s)

Filtering;	Thresholding;	Advanced	Morphology

The	culture	analysis	example	distinguishes	the	boundaries	of	each	cell	in
a	cluster	of	cells,	separates	the	cluster	into	its	individual	cells,	and
overlays	the	cell	boundaries	over	the	original	image.
Image	Buffer:	Add	Copy	(1)—Stores	a	copy	of	the	original	image	into
Buffer	#1	of	the	image	buffer	for	later	use.	The	final	results	are	overlaid
on	this	image.
Filters:	Smoothing—Median—Smoothes	the	image.	The	median	filter
removes	any	speckle	noise	that	is	present	in	the	image.	This	prevents
speckle	noise	from	being	highlighted	as	a	detail	in	the	next	step.
Filters:	Convolution—High	Level	Detail—Highlights	details	in	the
image.	The	convolution	filter	highlights	regions	in	the	image	where
there	are	sharp	changes	in	pixel	values.	These	regions	correspond	to
the	boundaries	of	the	cells	and	other	noisy	pixels	that	may	be	present
in	the	image.
Threshold:	Auto-Threshold—Metric—Separates	dark	regions	from
the	rest	of	the	image.	In	this	case,	the	dark	regions	in	the	image
correspond	to	the	cells.	The	regions	corresponding	to	the	medium	in
which	the	cells	are	present	appear	as	background	in	the	foreground
binary	image.
Adv.	Morphology:	Remove	Small	Particles—Removes	noise
particles	in	the	binary	image.	Any	particle	removed	by	two	iterations	of
the	erosion	operation	is	considered	to	be	a	noise	particle	and	removed
from	the	image.	The	rest	of	the	particles	are	left	untouched.
Adv.	Morphology:	Separate	Objects—Separates	touching	particles	in
the	image.	This	step	helps	to	separate	cells	that	may	be	touching	each
other	at	a	few	pixels	along	their	boundaries.	At	the	end	of	this	step,	the
binary	image	contains	particles	corresponding	to	the	cells	that	need	to
be	counted.



Adv.	Morphology:	Label	Objects—Labels	each	particle	with	a	unique
ID.	When	you	display	a	labeled	image	with	a	binary	palette,	each
particle	appears	as	with	a	different	color.	Labeling	helps	you	determine
if	the	cells	have	been	separated	correctly.
Basic	Morphology:	Gradient	Out—Finds	the	outer	boundary	of	each
particle	in	the	image.
Operators:	Multiply—Multiplies	the	image	by	255	to	extend	the
dynamic	of	the	image	from	(0,1)	to	(0,255).	Grayscale	255	is
represented	as	white,	which	becomes	the	overlap	color	in	the	next
step.
Operators:	Add—Adds	the	processed	image	to	the	original	image,
which	was	stored	in	Buffer	#1	of	the	image	buffer.	The	addition	process
adds	the	particle	boundary	information	to	the	original	image,	outlining
the	boundary	of	each	cell.



Printed	Circuit	Board	Inspection
Application	Type Inspection
Image	Characteristics Monochrome
Machine	Vision	Tool(s) Pattern	Matching

The	printed	circuit	device	inspection	example	uses	the	Pattern	Matching
function	to	determine	if	PCB	components	are	present	and	in	the	correct
location,	and	matches	areas	of	inspection	to	a	template	of	valid
components.	This	application	uses	shift-invariant	matching	to	inspect	an
oriented	component	(diode)	and	uses	rotation-invariant	matching	to
inspect	a	component	(resistor)	that	may	appear	in	multiple	orientations.
Pattern	Matching—Locates	a	specific	diode	component	in	the	image
of	the	PCB.	The	template	used	to	locate	the	component	is	chosen	so
that	it	contains	only	the	relevant	parts	of	the	component	necessary	for
the	location	process.	This	avoids	mismatches	or	positioning	accuracy
problems	that	may	arise	due	to	variations	in	the	background	of	the
component.
Because	the	orientation	of	the	diode	is	important	to	the	inspection
process,	shift-invariant	pattern	matching	is	used	to	locate	the	diode.
The	Pattern	Matching	function	does	not	find	the	diode	if	it	is	present	but
incorrectly	oriented,	causing	the	inspection	to	fail.
Because	you	know	the	expected	location	of	the	diode	before	you	begin
the	inspection	process,	you	can	specify	a	search	region	around	the
location	of	the	diode,	which	speeds	up	the	pattern	matching	process.
Pattern	Matching—Locates	a	specific	resistor	component	in	the	image
of	the	PCB.	The	template	used	to	locate	the	component	is	chosen	such
that	it	contains	one	of	the	relevant	parts	of	the	component	needed	to
locate	it.	This	avoids	mismatches	or	positioning	accuracy	problems	that
may	arise	due	to	variations	in	the	background	of	the	component.
Because	the	orientation	of	the	resistor	is	not	important	in	the	inspection
process,	rotation-invariant	pattern	matching	is	used	to	locate	the
resistor.	The	Pattern	Matching	function	finds	the	resistor	if	it	is	present
in	the	image	at	any	orientation.	Inspection	fails	only	when	the	resistor	is
not	present	in	the	image.
Because	you	know	the	expected	location	of	the	resistor	before	you



begin	the	inspection	process,	you	can	specify	a	search	region	around
the	location,	which	speeds	up	the	pattern	matching	process.



Pins	Inspection
Application	Type Inspection;	Gauging
Image	Characteristics Monochrome;	Good	Contrast
Machine	Vision	Tool(s) Edge	Detection;	Caliper

The	pins	inspection	example	examines	if	the	connector	pins	on	a	Berg
stick	are	vertical	and	straight.	The	inspection	requires	finding	the	edge	of
each	pin	at	three	different	locations,	and	computing	the	angle	formed	by
these	points	to	determine	the	orientation	of	the	pin.
Edge	Detection	(All	Edges)	Simple	Edge	Detection—Finds	the	edge
points	of	the	pins.	The	edge	detection	process	looks	for	edges	(sharp
transitions	in	pixel	values)	along	a	search	path.	The	search	path	is
defined	as	the	horizontal	line	drawn	across	the	image	close	to	the	top
of	the	pins.
The	simple	edge	tool	is	used	to	detect	the	edges	because	the	pins	are
well	contrasted	from	the	background	in	the	image,	and	there	is	no	noise
in	the	image.	Based	on	the	line	profile	obtained	along	the	search	line,	a
threshold	value	of	100	is	used	to	detect	the	edges.
The	pixel	coordinates	of	the	left	and	right	edges	of	each	pin	along	the
search	line	in	the	image	are	returned	at	the	end	of	this	step.
Edge	Detection	(All	Edges)	Simple	Edge	Detection—Finds	edges	on
the	pins	along	a	horizontal	search	line	that	passes	midway	through
each	pin.	The	pixel	coordinates	of	the	left	and	right	edges	of	each	pin
along	the	horizontal	search	line	are	returned	at	the	end	of	this	step.
Edge	Detection	(All	Edges)	Simple	Edge	Detection—Finds	edges	on
the	pins	along	a	horizontal	search	line	that	passes	close	to	the	bottom
of	each	pin.	The	pixel	coordinates	of	the	left	and	right	edges	of	each	pin
along	the	horizontal	search	line	are	returned	at	the	end	of	this	step.
Caliper—Finds	the	angle	of	each	pin.	The	right	edge	locations	of	each
pin,	obtained	from	the	previous	steps,	are	used	to	compute	the	angle	of
the	pin.



Bordon	Pressure	Tube	Calibration
Application	Type Gauging
Image	Characteristics Monochrome;	Good	Contrast
Machine	Vision	Tool(s) Pattern	Matching;	Caliper

The	Bordon	pressure	tube	inspection	example	demonstrates	calibrating	a
Bordon	pressure	tube	by	measuring	the	distance	between	the	base	and
the	tip	of	the	tube.
As	pressure	is	applied	to	the	Bordon	tube,	the	tip	of	the	tube	extends
outward.	The	calibration	process	involves	correlating	the	computed
distance	from	the	image	to	the	pressure	applied	to	the	Bordon	tube.
Pattern	Matching—Finds	the	tip	of	the	Bordon	pressure	tube.	A	region
containing	the	hole	at	the	tip	of	the	tube	is	used	as	the	template.
Because	the	template	is	rotationally	symmetric,	shift-invariant	pattern
matching	is	used	to	locate	the	tip.	The	Pattern	Matching	function	finds
the	location	of	the	tip	and	returns	the	pixel	coordinates	of	the	location.
Pattern	Matching—Finds	the	base	of	the	Bordon	pressure	tube.	A
region	containing	the	hole	at	the	base	of	the	tube	is	used	as	the
template.	Because	the	template	is	rotationally	symmetric,	shift-invariant
pattern	matching	is	used	to	locate	the	base.	The	Pattern	Matching
function	finds	the	location	of	the	base	and	returns	the	pixel	coordinates
of	the	location.
Caliper—Uses	the	caliper	tool	to	measure	the	distance	between	the
locations	of	the	tip	and	the	base	of	the	Bordon	tube.



Label	Inspection
Application	Type Inspection
Image
Characteristics

Monochrome;	Good	Contrast

Machine	Vision
Tool(s)

Pattern	Matching;	Golden	Template	Comparison;
Particle	Analysis

The	label	inspection	example	demonstrates	finding	defects	such	as
double-prints,	scratches,	and	lack	of	ink	on	a	printed	label.	The	defects
are	found	by	defining	a	golden	template	of	a	perfect	label	and	comparing
it	to	the	inspection	images.	The	particle	analysis	step	at	the	end	of	the
inspection	characterizes	the	defects.
Pattern	Matching—Finds	the	printed	label	in	the	image.	A	region
containing	the	printed	label	is	used	as	the	template.	Because	the	label
can	rotate	slightly,	rotation-invariant	pattern	matching	is	used	to	locate
the	label.	The	Pattern	Matching	function	finds	the	location	of	the	label
and	returns	the	pixel	coordinates	of	the	location.
Golden	Template	Comparison—Uses	the	same	template	from	the
pattern	matching	step	as	a	golden	template.	This	template	represents	a
"perfect"	label	in	the	first	image.	The	golden	template	comparison	uses
the	coordinates	returned	by	the	pattern	matching	step	to	position	the
golden	template	in	the	image	and	compare	the	golden	template	with
the	corresponding	pixels	of	the	image.	The	difference	image	highlights
the	defects	between	the	golden	template	and	the	image	under
inspection.
Particle	Analysis—Analyzes	the	properties	of	the	defects	in	the
image.	The	particle	measurement	function	can	analyze	up	to	50
different	properties	of	a	particle.



LEGO	Bricks	Classification
Application	Type Identification
Image	Characteristics Color
Machine	Vision
Tool(s)

Run	LabVIEW	VI;	Custom	Classification;
Overlay

The	LEGO	bricks	classification	example	demonstrates	the	use	of	the	Run
LabVIEW	VI	step.	The	Run	LabVIEW	VI	step	calls	a	custom	classification
algorithm	written	in	LabVIEW	to	classify	LEGO	bricks	based	on	the	color
and	shape	of	the	bricks.	The	Overlay	step	overlays	the	result	onto	the
image.
Run	LabVIEW	VI—Calls	a	custom	classification	VI	written	in	LabVIEW.
The	VI	classifies	the	LEGO	brick	based	on	the	specific	features	of	the
brick.	The	feature	vector	is	made	of	an	array	containing	the	color
spectrum	of	the	part	and	a	shape	descriptor	that	recognizes	the	shape
of	the	brick.
Overlay—Overlay	the	result	of	the	classification	onto	the	image	without
destroying	the	image	data.



Color	Pencil	Inspection
Application	Type Inspection
Image	Characteristics Color
Machine	Vision	Tool(s) Color	Matching;	Pattern	Matching

The	color	pencil	inspection	example	determines	if	manufactured	colored
pencils	meet	specifications.	This	application	compares	the	pencil	lead
color	to	the	color	of	the	pencil	shaft	using	the	Color	Matching	function,
and	uses	the	Pattern	Matching	function	to	ensure	that	the	tip	of	the	pencil
is	not	broken.
Color	Matching—Determines	if	the	color	of	the	pencil	tip	is	the	same
color	as	the	shaft.
Color	Plane	Extraction:	HSL—Luminance—Extracts	the	luminance
plane	from	the	color	image.
Pattern	Matching—Verifies	that	the	tip	of	the	pencil	is	not	broken.



Wood	Inspection
Application	Type Inspection
Image
Characteristics

Monochrome;	Low	Contrast

Image	Processing
Tool(s)

Lookup	Table;	Thresholding;	Advanced
Morphology;	Particle	Analysis

The	wood	inspection	example	checks	the	surface	of	wood	planks	for
structural	defects	using	a	lookup	table,	an	automatic	threshold,	binary
image	processing,	advanced	morphology,	and	particle	analysis.
Lookup	Table:	Square	Root—Enhances	the	appearance	of	the	pixels
in	the	image	with	low	grayscale	values.	Structural	defects	on	the	wood
surface	appear	as	slightly	darker	regions	in	the	image.	A	lookup	table
that	applies	a	square	root	function	to	the	image	helps	to	enhance	the
difference	between	the	defects	and	the	surface	of	the	wood.
Threshold:	Auto-Threshold—Entropy—Separates	the	areas	in	the
image	that	may	be	defects	from	the	rest	of	the	wood	surface.	An
automatic	thresholding	technique	is	applied	to	create	a	binary	image.
An	automatic	threshold	has	the	advantage	of	being	independent	of	the
imaging	conditions.
Adv.	Morphology:	Remove	Small	Particles—Removes	small	noise
particles	from	the	binary	image.	Particles	that	are	removed	by	an
iteration	of	erosion	are	assumed	to	be	noise	particles.
Adv.	Morphology:	Remove	Border	Objects—Removes	particles	that
touch	the	border	of	the	image.	Complete	information	about	particles
that	touch	the	border	of	the	image	is	not	available,	so	the	particles	are
removed	from	further	analysis.
Particle	Analysis—Determines	characteristics	of	each	particle	(defect)
in	the	image.	You	can	compute	up	to	50	different	properties	of	the
structural	defects.



Blister	Pack	Inspection
Application	Type Inspection
Image	Characteristics Color;	Non-linear	Lighting
Machine	Vision	Tool(s) Color	Location

The	blister	pack	inspection	example	determines	if	a	blister	pack	has	the
correct	number	and	type	of	pills	using	the	Color	Location	function.	The
inspection	determines	the	number	of	a	specific	color	pill	in	the	package.
Because	the	colors	of	the	wrong	pills	(blue)	are	very	distinct	from	the
correct	ones	(green),	a	low	sensitivity	color	representation	is	adequate	for
color	location.	Because	you	are	interested	only	in	counting	the	number	of
pills	rather	than	finding	the	exact	location	of	the	pills,	use	a	very
aggressive	search	strategy.
Color	Location—Determines	the	number	of	a	specific	color	pill	in	the
blister	pack.	To	use	color	location,	you	first	define	a	color	template	that
represents	the	green	part	of	a	good	pill.	The	Color	Location	function
locates	all	instances	of	color	information	in	an	image	that	matches	the
template.	You	can	use	the	number	of	matches	(locations)	to	determine
if	the	blister	pack	contains	the	correct	number	of	pills.



Dental	Floss	Inspection
Application	Type Inspection
Image	Characteristics Monochrome;	Good	Contrast
Image	Processing
Tools

Pattern	Matching;	Set	Coordinate	System;
Quantify

The	dental	floss	inspection	determines	if	dental	floss	holders	contain
toothpaste	and	a	wire.	The	dental	floss	holders	appear	shifted	and
rotated	from	one	image	to	another.	To	account	for	the	different	locations,
this	application	uses	the	Set	Coordinate	System	step	to	define	a
coordinate	system	relative	to	the	feature	found	in	the	Pattern	Matching
step,	the	base	of	the	dental	floss	holder.
Pattern	Matching—Locates	the	dental	floss	base.	The	base	is	always
in	the	field	of	view	of	the	camera	despite	the	different	locations	the
dental	floss	holders	may	appear	in	from	image	to	image.	This	feature	is
used	to	define	the	coordinate	system.
Set	Coordinate	System—Defines	a	coordinate	system	based	on	the
Pattern	Matching	step.	Because	the	dental	floss	holders	appear	shifted
and	rotated	from	one	image	to	another,	the	changes	in	the	region	of
interest	are	accounted	for	using	the	Horizontal,	Vertical,	and	Angular
Motion	mode.	This	mode	adjusts	the	region	of	interest	positions	along
the	horizontal	and	vertical	axes,	and	adjusts	for	rotational	changes.
Quantify—Checks	the	dental	floss	holders	for	the	presence	of
toothpaste	and	a	wire.	This	step	measures	the	pixel	intensities	of	three
regions	of	interest	within	the	image—the	wire,	and	the	two	toothpaste
regions.	This	step	uses	the	Reposition	Region	of	Interest	control	to
link	the	regions	of	interest	specified	in	this	step	to	the	previously
defined	coordinate	system.	Vision	Assistant	can	adjust	the	location	and
orientation	of	the	regions	of	interest	from	image	to	image	relative	to	the
coordinate	system.



Pills	Inspection
Application	Type Inspection
Image
Characteristics

Monochrome;	Good	Contrast

Machine	Vision
Tool(s)

Threshold;	Watershed	Segmentation;	Particle
Analysis

The	pill	inspection	example	uses	the	Watershed	Segmentation	algorithm
to	separate	pills	in	an	image	and	then	perform	particle	analysis	on	the
individual	pills.
The	Watershed	Segmentation	algorithm	partitions	an	image	based	on	the
topographic	surface	of	the	image.	The	image	is	separated	into	non-
overlapping	segments.	Each	segment	contains	a	unique	particle.	This
example	shows	how	to	use	the	Watershed	image	to	mask	the	original
image	and	separate	the	objects.	The	particle	analysis	step	then	analyzes
each	individual	pill.
Threshold:	Auto	Threshold—Clustering—Separates	the	bright
regions	in	the	image	from	the	rest	of	the	image	using	an	automatic
threshold	technique.
Image	Buffer:	Add	Copy	(1)—Stores	a	copy	of	the	thresholded	image
in	Buffer	#1	of	the	image	buffer	for	later	use.
Distance—Assigns	to	each	pixel	a	grayscale	value	equal	to	the
shortest	distance	to	the	border	of	the	object,	which	might	be	to	a	hole
within	the	object.	This	step	is	a	preprocessing	step	before	applying	the
Watershed	Segmentation	algorithm.
Watershed	Segmentation—The	Watershed	Segmentation	algorithm
partitions	an	image	based	on	the	topographic	surface	of	the	image.	The
image	is	separated	into	non-overlapping	segments,	with	each	segment
containing	a	unique	particle.	Each	region	is	separated	by	a	line	of
pixels	with	values	of	0.	This	line	is	called	the	watershed	line.
Image	Buffer:	Add	Copy	(2)—Stores	a	copy	of	the	watershed	image
in	Buffer	#2	of	the	image	buffer	for	later	use.
Image	Buffer:	Retrieve	Buffer—Retrieves	the	copy	of	the	thresholded
image.
Mask	Buffer—Masks	the	thresholded	image	with	the	watershed	image.



As	a	result,	the	pixels	of	the	watershed	lines	(with	values	of	0)	are	set
to	0	on	the	resulting	image,	therefore	separating	the	particles.
Particle	Analysis—Analyzes	the	properties	of	the	remaining	particles
(pills)	in	the	image.	The	particle	measurement	function	can	analyze	up
to	50	different	properties	of	a	particle.



Tablet	Discoloration	Inspection
Application	Type Inspection
Image	Characteristics Color
Image	Processing	Tool(s) Color	Thresholding;	Particle	Analysis

The	tablet	discoloration	inspection	example	determines	the	presence	and
quantity	of	discolored	areas	on	tablets.	This	application	performs	a	color
threshold	in	HSL	mode	to	detect	any	discoloration	and	uses	the	Particle
Analysis	function	to	count	the	number	of	defects.
Color	Threshold:	Manual—Thresholds	the	color	image	to	separate
the	colored	pills	from	the	background.	A	color	threshold	in	the	HSL
color	space	is	applied	to	the	image.	For	thresholding,	appropriate
threshold	ranges	for	the	Hue,	Saturation,	and	Luminance	planes	are
chosen	so	that	all	the	areas	in	the	image	containing	the	color	of	the	pill
appear	in	the	resulting	binary	image.	All	other	areas,	such	as	the
background	and	the	defects	on	the	pills,	do	not	show	up	in	the	binary
image.
Image	Buffer:	Add	Copy	(1)—Stores	a	copy	of	the	binary	image	into
the	image	buffer	for	later	use.	The	copy	is	stored	in	Buffer	#1	of	the
image	buffer.
Adv.	Morphology:	Fill	Holes—Fills	any	holes	that	are	present	in	the
particles	corresponding	to	the	pills	in	the	binary	image.	These	holes	are
caused	by	regions	on	the	pills	that	do	not	have	the	same	color
information	as	the	pills.	The	resulting	binary	image	contains	entire
particles,	without	holes,	that	correspond	to	the	pills.
Operators:	Subtract—Subtracts	the	original	binary	image	stored	in
Buffer	#1	of	the	image	buffer	from	the	binary	image	that	contains	the	pill
particles	in	their	entirety.	The	resulting	image	contains	the	regions
corresponding	to	the	defects	on	the	pills,	as	well	as	other	noise
particles.
Adv.	Morphology—Removes	the	noise	particles	from	the	image.
Particle	Analysis—Analyzes	the	remaining	particles	in	the	binary
image	to	determine	if	they	are	significant	enough	to	classify	a	pill	as
defective.	Particle	measurements	such	as	area,	length,	and	orientation
are	parameters	that	determine	if	a	defect	is	significant	or	not.



Foreign	Tablet	Inspection
Application	Type Sorting
Image	Characteristics Color
Image	Processing
Tool(s)

Color	Thresholding;	Operators;	Particle
Analysis

The	foreign	tablet	inspection	example	determines	if	a	sample	of	tablets
contains	any	foreign	tablets.	This	application	performs	a	color	threshold
to	distinguish	all	tablets	from	the	background,	performs	another	color
threshold	to	isolate	the	correctly	colored	tablets	in	the	sample,	and	then
subtracts	the	first	thresholded	image	from	the	second	to	find	the	foreign
tablets.
Image	Buffer:	Add	Copy	(1)—Stores	a	copy	of	the	original	image	into
the	image	buffer	for	later	use.	The	image	is	stored	in	Buffer	#1.
Color	Threshold:	Manual—Thresholds	the	color	image	to	separate	all
the	tablets	in	the	image	from	the	background.	A	color	threshold	is
applied	to	the	image	in	the	HSL	color	space.	The	resulting	binary	image
contains	all	the	tablets	and	some	noise	particles	from	the	background.
Image	Buffer:	Add	Copy	(2)—Stores	the	binary	image	with	all	the	pills
into	the	image	buffer.	The	image	is	stored	in	Buffer	#2
Image	Buffer:	Retrieve	Copy	(1)—Retrieves	the	original	color	image
from	Buffer	#1	in	the	image	buffer.
Color	Threshold:	Manual—Thresholds	the	color	image	to	separate	all
the	correctly	colored	tablets	from	the	rest	of	the	image.	A	color
threshold	is	applied	to	the	thresholded	image	in	the	HSL	color	space.
The	hue	values	of	the	correctly	colored	tablets	fall	in	a	range	from	230
–	255	(red).	The	resulting	binary	image	contains	all	the	correctly
colored	tablets	and	some	noise	particles	from	the	background.	The
particles	corresponding	to	the	tablets	may	have	holes	in	them.
Adv.	Morphology:	Fill	Holes—Improves	the	binary	image	by	filling
holes	in	the	particles	corresponding	to	the	correct	tablets.
Image	Buffer:	Add	Copy	(3)—Stores	the	binary	image	with	the	correct
tablet	particles	into	the	image	buffer.	The	image	is	stored	in	Buffer	#3.
Image	Buffer:	Retrieve	Copy	(2)—Retrieves	the	binary	image	with	all
the	tablet	particles	for	processing	from	Buffer	#2	in	the	image	buffer.



This	image	becomes	the	active	image.
Operators:	Subtract—Subtracts	the	binary	image	with	the	correct
tablet	particles	from	the	binary	image	containing	all	the	particles.	The
Subtract	operator	subtracts	the	image	stored	in	Buffer	#3	from	the
binary	image	you	are	processing.	The	resulting	image	contains
particles	that	correspond	to	the	foreign	tablets	and	other	noise	particles
in	the	background.
Basic	Morphology:	Erode	Objects—Removes	noise	particles	that	are
present	in	the	image.	All	noise	particles	are	removed	within	two	erosion
iterations.	The	resulting	image	contains	particles	corresponding	to	the
foreign	tablets	in	the	image.
Adv.	Morphology:	Remove	Small	Particles—Uses	the	Particle
Analysis	function	to	determine	the	location	of	the	foreign	tablets.	The
center	of	mass	coordinates	of	each	particle	are	used	to	locate	the
particle	in	the	image.
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Warranty
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS	MAKES
NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND	SPECIFICALLY
DISCLAIMS	ANY	WARRANTY	OF	MERCHANTABILITY	OR	FITNESS
FOR	A	PARTICULAR	PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER
DAMAGES	CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE	AMOUNT
THERETOFORE	PAID	BY	THE	CUSTOMER.	NATIONAL
INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR	DAMAGES	RESULTING
FROM	LOSS	OF	DATA,	PROFITS,	USE	OF	PRODUCTS,	OR
INCIDENTAL	OR	CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF
THE	POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in
contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action



accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.
National	Instruments	respects	the	intellectual	property	of	others,	and	we
ask	our	users	to	do	the	same.	NI	software	is	protected	by	copyright	and
other	intellectual	property	laws.	Where	NI	software	may	be	used	to
reproduce	software	or	other	materials	belonging	to	others,	you	may	use
NI	software	only	to	reproduce	materials	that	you	may	reproduce	in
accordance	with	the	terms	of	any	applicable	license	or	other	legal
restriction.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,
Stateflow®,	and	xPC	TargetBox®	are	registered	trademarks,	and
TargetBox™	and	Target	Language	Compiler™	are	trademarks	of	The
MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.
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Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file	on
your	CD,	or	ni.com/patents.
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WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT	DESIGNED
WITH	COMPONENTS	AND	TESTING	FOR	A	LEVEL	OF	RELIABILITY
SUITABLE	FOR	USE	IN	OR	IN	CONNECTION	WITH	SURGICAL
IMPLANTS	OR	AS	CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT
SYSTEMS	WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,	RELIABILITY	OF
OPERATION	OF	THE	SOFTWARE	PRODUCTS	CAN	BE	IMPAIRED	BY
ADVERSE	FACTORS,	INCLUDING	BUT	NOT	LIMITED	TO
FLUCTUATIONS	IN	ELECTRICAL	POWER	SUPPLY,	COMPUTER
HARDWARE	MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN	APPLICATION,
INSTALLATION	ERRORS,	SOFTWARE	AND	HARDWARE
COMPATIBILITY	PROBLEMS,	MALFUNCTIONS	OR	FAILURES	OF
ELECTRONIC	MONITORING	OR	CONTROL	DEVICES,	TRANSIENT
FAILURES	OF	ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR	ERRORS	ON
THE	PART	OF	THE	USER	OR	APPLICATIONS	DESIGNER	(ADVERSE
FACTORS	SUCH	AS	THESE	ARE	HEREAFTER	COLLECTIVELY
TERMED	"SYSTEM	FAILURES").	ANY	APPLICATION	WHERE	A
SYSTEM	FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO
PROPERTY	OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY
INJURY	AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON	ONE
FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK	OF	SYSTEM
FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR	DEATH,	THE	USER	OR
APPLICATION	DESIGNER	MUST	TAKE	REASONABLY	PRUDENT
STEPS	TO	PROTECT	AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT
NOT	LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING	PLATFORMS
AND	BECAUSE	A	USER	OR	APPLICATION	DESIGNER	MAY	USE
NATIONAL	INSTRUMENTS	PRODUCTS	IN	COMBINATION	WITH
OTHER	PRODUCTS	IN	A	MANNER	NOT	EVALUATED	OR
CONTEMPLATED	BY	NATIONAL	INSTRUMENTS,	THE	USER	OR



APPLICATION	DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR
VERIFYING	AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL	INSTRUMENTS
PRODUCTS	ARE	INCORPORATED	IN	A	SYSTEM	OR	APPLICATION,
INCLUDING,	WITHOUT	LIMITATION,	THE	APPROPRIATE	DESIGN,
PROCESS	AND	SAFETY	LEVEL	OF	SUCH	SYSTEM	OR
APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	award-winning	National	Instruments
Web	site	at	ni.com	for	technical	support	and	professional	services:

Support—Technical	support	resources	at	ni.com/support	include	the
following:

Self-Help	Resources—For	answers	and	solutions,	visit
ni.com/support	for	software	drivers	and	updates,	a	searchable
KnowledgeBase,	product	manuals,	step-by-step
troubleshooting	wizards,	thousands	of	example	programs,
tutorials,	application	notes,	instrument	drivers,	and	so	on.
Registered	users	also	receive	access	to	the	NI	Discussion
Forums	at	ni.com/forums.	NI	Applications	Engineers	make
sure	every	question	submitted	online	receives	an	answer.
Standard	Service	Program	Membership—This	program
entitles	members	to	direct	access	to	NI	Applications
Engineers	via	phone	and	email	for	one-to-one	technical
support,	as	well	as	exclusive	access	to	on	demand	training
modules	via	the	Services	Resource	Center.	NI	offers
complementary	membership	for	a	full	year	after	purchase,
after	which	you	may	renew	to	continue	your	benefits.
For	information	about	other	technical	support	options	in	your
area,	visit	ni.com/services	or	contact	your	local	office	at
ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.
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Image	Browser	Controls
You	can	use	the	buttons	in	the	Image	Browser	to	navigate	images	you
have	opened	in	Vision	Assistant.	Refer	to	the	following	button
descriptions	for	information	about	how	to	view	images.



First	Image—In	thumbnail	view,	navigates	to	the	first	page	of
thumbnail	images.	In	full-size	view,	navigates	to	the	first	image	you
opened.
Scan	Backward—In	thumbnail	view,	scans	from	the	last	page	of
thumbnail	images	to	the	first	page	of	thumbnail	images.	In	full-size,
view	scans	from	the	last	image	to	the	first	image.
Previous	Image—In	thumbnail	view,	navigates	to	the	previous
page	of	thumbnail	images.	In	full-size	view,	navigates	to	the
previous	image.
Stop—In	thumbnail	view,	stops	continuous	scanning	of	thumbnail
image	pages.	In	full-size	view,	stops	the	continuous	scanning	of
images.
Next	Image—In	thumbnail	view,	navigates	to	the	next	page	of
thumbnail	images.	In	full-size	view,	navigates	to	the	next	image.
Scan	Forward—In	thumbnail	view,	scans	from	the	first	page	of
thumbnail	images	to	the	last	page	of	thumbnail	images.	In	full-size
view,	scans	from	the	first	image	to	the	last	image.
Last	Image—In	thumbnail	view,	navigates	to	the	last	page	of
thumbnail	images.	In	full-size	view,	navigates	to	the	last	image	you
opened.
Continuous	Scan—In	thumbnail	view,	continuously	scrolls	through
thumbnail	image	pages.	In	full-size,	continuously	scrolls	through
open	images.
Thumbnail/Full-Size	View	Toggle—Toggles	between	the
thumbnail	image	view	and	full-size	image	view.
Open	Image—Add	an	image	or	images	from	file	to	the	Image
Browser.
Close	Selected	Image(s)—Removes	the	selected	image	or
images	from	the	Image	Browser.



Snapping	an	image	(single	image	acquisition)
1.	 Click	File»Acquire	Image.	Vision	Assistant	displays	the

Acquisition	Functions	palette.
2.	 Click	the	appropriate	acquisition	step.	The	Devices	window

displays	all	NI	image	acquisition	devices	and	channels	or	ports
available	for	the	computer.

3.	 Select	the	device	and	channel	or	port	you	want	to	use	to	acquire
an	image.

4.	 Click	 	Acquire	Single	Image	to	acquire	a	single	image	with
the	NI	image	acquisition	device	and	display	it.	This	operation	is
known	as	a	snap.

5.	 Click	 	Store	Acquired	Image	in	Browser	to	send	the	image
to	the	Image	Browser.

6.	 Click	Close	to	add	the	acquisition	step	and	close	the	setup
window.

7.	 Process	the	image	as	you	would	any	other	image	in
Vision	Assistant.
Note		Refer	to	the	NI	Vision	Acquisition	Software	Release	Notes
for	more	information	about	configuring	NI	image	acquisition
devices.

Related	Topics
Simulating	image	acquisitions
Acquiring	a	sequence	of	images
Acquiring	images	in	color
Grabbing	an	image	(continuous	image	acquisition)
Image	Acquisition	in	Vision	Assistant



Grabbing	an	image	(continuous	image
acquisition)

1.	 Click	File»Acquire	Image.	Vision	Assistant	displays	the	Acquire
Images	Processing	Functions	palette.

2.	 Click	the	appropriate	acquisition	step.	The	Devices	window
displays	all	NI	image	acquisition	devices	and	channels	or	ports
available	for	the	computer.

3.	 Select	the	device	and	channel	or	port	you	want	to	use	to	acquire
an	image.

4.	 Click	 	Acquire	Continuous	Images	to	acquire	and	display
images	in	continuous	mode	at	the	maximum	rate.	This	operation
is	known	as	a	grab.

5.	 Click	Acquire	Continuous	Images	again	to	stop	the	acquisition
and	display	the	last	acquired	image.

6.	 Click	 	Store	Acquired	Image	in	Browser	to	send	the	image
to	the	Image	Browser.

7.	 Process	the	image	as	you	would	any	other	image	in
Vision	Assistant.
Note		Refer	to	the	NI	Vision	Acquisition	Software	Release	Notes
for	more	information	about	configuring	NI	image	acquisition
devices.

Tip			You	can	select	a	region	of	interest	from	a	full-size	image
during	the	acquisition.	To	reduce	the	image	to	the	selected	ROI,
draw	an	ROI	in	the	image	while	grabbing	it.	You	can	further	refine
the	image	by	selecting	another	ROI.	Return	to	the	full-size	image
by	clicking	the	image.

Related	Topics
Acquiring	a	sequence	of	images
Acquiring	images	in	color
Image	Acquisition	in	Vision	Assistant
Snapping	an	image	(single	image	acquisition)



Acquiring	a	sequence	of	images
1.	 Click	File»Acquire	Image.	Vision	Assistant	displays	the

Acquisition	Interface	window	and	acquisition	property	pages.
2.	 Click	the	appropriate	acquisition	step.	The	Devices	window

displays	all	NI	image	acquisition	devices	and	channels	or	ports
available	for	the	computer.

3.	 Select	the	device	and	channel	or	port	you	want	to	use	to	acquire
an	image.

4.	 Click	 	Sequence	Acquisition	to	view	the	Sequence
Acquisition	Wizard.

5.	 Set	the	following	properties	in	the	Sequence	Acquisition	Wizard:
Number	of	Frames—Number	of	frames	you	want	to
acquire.
Skip	Count—Number	of	frames	you	want	to	skip	between
acquisitions.
Action—Triggering	action.	Select	Disabled,	Trigger	start
of	acquisition,	or	Trigger	each	image.
Line—Physical	trigger	line.
Timeout—Time,	in	milliseconds,	within	which	the	trigger
must	occur.
Polarity—Edge	of	the	signal	at	which	the	trigger	occurs.

For	example,	if	you	have	a	camera	that	acquires	30	frames	per
second	(f/s)	and	you	want	to	acquire	an	image	every	second	until
you	acquire	10	images	in	the	sequence,	set	Number	of	Frames
to	10	and	Skip	Count	to	29	(30	f/s–1	frame	acquired	in	the
sequence).

6.	 Click	Next,	Next,	and	Finish	to	complete	the	sequence
acquisition.	Vision	Assistant	sends	acquired	images	to	the	Image
Browser.

7.	 Process	the	images	as	you	would	any	other	image	in
Vision	Assistant.
Note		Refer	to	the	NI	Vision	Acquisition	Software	Release	Notes
for	more	information	about	configuring	the	NI	image	acquisition
device.



Related	Topics
Acquiring	images	in	color
Grabbing	an	image	(continuous	image	acquisition)
Image	Acquisition	in	Vision	Assistant
Snapping	an	image	(single	image	acquisition)



NI	17xx	Light	Configuration
Use	the	Configure	Light	dialog	box	to	control	your	light.	You	must
choose	between	Select	Light	and	Enter	Light	Protection	Data	when
configuring	a	light	source.
Select	Select	Light	to	choose	a	lighting	data	file.	Lighting	data	files	exist
in	four	levels	of	certification:

Digitally	Signed	by	National	Instruments—The	information
contained	within	this	file	has	been	verified	as	correct	and	safe	by
National	Instruments.	Contact	National	Instruments	for	support
regarding	this	lighting	data	file	or	the	light	to	which	it	refers.

Digitally	Signed	by	a	Third-party	Company—The	information
contained	within	this	file	has	been	verified	as	correct	and	safe	by
the	specified	third-party	company.	Contact	the	third-party	company
for	support	regarding	this	lighting	data	file	or	the	light	to	which	it
refers.

Not	Digitally	Signed—The	information	contained	within	this	file
meets	the	requirements	of	Direct	Drive	lighting;	however,	it	has	not
been	verified	that	the	information	is	safe	to	use	with	the	specified
light.	Use	this	file	at	your	own	risk.

Invalid—The	information	contained	within	this	file	is	unusable
because	the	digital	signature	is	corrupt,	the	data	describing	the
light	is	corrupt,	the	data	describing	the	light	is	not	in	the	proper
syntax,	or	the	data	does	not	meet	the	requirements	of	Direct	Drive
lighting.

Select	Enter	Lighting	Protection	Data	to	manually	enter	control	limits
for	your	light.	Before	manually	entering	limits	for	your	light,	be	aware	of
the	manufacturer	specified	limitations.	Exceeding	the	maximum	current
or	timing	limits	specified	by	the	manufacturer	will	damage	the	light.	All
lights	support	the	following	options:

Maximum	Continuous	Current	(mA)	specifies	the	continuous
current	limit	in	milliamps	and	is	the	maximum	current	limit	the	light
supports	in	continuous	mode.
Maximum	Strobe	Current	(mA)	specifies	the	strobe	current	limit
in	milliamps	and	is	the	maximum	current	the	light	supports	when	in



strobe	mode.
Maximum	Strobe	Duration	(ms)	specifies	the	strobe	duration	limit
in	milliseconds	and	is	the	maximum	amount	of	time	that	the	light
remains	on	when	being	driven	with	the	maximum	strobe	current.
Maximum	Strobe	Duty	Cycle	(%)	specifies	the	maximum	duty
cycle	to	allow	for	the	strobe.	The	duty	cycle	is	the	ratio	of	the	light
strobe	duration	to	the	frame	period.

Note		If	you	violate	either	the	strobe	duration	limit	or	the
strobe	duty	cycle	limit,	then	the	settings	will	revert	to	the
continuous	current	limit.

Refer	to	your	light	documentation	for	additional	information	about
supported	features	and	lighting	limits.



Processing	an	Image

1		Image	Preview	Window		 3		Processing	Functions	Palette		
2		Main	Window		 4		Script	Window		

1.	 Load	the	image	into	the	Processing	window.
2.	 Select	the	appropriate	function	from	the	Image,	Color,

Grayscale,	Binary,	Machine	Vision,	or	Identification	menu.
Tip		You	can	run	a	particular	step	of	a	script	by	selecting	the	step
in	the	Script	window.

Related	Topics
Adding	a	processed	image	to	the	Image	Browser
Browsing	images	in	the	Image	Browser
Magnifying	an	image
Opening	images	in	Vision	Assistant
Printing	an	image
Removing	an	image	from	the	Image	Browser
Saving	an	image



Batch	Processing	Controls
Image	Source

Hard	Disk—Processes	the	images	in	the	directory	you
specify.
Browser—Processes	all	images	in	the	Image	Browser.
Acquisition—Acquires	images	using	the	module	you	select
in	Acquisition	Modules.

Acquisition	Modules—Types	of	acquisition	you	can
perform	during	batch	processing.
Iterations—Number	of	times	you	want	to	acquire	an
image	during	batch	processing.
Period	(s)—Length	of	the	delay,	in	seconds,	between
acquisitions.

Script	Steps
Analysis	Mode

Open	Results	Panel—Displays	the	results	panel	for
the	selected	analysis	step	for	each	image.
Save	Results—Applies	the	script	to	each	image	and
saves	the	analysis	results	to	a	text	file.
Save	Options—Displays	the	options	you	specified	in
the	Save	Results	Setup	dialog	box.

Process	Mode
Open	Process	Interface—Displays	each	image	in	the
Processing	window	and	displays	the	Parameter
window	for	each	step	in	the	script.	You	can	modify	the
step	and	save	the	changes	before	Vision	Assistant
processes	the	next	image.
Display	Result	Image—Applies	the	script	to	each
image	and	displays	the	resulting	image.
Save	Result	Image—Applies	the	script	to	each	image
and	allows	you	to	save	each	processed	image.
Save	Options—Displays	the	options	you	specified	in
the	Save	Results	Image	Setup	dialog	box.



Save	Results	Setup
One	file	for	all	results—Creates	a	single	results	file	that	contains
the	results	information	for	each	file	in	the	batch	process.
Separate	files	for	each	image—Creates	separate	results	files	for
each	image	in	the	batch	process.
Folder	Path—Directory	in	which	you	want	to	save	the	results	file
File	Prefix—Name	of	the	individual	results	file	when	you	select
Separate	files	for	each	image,	or	the	prefix	associated	with	the
index	for	each	results	file	when	you	select	Separate	files	for	each
image.



Save	Results	Image	Setup
File	Format—Standard	graphics	format	you	want	to	save	the
processed	image	in.
Folder	Path—Location	to	which	you	want	to	save	the	processed
images.
File	Prefix	and	Start	Index—Text	and	browser	position
information	you	can	use	to	distinguish	the	processed	images.	For
example,	you	can	type	Bracket	and	01	to	indicate	that	the
processed	image	is	the	processed	result	of	the	first	bracket	image
in	the	browser.

Note		Values	for	File	Prefix	and	Start	Index	are	required	to
save	results	images.

Save	Image	Calibration—Saves	calibration	information	with	the
image,	if	applicable.
Expand	Dynamic	of	Binary	Images—Replaces	all	pixels	whose
value	is	1	with	pixels	whose	value	is	255	so	that	the	image
appears	black	and	white	when	opened.	If	you	are	processing	a
binary	image	and	you	do	not	select	this	option,	the	image	appears
entirely	black.
Compress—When	selected,	specifies	that	BMP	images	should	be
compressed.
Image	Quality—Level	of	compression	to	apply	to	JPEG	and	PNG
images.	Valid	values	are	0	through	1000.	A	value	of	0	completely
compresses	the	image	and	produces	a	low-quality	image.	A	value
of	1000	compresses	the	image	slightly	and	produces	a	high-quality
image.
Lossless—When	selected,	specifies	that	images	should	be
compressed	with	lossless	compression.
Ratio—The	degree	to	which	to	compress	the	JPEG2000	file	when
Lossless	is	not	selected.	For	example,	if	Ratio	is	50,	the	resulting
file	will	be	50	times	smaller	than	the	size	of	the	image	in	memory.
This	parameter	is	ignored	if	Lossless	is	True.
Filter—Filter	you	want	to	use	to	compress	AVI	files.
Frame	Rate—Movie	frame	rate	for	AVI	files.

Related	Topic



Performing	batch	processing



Selecting	a	Region	of	Interest	(ROI)
1.	 Select	an	ROI	tool	from	the	toolbar.
2.	 Using	the	mouse,	click	and	drag	on	the	image	to	select	the	ROI.
Note		The	ROI	tools	are	accessible	only	for	particular	functions.

Tip			If	you	want	to	select	an	ROI	on	an	image	and	save	it,	click
Image»Image	Mask	or	select	Image	Mask	in	the	Image	tab	of	the
Processing	Functions	palette.	When	you	use	the	Broken	Line	and
Polygon	ROI	tools,	you	must	double-click	to	release	the	tool.	When
you	release	the	mouse	button	after	drawing	an	ROI,	the	ROI	is
green.

Related	Topics
Tools	Palette



Glossary
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Numbers 	

1D One-dimensional.
2D Two-dimensional.
3D Three-dimensional.
3D	view Displays	the	light	intensity	of	an	image	in	a	three-

dimensional	coordinate	system,	where	the	spatial
coordinates	of	the	image	form	two	dimensions	and	the	light
intensity	forms	the	third	dimension.



A
area
threshold

Detects	objects	based	on	their	size.

arithmetic
operators

Multiply,	divide,	add,	subtract,	and	remainder	operations
you	can	perform	on	images.

auto-
median
function

A	function	that	uses	dual	combinations	of	opening	and
closing	operations	to	smooth	the	boundaries	of	objects.



B
barycenter The	grayscale	value	representing	the	centroid	of	the	range

of	an	image's	grayscale	values	in	the	image	histogram.
binary
image

An	image	containing	objects	usually	represented	with	a
pixel	intensity	of	1	(or	255)	and	the	background	of	0.

binary
morphology

Functions	that	perform	morphological	operations	on	a
binary	image.

BMP Bitmap.	Image	file	format	commonly	used	for	8-bit	and
color	images	
(extension	.bmp).

border
function

Removes	objects	(or	particles)	that	touch	the	image	border
in	a	binary	image.

Builder	file Vision	Assistant	script	file.	Builder	files	are	ASCII	text	files
that	list	the	Visual	Basic	processing	functions	and	relevant
parameters	for	an	image	processing	algorithm	that	you
created	in	Vision	Assistant.



C
caliper A	function	that	calculates	distances,	angles,	circular	fits,

and	the	center	of	mass	based	on	positions	given	by	edge
detection,	particle	analysis,	centroid,	and	search	functions.

circle
function

Detects	circular	objects	in	a	binary	image.

class A	category	representing	a	collection	of	similar	samples.
classification An	operation	that	assigns	samples	to	classes	based	on

predefined	features.
classification
score

Degree	of	certainty	that	a	sample	is	assigned	to	one	class
instead	of	other	classes.

classifier A	function	or	VI	that	assigns	a	sample	to	a	class.
closing A	dilation	followed	by	an	erosion.	A	closing	fills	small	holes

in	objects	and	smoothes	the	boundaries	of	objects.
clustering Technique	where	the	image	is	sorted	within	a	discrete

number	of	classes	corresponding	to	the	number	of	phases
perceived	in	an	image.	The	gray	values	are	determined
and	a	barycenter	is	determined	for	each	class.	This
process	is	repeated	until	a	value	is	obtained	that
represents	the	center	of	mass	for	each	phase	or	class.

color	images Images	containing	color	information,	usually	encoded	in
the	RGB	form.

complex
images

Save	information	obtained	from	the	FFT	of	an	image.	The
complex	numbers	that	compose	the	FFT	plane	are
encoded	in	64-bit	floating-point	values:	32	bits	for	the	real
part	and	32	bits	for	the	imaginary	part.

connectivity Defines	which	of	the	surrounding	pixels	of	a	given	pixel
constitute	its	neighborhood.	See	also	connectivity-4	and
connectivity-8.

connectivity-
4

Connectivity	where	only	pixels	adjacent	in	the	horizontal
and	vertical	directions	are	considered	neighbors.	Two
pixels	are	considered	as	part	of	a	same	object	if	they	are
horizontally	or	vertically	adjacent.	They	are	considered	as



part	of	two	different	objects	if	they	are	diagonally	adjacent.
connectivity-
8

Connectivity	where	all	adjacent	pixels	are	considered
neighbors.	Two	pixels	are	considered	as	part	of	a	same
object	if	they	are	horizontally,	vertically,	or	diagonally
adjacent.

convex
function

Computes	the	convex	regions	of	objects	in	a	binary
image.

convolution See	linear	filter.
convolution
kernel

3	×	3,	5	×	5,	or	7	×	7	matrices	(or	templates)	used	to
represent	the	filter	in	the	filtering	process.	The	contents	of
these	kernels	are	a	discrete	two-dimensional
representation	of	the	impulse	response	of	the	filter	that
they	represent.

coordinate
system

A	reference	location	(origin)	and	angle	in	an	image	that
ROIs	can	relate	to	when	positional	and	angular
adjustments	of	the	ROI	are	necessary.	A	coordinate
system	is	depicted	by	two	lines	representing	the
orientation	and	direction	of	its	two	axes.



D
Danielsson
function

Similar	to	the	distance	functions,	but	with	more	accurate
results.

definition The	number	of	values	a	pixel	can	take	on,	which	is	the
number	of	colors	or	shades	that	you	can	see	in	the
image.

dendrite Branches	of	the	skeleton	of	an	object.
density
function

For	each	gray	level	in	a	linear	histogram,	it	gives	the
number	of	pixels	in	the	image	that	have	the	same	gray
level.

device Plug-in	data	acquisition	device	that	can	contain	multiple
channels	and	conversion	devices.

differentiation
filter

Extracts	the	contours	(edge	detection)	in	gray	level.

dilation Increases	the	size	of	an	object	along	its	boundary	and
removes	tiny	holes	in	the	object.

distance
calibration

Determination	of	the	physical	dimensions	of	a	pixel	by
defining	the	physical	dimensions	of	a	line	in	the	image.

distance
function

Assigns,	to	each	pixel	in	an	object,	a	gray-level	value
equal	to	its	shortest	Euclidean	distance	from	the	border	of
the	object.

driver Software	that	controls	a	specific	hardware	device,	such
as	a	data	acquisition	device.



E
ECC Error	Checking	and	Correcting.	Type	of	algorithm	used	for

error	correction	with	Data	Matrix	codes.
edge Defined	by	a	sharp	change	(transition)	in	the	pixel

intensities	in	an	image	or	along	an	array	of	pixels.
edge
contrast

The	difference	between	the	average	pixel	intensity	before
and	the	average	pixel	intensity	after	the	edge.

edge
steepness

The	number	of	pixels	that	corresponds	to	the	slope	or
transition	area	of	an	edge.

entropy Method	based	on	a	classical	image	analysis	technique	that
is	best	suited	for	detecting	objects	present	in	minuscule
proportions	on	the	image.	For	example,	this	function	would
be	suitable	for	default	detection.

equalize
function

See	histogram	equalization.

erosion Reduces	the	size	of	an	object	along	its	boundary	and
eliminates	isolated	points	in	the	image.

exponential
function

Decreases	the	brightness	and	increases	the	contrast	in
bright	regions	of	an	image,	and	decreases	contrast	in	dark
regions.



F
feature A	measurement	from	or	attribute	of	a	sample.
feature
vector

A	1D	array	in	which	each	element	represents	a	different
feature	of	a	sample.

FFT Fast	Fourier	Transform.	A	method	used	to	compute	the
Fourier	transform	of	an	image.

finder
pattern

The	perimeter	of	a	Data	Matrix	barcode.	The	left	and	bottom
sides	of	the	finder	pattern	form	a	solid	L	shape.	The	right	and
bottom	sides	of	the	finder	pattern	are	made	of	alternating
light	and	dark	cells.

Fourier
spectrum

The	magnitude	information	of	the	Fourier	transform	of	an
image.

Fourier
transform

Transforms	an	image	from	the	spatial	domain	to	the
frequency	domain.

frequency
filters

Counterparts	of	spatial	filters	in	the	frequency	domain.	For
images,	frequency	information	is	in	the	form	of	spatial
frequency.



G
Gaussian
filter

A	filter	similar	to	the	smoothing	filter,	but	using	a	Gaussian
kernel	in	the	filter	operation.	The	blurring	in	a	Gaussian
filter	is	more	gentle	than	a	smoothing	filter.

grab Acquisition	technique	that	acquires	and	displays	a
continuous	sequence	of	images	using	an	NI	image
acquisition	device.	Use	this	acquisition	technique	when	you
need	to	focus	the	camera.

gradient
convolution
filter

See	gradient	filter.

gradient
filter

Extracts	the	contours	(edge	detection)	in	gray-level	values.
Gradient	filters	include	the	Prewitt	and	Sobel	filters.

gray	level The	brightness	of	a	pixel	in	an	image.
grayscale
image

An	image	with	monochrome	information.

grayscale
morphology

Functions	that	perform	morphological	operations	on	a
grayscale	image.



H
highpass
attenuation

Applies	a	linear	attenuation	to	the	frequencies	in	an	image,
with	no	attenuation	at	the	highest	frequency	and	full
attenuation	at	the	lowest	frequency.

highpass
FFT	filter

Removes	or	attenuates	low	frequencies	present	in	the	FFT
domain	of	an	image.

highpass
filter

Emphasizes	the	intensity	variations	in	an	image,	detects
edges	(or	object	boundaries),	and	enhances	fine	details	in
an	image.

highpass
frequency
filter

Attenuates	or	removes	(truncates)	low	frequencies	present
in	the	frequency	domain	of	the	image.	A	highpass
frequency	filter	suppresses	information	related	to	slow
variations	of	light	intensities	in	the	spatial	image.

highpass
truncation

Removes	all	frequency	information	below	a	certain
frequency.

histogram Indicates	the	quantitative	distribution	of	the	pixels	of	an
image	per	gray-level	value.

histogram
equalization

Transforms	the	gray-level	values	of	the	pixels	of	an	image
to	occupy	the	entire	range	(0	to	255	in	an	8-bit	image)	of
the	histogram,	increasing	the	contrast	of	the	image.

hole	filling
function

Fills	all	holes	in	objects	that	are	present	in	a	binary	image.

HSI Color	encoding	scheme	in	Hue,	Saturation,	and	Intensity.
HSL Color	encoding	scheme	in	Hue,	Saturation,	and

Luminance.
HSV Color	encoding	scheme	in	Hue,	Saturation,	and	Value.



I
identification
score

Degree	of	similarity	between	a	sample	and	members	of
the	class	to	which	the	sample	is	assigned.

image Light	intensity	as	a	function	of	the	spatial	coordinates	f	(x,
y)	where	x	and	y	denote	spatial	coordinates	and	the	value
f	at	any	point	(x,	y)	is	the	light	intensity	at	that	point.

image
border

A	user-defined	region	of	pixels	surrounding	an	image.
Functions	that	process	pixels	based	on	the	value	of	pixel
neighbors	require	image	borders.

Image
Browser

Vision	Assistant	feature	that	displays	all	of	the	images
currently	loaded.	Through	the	Image	Browser,	you	can
select	an	image	that	you	want	to	process	by	double
clicking	it.

image	buffer Memory	location	used	to	store	images.
image	file A	file	containing	pixel	data	and	additional	information

about	the	image.
image	mask A	binary	image	that	isolates	parts	of	a	source	image	for

further	processing.	A	pixel	in	the	source	image	is
processed	if	its	corresponding	mask	pixel	has	a	non-zero
value.	A	source	pixel	whose	corresponding	mask	pixel	has
a	value	of	0	is	left	unchanged.

image
palette

The	gradation	of	colors	used	to	display	an	image	on
screen,	usually	defined	by	a	color	look-up	table.

image
processing

Encompasses	various	processes	and	analysis	functions
that	you	can	apply	to	an	image.

image
source

Original	input	image.	If	you	start	processing	an	image	and
want	to	revert	back	to	the	original	image,	select	Source
Image	from	the	list	box.	When	you	click	Source	Image,	the
image	reverts	to	the	original	image,	and	any	processing
done	on	the	image	prior	to	selecting	Image	Source	is
cancelled.

inner
gradient

Finds	the	inner	boundary	of	objects.



inspection
functions

Detects	specific	features	in	an	image.	The	features
detected	include	edges,	peaks,	and	rotational	shifts.

intensity
range

Defines	the	range	of	gray-level	values	in	an	object	of	an
image.

intensity
threshold

Characterizes	an	object	based	on	the	range	of	gray-level
values	in	the	object.	If	the	intensity	range	of	the	object	falls
within	the	user	specified	range,	it	is	considered	an	object;
otherwise	it	is	considered	part	of	the	background.

interclass
variance

Classical	statistic	technique	used	in	discriminating	factorial
analysis.	This	method	is	best	suited	for	images	in	which
classes	are	not	too	disproportionate.	For	satisfactory
results,	the	smallest	class	must	be	at	least	five	percent	of
the	largest	one.	This	method	has	the	tendency	to
underestimate	the	class	of	the	smallest	standard	deviation
if	the	two	classes	have	a	significant	variation.

interpolation The	technique	used	to	find	values	in	between	known
values	when	resampling	an	image	or	array	of	pixels.



J
JPEG Joint	Photographic	Experts	Group.	Image	file	format	for

storing	8-bit	and	color	images	with	lossy	compression
(extension	.jpg).

JPEG2000 Joint	Photographic	Experts	Group	2000.	Image	file	format
for	storing	8-bit	and	color	images	with	lossless	compression
(extension	.jp2).



K
kernel Structure	that	represents	a	pixel	and	its	relationship	to	its

neighbors.	The	relationship	is	specified	by	weighted	coefficients
of	each	neighbor.

keying
color

Color	in	an	overlaid	bitmap	that	becomes	transparent,	allowing
pixels	in	the	underlying	image	beneath	the	keying	color	to	show
through.



L
labeling A	morphology	operation	that	identifies	each	object	in	a

binary	image	and	assigns	a	unique	pixel	value	to	all	the
pixels	in	an	object.	This	process	is	useful	for	identifying
the	number	of	objects	in	the	image	and	giving	each	object
a	unique	pixel	intensity.

LabVIEW Laboratory	Virtual	Instrument	Engineering	Workbench.
Program	development	environment	based	on	the	G
programming	language.	LabVIEW	is	used	commonly	for
test	and	measurement	applications.

Laplacian
filter

Extracts	the	contours	of	objects	in	the	image	by
highlighting	the	variation	of	light	intensity	surrounding	a
pixel.

line	profile Represents	the	gray-level	distribution	along	a	line	of	pixels
in	an	image.

linear	filter A	special	algorithm	that	calculates	the	value	of	a	pixel
based	on	its	own	pixel	value	as	well	as	the	pixel	values	of
its	neighbors.	The	sum	of	this	calculation	is	divided	by	the
sum	of	the	elements	in	the	matrix	to	obtain	a	new	pixel
value.

logarithmic
function

Increases	the	brightness	and	contrast	in	dark	regions	of
an	image,	and	decreases	the	contrast	in	bright	regions	of
the	image.

logic
operators

The	image	operations	AND,	NAND,	OR,	XOR,	NOR,
difference,	mask,	mean,	max,	and	min.

look-up
table

Table	containing	values	used	to	transform	the	gray-level
values	of	an	image.	For	each	gray-level	value	in	the
image,	the	corresponding	new	value	is	obtained	from	the
look-up	table	and	applied	to	the	image.

lossless
compression

Compression	in	which	the	decompressed	image	is
identical	to	the	original	image.

lossy
compression

Compression	in	which	the	decompressed	image	is	visually
similar	but	not	identical	to	the	original	image.

lowpass Applies	a	linear	attenuation	to	the	frequencies	in	an



attenuation image,	with	no	attenuation	at	the	lowest	frequency	and	full
attenuation	at	the	highest	frequency.

lowpass	FFT
filter

Removes	or	attenuates	high	frequencies	present	in	the
FFT	domain	of	an	image.

lowpass
filter

Attenuates	intensity	variations	in	an	image.	You	can	use
these	filters	to	smooth	an	image	by	eliminating	fine	details
and	blurring	edges.

lowpass
frequency
filter

Attenuates	high	frequencies	present	in	the	frequency
domain	of	the	image.	A	lowpass	frequency	filter
suppresses	information	related	to	fast	variations	of	light
intensities	in	the	spatial	image.

lowpass
truncation

Removes	all	frequency	information	above	a	certain
frequency.

L-skeleton
function

Uses	an	L-shaped	structuring	element	in	the	Skeleton
function.



M
median
filter

A	lowpass	filter	that	assigns	to	each	pixel	the	median	value	of
its	neighbors.	This	filter	effectively	removes	isolated	pixels
without	blurring	the	contours	of	objects.

metric Technique	used	in	situations	similar	to	interclass	variance.	For
each	threshold,	a	value	is	calculated	that	is	determined	by	the
surfaces	representing	the	initial	grayscale.	The	optimal
threshold	corresponds	to	the	smallest	value.

moments Technique	best	suited	for	images	that	have	poor	contrast	(an
overexposed	image	is	better	processed	than	an
underexposed	image).	The	moments	method	is	based	on	the
hypothesis	that	the	observed	image	is	a	blurred	version	of	the
theoretically	binary	original.	The	blurring	that	is	produced	from
the	acquisition	process	(electronic	noise	or	slight
defocalization)	is	treated	as	if	the	statistical	moments
(average	and	variance)	were	the	same	for	both	the	blurred
image	and	the	original	image.	This	function	recalculates	a
theoretical	binary	image.

M-
skeleton

Uses	an	M-shaped	structuring	element	in	the	skeleton
function.



N
neighbor A	pixel	whose	value	affects	the	value	of	a	nearby	pixel	when

an	image	is	processed.	The	neighbors	of	a	pixel	are	usually
defined	by	a	kernel	or	structuring	element.

nonlinear
filter

Replaces	each	pixel	value	with	a	nonlinear	function	of	its
surrounding	pixels.

nonlinear
gradient
filter

A	highpass	edge-extraction	filter	that	favors	vertical	edges.

nonlinear
Prewitt
filter

A	highpass	edge-extraction	filter	that	favors	horizontal	and
vertical	edges	in	an	image.

nonlinear
Sobel
filter

A	highpass	edge-extraction	filter	that	favors	horizontal	and
vertical	edges	in	an	image.

Nth
order
filter

Filters	an	image	using	a	nonlinear	filter.	This	filter	orders	(or
classifies)	the	pixel	values	surrounding	the	pixel	being
processed.	The	pixel	being	processed	is	set	to	the	Nth	pixel
value,	where	N	is	the	order	of	the	filter.

number
of	planes
(in	an
image)

The	number	of	arrays	of	pixels	that	compose	the	image.	A
gray-level	or	pseudo-color	image	is	composed	of	one	plane,
while	an	RGB	image	is	composed	of	three	planes	(one	for	the
red	component,	one	for	the	blue,	and	one	for	the	green).



O
offset The	coordinate	position	in	an	image	where	you	want	to	place

the	origin	of	another	image.	Setting	an	offset	is	useful	when
performing	mask	operations.

opening An	erosion	followed	by	a	dilation.	An	opening	removes	small
objects	and	smoothes	boundaries	of	objects	in	the	image.

operators Allow	masking,	combination,	and	comparison	of	images.	You
can	use	arithmetic	and	logic	operators	in	NI	Vision.

outer
gradient

Finds	the	outer	boundary	of	objects.



P
palette The	gradation	of	colors	used	to	display	an	image	on	screen,

usually	defined	by	a	color	look-up	table.
particle A	connected	region	or	grouping	of	pixels	in	an	image	in

which	all	pixels	have	the	same	intensity	level.	You	can
identify	particles	in	binary	images	as	black	objects	on	white
backgrounds.

particle
analysis

A	series	of	processing	operations	and	analysis	functions
that	produce	some	information	about	the	particles	in	an
image.

pattern
matching

The	process	of	locating	a	grayscale	template	in	a	grayscale
image.

picture
element

An	element	of	a	digital	image.	Also	called	pixel.

pixel Picture	element.
pixel
calibration

Directly	calibrating	the	physical	dimensions	of	a	pixel	in	an
image.

pixel	depth The	number	of	bits	(n)	used	to	code	the	intensity	of	a	pixel.
For	a	given	n,	a	pixel	can	take	2n	different	values.	For
example,	if	n	equals	8-bits,	a	pixel	can	take	256	different
values	ranging	from	0	to	255.	If	n	equals	16	bits,	a	pixel	can
take	65,536	different	values	ranging	from	0	to	65,535	or
32,768	to	32,767.

pixel	frame Describes	the	neighborhood.	For	a	square	pixel	frame,	each
pixel	is	surrounded	by	eight	neighbors.	The	vertical	and
horizontal	neighbors	have	a	distance	d	from	the	pixel.
Diagonal	pixels	have	a	slightly	greater	distance	because
they	are	farther	away	from	the	central	pixel.	For	a
hexagonal	pixel	frame,	each	pixel	is	surrounded	by	six
neighbors.	Each	neighbor	is	at	an	equal	distance	from	the
central	pixel.

PNG Portable	Network	Graphic.	Image	file	format	for	storing	8-bit,
16-bit,	and	color	images	with	lossless	compression
(extension	.png).



Prewitt
filter

Extracts	the	contours	(edge	detection)	in	gray-level	values
using	a	3	×	3	filter	kernel.

Processing
window

Vision	Assistant	feature	that	updates	the	image	as	you
change	parameters.	The	Processing	window	is	located	on
the	right	side	of	the	Vision	Assistant	window.

proper-
closing

A	finite	combination	of	successive	closing	and	opening
operations	that	you	can	use	to	fill	small	holes	and	smooth
the	boundaries	of	objects.

proper-
opening

A	finite	combination	of	successive	opening	and	closing
operations	that	you	can	use	to	remove	small	particles	and
smooth	the	boundaries	of	objects.



Q
quantitative
analysis

Obtaining	various	measurements	of	objects	in	an
image.



R
Reference
window

Vision	Assistant	feature	that	displays	the	original	version	of
the	image	(image	source)	as	you	manipulate	it	in	the
processing	window.	The	Reference	window	appears	in	the
upper	left	corner	of	the	Vision	Assistant	window.

region	of
interest

An	area	of	the	image	that	is	graphically	selected	from	a
window	displaying	the	image.	This	area	can	be	used	to	focus
further	processing.	Also	called	ROI.

resolution The	number	of	rows	and	columns	of	pixels.	An	image
composed	of	m	rows	and	n	columns	has	a	resolution	of	m	×
n.	This	image	has	n	pixels	along	its	horizontal	axis	and	m
pixels	along	its	vertical	axis.

Reverse
function

Inverts	the	pixel	values	in	an	image,	producing	a	photometric
negative	of	the	image.

RGB Color	image	encoding	using	red,	green,	and	blue	colors.
Roberts
filter

Extracts	the	contours	(edge	detection)	in	gray	level,	favoring
diagonal	edges.

ROI Region	of	interest.
ROI	tools Collection	of	tools	that	enable	you	to	select	a	region	of

interest	from	an	image.	These	tools	let	you	select	a	point	or
line;	polygon,	rectangle,	and	oval	regions;	and	freehand	lines
and	areas.



S
sample An	object	in	an	image	that	you	want	to	classify.
script List	of	image	processing	and	analysis	functions	and	the

parameters	for	each	of	those	functions.	Vision	Assistant
records	each	function	and	relevant	parameters	as	you
prototype	the	image	processing	application.

Script
window

The	window	in	which	Vision	Assistant	displays	a	script.
From	the	scripting	window,	you	can	edit	or	remove	steps
and	run	scripts.

segmentation
function

Fully	partitions	a	labeled	binary	image	into	non-
overlapping	segments,	with	each	segment	containing	a
unique	object.

separation
function

Separates	objects	that	touch	each	other	by	narrow
isthmuses.

sequence Acquisition	technique	that	acquires	images	according	to
settings	that	you	specify	in	the	acquisition	property	pages.

shape
matching

Finds	objects	in	an	image	whose	shape	matches	the
shape	of	the	object	specified	by	a	template.	The	matching
process	is	invariant	to	rotation	and	you	can	set	it	to	be
invariant	to	the	scale	of	the	objects.

skeleton
function

Applies	a	succession	of	thinning	operations	to	an	object
until	its	width	becomes	one	pixel.

skiz	function Obtains	lines	in	an	image	that	separate	each	object	from
the	others	and	are	equidistant	from	the	objects	that	they
separate.

smoothing
filter

Blurs	an	image	by	attenuating	variations	of	light	intensity
in	the	neighborhood	of	a	pixel.

snap Acquisition	technique	that	acquires	and	displays	a	single
image.

Sobel	filter Extracts	the	contours	(edge	detection)	in	gray-level
values	using	a	3	×	3	filter	kernel.

spatial
calibration

Assigning	physical	dimensions	to	the	area	of	a	pixel	in	an
image.



Square
function

See	exponential	function.

Square	Root
function

See	logarithmic	function.

structuring
element

A	binary	mask	used	in	most	morphological	operations.	A
structuring	element	is	used	to	determine	which
neighboring	pixels	contribute	in	the	operation	and	to	what
degree.



T
template Pattern,	shape,	or	color	that	you	are	trying	to	match	in	an

image	using	the	Pattern	Matching,	Shape	Matching,	or	Color
Matching	functions.	A	template	can	be	a	region	selected	from
an	image	or	it	can	be	an	entire	image.

thickening Alters	the	shape	of	objects	by	adding	parts	to	the	object	that
match	the	pattern	specified	in	the	structuring	element.

thinning Alters	the	shape	of	objects	by	eliminating	parts	of	the	object
that	match	the	pattern	specified	in	the	structuring	element.

threshold Separates	objects	from	the	background	by	assigning	all
pixels	with	intensities	within	a	specified	range	to	the	object
and	the	rest	of	the	pixels	to	the	background.	In	the	resulting
binary	image,	objects	are	represented	with	a	pixel	intensity	of
255	and	the	background	is	set	to	0.

TIFF Tagged	Image	File	Format.	Tagged	Image	File	Format.
Image	format	commonly	used	for	encoding	8-bit	and	color
images	(extension	.tif).

toolbar Collection	of	tools	that	enable	you	to	select	regions	of
interest,	zoom	in	and	out,	and	change	the	image	palette.
These	tools	are	located	in	the	toolbar	at	the	top	of	the
Vision	Assistant	dialog	box.



W
watershed Fully	partitions	an	image	based	on	the	topographic	surface

of	the	image.	The	image	is	separated	into	non-overlapping
zones	with	each	zone	containing	a	unique	particle.



Saving	a	VI	for	Distribution
Complete	the	following	steps	to	save	a	LabVIEW	VI	for	distribution:

1.	 Launch	LabVIEW.
2.	 Open	the	VI.	If	the	VI	is	already	open,	save	the	VI.
3.	 Select	File»New	Project.
4.	 Add	the	VI	and	any	dependencies	to	the	project.	If	you	want	to	run

the	VI	on	a	remote	target,	you	must	first	add	the	target	to	the
project.	Compete	the	following	steps	to	add	a	remote	target	to	the
LabVIEW	project:

a.	 In	the	Project	Explorer	window,	right-click	the	project	root
and	select	New»Targets	and	Devices.

b.	 Select	the	target	you	want	to	add	from	the	Targets	and
Devices	section	of	the	Add	Targets	and	Devices	dialog
box.

c.	 Click	OK	to	add	the	target	to	the	project.
5.	 Save	the	project	by	selecting	File»Save	Project.
6.	 Right-click	Build	Specifications	underneath	the	VI	you	added	to

the	project	and	select	New»Source	Distribution	from	the
shortcut	menu	to	display	the	Source	Distribution	Properties	dialog
box.

7.	 Enter	a	Build	Specification	Name	and	Destination	Directory.
8.	 Select	the	Source	Files	category.
9.	 In	the	Project	Files	list,	select	the	top-level	VI	and	any

dependencies,	and	add	the	files	to	the	Always	Included	list.
10.	 Select	the	Destinations	category.
11.	 In	the	Destination	type	control,	select	LLB.
12.	 Select	the	Source	Files	Settings	category.
13.	 In	the	Project	Files	list,	click	Dependencies.
14.	 Enable	the	Apply	prefix	to	all	contained	items	checkbox	and

enter	a	prefix.
15.	 Select	the	Additional	Exclusions	category.
16.	 Enable	the	Disconnect	type	definitions,	Remove	unused

polymorphic	VI	instances,	and	Remove	unused	members	of
project	libraries	checkboxes.	Do	not	enable	the	Modify	project



library	file	after	removing	unused	members	checkbox.
17.	 Disable	the	Exclude	files	from	vi.lib,	Exclude	files	from

instr.lib,	and	Exclude	files	from	user.lib	checkboxes.
18.	 Select	the	Preview	category.	Click	Generate	Preview	to	review

the	generated	file	hierarchy	for	the	source	distribution.	To	ensure
the	preview	is	accurate,	save	changes	to	VIs	in	memory	before
you	create	or	edit	a	build	specification.

19.	 Click	Build.	You	can	find	the	resulting	source	distribution	in	the
directory	specified	in	the	Destination	directory	control	in	the
Information	category	of	the	build	specification.

Note		Before	you	can	use	the	new	LLB	on	a	remote	target,
you	must	first	download	the	LLB	to	the	target	using	FTP.



Particle	Filter	Measurements
Use	any	of	the	following	measurements	or	a	combination	of	the	following
measurements	to	keep	or	remove	particles	from	the	image.

Center	of	Mass	X	and	Center	of	Mass	Y—X-	and	Y-coordinates
of	the	particle	center	of	mass
First	Pixel	X	and	First	Pixel	Y—X-	and	Y-coordinates	of	the	first
pixel	of	the	particle
Bounding	Rect	(Left,	Right,	Top,	and	Bottom)

X-coordinate	of	the	leftmost	point	in	the	particle
Y-coordinate	of	highest	point	in	the	particle
X-coordinate	of	the	rightmost	point	in	the	particle
Y-coordinate	of	the	lowest	point	in	the	particle

Max	Feret	Diameter	Start	X	and	Max	Feret	Diameter	Start	Y—
X-	and	Y-coordinates	of	the	particle	center	the	Max	Feret	Diameter
Start
Max	Feret	Diameter	End	X	and	Max	Feret	Diameter	End	Y—X-
and	Y-coordinates	of	the	particle	center	the	Max	Feret	Diameter
End
Max	Horiz.	Segment	Length	(Left,	Right,	and	Row)

X-coordinate	of	the	leftmost	pixel	in	the	Max	Horiz.	Segment.
Always	given	as	a	pixel	measurement.
X-coordinate	of	the	rightmost	pixel	in	the	Max	Horiz.
Segment.	Always	given	as	a	pixel	measurement.
Y-coordinate	for	all	of	the	pixels	in	the	Max	Horiz.	Segment.
Always	given	as	a	pixel	measurement.

Bounding	Rect	(Width,	Height,	and	Diagonal)
Distance	between	Bounding	Rect	Left	and	Bounding	Rect
Right
Distance	between	Bounding	Rect	Top	and	Bounding	Rect
Bottom
Distance	between	opposite	corners	of	the	Bounding	Rect

Perimeter—Length	of	the	outer	boundary	of	the	particle.	Because
the	boundary	is	comprised	of	discrete	pixels,	Vision	Assistant
subsamples	the	boundary	points	to	approximate	a	smoother,	more



accurate	perimeter.
Convex	Hull	Perimeter—Perimeter	of	the	Convex	Hull
Hole's	Perimeter—Sum	of	the	perimeters	of	each	hole	in	the
particle
Max	Feret	Diameter—Distance	between	the	Max	Feret	Diameter
Start	and	the	Max	Feret	Diameter	End
Equivalent	Ellipse	(Major	Axis,	Minor	Axis,	and	Minor	Axis
(Feret))

Length	of	the	major	axis	of	the	Equivalent	Ellipse
Length	of	the	minor	axis	of	the	Equivalent	Ellipse
Length	of	the	minor	axis	of	the	ellipse	with	the	same	area	as
the	particle,	and	Major	Axis	equal	in	length	to	the	Max	Feret
Diameter

Equivalent	Rect	(Long	Side,	Short	Side,	Diagonal,	and	Short
Side	(Feret))

Longest	side	of	the	Equivalent	Rect
Shortest	side	of	the	Equivalent	Rect
Distance	between	opposite	corners	of	the	Equivalent	Rect
Shortest	side	of	the	rectangle	with	the	same	area	as	the
particle,	and	longest	side	equal	in	length	to	the	Max	Feret
Diameter

Average	Horiz.	Segment	Length—Average	length	of	a	horizontal
segment	in	the	particle.	Sum	of	the	horizontal	segments	that	do	not
superimpose	any	other	horizontal	segment.	Always	given	as	a
pixel	measurement
Average	Vert.	Segment	Length—Average	length	of	a	vertical
segment	in	the	particle.	Sum	of	the	vertical	segments	that	do	not
superimpose	any	other	vertical	segment.	Always	given	as	a	pixel
measurement
Hydraulic	Radius—Particle	area	divided	by	its	perimeter
Waddel	Disk	Diameter—Diameter	of	a	disk	with	the	same	area	as
the	particle
Area—Area	of	the	particle
Holes'	Area—Sum	of	the	areas	of	each	hole	in	the	particle
Particle	&	Holes'	Area—Area	of	a	particle	that	completely	covers



the	image
Convex	Hull	Area—Area	of	the	Convex	Hull	of	the	particle
Image	Area—Area	of	the	image
Number	of	Holes—Number	of	holes	in	the	particle.
Vision	Assistant	can	detect	holes	inside	a	particle	as	small	as	one
pixel
Number	of	Horiz.	Segments—Number	of	horizontal	segments	in
the	particle.	always	given	as	pixel	measurements.
Number	of	Vert.	Segments—Number	of	horizontal	segments	in
the	particle.	Always	given	as	pixel	measurements.
Orientation—Angle	of	the	line	passing	through	the	particle	center
of	mass	with	the	lowest	moment	of	inertia
Max	Feret	Diameter	Orientation—Angle	of	the	Max	Feret
Diameter
%Area/Image	Area—Percentage	of	the	particle's	Area	covering
the	Image	Area
%Area/(Particle	&	Holes'	Area)—Percentage	of	the	particle's
Area	in	relation	to	its	Particle	&	Holes'	Area
Ratio	of	Equivalent	Ellipse	Axes—Equivalent	Ellipse	Major	Axis
divided	by	Equivalent	Ellipse	Minor	Axis
Ratio	of	Equivalent	Rect	Sides—Equivalent	Rect	Long	Side
divided	by	Equivalent	Rect	Short	Side
Elongation	Factor—Max	Feret	Diameter	divided	by	Equivalent
Rect	Short	Side	(Feret).	The	more	elongated	the	shape	of	a
particle,	the	higher	its	elongation	factor
Compactness	Factor—Area	divided	by	the	product	of	Bounding
Rect	Width	and	Bounding	Rect	Height.	The	compactness	factor
belongs	to	the	interval	[0,	1].	The	closer	the	shape	of	a	particle	is
to	a	rectangle,	the	closer	to	1	the	compactness	factor
Heywood	Circularity	Factor—Perimeter	divided	by	the
circumference	of	a	circle	with	the	same	area.	The	closer	the	shape
of	a	particle	is	to	a	disk,	the	closer	the	Heywood	circularity	factor	to
1
Type	Factor—Factor	relating	area	to	moment	of	inertia
Angle—Degrees	of	rotation	counterclockwise	from	the	x-axis.
Range:	[0	°,	180	°)



Sum...—Moments	of	various	orders	relative	to	the	x-	and	y-axes
Moment	of	Inertia...—Moments	about	the	particle	Center	of	Mass.
Gives	a	representation	of	the	distribution	of	the	pixels	in	a	particle
with	respect	to	its	center	of	gravity.	Shift	invariant.
Norm.	Moment	of	Inertia...—Moment	of	Inertia	normalized	with
regard	to	the	particle	Area.	Shift	and	scale	invariant.
Hu	Moment...—Moments	derived	from	the	Norm.	Moment	of
Inertia	measurements.	Shift,	scale,	and	rotation	invariant.



Detect	Edges	with	the	Simple	Edge	Tool
1.	 Select	the	Simple	Edge	Tool	from	the	Edge	Detector	list.
2.	 In	the	image,	click	and	drag	to	select	a	path	along	which	to	search

for	edges.	Vision	Assistant	displays	a	line	profile	describing	the
path	and	lists	the	number	of	edges	found	along	that	path.

3.	 Select	the	option	from	Look	For	that	specifies	which	edges	you
are	looking	for.

4.	 Set	the	Level	Type.	Absolute	Value	specifies	the	threshold	level
in	pixel	intensities,	and	Relative	Value	specifies	the	threshold
level	as	a	percentage	of	the	intensity	range	found	in	the	line	of
pixels.

5.	 Set	the	Threshold	Level	(intensity	level	that	you	expect	to
constitute	an	edge)	or	click	and	drag	the	cursor	on	the	line	profile
to	position	the	cursor	at	the	appropriate	threshold	level.

6.	 Click	OK	to	add	this	step	to	the	script	and	close	the	Setup
window.
Tip		You	can	move	the	ROI	using	the	arrow	keys	on	the	keyboard.



Detect	Edges	with	the	Advanced	Edge	Tool
1.	 Select	the	Advanced	Edge	Tool	from	the	Edge	Detector	list.
2.	 In	the	image,	click	and	drag	to	select	a	path	along	which	to	search

for	edges.	Vision	Assistant	displays	the	strength	of	the	edges
along	the	ROI	and	lists	the	number	of	edges	found	along	that
path.

3.	 Select	the	option	from	Look	For	that	specifies	which	edges	you
are	looking	for.

4.	 Set	the	Edge	Polarity,	Interpolation	Type,	Kernel	Size,	Width,
and	Min	Edge	Strength	parameters	to	define	which	edges	you
are	looking	for.

5.	 Click	OK	to	add	this	step	to	the	script	and	close	the	Parameter
window.
Tip		You	can	move	the	ROI	using	the	arrow	keys	on	the	keyboard.



Branch	Offices
Office Telephone	Number
Australia 1800	300	800
Austria 43	662	457990-0
Belgium 32	(0)	2	757	0020
Brazil 55	11	3262	3599
Canada 800	433	3488
China 86	21	5050	9800
Czech	Republic 420	224	235	774
Denmark 45	45	76	26	00
Finland 358	(0)	9	725	72511
France 33	(0)	1	57	66	24	24
Germany 49	89	7413130
India 91	80	41190000
Israel 972	0	3	6393737
Italy 39	02	41309277
Japan 0120-527196	/	81	3	5472	2970
Korea 82	02	3451	3400
Lebanon 961	(0)	1	33	28	28
Malaysia 1800	887710
Mexico 01	800	010	0793
Netherlands 31	(0)	348	433	466
New	Zealand 0800	553	322
Norway 47	(0)	66	90	76	60
Poland 48	22	3390150
Portugal 351	210	311	210
Russia 7	495	783	6851
Singapore 1800	226	5886
Slovenia 386	3	425	42	00



South	Africa 27	0	11	805	8197
Spain 34	91	640	0085
Sweden 46	(0)	8	587	895	00
Switzerland 41	56	2005151
Taiwan 886	02	2377	2222
Thailand 662	278	6777
Turkey 90	212	279	3031
United	Kingdom 44	(0)	1635	523545
United	States	(Corporate) 512	683	0100


